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Introduction 

It's evident that the vast majority of websites are of a graphical nature. The presentation 

of your website matters a great deal. You want a competent, professional looking 

website.  We believe you should not have to use multiple different tools - graphics and 

HTML editing - to create your website. We believe you should have complete freedom to 

include any text, graphics, photos anywhere on the page. 

Creating websites should be like creating PDF files - you should not need to know 

anything about what happens 'under the hood'. You would not expect to edit the PDF file 

data directly. You should not need to know, or even see, the HTML that goes into 

creating your website. 

 

What makes Web Designer Premium so special? 

Web Designer Premium is unique in that it's the only truly free-form web design tool, that 

allows true freedom of web page design, with 'anything anywhere' yet produces 

completely accurate WYSIWYG results. In other words you can position text, graphics, 

photos anywhere on the page, any size, any angle, overlaid, with transparency...and 

Web Designer Premium will produce a pixel accurate perfect working HTML page. 

Web Designer Premium can do things that are regarded as near impossible with other 

web-authoring software, such as repel text around irregular shapes and photos. It 

includes advanced vector graphics tools to draw anything from simple shapes to complex 

company logos and graphics. It includes automatic optimization of graphics (not only 

producing optimized resolution images, but automatically detecting repeating elements 

across the website so producing faster, more optimized websites). 

It supports CSS layers with advanced features such as transparency, even graduated 

transparency, mouse-over effects and more.  It creates cross-browser, cross-platform 

totally XHTML compatible HTML websites. And as browsers advance, Web Designer 

advances too and exports your website so as to make best use of the capabilities of the 

latest browsers, while also still working in older browsers that are still commonly in use. 

For example modern devices with high resolution screens see high resolution images in 

your site, while devices and browsers without such capabilities see download and show 

only ordinary resolution image  

See High resolution images (on page 351) for more info. 

On top of all this Web Designer Premium is perhaps the easiest, simplest to learn web 

authoring tool available. 

Web Designer Premium is aimed at graphic designers who do not want to learn HTML or 

scripting languages. For graphics designers it's the perfect 'rapid website prototyping' 

tool. 
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It's also aimed at beginners who just want the easiest possible way of create professional 

looking websites. 

Web Designer Premium provides no programming tools, no script editing and doesn't 

even provide an 'HTML view'. Our design philosophy is this: You do not need to know the 

PDF programming language in order to produce PDF files. So neither should you have to 

know anything about HTML or Javascript in order to create great websites. 

A Website in a Few Steps 

For those with short attention spans (that's most of us), you can discover the main 

benefits of Web Designer Premium by just following the instructions in the initial opening 

document when you start Web Designer Premium. This is both a basic introduction and 

an actual website you can experiment with. You can also find this example document in 

the ONLINE CONTENT CATALOG. 

Open the ONLINE CONTENT CATALOG  - "FILE" > "NEW FROM CONTENT CATALOG" > "FIRST 

LOOK" > "INTRODUCTION" and import the document. 

Here you can find out how to change your website colors, edit your text, drag and drop 

photos, move objects around the page and more. 

Undo 

 

Remember you can undo any change you make using the UNDO button or "Ctrl + 

Z". If you hold the button down you can race back through all your actions, right 

back to the beginning. 

 

Getting Help 

Document info 

"FILE" > "DOCUMENT INFO" displays information about the selected document such as its 

size and any fonts used, together with their permissions. This is a good way to find out if 

you are missing a required font that could prevent the document from displaying 

correctly. 

Anything you type into the comment field is stored as part of the file. This comment is 

displayed whenever you display the document info dialog box. 

Support 

If you can’t find the answer in this guide, we highly recommend viewing the  Designer 

movie tutorials http://www.xara.com/movies/webdesigner8premium. It is the ideal way to 

get to know Xara Web Designer Premium and get an overview of its features, allowing 

you to make the most of the program.  

http://www.xara.com/movies/webdesigner8premium
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Here are some other sources of information and help from Xara and the Xara community 

that may be of use: 

 Program help - Choose "Xara Web Designer Premium Help" from the "Help" menu to 

open Xara Web Designer Premium Help (containing hundreds of pages of 

information).  

 Status bar - Try reading the text on the status bar at the bottom of the main Xara Web 

Designer Premium window. It always describes what actions are currently possible 

and what they will do (even during drags), and helps you learn to use the Xara Web 

Designer Premium tools. It also gives details of what buttons and controls do as you 

move the pointer over them. See Status Bar (on page 67) for more details.  

 Tooltips - If you hold the mouse pointer over a button or control for a short while, then 

a short  message appears telling you what it does.  

 Menus - If you want to know what a menu item does, highlight it and press "F1". 

 Dialog boxes - If you want to know what a dialog box does or how to use it, click HELP.  

 Movies - Use the menu option "HELP" > "MOVIES" or click here 

http://www.xara.com/movies/webdesigner8premium to view a list of available movies.  

 The TalkGraphics forums - Post your question in the popular, dedicated Xara forums 

at TalkGraphics.com (www.talkgraphics.com), where you can ask other Xara Web 

Designer Premium users for advice or suggestions – available 24x7. You can share 

tips and ideas, ask questions or offer solutions to other users. 

MAGIX Support 

Dear MAGIX customer, 

Our aim is to provide convenient, fast and solution-focused support at all times. To this 

end, we offer a wide range of services: 

 Unlimited web support: 

As a registered MAGIX customer, you have unlimited access to web support offered 

via the convenient MAGIX service portal on http://support.magix.net, including an 

intelligent help assistant, high-quality FAQs, patches and user reports that are 

constantly updated. 

The only requirement is that you have registered your product. 

 The online community - on-the-spot support and a platform for exchange: 

MAGIX customers have free and unlimited access to the online community at 

www.magix.info, which includes approx. 120,000 members and offers the opportunity 

to ask members questions concerning MAGIX products as well as use the search 

function to search for specific topics or answers. In addition to questions & answers, 

the knowledge pool includes a glossary, video tutorials and a discussion forum. The 

multiple experts, found round-the-clock on www.magix.info guarantee quick answers, 

which sometimes come within minutes of a question being posted.  

 Email support for MAGIX products: 

For every new MAGIX product you will receive, as of date purchase, 12 months of 

email based customer service. 

 

Please note: To be able to use the Premium email support and free product email 

support via the Internet, you have to register your MAGIX product using the serial 

http://www.xara.com/movies/webdesigner8premium
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number provided. This can be found in your purchase confirmation email, or on the DVD 

case or box. 

 Additional telephone service: 

Besides the large number of free customer service offers, we also offer a fee-based 

telephone customer service available to customers that have purchased from Magix. 

Here you can find a summary of our technical support telephone numbers: 

http://support.magix.net  

Mail (Europe): MAGIX Development Support, P.O. Box 20 09 14, 01194 Dresden, 

Germany 

Mail (North America): MAGIX Customer Service, 1105 Terminal Way #202, Reno, NV 

89502, USA 

Please make sure you have the following information at hand: 

 Program version 

 Configuration details (operating system, processor, memory, hard drive, etc.), sound 

card configuration (type, driver) 

 Information regarding other audio software installed 

MAGIX Sales Department 

You can reach the MAGIX Sales Department workdays for help with the following 

questions and problems: 

 Orders 

 Product consulting (pre-purchase) 

 Upgrade requests 

 Returns 

Europe 

Monday - Friday, 09:00-16:00 GMT 

U.K.: 0203 3189218  

Denmark: 699 18149  

Sweden: 0852500858  

Finland: 09 31581630 

Norway: 0210 30665 
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North America 

9 am to 4 pm EST Mon-Fri 

Phone: 1-305-722-5810  

ToolTips 

 

When you move over a button, the ToolTip 

tells you the function of the button. 

 

About Xara Web Designer Premium 

Choose "HELP" > "ABOUT XARA WEB DESIGNER PREMIUM". This displays general 

information about the program. If you contact the support, you may be asked for this 

information. 
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Getting Started 

This section gives an overview of the main functionality of Web Designer Premium. Later 

sections go into more detail about each tool. 

Program Layout 
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InfoBar - changes with each tool 

 
Website Toolbar 

 
Zoom 

 
Local Designs Gallery (Galleries bar) 

 
Page & Layer Gallery (Galleries bar) 

 
Selector Tool 

 Photo Editing Tool 

 
Drawing Tools 

 
Text Tool 

 
Shadow Tool 

 
Tabs for all open documents - icon identifies document type. 

 
Color Line 

Note: All Web Designer Premium InfoBars now have improved text rendering for easier 

viewing, if you have ClearType text enabled in your Windows Control Panel. 

There are four buttons in the top bar that relate to website functions. Three of these have 

flyout bars which are shown when you move the mouse pointer over them, revealing 

more web function buttons. 

 

 
Export and preview web page/website 

 
Link properties 

 
Website options 

 
Export 

 

 Move your mouse pointer over each button in the flyout bar to see a tooltip describing the 
button. 

There are two ways to create a new website. Either by starting with a pre-designed 

template and then customizing this with your own text, photos and color scheme. Or by 

creating a website from scratch, placing all the required elements, text, graphics and 

photos on the page where you require. 
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Note: By default Web Designer Premium opens a new document showing just one page. 

To view all the pages in your website document, right click a page and choose MULTIPLE 

PAGE VIEW. You can now scroll the Web Designer Premium window up and down to view 

all the pages in the document. 

Zooming / Scrolling / Pushing your page 

These common operations are made very easy: 

 To Zoom in or out, hold "Ctrl" and use the mouse-wheel 

 To push the page, press your mouse-wheel and push (yes it's a button as well) 

 To scroll use the mouse-wheel (or the scroll bars of course) 

 

Web documents are displayed in 

single page mode by default and print 

documents in multi-page view mode. 

Switch between display modes by 

right clicking on the page or 

pasteboard and selecting or 

deselecting MULTIPLE PAGE VIEW from 

the drop-down menu. An example of 

multiple page view is shown to the 

left. 

You can drag and drop items 

between pages. When you make 

document-wide Theme color 

changes, you can see how the 

changes affect all pages. 

The current page is marked with 4 

corner brackets.  

 

In this example you can see some items have been placed on the pasteboard area 

beside the pages. The pasteboard area is useful as a place to keep temporary or working 

graphics, photos or other objects. These objects are not exported as part of your website, 

unless you place them on the special Pasteboard Background layer, in which case they 

are exported as it’s assumed they are intended to form part of the background of your 

site. 

Flyout Bars 

Some tools on the main toolbar are grouped together under a single icon. These icons 

have a small triangle indicator in the bottom right corner and when you move the mouse 

pointer over one of these icons a flyout bar appears. The bar holds the other tool icons 
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that are in this group. Simply move the mouse pointer over each one to see a tooltip, and 

click to select the tool you want.  

If you select a modal tool from a flyout bar, that tool becomes the primary tool for that 

group. So you’ll then see its icon highlighted on the main toolbar.  

There are also some flyout bars on the toolbar at the top of the window. Again these are 

used to group together closely related operations under a single icon. This makes them 

conveniently accessible while not taking up too much space on the bar. 

See Customizing (on page 509) for more information on flyout bars. 

Objects On The Page 

Whether you customize a template or create your own graphics from scratch, you can 

rotate, resize and position anything on the page, anywhere you like. You can easily 

resize the page to be any required size and add new web pages as required. Certain 

features, such as changing color schemes, work across all pages simultaneously. 

These are the basic types of page element: 

 Text: Using the TEXT TOOL you can create anything from single word headings to 

columns of text or even blocks of text that flow from one block into another. You can 

also create bulleted or numbered lists. The TEXT TOOL InfoBar provides controls over 

the font, size, line spacing and more. You can resize text either by using the SELECTOR 

TOOL or by selecting the text in the usual fashion and choosing alternative point or 

pixel sizes. Perhaps surprisingly you can even rotate text by any angle, and by using 

REPEL TEXT UNDER (right click an object to see this option) you can automatically flow 

text around objects on the page, such as photos.   

 Graphics: Any type of logo, heading and most buttons that appear on your website 

are graphics. Web Designer Premium is a vector graphics program which means you 

can edit the shape, rotate and resize your graphic objects with no loss of quality 

(unlike pixel photo editing tools such as Photoshop). And although there is no vector 

graphics standard for web pages (for websites all graphics have to be either JPG, GIF 

or PNG formats) Web Designer Premium creates the correct format and resolution 

automatically. For example, if you want to create a colored panel to place behind your 

text, you'd do this by drawing a rectangle or rounded rectangle object on the page, and 

placing this behind your text. When you export your website, this is automatically 

converted into a PNG graphic image of the correct resolution. 

 Photos: There are few websites that do not contain photos of some sort. Xara Web 

Designer Premium has a great range of photo editing tools. You can drag and drop 

photos directly from your camera or File Explorer window onto the page, rotate, 

enhance, crop, and Web Designer Premium automatically generates the correct 

resolution JPG image. Replacing existing photos in templates is as easy as drag and 

drop - and you can alter the size and angle of photos 'inside' their frame very easily. 

You can easily create clickable photo thumbnails that pop-up an enlarged version and 

optionally include gallery controls that allow your visitors to browse your photos or view 

an automatic slideshow. 

 Placeholders:  These are graphic objects on the page which represent the size and 

position of dynamic "widgets" such as a Flash animations, movies, or forms. When 
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your site is exported the placeholder graphic is replaced by the code required to make 

the widget work and so the working widget appears at the same position on your page. 

See the Website Widgets (on page 436) chapter in the pdf manual for details. 

Right-click context menus 

When you right-click any object in the Xara Web Designer Premium workspace, a drop-

down context menu lists useful operations that are relevant to the object clicked on. For 

example, if you right-click a rectangle you've drawn previously, the drop-down menu 

allows you to perform actions only relevant to a rectangle. 

If you right-click a photo, however, some of the menu options that appear apply only to 

photos, while others are similar to the actions you can perform on a rectangle. The 

object-specific operations are listed towards the top of the right-click menu's list, e.g., in 

the case of a rectangle the first three actions above apply only to rectangles. 

You can also right click both the page and pasteboard to see a menu of page and 

pasteboard  background-related operations you can apply.  

If you select more than one object and right-click, the menu lists actions specific to 

multiple objects, such as group, align and combine, as well as the common operations 

such as cut, copy and delete. Similarly if you right-click objects that you have previously 

grouped, actions specific to a group are displayed.  

It's recommended that you right-click any object or multiple objects in the workspace to 

access the context menu specific to those objects. Once you've done this a few times 

you will know which actions you can quickly perform with right-click menus.  

Object Based Web Design 

All the types of elements described above are collectively referred to as objects. 

One of the unique benefits of Web Designer Premium is that you have complete freedom 

to place any object anywhere on the page, and your website will faithfully reproduce this. 

 

The SELECTOR TOOL can be used to select any object on the page, and to 

move (just drag it), resize and rotate the objects. 

You can adjust the stacking order (that is whether an object appears in front or behind 

others on the page) by right clicking and choosing ARRANGE or using the ARRANGE menu 

options. With the SELECTOR TOOL you can resize objects by dragging on the corner 

resize handles. You can rotate any object by dragging just inside the corner selection 

handles. And although websites do not support rotated text, Web Designer Premium 

knows to automatically create the appropriate graphic image so the resulting page will 

always look exactly right. 

 

To add some text to your website, select the TEXT TOOL and click anywhere on 

the page and start typing.  
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You can also create text columns, by clicking and dragging horizontally in the TEXT TOOL, 

or text areas by dragging diagonally. See the Text section in the pdf manual for more 

details and the Chapter Text Handling (on page 191) for a complete reference of text 

functions of Xara Web Designer Premium. 

 

 

You can use the drawing tools to create rectangles, rounded 

rectangles, circles and ellipses, and just about any shape you like using 

the SHAPE EDITOR TOOL. See the Drawing tools section in the pdf 

manual for more detail.  

 

 

Stacking Order 

All objects on the page are placed one on top of another. The most recently drawn or 

created object is always on top, that is, in front of any others. You can adjust the stacking 

position by right clicking and choosing ARRANGE or using the ARRANGE menu options. 

For example, when you draw a new rectangle it always appears to cover all the objects 

behind it. By right clicking and choosing ARRANGE or pressing "Ctrl + B" (or the menu 

"ARRANGE" > "PUT TO BACK") the object is moved behind everything else. Similarly "Ctrl + 

F" brings any selected object to the top, that is, in front of everything else. 

 

These objects are stacked over each other. 

All objects are collected into named layers, and each layer can be turned on or off to 

show or hide everything on that layer.  

 

The Selector Tool 

 

This tool is a general purpose tool that allows you to select, move, resize, crop 

and rotate all objects on your web page. 
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You can do all these things by just dragging on the objects on the page, or on the 

selection handles around the object, or you can enter precise numeric values. The 

selected object is shown with 8 handles around the outside, and the status line at the 

bottom of the screen also tells you what is selected. 

 

Select a photo and the Smart Photo handles appear (shown left). These allow you to 

crop, resize, rotate and round your photo. Drag on any corner handle to resize an object. 

Drag just inside the corner handles (shown centre) to rotate, stretch and resize. The 

rotate handles appear when you click the object again and allow you rotate and skew the 

object around an anchor (shown right). 

Nudging Objects 

The arrow keys can be used to nudge the selected object, one pixel at a time. If you hold 

"Shift", it nudges objects 10 pixels at a time. 

Rotating Objects 

There are two ways to rotate an object. Either click on the object a second time, so the 

selection handles change to show rotation handles, which you can then drag on to rotate 

the object. Or, when it's showing the square selection handles, move the mouse pointer 

just inside the corner handles until you see the mouse pointer change to a rotation 

indicator - you can then also drag to rotate the selected object. 

 

InfoBar 

When an object is selected, the InfoBar - just above your document - shows all the 

relevant controls for the current tool.   

Important: This bar changes depending on which tool is selected.  

This is the InfoBar in the SELECTOR TOOL: 

 

The InfoBar, just above your document, shows controls for the selected tool.  

You can enter numeric values into any field; e.g. to reduce the size of an object by 20% 

you can enter 80% into the W field (which is a % size). The little padlock selects whether 

both the width and height change together. 
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Copying Objects 

You can use the usual "EDIT" > "COPY" ("Ctrl + C") and "EDIT" > "PASTE" ("Ctrl + V") 

options or right click an object and choose COPY, but a really quick way to copy any item 

is drag on it with the right mouse button. 

You can also copy and paste a page anywhere in your document from the current 

document or another document – see Copying and pasting (on page 72) pages. 

Website Toolbar 

The WEBSITE TOOLBAR at the top of the Xara Web Designer Premium window provides 

convenient access to the main web functions you’ll use regularly. 

 

 
Preview web page/website 

 
Link 

 
Website Options 

 
Publish Options 

 

 Move your mouse pointer over each button in the flyout bar to see a tooltip describing the 
button. 

Creating a website 

There are two ways to create a new website. Either by starting with a pre-designed 

template and then customizing this with your own text, photos and color scheme. Or by 

creating a website from scratch, placing all the required elements, text, graphics, photos 

and placeholders on the page as you require. 

Previewing Your Website 

When creating your website in Web Designer Premium, your working document shows 

an accurate static preview, but to check the behavior of pop-ups, mouseover effects 

and Flash and other widgets it's necessary to use true Browser Preview. 

 

There are two preview options located on the web toolbar. 
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PREVIEW PAGE exports and previews only the current page. So it’s useful if 

you have a large site which takes some time to export as a whole. You 

can just quickly preview the page you are working on, without exporting 

the rest of the site. 

 

PREVIEW WEBSITE exports all the pages of your site and then brings up the 

preview window. So all the pages and links in your site should be working.  

The navigation buttons in the top bar of the preview window allow you move back or 

forward, just like in a web browser, and the Home button returns you to the page you 

started the preview on. 

 

 

You can preview your website or web page in full screen mode by clicking the 

VIEW FULL SCREEN button at the top right of the preview window (press "Esc" to 

exit or "F11" to enter and exit full screen mode). When you close the preview 

window and next reopen it, Web Designer Premium displays the last mode you 

chose for the window, i.e., normal, maximised or full screen. 

If you’ve not yet exported your site, these previews export to a temporary folder on your 

computer. Once you’ve exported, the same export location is used each time you 

preview, so your exported site is continually updated as you preview. 

Choose your preview browser 

Although this internal preview uses a simplified version of the Internet Explorer browser 

by default, you can choose one of the six most popular browser types to view your page 

or website from the preview window. 

To preview your website in your favorite web browser, click one of the following from the 

bar at the top of the preview window: 

Note: These buttons are only enabled if you have installed the browsers on your PC. 

 

Previews your page or website in Google Chrome 

 

Previews your page or website in Mozilla Firefox 

 

Previews your page or website in Internet Explorer 

 

Previews your page or website in Opera 
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Previews your page or website in Safari 

 

Previews your page or website in MS Edge (Windows 10 only) 

 

When you click on one of the above buttons, the browser opens in the page that you are 

currently viewing in the preview window.  

If you want to preview your pages in a browser other than these types, you can right click 

on the exported .htm file and select OPEN WITH..., or you can just drag and drop the file 

onto an open browser window. Once you have exported then each time you click the 

Preview buttons, the export is updated as well, and so it's just necessary to click the 

Reload button in your browser (or press "F5"). 

Using Templates, Clipart & Widgets 

Open the ONLINE CONTENT CATALOG from the menu "INSERT" > "FROM CONTENT 

CATALOG" (or use "FILE" > "NEW FROM CONTENT CATALOG"). 

The Catalog shows folders containing collections of website designs and associated 

graphic files that each follow a specific theme. Look under "WEBSITES" > "WEBSITE 

THEMES"  to find all the template designs available for rapidly building a quality website. 

Under "WEBSITES" > "BUSINESS THEMES", you’ll find complete, ready-made websites built 

for specific types of business, which makes it even quicker to get a finished business site 

online.  

Each website theme section has a collection of alternative page layouts and useful page 

elements. Each also contains a complete website template and several ‘color schemes’. 

You can change your entire site to a different color scheme by just importing the scheme 

from the Catalog onto your page. As you import schemes and templates to your page 

they are added to the LOCAL DESIGNS GALLERY at the same time. 

Under COMPONENTS you’ll find a wide variety of graphics and widgets you can add to 

your site, from buttons, NavBars and text panels, to forms, e-commerce facilities. Just 

import from the Catalog directly onto your page. They will also be added to the LOCAL 

DESIGNS GALLERY at the same time. 

If you’re online, the Catalog updates automatically to show you the latest available 

templates and additions.  

Adding New Pages To Your Website 

You can drag any template design from the ONLINE CONTENT CATALOG/DESIGNS GALLERY 

onto your page. If this is a page template, it will add a new page to your website, after 

first asking if you want to match any color changes. If you drag a clipart item such as a 

button, heading or photo object, this gets added onto the page where you dropped it, and 

again you will be asked if you want to match any color changes you've made. 
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To add a new page of the same design, the easiest way is to right click the page 

and choose DUPLICATE CURRENT PAGE or use the DUPLICATE CURRENT PAGE 

button on the standard toolbar. 

This replicates the current page below. You can then just delete or edit the elements as 

required. This has the advantage of keeping the same navigation structure. 

Or you can copy and paste an existing page in the same or another document. Right-

click an empty part of a page and choose COPY PAGE. In the destination document right-

click a page and choose PASTE > PAGE (or press "Ctrl + V").  

The page on the clipboard is added as a new page immediately following the current 

page. The pasted page adopts the page size of the document it’s pasted into (as long as 

the ALL PAGES IN DOCUMENT THE SAME checkbox is enabled in FILE > PAGE OPTIONS). 

Page layers and attributes and all the objects on the page are also pasted. 

 

You can add a new blank page by right clicking and choosing NEW PAGE or use 

the INSERT BLANK PAGE button in the 'page' flyout menu bar. 

 

You can delete pages by right clicking and choosing DELETE CURRENT PAGE or 

click the DELETE CURRENT PAGE buttonIN THE 'PAGE' FLYOUT MENU BAR. 

 

Embedding Movies, Flash And Other Widgets 

You can very easily embed movies, MP3 audio files, Flash animations, animated GIFs, 

PDFs, photo gallery and unlimited types of other interactive widgets on your website with 

Xara Web Designer Premium. See the Website Widgets (on page 436) chapter for 

details.  

You can create your own Flash and GIF animations using Xara Web Designer Premium. 

See Animations (on page 460) for more details. 

 

 

 

Photo Hover panels 

The Hover panels are a soft grouped (on page 115) collection of ready made photo, text 

and graphic components, which you can readily resize and customize with your own 

photos text and colors. Find them in the Online Content Catalog. 
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The components are soft grouped together on the MouseOver and MouseOff layers in 

the Page and Layer Gallery (on page 447) so bear in mind that you will need to unhide 

the normally hidden MouseOver layer in order to see all the components. 

 

Hover panel with mouseover text layer visible 

Drag a replacement photo onto the panel, use the Text tool to change the text and drag 

and drop a color from the Color line (on page 176) to change the theme.  

  

Preview the panel in the usual way using the onboard browser preview button. 

See MouseOff and MouseOver  (on page 57) layers for more info.  

The Local Designs Gallery 

This gallery is a local offline repository of content imported from the ONLINE CONTENT 

CATALOG. As the name implies, this now shows only content that you have present 

locally on your device, or was downloaded from the CONTENT CATALOGUE. This makes it 

easier to find and access designs you use regularly. 

To open this gallery: 

 Click the LOCAL DESIGNS GALLERY tab on the Galleries bar. 
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 Or choose "UTILITIES" > "GALLERIES" > "DESIGNS GALLERY". 

 

 

The top level folders are divided into four main categories. 

 First Look  

 Components 

 Websites 

 Print 

 Presentations 

Add more content by browsing through the folders and clicking on + MORE ONLINE... This 

will open the relevant folder category in the ONLINE CONTENT CATALOG for you to browse 

and import content to the LOCAL DESIGNS GALLERY.  The folder structure in the LOCAL 

DESIGNS GALLERY mirrors that of the ONLINE CONTENT CATALOG and each folder in the 

gallery has a link allowing you to jump straight into the corresponding folder in the 

CONTENT CATALOGUE, so you can easily view what other content is available for 

download into that folder. Whenever you open or import a design file from the Catalogue, 
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that file then appears in the Gallery and so you can use it even when offline. The freshly 

imported item is also opened in your current document as well. 

You can download a whole category, so it's available offline, by right clicking on the 

category name in the Gallery, and selecting the DOWNLOAD ALL option. The Gallery tab 

informs you of the update status. 

To open a template or piece of content from the Gallery as a new document double-click 

on it. To import it into your current open document, drag it and drop it into your design. 

Page templates are added as new pages to your current document when you do this. 

Other templates and widgets are dropped onto your current page. 

See Document Handling (on page 63) for more information on using galleries generally. 

 

The Online Content Catalog 

The Online Content Catalog is essentially a "cloud" companion to the LOCAL DESIGNS 

GALLERY. That is to say, all the content is stored online and as such requires you to be 

connected to the internet before you can import items to the Local Designs Gallery.  The 

catalog contains Web Designer Premium's full library of Stock photos, SmartShapes, 

symbols, design templates, widgets and vector art, and provides an easy and intuitive 

way to search all of the content.  

When you import a piece of content from the Content Catalog it is downloaded to your 

PC and remains available when you are offline as part of the Local Designs gallery. 

To open the Content Catalog 

 Click "FILE" > "NEW FROM CONTENT CATALOG" (Shift+Ctrl+Alt+K) 
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 Click "INSERT" > "FROM CONTENT CATALOG"   (Shift+Alt+I)  

 

The Online Content Catalog 

The catalog is a resizable window - drag the edges or lower right corner to resize. You 

can enter a keyword to search either all or individual categories, or else traverse the 

content categories on the left. A small pop-up preview appears as you traverse the 

categories - click to select and that category is expanded and shown on the right side. 

For categories that have many items there is a page control at the top right, allowing you 

to flick to the next and previous pages of content. 

Import an item either with a double click or by clicking the IMPORT button that appears as 

you mouse-over the item. After the import, the catalog closes. If you want the catalog to 

remain open after an import hold down the Shift key as you click. 

An enhanced Online Content Catalog is included free for one year as part of our new 

Update Service. It now offers:- 

 Regular updates to the templates as part of the Update Service 

 Full keyword search of the entire catalog 

 A new more logical structure to the content offering a better work flow 

When using the free trial version, items shown in blue in the left content list are free to 

use during the trial period. All items shown in grey are available instantly for free once 

you've purchased and unlocked the program. 

Stock Photos 

One of the categories you will see on the left is STOCK PHOTOS. These are provided by an 

external company called Pixabay and so the first time you import one of these photos 

you will be asked to read and accept Pixabay’s Terms & Conditions. But you only need to 

do this once on each computer you use, then you can import as many photos as you like. 
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The photos are released under a Creative Commons CC0 license and are totally royalty 

free. You can use the images for personal or commercial use with almost no limitation.  

There are thousands of photos available - just select STOCK PHOTOS on the left and then 

enter keywords in the search field at the top to find them. Alternatively you can replace 

an existing photo by right-clicking it in your document, and then choosing  "REPLACE 

PHOTO" > "WITH STOCK PHOTO" from the context menu.  

Stock Illustrations 

In addition to the STOCK PHOTOS, there is also a category of vector graphic STOCK 

ILLUSTRATIONS.  All the images have keywords so you can easily search for the graphic 

you want. Because the original vector files vary enormously in size, graphics larger than 

around 300px are scaled down. Also un-grouped images are placed in a group for ease 

of manipulation. Because this is vector clipart, it’s re-sizable to any size without loss of 

quality. 

Website Colors 

All the templates use a small set of theme colors, and various shades of those theme 

colors. The easiest way to re-color your site is to use one of the alternative color 

schemes provided with each web theme in the ONLINE CONTENT CATALOG/LOCAL 

DESIGNS GALLERY. Just drop a scheme onto your page to change the color of the whole 

site, or double-click on it. 

Or you can edit each of the theme colors individually yourself. These are called 'Named 

Colors' and appear on the left side of the Color Line along the bottom of the window.  
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Current Outline, Fill and Text Background Color 

 
Color Editor 

 
Eye dropper color picker 

 
‘No color’ patch. 

 
Named ‘Theme’ Colors and Linked Colors 

 
Fixed palette of standard colors 

 Hold pointer over a color to see its name 

 
Status line. Shows what is selected, and provides hints 

Simply click on any of the Named Colors and select the EDIT option (if you hover the 

mouse pointer over the color you will see a tooltip name). 

 

 
When editing a color you can drag the eye dropper to pick colors off screen, even 

from other open windows 

 
Select the color to edit: Fill color/Line color of the selected object or any of the 

named theme colors 

 
Click the label icon to create a Named Color 

 
Click to show extended color controls 

 
Previous color 

 
Actual color 

 Drag here to select any shade of the selected hue 

 
Drag here to select any hue 

 
Drag here to increase the window size 

The Color Editor provides an easy way of choosing any color. Click the Extended 

Controls to enter RGB values. 
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Note that when you change a Theme Color in this way, all the related shades used 

throughout the document will change as well. 

Coloring Shapes 

You can fill any drawn shape with a color, either by dragging the color from the Color 

Line and dropping it on to the shape, or by first selecting the object and then clicking on 

the Color Line.  

 Alternatively right click the shape and choose FILL COLOR or click the small Color 

Editor icon (or press "Ctrl + E") to display the Color Editor, where you can set any 

color you like. 

You can give drawn objects a graduated color fill using the FILL TOOL (ON PAGE 257). 

Coloring Imported Clipart 

When you import a clipart graphic by dragging from the ONLINE CONTENT CATALOG, using 

the "FILE" > "IMPORT" option, or dragging a .web or .xar file onto your page, you will 

usually be asked whether you want to match the colors. If you select DON'T MATCH, then 

any named colors used in this graphic will be added to the Color Line. Clicking on any 

color on the Color Line will give you the option to edit the color. 

You can also change the colors of any multi-colored object by selecting it and clicking a 

color on the color line. A dialog appears showing you the set of colours currently used in 

the object – just click the one you want to change. Or bring up the color editor and the 

color list at the top includes the same set of colors – choose the one you want to edit. 

Coloring Photos 

If you try to color a photo it turns it into a 'contoned' photo. For example, to make any 

photo black and white, right click and choose "CONTONE" > "MAKE BLACK AND WHITE" or 

select it and click on the white color patch on the end of the Color Line. You can set the 

light or dark color to be any two colors, not just white and black - right click, choose 

"CONTONE" > "LIGHT" and click a color in the Color Editor. 

 

You can also use the ENHANCE TOOL to provide a direct and very fast way of adjusting 

the brightness, contrast, color adjustment levels and sharpening of photos, You can also 

adjust the individual colors and tints within a photo as well as the shadows and highlights 

- even for ultra high-resolution images. 

Note: If the photo is inside a group, as many of the photo objects in the templates or 

clipart are, then you will have to select the photo inside the group first. You can do this by 

holding "Ctrl" down when clicking on the object in the SELECTOR TOOL. Another way of 

directly selecting the photo is to click on it in the PHOTO TOOL. 
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Website Backgrounds 

Most of the page designs in the ONLINE CONTENT CATALOG have two types of 

background. A wide Pasteboard background that extends across the background of the 

whole browser window when your site is exported. And on top of this sits the Page 

background with the various other elements that constitute the web page. 

 

 
Pasteboard/browser background color 

 
Page background color 

You can easily change the PASTEBOARD color or the PAGE BACKGROUND color by 

dragging and dropping a color from the COLOR LINE or else using the COLOR EDITOR to 

change colors.  

When you create a new blank document ("FILE" > "NEW") the page defaults to being 

transparent (no color) so you just see the pasteboard color behind it which is white by 

default. You will also see a faint rectangle guide outline which shows the boundary of the 

page against the pasteboard. 

In addition, there are a wide variety of ready made background textures for you to use in 

the ONLINE CONTENT CATALOG. Just drag and drop onto the Pasteboard to use. 

See Website Backgrounds (on page 333) for more detail. 
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Photos 

You can replace any photo by dragging and dropping it from your File Explorer onto any 

photo in Web Designer Premium. If you drop it onto the background then it is imported 

and placed where you dropped it. Photos larger than 500 pixels wide will be displayed at 

500 pixels wide, but you can of course change this to be any size in the usual way with 

the Selector Tool. 

There is also the option of importing stock photos from the Online Content Catalog. You 

can either browse the catalog from the File menu. "FILE" > "NEW FROM CONTENT 

CATALOG". Or you can replace a photo by right-clicking it, and then choosing  "REPLACE 

PHOTO" > "WITH STOCK PHOTO" from the context menu. 

 

Drag and drop your photo over any existing picture to replace it. Drop onto the background to 
import as a new photo 

 

When you replace an existing photo, the Photo tool is selected and the 

smartphoto adjustment handles (on page 360) appear on the photo. 
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You can use the adjustment handles to rotate and scale the picture, move it within its 

outline frame, resize the frame and even round its frame edges. 

  

Importing Large Photos 

When importing high resolution photos (anything above 1920 pixels either wide or high) 

into a web document, Xara Web Designer Premium automatically resizes the photo down 

to HD screen size without asking you if you want to import a lower resolution version. For 

a web document, even at the reduced size, there should be more than enough resolution 

in your photos for high quality results on your website, so it’s rarely necessary to import 

digital camera images at full resolution for web use. 

However, if you are importing a large photo into a print or animation document, Xara 

Web Designer Premium asks you if you want to import a lower resolution version of your 

photos. If your document is to include many photos, you may want to choose this 

reduced resolution option. Otherwise with large photos you may find that your saved 

design file is much bigger than it needs to be (because it contains a copy of each of your 

photos). And memory requirements when editing and exporting your document will be 

higher than necessary.   

The Photo Tool 

The Photo Tool provides a range of ways to enhance and crop any photo. 

 

 

To crop a photo, just drag across the photo while in the ENHANCE PHOTO TOOL. 

You can adjust the crop edges by dragging on the crop handles around the 

outside of the photo.  

 

Or use the CLIP TOOL for more control over crops.  

See the section on Photo Handling (on page 351) for background information on the 

advanced way in which Xara Web Designer Premium handles photos, and the section on 

the Photo tool to find out how to use the Photo tool. 

Thumbnail Photos With Pop-ups 

You can very easily create small thumbnail photos that when clicked will show an 

enlarged version. Simply resize your photo to be small, the usual way using the 

SELECTOR TOOL. 
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Select the small thumbnail photo, and select the POP-UP PHOTO option in the LINK 

tab of the Web Properties dialog (click the LINK button in the WEB TOOLBAR).  
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Click the SETTINGS button next to the popup photo option, to change to the IMAGE tab of 

the Web propertiesDIALOG. 

 

There you can change how your pop-up appears. One option allows you to place a title 

above each pop-up photo. Set the title for each photo using the TITLE field. You can also 

optionally show a caption below each popup photo. Just set the IMAGE CAPTION (Alt text) 

for the thumbnail on the same dialog. See the popup photo section of the Web Properties 

Dialog chapter for full details of the options available. 

 

Text 

 

You can edit the text by selecting the TEXT TOOL and clicking on the text. 

You have all the usual word processing facilities, and can paste text from the system 

clipboard. Double click will select a word, triple click will select a whole line - which can 

be useful for selecting all the text in a button. As usual the InfoBar provides a wide range 

of controls for this tool. Alternatively you can right click within text and choose ADVANCED 

TEXT PROPERTIES. 

 

The font menu displays a list of fonts and is split into four sections. The top section 

shows fonts already used in the document, the second section shows web safe fonts,  
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the third section shows available Google fonts, and finally the lower section shows all 

fonts installed on your computer. 
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Live font size pop-up 

 
Fonts used in the current document 

 
Web safe fonts 

 
Style variants available for the selected font. Not all fonts have such variants  

 
Google fonts  

 
All fonts installed 

 Font type - usually either OpenType or TrueType as designated by the 

accompanying symbol. 

The ‘Add’ option in the Google fonts section lets you browse, download and install from 

hundreds of open source fonts that you can use in your website. 

The font menu offers live font selection. As you traverse the menu, the selected text 

changes font allowing you to immediately preview what the font will look like in the 

document.  

Font Size 

The font size field shows the font size in pixels, as this is the most reliable method of 

setting the text size for use in a web browser. But you can enter any size in points (or any 

other unit for that matter), by entering a value with pt after it (for point) e.g. 72pt or 1in 

and this will get converted to the correct pixel size. 

Using fonts in your website 

Fonts in the web safe section are safe to use in websites because the vast majority of 

computers and other devices will have these fonts. You can also use any of the hundreds 

of Google fonts, because these are automatically downloaded by the web browser when 

someone views your site. You can use other fonts you have installed and have them 

automatically embedded in your website if the font license permits it – see the Text 

Handling chapter for details 

If you turn any text object into a graphic, you are free to use any font. See the Groups 

section (on page 44) below for details about this. 

Creating New Text Objects 

There are three types of text object - a single line of text, a column of text or a 

rectangular text area. To create a simple line of text, select the TEXT TOOL and then you 

can click anywhere on the background and start typing. To create a column click and 

drag horizontally on the background, and then start typing. You can adjust the column 

width at any time. To create a text area, click and drag diagonally. You can adjust the 

width and height of a text area by clicking and dragging on it in the TEXT TOOL. 

Rotated Text 

Unusually (uniquely for a web authoring tool) you can rotate any text object, even 

columns of text, using the usual rotate feature of the Selector tool. But because web 

browsers do not support native rotated text Web Designer Premium converts any rotated 

text into a graphic when the page is exported as a website. 
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Bulleted and numbered lists 

Use the bullet and numbered list buttons on the TEXT TOOL InfoBar to quickly enter 

bulleted or numbered lists. You can right click on a numbered list and choose LIST 

PROPERTIES… from the context menu to change the numbering scheme for your list. You 

can also use any graphic as the bullet or number in your list. See the Text Tool chapter 

(on page 191) for more information. 

Soft Shadows, Color Filled Text, Transparent Text 

You can apply any of these effects using the appropriate tools, e.g., if you drag across 

some text in the FILL TOOL it will give it a graduated color, or if you drag on it with the 

SHADOW TOOL it will give it a soft shadow. 

In all these cases Web Designer Premium will automatically convert the text to be a 

graphic on your exported website. 

Text Repel Around Objects 

If you right click on an object like a photo and select the menu option 'REPEL TEXT UNDER 

(on page 227)' you can make text flow around the object that is on top of the text. 

Many of the objects, such as photos, side panels, buttons and headings used in the 

templates from the ONLINE CONTENT CATALOG are automatically repelling - the text will 

always flow around these objects as you drag them around.  

Repelling objects only repel text that is behind the object - so you may have to 'bring to 

front' the object in order for the repel to work ("Ctrl + F"). Alternatively if you only want an 

object to repel text within an individual layer, you can prevent text that is below that layer 

from being repelled - see Layer Properties (on page 449). 

All operations in the TEXT TOOL are live - the text re-formats and re-flows as you adjust 

the column width or move repelling objects around. 

Note: You can now also repel text around anchored objects (on page 42). 

Anchored Objects 

If you want a graphical object to appear next to a particular part of a block of text, you 

can anchor the object to the text so it moves with it.  

Right click the object and choose ANCHOR TO TEXT. Using the SELECTOR TOOL click and 

drag the anchor symbol that appears in the top left of the object to the location in the text 

where you would like the object anchored. Now if you edit or move the text, the anchored 

object moves with the anchor point.  

 

Spell Checker 

 

On the TEXT TOOL InfoBar is a button that selects the spell checker, auto 

correction options and language. If you select CHECK SPELLING AS YOU TYPE this 

will also mark all unrecognized words with a red dotted underline. Right click on 
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any marked word to be presented with suggested alternatives. 

 

Page Size 

The pages in the ONLINE CONTENT CATALOG are designed to be a width that is known to 

fit the vast majority of computer screens. Creating wider pages is not recommended, 

even though you will probably have a wider computer screen, experience shows most 

viewers prefer to have a fixed width page. However you can adjust the page size to be 

anything. 

You can set any page size you like by selecting the PAGE SIZE tab of the OPTIONS DIALOG 

(right click and choose PAGE OPTIONS or PAGE OPTIONS from the FILE menu). It's not 

recommended that you make the page width more than 990 pixels, as that's the 

maximum width for many computer screens (1024 minus a small amount for the scroll 

bar). A more common page width is typically around 800 pixels. 

You can directly adjust the height and width of your page by just dragging on the bottom 

or right margin of the page. Go into the SELECTOR TOOL and hover the pointer over the 

bottom edge of the page, and it will change to indicate you can now drag resize the page 

up or down as required. You will also be prompted to choose whether the change should 

apply to all the pages in the document or website, or just the current one. 

 

Saving Your Work. Creating A Website 

Use the SAVE or SAVE AS menu options to save your work in progress. This saves a file 

with the .web extension, which is the native file format for Web Designer Premium (this is 

not a website). You are recommended to regularly save your work as you go along. If 

you want to edit or update your website in future, you must save a .web file this way and 

use to do further updates. 

It’s also recommended that you work with the automatic backup facility turned on. This is 

controlled from the BACKUPS tab of the "UTILITIES" > "OPTIONS" dialog. When on, a 

backup of your modified open documents is taken regularly. Here you can also choose 

how the program should behave when you close it. You can either be prompted about 

saving or discarding each open modified document, or have all documents automatically 

saved to the backup location and restored the next time you start. 

To save your website, that is the HTML and associated files for publishing to the 

web, use the "FILE" > "EXPORT WEBSITE" menu option or click this button on the 

top bar.  
 

This saves a .htm file for each page and a folder alongside these which contains all the 

graphic files that make up your website. 
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When you export a website, all the pages are exported together, and each page 

unnamed has _1, _2 ... appended to the end of the name you give when you export. The 

_FILES folder contains all the graphics and other files that go to make up your website. 

You can name each page individually if you wish using the PAGE tab of the WEB 

PROPERTIES dialog or using the PAGE & LAYER GALLERY (on page 447). 

The default name given to your website is index.htm as this is the usual name for the first 

page of a website. 

You can preview your saved website in any web browser, by dragging the index.htm (or 

any .htm) file from your Windows File Explorer onto a browser window. 

Automatic backups 

The BACKUPS tab of the "UTILITIES" > "OPTIONS" dialog allows you to turn the automatic 

backup facility on and off. This facility saves a copy of all your modified open documents 

at regular intervals. It’s recommended that you work with this backup option turned on, so 

your work is saved regularly. You can also choose whether you are prompted about 

unsaved documents when closing the program, or if instead all open documents should 

be backed up and restored for you when you next start up. 

See the Document Handling chapter (on page 76) for full details about these facilities. 

Groups 

You can group together any selection of objects on the page. Groups act much like a 

single object, in that you can drag them around the page, resize and rotate them as if 

they were one object. Many of the items in the template designs from the ONLINE 

CONTENT CATALOG such as buttons, text panels, and photo objects are grouped items.  

For example, you can draw a simple button from scratch by drawing a rectangle with the 

RECTANGLE TOOL (on page 153), and then placing a text label on top of this with the TEXT 

TOOL. These are separate objects and you can move them around independently in the 

SELECTOR TOOL.  But if you select both in the SELECTOR TOOL (you can lasso drag 

around to enclose them both, or hold "Shift" and click on additional objects) and right 

click and choose GROUP (or press "Ctrl + G" or use the menu "ARRANGE" > "GROUP"), 

these now become a grouped object (Hint: The status line at the bottom always tells you 

what is selected). Now when you drag, resize, rotate this object, all component parts of 

the group are moved and transformed as if they are one object. You can also 

duplicate/clone (Ctrl+K) objects within photo groups - the cloned object then appears as 

the topmost object in the Photo Group (look in the Page and Layer Gallery (on page 447) 

to verify!) 

Important: Grouped objects are usually converted into a single graphic object when you 

export your web page. 

By un-grouping (right click and choose UNGROUP or press "Ctrl + U"), you can access all 

the parts of your group again to make any changes. An alternative is that you can 

sometimes edit items directly inside a group. For example when using the TEXT TOOL to 
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edit text or the Photo tool to edit a photo, a click will automatically select the item inside a 

group.  

Change or edit any of the separate colors used in a group by just selecting it and clicking 

a color on the color line, or bringing up the color editor. See the Replace Colors section 

for more information. 

Converting Text To Be A Graphic 

As mentioned above only a very limited number of fonts are available in web browsers. If 

you want to use a different font on a button or, say, as a heading, you can do this by 

ensuring it is converted to a graphic, and all you need to do is group the object to make 

this happen automatically. You can still edit the text inside the group, but groups are 

automatically converted into a graphic when the website is exported. 

 

So all you need to do to include a font like this is to group it. It doesn't have to be 

grouped with anything - you can group it with itself, by just selecting GROUP from the 

ARRANGE menu or pressing "Ctrl + G". 

Technical Note:  When such groups are exported as images on a web page, any text in 

the group is used as the HTML ‘Alt’ text on the image (unless you have explicitly set 

some other Alt text for the group yourself). This means that the text will still be picked up 

by search engines and by ‘read aloud’ tools used by people with restricted vision, even 

though the text does not appear directly on the web page. If you don’t want the Alt text to 

be set this way, you can override this by specifying some other Alt text for the group on 

the Image tab of the Utilities->Web properties dialog. 

Soft Groups 

There is another type of group, called a 'Soft Group', which is a more loosely connected 

set of objects. See the Object Handling (on page 92) chapter for details.   

Anchored Groups 

When you make an object anchored to text, it gets put inside an Anchored Group. See 

Anchored Graphics (on page 229) for more information on anchored objects. 

Repeating Groups 

When you make an object repeating, it is placed inside a Repeating Group. See the 

Repeating Objects (on page 124) section of the Object Handling chapter for details. 

Repeating Objects 

It's common to have items like navigation buttons, headers or logos repeating on all 

pages of your document or website. Xara Web Designer Premium provides the ability to 
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repeat any item in the same place on any of your documents. When you update one of 

the copies, all changes are automatically replicated across all pages.  

See the Repeating Objects (on page 124) section of the Object Handling chapter for 

details. 

Creating Buttons, Banners And Other Web Graphics 

Web Designer Premium is great tool for creating any standalone web graphics for use 

with other programs or other web authoring tools. You can draw these objects from 

scratch using the drawing tools, or use ready made web clipart from the ONLINE CONTENT 

CATALOG. Just draw, design or import an item from the ONLINE CONTENT CATALOG onto a 

blank page. Manipulate this as required - size it, color it and change the text or fonts as 

required, and then export the item as a PNG or JPG. 

For example this is how to create a standalone button graphic from a template: 

Open the ONLINE CONTENT CATALOG and then the COMPONENTS category to import the 

component into your document.  

Edit this as required e.g. you can: 

 Resize it (or rotate) it using the SELECTOR TOOL 

 Change the color by clicking on the appropriate colors on the left end of the Color Line 

and choosing 'edit' 

 Change the text with the TEXT TOOL 

When you're happy, select the object and export it as a PNG 

or JPG using the  buttons in the Website bar (these are on a 

flyout bar on the Export HTML icon). 
 

For almost all graphics, such as buttons, headings, icons and other non-photographic 

objects you should use PNG format. For items that contain photos or that have large 

textured parts made from photos, then JPEG is a better format. If you're saving a rotated 

photo, or one with a soft shadow, or soft edge, then this should be in a PNG format, but 

be warned this will be a lot larger file than JPEG. 
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If you click the SETTINGS button in the Export file dialog you can access an advanced 

control panel that lets you optimize the image. 

 

Here you can compare side-by-side two different versions of the same image. For 

example you can compare a JPEG against a PNG version of the same graphic to 

compare the quality and / or file size, or you can compare two differently optimized PNG 

images. Refer to the reference chapter on the Export dialog (on page 496) in the pdf 

manual. The in the above example the JPEG compression is being adjusted to produce 

the optimum file size. 

 

Links, Buttons & Navigation Bars 

You can add a web link to any object, a button, graphic or some text.  

 

Select the object and just click the link icon on the top bar to enter the web 

address that you want to link to. 
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Enter the web address you want to link to in the highlighted field.  

The LINK tab of the Website Properties dialog allows you to control what happens when 

you click the linked object on the page. You can jump to any other web page (you can 

quickly select to link to any other page within your website by using the LINK TO drop 

down) and you can control whether this opens the page in a separate window. You can 

also link to any pop-up layers if you have created these.  

 

So to set one of your buttons to be a link, just select it (click on it in the 

SELECTOR TOOL), click the icon, and enter the web address, or just select one of 

your pages from the drop- down list and click APPLY. That's it. 

 

When you have created a link to an object you can quickly change its behavior by just 

clicking on the object. A Pop-up will appear with the link's details and options to Change 

or Remove the link. 
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Changing Button Text 

This is easy - in the TEXT TOOL, just click on the button text and edit it.  

Hint: if you triple-click on the button text that selects the whole line of text for easy 

replacement when you type. 

Note: You can’t edit the text of navigation bars this way, if the bar is set to be a site 

navigation bar. You need to edit the labels using the Navigation Bar Properties dialog 

instead - double-click a navigation bar to display it. 

Mouseover (Rollover) Buttons 

You will have noticed that most buttons highlight as you move the mouse pointer over 

them in your browser. This is called a mouseover, or sometimes a rollover effect. This is 

all automatic for most buttons used in the templates or from the Button section of the 

ONLINE CONTENT CATALOG.  But you can also create your own mouseover buttons – see 

the Layers section below. 

 

Adding New Buttons 

In the ONLINE CONTENT CATALOG, each Theme has a collection of button graphics that 

you can just drag onto the page. Typically there are two types of button. The ones called 

Stretch Button will elongate to accommodate the button label text. 

In addition under COMPONENTS there is a Buttons category that has a set of general 

button designs that can be added to your page in the same way. 

Or you can copy any existing button. You can copy/paste, but a much quicker shortcut is 

to drag with the right mouse button held down. (This is a general shortcut to copy any 

object). You can now just edit the text and link as required. 

Tip: If you hold the "Ctrl" key while dragging it will constrain the drag to be perfectly 

horizontal or vertical, making it really easy to create a row or column of buttons. 

Button Bars (NavBars) 

 

Most websites, and so most of the template designs we provide, have a row or column of 

buttons to navigate around the website or to other places. This is called a Navigation Bar 

and Xara Web Designer Premium includes special support for these bars. Read the 

Navigation Bars Chapter (on page 413) for full details about Navigation Bars. 
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Displaying your own icons in browser tabs: favicons  

You may want to display your own customized icon, for example, a logo, on your site's 

page tabs when they are displayed in a web browser. Web Designer Premium allows you 

to do this by applying the name 'favicon' to your custom tab icon. 

To create a 'favicon', draw or drag on to a web page the image that you want to use. The 

image can be any size as it will be scaled to the right size automatically when displayed 

in a browser. 

  

Click it then click the Names button to the right of the SELECTOR TOOL InfoBar. 

In the Names dialog, type 'favicon' into the APPLY NAMES box and click ADD then CLOSE. 

 

Preview your website in your choice of web browser. The easiest way is to click one of 

the Preview icons and in the Xara Web Designer Premium preview window, and then 

choose one of the web browsers in the top right of the preview window. 

Your web page tab is displayed with the custom icon, as shown in the example below. 

 

You can only use one favicon per website. Publish your website and view it to see your 

favicon. 

  

Drawing Tools 

 

 

Web Designer Premium provides all the graphics tools you 

need to create just about any graphical object on your page, 

as well as a range of pre-designed graphical elements in the 

ONLINE CONTENT CATALOG. There are several basic drawing 

tools that let you create rectangles, ellipses, regular 

polygons, stars or any shape you like.   

Web Designer Premium provides vector drawing tools which means you can resize, edit 

the outline shape and re-color with no loss of quality. You can zoom in to see almost 

infinite detail, and all edits are undoable.  
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Shape Tool 

  

The SHAPE EDITOR TOOL allows you to create detailed vector based shapes, 

and also to edit the outline of any shape. 

For preset shapes such as rectangles or ellipses, or if you want to edit the outline of your 

text character shapes, you need to convert the object to an editable shape first. You can 

do this by selecting the "Ctrl + 1" key shortcut. You can then use the SHAPE EDITOR TOOL 

to perform various advanced vector editing. Refer to the reference section on how to use 

this very powerful tool. 

Straight Line and Arrow Tool 

  

The STRAIGHT LINE TOOL makes it easy to draw single segment straight lines 

and to add arrow heads and tails to any lines.  

Simply click and drag on the page to draw a straight line. You can click on any existing 

line to select it, and once selected you can click-drag on either end to move the end of 

the line around. 

Adding arrowheads and tails using the Straight Line tool 

The InfoBar has two dropdown lists on the left which allow you to choose an arrow head 

or tail style for each end of the selected line.  

 

 
Arrow head 

 
Arrow tail 

 
Arrow head/tail size 

 
Reverse path 

The slider on the InfoBar allows you to change the size of the arrow head and tail on the 

current selected line. Or you can enter a percentage value into the size text field to the 

right of the slider.  

By default new arrowheads are created with a width of around 6 times that of the line 

width and that is taken as the 100% size, as indicated by the size slider. If you make the 

line wider, the arrowhead width also updates accordingly. Therefore enter a value less 

than 100% to reduce the size of the arrowhead (and tail), or greater than 100% to 

increase. Although the slider only takes the size value up to a maximum of 800%, you 

can enter percentage values larger than this into the size text field. 

Reverse path 

  

Press the Reverse path button on the InfoBar to switch around the head and tail 

of the selected line. 
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Adding more line segments 

Lines created with the STRAIGHT LINE TOOL are of course fully compatible with the other 

drawing tools. So if you want to add more segments to a line, make it curved, or perhaps 

even turn it into a closed shape, use the SHAPE EDITOR TOOL. 

Rectangle Tool 

To draw a rectangle, select the RECTANGLE TOOL and just drag across the page. 

You will see a solid filled shape as you drag across the page, indicating the fill 

and line color and boundaries of the shape you are drawing. 
 

 

Click the 'curved corners'  button on the InfoBar to make this a rounded rectangle 

- and you can drag on the curved corner handle to adjust the roundedness. 

 

You can drag on any corner handle to resize an object. 

Drag and drop a color from the Color Line onto your shape to re-color it. See Coloring 

Shapes (on page 34). With the SELECTOR TOOL you can drag it, resize it and rotate it as 

required. See Selector Tool (on page 22).  You can put this rectangle behind all other 

objects as a background image, by pressing "Ctrl + B" for 'Put to back'. Alternatively if it's 

in front of all other objects ("Ctrl + F") then you can right click on it and select REPEL TEXT 

UNDER to make the text on your page repel around the outside of this shape (another 

Web Designer Premium first for any web authoring tool.) 

Fill Tool 

 

You can easily put a graduated color fill onto a shape using this tool 

(and a lot more besides). Select the tool and just drag across your 

object. 

The fill arrow can be adjusted by dragging the ends to alter the direction, angle and 

extent of the graduation.  
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Rounded rectangle with a graduated fill. 

Note: If you drag with the FILL TOOL across a grouped item, such as a text panel, then 

everything in the group takes on the same fill style. To overcome this you must first 

select just the item you want to fill. You can do this several ways. A single click on the 

item with the FILL TOOL will select just that item, as will a click in the SELECTOR TOOL with 

the "Ctrl" key pressed (this is called 'select inside' because it selects just the one item 

inside the group).  Now when you drag it will fill only the selected object. 

To edit the start or color of the fill just drag and drop a color from the color line onto the 

shape, or you can select the end of the Fill Arrow in the FILL TOOL and use the Color 

Editor ("Ctrl + E"). 

You can create a multi-stage graduated fill by making sure the fill arrow is visible (select 

it with the FILL TOOL), now just drag a color from the Color Line and carefully drop it on 

the arrow line where you want the new color. You can now drag this fill point, or select 

"Ctrl + E" to adjust the color using the Color Editor. There are different fill styles, for 

example this is a circle with a circular fill. 

 

The shadow is another ellipse with a graduated color fill and feathered (see below).  

Transparency Tool 

 

Modern browsers support advanced transparency effects, and so does Web Designer 

Premium. You can adjust the transparency of any graphic or photo to make it see-

through. Try it on your rectangle example. Just select the TRANSPARENCY TOOL, and 

adjust the large slider on the InfoBar. 
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More than this, Web Designer Premium supports graduated transparency. It works very 

like the graduated color fill. In the TRANSPARENCY TOOL just drag across your shape and 

you can see the transparency fades. You can adjust the degree of transparency of each 

end of the fill arrow, by clicking on either end of the arrow, and adjusting the 

Transparency slider. 

Preview this and you'll find this works in your browser as well. 

Feather 

This is a graphical term for blending the edges of objects. Web Designer Premium 

provides a feather control that enables any object, graphics, text or photo to be feathered 

- giving it a blurred edge that blends with the background. The Feather control is not a 

tool on the left, but one of the controls on the top bar. Try it on your rectangle shape. 

Select the shape and then click this Feather control on the right of the top bar. 

 

The shadow below the ball drawing above has a feathered edge. Combining all of these 

controls you can very quickly produce amazing layered graphics for your design, all 

directly in Web Designer Premium without needing any other graphics tools. 

 

This is an example of a rounded rectangle with 

grad color, grad transparency and feathered 

edges with some text placed on top of it. 

This has a graduated color fill, light to dark green 

going left to right. It also has a vertical graduated 

transparency fading from top to bottom. The 

feather gives it a soft edge. It takes a couple of 

seconds to create such an image, and it's 

automatically converted to the right graphic when 

you save your design. 

 

Shadow Tool 

A very popular graphics effect is to create a soft drop- shadow under a graphic or some 

text. This serves to lift the object away from the background.  

 

The SHADOW TOOL lets you add a soft shadow to any object, text, graphics or 

photo. Select the SHADOW TOOL and just drag on the object. You can adjust the 

shadow blur and transparency using InfoBar controls. 
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Some text with a soft shadow.  

To adjust the position of an existing shadow, go into the SHADOW TOOL and drag on the 

shadow. 

 

Example Graphics 

 

This button combines many of the features described above - it's drawn by combining 

just a few feathered shapes, and using graduated transparency (the white reflection 

effect). The text has a slight soft shadow and the button has a glow shadow. The whole 

thing is grouped.  (You do not need to draw this button as it's provided in the Button 

category of the ONLINE CONTENT CATALOG). 

The huge benefit of vector graphics, compared to 'bitmap' graphics created in pixel 

editing software, is that you can re-color, edit, rotate, and resize the button with no loss of 

quality. Make it huge and it remains pin sharp: 

 

On top of that you can re-color easily, Just select, click a color and choose the color you 

want to replace from the list shown in the Color Replacement dialog that appears. And it 

will even stretch as required - everything in Web Designer Premium remains non-

destructive (which means you can always edit it, with no loss of quality). 

 

Something that would take skill and time to produce using alternative graphics software, 

is trivially easy in Web Designer Premium. 
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Layers, Mouseover (Rollover) & Pop-ups 

As mentioned earlier all objects have a stacking order on the page - from the backmost 

to the frontmost item. 

 

These objects are stacked over each other. 

In addition, all items can be placed into named layers. Each layer can have any number 

of objects, and has the ability to be turned on or off. When the layer is turned off all 

objects on that layer become invisible. 

 
The layers are controlled from the PAGE & LAYER GALLERY in the Galleries bar. 

In Web Designer Premium layers are used to provide mouseover (sometimes called 

rollover) features on your website. These include highlighting buttons (they highlight 

when you move the mouse over them) and also other pop-up effects such as text panels 

containing a detailed product description. 

Mouseover Effects 

There are several types of mouseover effect you can control. Firstly the one used by 

mouseover buttons, where any object with a web address can display an overlapping 

graphic object that appears on a layer called MOUSEOVER. See below for more detail. 

There also is a more powerful mouseover ability where you can make the contents of any 

layer appear as your mouseover, or click any object on your page. This pop-up layer can 

contain text, graphics, photos or any combination of these things. More below. You can 

also add a wide range of animations effects see Mouse over properties for more details. 
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The MouseOff and MouseOver Layers 

All the main objects on your website are placed on the bottom layer, usually called 

MOUSEOFF. Buttons that highlight when you move the mouse over them on the web page 

have an alternative graphic on the layer called MOUSEOVER.  

 

If you open the PAGE & LAYER GALLERY you can show or hide any layer by checking or 

un-checking the visibility icon (the eye symbol). This is a way of showing what your 

MouseOver elements will look like on your page. 

The current layer is always indicated with an arrow in the PAGE & LAYER GALLERY - the 

MouseOff layer in the above diagram - and this is the layer that all new objects are drawn 

on.  To place objects on any other layers just click the required layer in the PAGE & LAYER 

GALLERY, ensure the eye and the lock icon are open for that layer. 

Note: The MouseOver layer must always be above, that is on top of, the MouseOff layer, 

as shown in the above example. 

To edit the objects on a layer both the 'eye' and 'lock' icons have to be open - this means 

you can see and edit the layer (as shown above in the MouseOff layer). 

Mouseover (Rollover) Buttons 

Almost all the ready-made buttons from the ONLINE CONTENT CATALOG have a 

mouseover effect in Web Designer Premium.  These are created by having two versions 

of each button, the main one on the MouseOff layer and a 'highlight' one on the 

MouseOver layer.   

Normally you do not need to know or care about this because both buttons behave as 

one - the changes you make to one, such as editing the label text, are reflected on the 

other version. If you move, drag or resize a button on the MouseOff layer, the other 

version on the MouseOver layer will change as well, even if you can't see it. This is done 

using Soft Groups (on page 115). 
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Layer ordering in website documents 

If your website document has mouseover effects, popup layers and perhaps even 

mouseover effects on those popup layers, there are some important rules you need to 

follow in terms of how you order the layers in your document. If you don't follow these 

ordering rules, you may find that some of the effects don't work. 

Considering the layers in turn from background to foreground (which is working upwards 

in the PAGE & LAYER GALLERY), first you must have all the static layers. These are layers 

which are always visible and are not used as popups. In most designs there will only be 

one – the "MouseOff" layer. But some designs may have several, in which case they 

must be the first layers in the layer stack. 

Next comes the MouseOver layer, if there are mouseover effects on the static layer(s). 

This contains the mouseover states for all your mouseover buttons. This must be 

followed by the "MouseDown" layer, if you have mousedown effects on the static 

layer(s). 

Next you may have a popup layer. If the objects on this popup layer have mouseover 

effects, then the next layer following the popup layer must be the layer holding those 

effects. It must have a name that begins with "MouseOver", E.g. "MouseOverPopup1". 

And then if the popup layer also has mousedown effects, a layer whose name begins 

with "MouseDown" must follow containing those effects. 

Then you can have another popup layer, followed again by any mouseover and 

mousedown layers for that popup layer. And so on - you can have as many popup layers 

as you like. 

So to summarise the above, in general the layer ordering needs to be as indicated by the 

following list, which is shown in the same order as displayed by the PAGE & LAYER 

GALLERY (foreground to background). All layers are optional and the layer names can be 

anything you like, except for the characters shown in Bold, which identify the special 

mouseover and mousedown layers. 

MouseDown popup n 

MouseOver popup n 

PopUp layer n 

... 

MouseDown popup 1 

MouseOver popup 1 

Popup layer 1 

MouseDown 

MouseOver 

Static layer n 

... 

Static layer 2 

MouseOff 

 

Note that you only need to be concerned with these ordering rules if you are building 

complex pages with multiple popup effects! If you are just using the template designs 



 

Getting Started 59  
 
 

 

provided in the ONLINE CONTENT CATALOG, you should not have any problems with layer 

ordering on your website. 

Moving Objects Between Layers 

There are several ways to move objects between layers. First select the object or objects 

you want to move, then; 

 CUT the object ("Ctrl + X" or right click and CUT). Ensure the target layer is the current 

layer (shown with  , click the layer if it's not) and then right click and choose PASTE or 

PASTE IN PLACE. Note that if you cut or copy multiple items that are on different layers, 

the layer structure is preserved when you paste. Items are pasted to the same layer 

they were copied/cut from, instead of being pasted to the current layer. If you want to 

paste all such items to the current layer, ignoring the layer structure, use the PASTE IN 

CURRENT LAYER option instead. If you want to retain layer structure, choose PASTE IN 

PLACE IN CURRENT LAYER. These paste options are also in the clipboard fly-out bar on 

the top bar, as well as the EDIT menu. 

 Right click and choose ARRANGE then MOVE TO LAYER IN FRONT / MOVE TO LAYER 

BEHIND to shift the selected objects one layer up or down. 

 Ensure the target layer is selected as current, then find the selected item in the PAGE & 

LAYER GALLERY (click the LOCATE button), right click and select MOVE TO CURRENT 

LAYER. 

Applying settings to popup layers 

You can apply a transition to a popup layer to control how the layer appears, as well as 

choosing how the popup layer closes. 

1. Click the layer in the PAGE & LAYER GALLERY and click the PROPERTIES button at the 

top of the gallery. 

2. Click the POP-UP SETTINGS tab of the Layer properties dialog. 

3. Choose an effect from the TRANSITION EFFECT drop-down list and move the slider to 

set a speed for the transition in seconds. 

4. Choose how you want the popup layer to close using the check box. Leave it 

unchecked if you want the popup layer to stay open until you close it manually, or 

else check the box if you want it to close automatically when you click on another 

part of the webpage. 

5. Click APPLY. 
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Note: The mouseover layer appears and disappears as you move the mouse pointer on 

and off the triggering object. If you use a click method to display the layer (from the Link 

dialog), then the layer is revealed by a click on the object, and is hidden when you click 

anywhere else on the page (or when you click on the pop-up layer’s close button if you 

have turned off the "Close pop-up automatically" option shown above). 

 

Pop-up Layers 

A more powerful alternative allows you to display the contents of any layer as a result of 

mousing over, or clicking, any object. This can be used for a range of different pop-up 

effects such as pop-up photos, menus or detailed object descriptions.  

To do this, place all the objects you want to pop-up on a new layer (in the PAGE & LAYER 

GALLERY click NEW LAYER while you have a layer selected - don't use the MouseOver 

layer), then set the Mouseover property (MOUSE-OVER tab of the Web Animation dialog) 

of the original object to trigger the display of this layer when you mouseover any other 

object. For example you can make a pop-up, like this, appear as you mouse over some 

text: 
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Here are the steps to create a pop-up text block like this: 

1. Click NEW LAYER in the PAGE & LAYER GALLERY, while you have a layer selected, to 

create a new layer. 

2. Draw a rounded rectangle with the RECTANGLE TOOL, click a (pale) color patch on 

the COLOR LINE to give it a fill color. For good measure give it a soft shadow (select 

the SHADOW TOOL and just drag on the rectangle). 

3. Create a block of text on top of your rectangle. Select the TEXT TOOL and drag 

diagonally across the rectangle. Type your text. You probably want to hide the pop-

up layer now, so just un-check the 'eye' checkbox of your new layer. 

4. Back on the base (MouseOff) layer (click it in the PAGE & LAYER GALLERY to set this 

as current layer) now select the text you want to trigger the pop-up, using the usual 

method (in the Text tool). Then open the Web Animation dialog (right click and 

choose WEB ANIMATION...) and on the MOUSE-OVER tab select the new layer from the 

SHOW POP-UP LAYER drop-down menu. Click OK. 

5. Preview and test your mouseover effect. 

If you want the pop-up to only appear when you click, then select the SHOW POP-UP 

LAYER option on the LINK tab of the Web Properties dialog (on page 292) instead. 

Note: The mouseover layer appears and disappears as you move the mouse pointer on 

and off the triggering object. If you use a click method to display the layer, then the layer 

is revealed by a click on the object, and is hidden when you click anywhere else on the 

page. 

Pop-up Photos 

There is a second, easier, way of showing enlarged photos from thumbnails, that does 

not involve creating new layers. See the Photo section (on page 37) earlier in this 

chapter. This method is better for when you have large pop-up photos as the pop-up 

photos are not loaded until the thumbnail image is clicked. 

Publishing Your Website 

To get your website onto the internet instantly, you can either publish it to Xara Hosting, 

which includes a free hosting service, or to any other web space. Publishing to Xara 

Hosting is simplest because it’s integrated into Web Designer Premium. 
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Choose "FILE">"PUBLISH" website. Then either sign into Xara Hosting, or press the 

PUBLISH TO ALTERNATIVE WEB HOST link.  

Xara Hosting 

Press the REGISTER button if you don’t have a Xara Hosting account already – 

registration is free, quick and easy. Sign in with your email and password – click KEEP ME 

SIGNED IN to avoid having to sign in again in future Web Designer Premium sessions.  

When the Xara Hosting publish dialog appears, just click the PUBLISH button to put your 

website at the root of your web space, or enter a sub-folder name first if you want to 

publish multiple sites. To get a different website address, press the NEW WEB ADDRESS 

button. 

Other web host 

Enter the FTP details for your web hosting space – these details should be provided by 

your web hosting company.  

You need:- 

 Host address 

 Username 

 Password 

 Sub-folder 

 URL of published website 

See the main Website publishing (on page 340) section for more detail. 

Transferring data 

1. After you have clicked EXPORT (or PUBLISH), Web Designer Premium displays a 

small window that shows the progress of data transmission and tells you when the 

publish is complete. If you entered your website's URL with the FTP details then 

you can go straight to it from this location.  

2. Alternatively, as soon as the transfer is finished, you can open a browser window 

and navigate to the URL of your published website. 

Note: If you entered a sub-folder in the Publish tab of the Web Properties dialog, your 

website is saved there. 

Note: Many web servers use case-sensitive filenames. So, for example, the web 

address xara.com/products.htm is not the same thing as xara.com/Products.htm. To 

reduce confusion and the likelihood of errors Web Designer Premium enforces that all 

page names are all lower-case and contain only allowable characters. This means that 

spaces are not allowed in page names. We suggest using an underscore as an 

alternative separator.  
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Document handling 

Starting a new document 

Primarily, there are four different types of documents in Xara Web Designer Premium, 

i.e. web page, presentation, photo and animation.  

To start a new document choose "FILE" > "NEW" 

This opens a sub menu with several pre-defined template documents to start from. The 

first template is the default and is used to create a new document after starting Xara Web 

Designer Premium. The Animation template is the default template for animation 

documents. 

 

The NEW DOCUMENT button on the Standard control bar creates a new 

document using the default template (shortcut "Ctrl + N"). 

You can save your own templates with the "FILE" > "SAVE TEMPLATE" command – see 

"Changing the template document (on page 509)" for details. 

Opening an existing document 

To open an existing document: 

 Drag & drop a file. Select the file in Windows Explorer or on your desktop, and drag it 

over an existing open document to import it  into that document, or any other part of 

the Web Designer Premium window to open the document. 

 Or double click a Web Designer Premium file. 

 Or to open a recently used file, select it from "FILE" > "OPEN RECENT" 

 Or select "FILE" > "OPEN" (shortcut "Ctrl + O"). 

 Or click the OPEN button on the standard control bar. 

 

The open dialog will be displayed. The dialog allows multiple file selection, "Ctrl 

+ click" to select several files or "Shift + click" to select a range of files. 

 
As in Explorer windows, you can switch the file display to a detailed or thumbnail 

view with this button 

If SHOW PREVIEW in the upper right corner is checked, the selected file is shown in an 

even bigger preview (this does not work for a multiple file selection). 

Online editing in the Cloud 

Web Designer Premium  can now sync files via Dropbox and Google Drive. These 

services provide free file storage in the Cloud, and a small desktop utility that can be 

installed on your PC that will automatically sync files saved on your hard disk to the 

cloud.  
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Web Designer Premium will notice if files have changed, and will automatically reload 

updated files. It means that you can have the same file open on multiple computers, and 

if you make an edit, and save the file, then it will be updated in Web Designer Premium 

on the other computers. Further, using cloud based file sharing, you can share the file 

with someone else, and whenever they edit the file and save, your version will be 

updated, and vice versa. 

This does not solve the problem of edit clashes. So if you edit the file and at the same 

time someone else edits the same file, then Web Designer Premium will tell you there 

has been an edit and give you the choice of opening the updated file in a new document. 

For more details see the quick start guide for Xara Online Designer here 

http://kovemi.xara.hosting/XOLDesigner-Intro/ 

 Xara Online Designer, Online editing, Online, Document sync, Dropbox sync, cloud.xara 

The Xara Web Designer Premium window 

 

http://kovemi.xara.hosting/XOLDesigner-Intro/
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Title bar 

 
File name for currently displayed file 

 
Standard button bar 

 
Galleries bar 

 
InfoBar 

 
Toolbars 

 Rulers 

 
Page 

 
Pasteboard background 

 
Color line 

 
Status line 

 
Live drag / snapped indicators 

 
Web toolbar 

 Document tabs for every open file  

The Web Designer Premium window is similar to a conventional sheet of paper on a 

drawing board or easel. The white rectangle represents the sheet of paper (the spread or 

page). The pale border is the pasteboard background. 

You can change the size of the page by right clicking it and choosing PAGE OPTIONS, then 

click the PAGE SIZE (on page 517) tab.  

Selected document and title bar 

You can have more than one file open at a time in Web Designer Premium, which 

displays all open documents as tabs at the top of the workspace. 

The current document is displayed in the workspace and its name is highlighted gray in 

the document tabs. Right click on a document tab for a menu of document operations. 

The current document type is indicated in the top left corner of the Web Designer 

Premium window, next to the menu options. The current document receives all input. Any 

unsaved changes in a document are indicated with a star after the file name. 

 

Document tabs show all open documents, with the current document tab highlighted gray.  

Control bars 

These contain buttons that you can use to operate Web Designer Premium. You can 

customize control bars in several ways, such as re-ordering, creating, and hiding bars. 

The default window shows the standard button bar with commonly used buttons: 

 

You can customize the standard control bar in the same way as other control bars. 
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Those icons with a triangle indicator in the bottom right corner have "fly-out bars" on 

them. Hold the mouse pointer over these icons and you’ll see the fly-out bar appear, with 

more icons. 

For information on customizing control bars, refer to "Customizing Web Designer 

Premium (on page 519)". 

InfoBar 

This is a special control bar. Its contents change when you select different tools. InfoBars 

specific to certain tools are described in their relevant chapters. 

You cannot customize the InfoBar. 

 

The InfoBar for the Selector Tool 

Main toolbar 

 

This is a control bar that initially contains all the tools available in Web 

Designer Premium (see left). You can customize the toolbar, or move tools 

to other control bars. 

Some of the toolbar icons have a small triangle indicator in the bottom right 

corner. This indicates that there is a flyout bar containing more tool icons. 

Hold your mouse pointer over the icon to see the flyout bar appear.  

 

You can then move the mouse pointer over each icon in the bar to see a 

tooltip indicating what each one does. Click on a tool to select it (some tools 

have keyboard shortcuts, too). 

For information on customizing control bars, refer to "Customizing Web 

Designer Premium (on page 519)". 
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Rulers 

 

You can hide the rulers, change their zero point (origin), and 

use them to create guidelines. For more information, see 

Rulers (on page 79). 

 

The status line 

 

 
Selected objects 

 
Available options 

 
Indicators 

 
Mouse pointer X-Y 

This appears at the bottom of the window. The status line tells you about the selected 

objects, available options, live drag/snapping indicators, and the X/Y position of the 

pointer. 

The indicators 

These appear on the right of the status line: 

 Live drag indicator 

This indicator shows whether live drag is active or not (it is active by default). 

Double click the indicator to toggle live drag on/off. When active, if you 

reposition, resize, or rotate an object, the whole object moves (not just an 

outline), making it far easier to judge the effect of your edits in real time. Drawing 

in the FREEHAND, STRAIGHT LINE, QUICKSHAPE, RECTANGLE and ELLIPSE TOOLS 

(on page 154) is also live with this option on. If your computer is unable to cope 

with a particularly complex document, it will automatically turn active drag off to 

ensure editing remains fast and efficient. 

 

 

Snapped indicator 

This indicator is active when SNAP TO OBJECTS is enabled. Click the SNAP TO 

OBJECTS button (shown left) to toggle off and on. Snap to objects allows you to 

see potential snapping paths and points relative to other objects and the page 

center and edges by showing blue snapping lines for snapping paths and red 

dots for points as you drag an object. For more information on snapping, refer to 

"Object Handling (on page 92)". 

 

X/Y co-ordinates 

Web Designer Premium shows measurements relative to the bottom left corner of the 

page area or spread. However, this is configurable. For more information refer to OBJECT 

HANDLING (on page 92). 
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Normal/full screen modes 

In normal screen mode part of the window is occupied by the title bar, menu bar, and 

scroll bars. This can be inconvenient if you want the maximum possible editing area. 

Web Designer Premium has a second screen mode, fullscreen, which displays a more 

streamlined screen. You can configure each screen mode as you wish. For example, 

each can have its own configuration of the control bars. The configuration is remembered 

and applies whenever you swap between screen modes. 

Normal/full screen is controlled by "WINDOW" > "FULL SCREEN" or right click and choose 

FULL SCREEN ("8" on the numeric keypad toggles between the two displays). 

To display the menu bar in full screen mode, move the pointer to the top of the screen. 

Opening a second window 

You may want to open a second window onto the same document to: 

 Get an enlarged or reduced view of the document; 

 Show another part of the document; 

 Have two views of the same area at different quality settings (quality settings are 

described later.) 

Choose "WINDOW" > "NEW VIEW" to open another window. You can have several windows 

open on the same document. Additionally, Ctrl+Tab will allow you to flick between 

windows. 

Selecting which window to display 

Each window that you have currently open is displayed as a tab below the InfoBar. Click 

on a tab to display the window or click on the WINDOW menu and choose a window name 

at the bottom. 

Ordering multiple windows 

"WINDOW" > "ARRANGE VIEWS" helps you organize multiple windows. Each window has its 

own title bar but no control bars. Click on a window to make it the current window. 

Pressing "Ctrl + F6" steps through the windows in sequence. 

ARRANGE VIEWS displays the windows arranged vertically or, for more than three 

windows, as tiles. 

Minimizing multiple windows 

Minimizing one of several windows displays an icon on the background of the main Web 

Designer Premium window. Double click the icon to reopen the window. 

Changing the zoom value 

It’s often useful to enlarge your view of the document to examine details or reduce your 

view to get an overall impression. Scalings above 100% show an enlarged view (similar 
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to looking through a magnifying glass); below 100% a reduced view. The only change is 

your view of the document; the size of the document itself and the objects in it are 

unchanged (changing the document size is described later). To change the zoom value 

you can use either the ZOOMTOOL, mouse, or control bars. 

Some shortcuts are available for quick setting of zoom values: The plain numeric keys (1, 

2, 3, 4) set the zoom to between 100% and 400%. The number 5 key sets it to 50%. 

Using the Zoom Tool 

 

To zoom: 

 Select the ZOOM TOOL from the MAIN TOOLBAR. 

 Or press "Alt + Z" to toggle between the current tool and the ZOOMTOOL. 

 Or press and hold down "Alt + Z" to temporarily swap to the ZOOMTOOL (release "Alt + 

Z" to return to the previous tool). 

 Or press "Shift + F7" to select the ZOOMTOOL. 

Changing the zoom value using the mouse 

If you have a mouse wheel: 

 Hold "Ctrl" and scroll your mouse wheel to change the zoom level. 

You can also configure a mouse button to zoom in or out. Furthermore, you can change 

the mouse wheel action between scrolling and zooming in "UTILITIES" > "OPTIONS" > 

"MOUSE TAB (ON PAGE 515)" or right click and choose "PAGE OPTIONS" > "MOUSE" tab. The 

opposite action is available then by pressing "Ctrl". 

Alternatively, select the ZOOMTOOL, and 

 Click to zoom in (enlarge). 

 "Shift + click" to reduce the zoom value (to see more of the document). 

 Drag the mouse diagonally to create a rectangle. When you release the mouse button, 

the area within the rectangle is enlarged to fit the window. 

Changing the zoom using the zoom InfoBar/control bar  

There is a flyout bar on the standard toolbar which gives you quick access to zoom 

functions, without having to go into the ZOOM TOOL. There is also a flyout bar on the 

ZOOM TOOL icon on the main toolbar. 

 

Hold the mouse pointer over the zoom icon on the standard toolbar to see the 

flyout bar. 

To change the zoom: 
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Shortcut "Ctrl + R". Click the PREVIOUS ZOOM button. This is the zoom value 

before the current setting. Using this button lets you flip zoom in and out on the 

document. This is useful for switching between examining an area in detail and 

an overall view. The previous zoom value is stored for each window. You can 

swap between windows and the previous zoom values are retained. 

 

Shortcut "1" Click the Zoom to 100% button. The zoom factor is changed to 

100%. 

 

Shortcut "Ctrl + Shift + J". Click the ZOOM TO DRAWING button. The window 

shows all the objects in the document. 

 

Shortcut "Ctrl + Shift + P". Click the ZOOM TO PAGE button. The window shows 

the entire page or pair of pages. 

 

Shortcut "Ctrl + Shift + Z". Click the ZOOM TO SELECTION button. The selected 

object or objects fill the window. 

 

 

Type a value into the text box. Press "" to implement 

the change, or select preset zoom values including those 

above (page, drawing, selected, previous) in the drop-

down menu. 

 

Sliding the document within the window 

The quickest and easiest way to move around the document is to use the middle mouse 

button (normally the mouse wheel) if you have one. Click and hold the middle button 

down and then move the mouse. Release the button to return to your previous tool. 

To move the document within the window you can also: 

 Use the scroll bars and arrows at the side of the window. 

 Use the mouse wheel to scroll the document up and down ("Shift + mouse wheel" for 

left and right) 

 

 Or select the PUSHTOOL from the main toolbar ("H"). 

 Or press the space bar or "Alt + X" to toggle between the current tool and the 

PUSHTOOL. 

 Or press and hold down the space bar or "Alt + X" to temporarily switch to the 

PUSHTOOL (release key(s) to return to the previous tool). You can then use the mouse 

to drag the document around in the window. 

The PUSHTOOL InfoBar is the same as the ZOOMTOOL InfoBar (described above). 
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Displaying the scroll bars is optional. Choose "WINDOW" > "BARS" > "SCROLLBARS" to turn 

them off. 

You can change the mouse wheel action between scrolling and zooming in "UTILITIES" > 

"OPTIONS" > "MOUSE" or right click and choose "PAGE OPTIONS" > "MOUSE". The opposite 

action is available then by pressing "Ctrl". 

Changing the page size 

When you open a new Web Designer Premium document, the page size is 760 x 700 

pixels (SVA web page). However, you can change the page size if required, e.g. to 

support other screen resolutions such as VGA. 

1. Choose Menu "UTILITIES" > "OPTIONS" or right click a page and choose "PAGE 

OPTIONS". 

2. If necessary, click the PAGE SIZE tab. 

3. Choose the required page size. 

If you select CUSTOM in the size selector, you can set a custom width and height in the 

fields below it. 

Every page in the document (exported website) can have a different size. With the option 

ALL PAGES IN WEBSITE THE SAME SIZE you will set the page size to the same value for all 

pages in the document. 

  

You can resize the height and width of the page by dragging the 

lower and right border of the page with the selector tool.  If you 

use this method you will be prompted to choose whether the 

change should apply to all the pages in the document or website, 

or just the current one. 

 

 

Multiple pages in the document 

A Xara Web Designer Premium document can have multiple pages. Each page is 

exported to a separate HTML page and so each document in Xara Web Designer 

Premium corresponds to a website. 

By default when you open or create a new web document, Web Designer Premium 

shows only one page. Print documents however are displayed in multiple page view by 

default. Right click a page or its pasteboard and select/deselect MULTIPLE PAGE VIEW to 

toggle between display modes. 

The current page 

If you click a page in a multi-page document it will become the current page. 
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The current page is relevant when inserting, duplicating, or moving pages as 

described in the following sections. 

The current page in the document is shown by indicators on the page’s corners. 

 
 

Inserting pages into your document 

Right click a page and choose NEW PAGE or NEW DOUBLE PAGE SPREAD. A new blank 

page is inserted after the page. 

or 

Right click a page and choose DUPLICATE CURRENT PAGE. A duplicate of the current page 

is inserted after the page. 

 

The new page will be the 

same as the original page, 

including its size and 

orientation, and will include all 

its content so that you can 

use it as a template for new 

content. 

You can also use the Menu 

items under "EDIT" > "PAGES" 

In addition, the standard toolbar has a flyout bar which allows you to add, duplicate and 

delete pages quickly. 

 

Hold the mouse pointer over each icon in the bar to see a tooltip for each available 

operation. You can add a new blank page, duplicate the current page or delete the 

current page. 

Copying and pasting pages 

You can copy and paste whole pages in the current document or paste pages to another 

document. This copies the page dimensions, layers and other page attributes in addition 

to all the objects on the page.  

 

To copy the current page, clear any current selection by pressing Esc or by clicking on 
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an empty part of the page or pasteboard. The status line says "No objects selected". 

Right click an empty part of a page and choose COPY PAGE (or press "Ctrl + C").  

When you paste a copied page, it is added immediately following the current page. To 

paste use "Ctrl + V" or  right click the page and choose PASTE > PAGE from the context 

menu. 

Note: If the document into which you paste a page has the ALL PAGES IN DOCUMENT THE 

SAME option enabled in FILE > PAGE OPTIONS, the dimensions of the pasted page will be 

overridden by the page dimensions of the document. So the new page will be given the 

same dimensions as all the other pages in the document.  

Moving pages within the document 

The easiest way to change the order of the pages in your document is to just drag on the 

page thumbnails in the Page & Layer gallery (which is docked on the right by default).  

You can also select more than one page at a time and drag to re-order. 

Alternatively to move the current page: 

 Choose "EDIT" > "PAGES" > "MOVE PAGE UP" or right click and choose MOVE PAGE UP to 

swap the current page with the one previous to it. 

 Choose "EDIT" > "PAGES" > "MOVE PAGE DOWN" or right click and choose MOVE PAGE 

DOWN to swap the current page with the one after it. 

These menu options will be grayed out of if you are on the first or the last page of the 

document respectively. 

Removing pages from your document 

To delete the current page from your document right click and choose DELETE CURRENT 

PAGE or select "EDIT" > "PAGES" > "DELETE CURRENT PAGE". The current page and all its 

content will be deleted. Or select one or more pages in the Page & Layer Gallery and 

press the Delete button or Delete key. 

Navigating between pages 

As well as the usual methods of moving through your document (such as scrollbars and 

the mouse wheel), there are also some other ways to navigate through the pages: 

Page up: Moves up the document. The amount moved depends on your zoom level. The 

further you are zoomed out the bigger the move. 

Ctrl + Page up: Go to and center on the previous page. 

Page down: Moves down the document. The amount moved depends on your zoom 

level. The further you are zoomed out the greater the move. 

Ctrl + Page down: Go to and center on the next page. 
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Or click the up or down arrow on the status line: 
 

The status line is also useful for knowing what page(s) you are currently viewing. 

Note: All of these movements are relative to the page you are viewing, not the current 

page. 

Page & Layer Gallery 

You can also use the PAGE & LAYER GALLERY to conveniently manage the pages in your 

document. It allows you to view, add, duplicate, delete, re-order pages all from a single 

view. For more information see PAGE & LAYER GALLERY (on page 447). 

Saving the document 

This section covers saving in Web Designer Premium’s own format (native format). Refer 

to Importing and Exporting (on page 486) for details of exporting in other formats. 

We recommend that you always save documents regularly. A complicated document 

may represent many hours of work and power failures or computer crashes always 

happen at just the wrong moment.  Make sure you have the automatic backup facility 

turned on, so that regular backups are taken of your open documents as you work. See 

the Automatic Backups (on page 76) section below for details. 

Save option (on the File menu) 

 

("Ctrl + S", or click the SAVE button on the standard control bar.) 

This provides a quick way to save a document using the same file name. The option is 

disabled unless the document has unsaved changes, i.e. you have made changes, but 

haven't saved them yet. 

For a new document that has not been saved, this option acts like "Save as" (described 

below). 

Save as (on the File menu) 

This opens a dialog box letting you save the document under a different name or to a 

different directory. This option is useful for making backups of Web Designer Premium 

documents. 

Save all (on the File menu) 

This acts like a series of SAVE or SAVE AS commands to save all currently open files. 
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Support folders 

Some documents which are used to create websites need to reference external files 

which cannot be embedded in the .xar design file. For example you may have a Flash 

(.swf) file which is used on your website and so you’ll want to keep that file with the 

design file because you can’t export a fully working website from the design file without 

also having the Flash file.  

So Xara Web Designer Premium uses an optional “support folder” right alongside the 

design file to hold these important external files. 

Support folder naming 

The design file and its corresponding support folder are tied together by their names. The 

support folder for “mySite.xar” is always “mySite_xar_files”. This naming convention 

makes it obvious which support folder belongs to which design file.  So if you rename, 

copy or move a design file, always remember to do the same to the corresponding 

support folder, if it exists! And if you send a design file to someone else, send any 

support files folder along with it. 

If you load a design that has a support folder, and then subsequently do a SAVE AS to 

save another copy of that design, Xara Web Designer Premium will copy the whole 

support folder too, if there is one. 

Support folder contents 

When you use the Placeholder Tab (on page 311) of the Web Properties dialog to insert 

a reference to an external file into your website design (using the Browse buttons), Xara 

Web Designer Premium will automatically copy that file into the design’s support folder 

for you. If the support folder doesn’t already exist, it will be created.  

Note that if you subsequently change a placeholder object to reference a different file, 

the original file will not be automatically deleted from the support folder. So if a file is no 

longer needed, you need to remove it manually. 

Exporting websites with support folders 

When you export a website document, any files in the corresponding support folder are 

copied to the folder which contains all the generated images for your website. So if you 

export “mySite.xar” to “index.htm”, then any files in folder “mySite_xar_files” are copied 

into the “index_htm_files folder”. 

Closing the document 

To close the document: 

 Choose "FILE" > "CLOSE". 

 Or press "Ctrl + F4", or "Ctrl + W". 

 Or click the smaller, lower X of the two in the top right hand corner. 
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 Or right-click on the document tab to view a context sensitive menu with a series of 

save and close options for both individual and all open tabs. 

 

Right-click on a tab to display multiple save and close options. 

Automatic Backups 

Xara Web Designer Premium will optionally save regular backup copies of your open 

documents while you work.  

To turn automatic backups on or off, open the "UTILITIES" > "OPTIONS" dialog and choose 

the BACKUPS tab. 

 

Backup open documents 

To turn backups on select this checkbox and choose how often you would like backups 

to be taken. The suggested period is 10 mins, which means each open document will be 

backed up if it’s more than 10 mins since the last backup of that document was taken (or 

since the document was created or opened).  

Note that once the configured period since the last backup has expired, the next backup 

is only saved when the program has been idle for at least 15 secs. This is to avoid 

interrupting your work as much as possible and to avoid backing up the document while it 

is being actively modified. In normal use it’s unlikely that there won’t be regular inactive 

periods of 15 secs or more, allowing a backup to be taken soon after it is due. But note 
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that if you are actively editing for an extended period of time it could be significantly 

longer than the configured backup period before the next backup runs. 

The Automatic Backup facility does not save modifications to open ‘edit inside’ sub-

documents. Only the parent main document is saved when a scheduled backup runs, in 

its current state without the unsaved group edits. For this reason it's recommended that 

you save ‘edit inside’ edits back to the parent document regularly.  

When a backup is taken, you’ll see the save progress bar appear at the bottom of the 

Xara Web Designer Premium window while the save is completed. 

 

Backup location 

User the BROWSE button if you want to change the folder where your backups are stored.  

You can access the backup documents saved here at any time using the "FILE" > "OPEN 

RECENT" > "BACKUPS" menu option. This opens a file dialog onto your backup folder so 

that you can browse, open, or delete any of your backup files. 

 

Revisions 

By default up to 10 revisions of each design are kept in your backups folder, but you can 

choose to change this number in the revisions field.  Older revisions in excess of the 

number chosen are deleted automatically. Each backup file is named using the name of 

the document from which it is taken, suffixed by the date and time at which the backup 

was taken.  

Warning: Note that if you have multiple documents that share the same filename in 

different folders on your computer, their backups will also share the same names in the 

backups folder. Therefore try and use unique filenames for your designs to avoid the 

backups of one design overwriting another with the same name. 

 

Untitled documents 

Documents that you have created and not saved are backed up using the name 

"Untitled" followed by a number and the date/time. This name and number corresponds 

to those shown in the titlebar when you are editing new unsaved documents.  

Warning: Since all new unsaved documents are named Untitled1, Untitled2, etc. 

backups of these documents are likely to be overwritten relatively quickly. Therefore you 

should always save important documents with a unique name of your choice, so that you 

can easily identify backups of that document in the backups folder. 

 

Backup open documents on program close 

The Backups tab in the Options dialog also allows you to turn on AUTOMATIC BACKUP 

AND RESTORE. When this option is on, when the you close Xara Web Designer Premium 

you will not be prompted to save  any modified documents that you have open. Instead 

all open documents are backed up to the backups folder and the program closes. Then 
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when you next start the program, the same documents are automatically reloaded so that 

you can continue working where you left off.   

Note that if you have any "Edit inside" sub-document views open, these are silently 

closed and saved back to the main document when the program is closed, and the main 

document is backed up. The ‘edit inside’ sub-document views are not re-opened on next 

program start. See editing inside groups.  

 

Recovering from abnormal program closures 

If you have automatic backups turned on and the program closes abnormally (perhaps 

due to a power failure for example)  the program should detect this when it is next 

restarted. It will then offer you the chance to restore the most recent backup version of 

each document that was open at the time of the last backup. 

Abnormal closure will not be detected if no automatic backup completed since the last 

normal program closure. 

 

Backups on system shut down 

If you shut down Windows without first closing the program, all open documents are 

backed up to the backup folder even if ‘Backup open documents on program close’ is not 

turned on. This allows system shutdown to proceed without Xara Web Designer Premium 

interrupting it by prompting you about unsaved or modified documents. On next program 

startup you’ll be asked whether or not you want to restore the documents that were open 

at the time of the system shut down. 

 

Recovering backups 

You can access your document  backups using the "FILE" > "OPEN RECENT" > "BACKUPS" 

menu option. This opens a file dialog onto your backup folder so that you can browse, 

open, or delete any of your backup files. It’s a good idea to use this file dialog to clear out 

any old unwanted backups periodically. 

Note that when you load a backup document, it is not automatically associated with the 

design file from which the backup was taken. It’s treated as an independent document in 

its own right. Therefore if you decide to keep a backup document you should use "FILE" > 

"SAVE AS" to save it elsewhere with a suitable name. 

On-screen grid 

To help you lay out your document, Web Designer Premium can display a grid on the 

screen (the grid appears only on the screen; it is never exported or printed.) The grid 

helps you align objects (similar to using graph paper as a drawing aid). 

Right click and choose "SHOW GRID/GUIDES" > "SHOW GRID" to turn display of the grid 

on/off or choose "SNAP TO" > "SNAP TO GRID". You can also choose "WINDOW" > "SNAP TO 

GRID".  



 

Document handling 79  
 
 

 

The grid points then act like magnets, and as you move objects, they snap to the nearest 

grid point. By default web documents have "SNAP TO GRID" on, with a 1 pixel grid. 

The type of grid (isometric/rectangular), the 0,0 point (the origin), and spacing of grid 

points is controlled by the GRID & RULERS TAB (on page 514) of the options dialog box. 

Any changes you make apply only to the selected document. 

Magnetic object snapping is also enabled by default in web documents. Object snapping 

is a very powerful way of accurately aligning lines, points and the edges of objects to any 

other object so they exactly touch. 

You can even use this to align the centers of objects, or align objects to the center of the 

page, or align them horizontally and vertically anywhere in the middle of the page or 

edge of the page. 

 

To toggle object snapping, click the SNAP TO OBJECTS button or right click and 

choose "SNAP TO" > "SNAP TO OBJECTS". You can also choose "WINDOW" > 

"SNAP TO GRID".  

Refer to Object Handling (on page 92) for details on snapping to grid and snapping to 

objects. 

Rulers 

Rulers are turned off by default. To turn them on: 

 Right click and choose "SHOW GRID/GUIDES" > "SHOW RULERS" to turn display of the 

grid on/off. 

 Press "Ctrl + Shift + R". 

 Or select "WINDOW" > "BARS" > "SHOW RULERS". 

Web Designer Premium uses rulers to: 

 Control text margins, tabs and indents (on page 224) in the TEXT TOOL. 

 Let you know which part of the page you are viewing; 

 Show the current pointer X/Y position; 

 Apply guidelines. If "WINDOW" > "SNAP TO GRID" is active, guidelines snap to divisions 

on the ruler. For more information on guidelines, refer to the guides & guidelines 

section in "Object Handling". 

As you create or scale objects, you can use the rulers to check their size. You can also 

more accurately use the SELECTORTOOL (see "Selecting objects" for more information). 

Rulers are displayed at the left and top of the window. A dotted line on each ruler follows 

the current pointer position. 

The units and number of divisions on the rulers are the same as those set for 

customizing the on-screen grid. These are set using the Grid & Ruler Tab (on page 514) 

of the options dialog box. The current units and any scaling factor are displayed on the 

right hand end of the top ruler. 
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Displaying/hiding rulers 

Right click and choose "SHOW GRID/GUIDES" > "SHOW RULERS" ("Ctrl + Shift + R") to turn 

rulers on/off. Any change applies to the current window and subsequent windows you 

open. It does not affect other open windows. 

Changing the ruler zero points 

It is often easier to measure objects if you align the origin (0,0) point of the rulers with the 

object. To move the origin (0,0) point, drag the square at the intersection of the two 

rulers. 

 

You can drag vertically or horizontally along the rulers 

or over any part of the Web Designer Premium editing 

window. As you do, a dotted line will outline the new 

position. 

This also moves the grid origin so that divisions on the 

ruler always align with the grid. 

You can also move the zero point under the GRID & RULER tab (on page 514) of the 

Options dialog. 

View quality 

There are five different quality settings available in the "WINDOWS" > "QUALITY" menu, 

which affect how the document appears in Xara Web Designer Premium: 

 Outline only. This is now fully anti-aliased for higher quality screen display. 

 Outline with blend steps. 

 Full color (no anti-aliasing). 

 High quality (full anti-aliasing and image smoothing) 

 Very high quality (best anti-aliasing in the industry. New bi-cubic photo display 

considerably improves the quality of scaled down photos). 

FULL COLOR shows the document colored, but with anti-aliasing turned off. 

On the OUTLINE setting only the outlines of the shapes appear (they are drawn as wire 

frames). This makes it easier to select objects hidden behind other objects. 

The quality setting has no effect on how the document exports or prints, except for 

bitmap exports which do use the current quality setting. 

The constrain key 

The "Ctrl" key has a special function in Web Designer Premium. It constrains the action 

of the current operation in some way. For example, normally you can rotate an object to 
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any angle. But in Web Designer Premium,if you hold down "Ctrl" while you rotate an 

object, the rotation is constrained to a subset of the possible angles. By default the object 

will rotate only to multiples of 45 degrees plus any rotations where a significant straight 

edge in the object becomes vertical or horizontal.  

 

The black line on the left can be rotated to 

any angle within the circle. On the right is 

the same line, but with "Ctrl" held down it 

can only be rotated to the positions 

indicated. 

Similarly, constraining a rectangle creates a perfect square and constraining an ellipse 

creates a perfect circle. Release "Ctrl", and they will not be constrained. 

The constrain angle feature is defined in "FILE" > "PAGE OPTIONS" > "GENERAL" > "ANGLE 

CONSTRAINT (ON PAGE 513)" 
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Galleries 

Xara Web Designer Premium uses galleries to provide convenient access to libraries of 

content such as templates, fonts, colors, clip-art, line attributes, and bitmaps/photos. This 

section of the help gives general information on features which are common to multiple 

galleries. Individual sections describe features specific to a particular gallery. 

 

By default the PAGE & LAYER GALLERY is open in Pages mode (displaying only pages, not 
their layers) and docked on the right of the Web Designer Premium window 
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Page & Layer 

 
Local Designs 

 
Bitmap 

 
Lines 

 
Fill 

The PAGE & LAYER GALLERY shows you, and allows you to manipulate, the pages in your 

document and the layers within each page.  

The LOCAL DESIGNS and FILL GALLERIES allow you to choose from different templates 

and styles provided with Xara Web Designer Premium. 

The BITMAP GALLERY shows you the bitmaps and photos which are used by all open 

documents. 

Some galleries are described in detail later. 

Displaying a gallery 

To display a gallery: 

1. Click or hover the mouse pointer over the vertical tab for the gallery to the right of 

the workspace (the gallery bar). The gallery opens automatically. When you move 

the mouse pointer away from the gallery, it automatically closes. 

2. To keep a gallery open while you work, click the AUTO HIDE (pin) button in its top 

right corner. The AUTO HIDE button changes so the pin points downwards to indicate 

that the gallery is now ‘pinned’ to the workspace  

3. To close a ‘pinned’ gallery, see Closing a Gallery (on page 90). 

4. To stop galleries automatically opening on mouse-over, uncheck the FLY-OUT BAR 

option in the "Utilities" > "Galleries" menu.   

 

Unpinned: gallery closes when you move the mouse pointer away from the 

gallery. 

 

Pinned: gallery stays open when you move the mouse pointer away, and can 

also be moved and docked (on page 84) elsewhere. 

Note: By default the LINE and FILL GALLERIES do not display their title, just their individual 

icons, until they have been opened. Web Designer Premium always displays the title of 

the last gallery that you have viewed. 
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Moving and docking a gallery 

You can ‘detach’ any gallery from the gallery bar and move it to a more convenient 

location anywhere in the workspace. You can also dock the gallery (or a gallery group, 

see Grouping Galleries) in the top, bottom, left or right of the workspace. 

 

You can move a gallery anywhere in the workspace 

To move a gallery: 

1. Open a gallery and click the AUTO HIDE button to pin the gallery. The button 

changes to a downward-pointing pin to indicate that the gallery can be moved and 

pinned elsewhere.  

2. Click and drag on the gallery’s title bar to move it around. You can either leave the 

gallery ‘free floating’ anywhere in the workspace or dock it in a new location. 

If you move any of the following galleries, the others accompany it as a group. Access an 

individual gallery by clicking its tab at the bottom of the group or click and drag a gallery 

tab to move it away from the group. 

 Bitmap 

 Line 

 Fill 
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When you click and drag on a dockable gallery’s title bar, a number of arrows appear on 

the workspace, indicating where you can dock the gallery.  
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Dragging a gallery causes docking arrows to appear in the center, top, bottom, left and right of 
the workspace. Dock the gallery by dragging it to an arrow. 

 

Example of a gallery that has been docked to the left of the workspace 

To dock a gallery: 

1. Click and drag the gallery to the arrow pointing towards the location where you want 

to place the gallery. For example, if you want the gallery at the top of the screen, 

move it to the upward pointing arrow at the top of the workspace. 

2. When the mouse pointer reaches the arrow, a gray transparent box highlights the 

gallery’s new location.  

3. Let go of the mouse button to dock the gallery. Now when you close or ‘auto hide’ 

the gallery, its tab will be displayed in the new location. 

4. Hover over or click its tab to reopen the gallery.  

Note: To move all galleries back to their default position, choose CONTROL BARS from the 

WINDOW menu, click GALLERIES then RESET. 

Grouping galleries 

You can arrange two or more frequently-used galleries so that they are next to each 

other. 

1. To move a second gallery so that it is adjacent to a gallery you have previously 

docked, click and drag the second gallery to the four arrows in the workspace 

center.  
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2. Let go of the mouse when you are over the arrow pointing towards the previously 

moved (first) gallery. The second gallery docks next to the first. 

You can also group galleries and move the whole group to a new location if, for example, 

you are working primarily with 2 or 3 galleries that you want to be close to each other and 

easily accessible.  

 

Example of a gallery group with gallery tabs at the bottom - click and drag to add a gallery to or 
remove a gallery from the group. 

To group galleries: 

1. Disable the AUTO HIDE button (pin) on one of the following galleries: BITMAP, LINE 

and FILL GALLERY.The gallery is automatically grouped with the other five galleries, 

displayed as tabs at the bottom of the group.  

2. Click a tab and drag to remove a gallery from the group. 

3. Click on a tab to open a gallery in the group. 

4. To add a gallery to a group, click and drag the gallery over the group. Four docking 

arrows appear in the center of the group.  
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5. Drag and drop the gallery into the square in the middle of these arrows and Web 

Designer Premium adds it to the group and its tab displayed at the bottom of the 

group.  

6. When you dock a gallery group, all galleries within the group are also docked. 

When you auto hide or close a gallery group, all gallery tabs in the group are 

displayed in the workspace border nearest to the last docking location. 

Using galleries 

To fold or unfold a section in a gallery: 

 Click the FOLD/UNFOLD icon. 

 Or double click the title strip. 

 Or right click a section to display a pop-up menu. Select FOLD/UNFOLD section. The 

pop-up menu also has options to scroll to the previous section or next section. 
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This illustration shows the gallery is unfolded. Other galleries are similar.  

The buttons along the top depend on the gallery (e.g. FILL and TRANSP are specific to the 

BITMAP GALLERY.) However, most galleries have these buttons: 

APPLY applies the selected item in the gallery. Click on an item to select it. 

MORE opens a menu from which you can choose from the following: 

 FIND is described later in searching for an item name. 

 SORT is described later in re-ordering items in a gallery. 

 PROPERTIES provides control over size of the icons and amount of information 

displayed in the gallery. 

 ADD (clipart, fill, and fonts galleries) is described later in adding to a gallery. 

 REMOVE (clipart, fill, and fonts galleries) is described later in deleting sections from a 

gallery. 

Selecting items 

To select an item: 

 Click an item to select it. 

 Or click an item, then "Shift + click" on another item; all items in between the two 

points will be selected. 

 Or "Ctrl + click" to add that item to the selection. 

Re-ordering items in the gallery 

In some galleries, "MORE" > "SORT" opens a dialog box. You can sort by name and, 

depending on the gallery, by other criteria. The primary key controls the initial sort. For 

some sort parameters such as file type or name length, there may be two or more files 

with the same type or name length. These files can be further sorted using the secondary 

key. 

Adding to a gallery 

You may want to add extra items to these galleries (LOCAL DESIGN & FILL GALLERIES 

only). To do this: 

7. Copy the files you want to add into a new directory (folder) using the Windows 

Explorer. 

- For the LOCAL DESIGNS GALLERY these files can be any of a wide range of 

vector or bitmap file types. 

- For the FILL GALLERY they can be any of the bitmap formats supported by Web 

Designer Premium (listed in importing and exporting (on page 487)). 

8. In the appropriate gallery, click the DISC DESIGNS/FILLS button. This opens a dialog 

box. 

9. Use the dialog box to select the directory you want to add. 

10. Click ADD. This creates a new section in the gallery. 
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If you later want to add more items to the folder: 

1. Copy the new files into the existing folder. 

2. In the gallery, click DISC DESIGNS/FILLS. This opens a dialog box. 

3. Use the dialog box to select the folder you want to add. 

4. Click UPDATE to update the section in the gallery. 

Deleting sections from a gallery 

To delete a section from a gallery (LOCAL DESIGNS & FILL GALLERIES only): 

1. Click on the title strip of the section or sections you want to delete. 

2. Click "REMOVE". 

If you later want the section again, add its folder to the gallery (described earlier). 

Closing a gallery 

By default a gallery’s AUTO HIDE button is enabled (i.e., the gallery’s AUTO HIDE button in 

the top right corner is unpinned), so that the gallery closes automatically when you move 

the mouse pointer away from it. 

However if you have disabled the AUTO HIDE button (pinned the gallery), you have to 

close the gallery manually. 

To close a free-floating gallery, click the CLOSE button in the top right of the gallery. The 

gallery closes and its tab is displayed in the gallery bar. 

To close a docked gallery, click the AUTO HIDE (pin) or CLOSE button in the top right of the 

gallery. The gallery closes and its tab is displayed in the workspace border where you 

docked it.   

To re-open the gallery, hover over or click on its tab. 

Note: To remove a gallery completely, choose GALLERIES from the UTILITIES menu and 

choose the gallery you want removed.  

Removing a gallery from the workspace 

By default, when you close a gallery, Web Designer Premium returns it to the gallery bar 

so that you can reopen it by hovering the cursor over its icon or tab. However you can 

configure Web Designer Premium to remove any gallery from the workspace if it’s not 

needed.  

To remove unwanted galleries from the workspace, do one of the following: 

 Choose GALLERIES from the UTILITIES menu and choose the gallery you want 

removed. The selected gallery disappears from your workspace. If you want to 

reinstate a gallery, choose GALLERIES from the UTILITIES menu and choose the gallery 

you want to reinstate. 
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 Choose CONTROL BARS from the WINDOW menu and scroll down the list of available 

control bars to find GALLERIES. Click the GALLERIES box to show the Galleries toolbar. 

Click CLOSE. In the Galleries toolbar that is now displayed above the workspace, you 

can toggle display of a gallery by clicking its toolbar button.   

Undo and Redo 

What are undo and redo? 

We all make mistakes or change our minds. Web Designer Premium makes it easy to 

correct mistakes or cancel unwanted changes. Every action you make is recorded in an 

undo list which lets you undo not just the last operation, but also to step back by undoing 

successive operations. In this way, you can experiment freely knowing that you can 

always undo anything that doesn‘t look correct. 

The undo command 

 

"UNDO" cancels the effects of the last operation. To undo an operation: 

 Click UNDO on the standard control bar. 

 Or choose "EDIT" > "UNDO" (the exact wording tells you what the next undo step is, i.e. 

undo scale). 

 Or press "Ctrl + Z". 

 Or press the comma key (in any tool except the TEXTTOOL). 

You can repeat the undo command to step back through the sequence of previous 

operations. 

The redo command 

 

Redo cancels the last undo command. To redo the last operation: 

 Click the REDO button on the standard control bar. 

 Or choose "EDIT" > "REDO" (the exact wording tells you what the next redo step is, i.e. 

redo scale). 

 Or press "Ctrl + Y". 

 Or press the period (full stop) key (in any tool except the TEXTTOOL). 

You can only redo immediately after undo. You cannot redo after changing the document 

(for example, by moving or adding an object). 
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Object Handling 

The Selector Tool 

 

The SELECTORTOOL is the main tool for selecting, moving, scaling, and rotating 

objects. It is typically used more than any other tool and is the central tool for 

manipulating documents. 

 

 
Toggle bounds handles/photo handles 

 
Dimensions of selection 

 
% size controls 

 
Lock aspect ratio 

 
Rotate and skew 

 
Flip 

 Scale line widths 

 
Apply names 

To use the SELECTOR TOOL: 

 Click on the SELECTOR TOOL on the MAIN TOOLBAR. 

 Or press "Alt + S", "V", or "F2". 

When switching to the SELECTOR TOOL, if there are objects selected inside a group or 

other composite object type, the parent object (group) becomes selected instead.  

Because the SELECTORTOOL is the most used tool, there is an additional shortcut that lets 

you switch to the SELECTOR TOOL to perform a selection or other operation, and quickly 

switch back to the previous tool. If you are using another tool, you can easily switch to 

the SELECTOR TOOL: 

 Press and release "Alt + S" to switch to the SELECTOR TOOL. Press again to return to 

the previous tool. 

Selecting objects 

To select a single object, click on any visible part of the object.  

Change object selection 

Once an object is selected, you can use the following keys to change the selection: 

 End selects the back object. 

 Home selects the front object. 

 "Tab" selects the next object towards the back. 
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 "Shift + Tab" selects the next object towards the front. 

Front and back objects are described in "Object handling (on page 92)". 

Marquee selection 

To select multiple objects, press and hold down the mouse button. Dragging the mouse 

draws a selection rectangle, and all objects wholly within the selection rectangle are 

selected.  

Some other drawing programs call this marquee selection. 

If you have an object in the way which is preventing you from drawing a rectangle 

because you end up moving the object, hold down "" while dragging out the selection 

rectangle. 

Extend Selection 

To select additional objects: 

 "Shift + click" on them. 

 Or "Shift + drag" the mouse pointer. This draws a selection rectangle and adds objects 

within the rectangle to the selection. 

Select under 

Hold down "Alt" to select objects hidden by other objects. By "Alt + clicking" you can step 

through several overlapping objects. 

Select inside 

You can select an object that’s inside a group or other container object by holding down 

"Ctrl" while you click on it. This is called selecting inside. The object you click on will 

always become selected, even if it’s deep down inside several levels of nested groups. 

When you have such deep nesting of groups, sometimes you may want to select one of 

the nested groups (a group inside another group). If you hold down the "Alt" and "Ctrl" 

keys while you click you can do this easily. The first such click will select the top level 

group (just as  an unmodified click does). Click again and the next group down in the 

hierarchy will be selected instead. Continue clicking to ‘drill down’ into the group structure 

until the group you want becomes selected. 

Note that some operations are not permitted with select inside. For example, marquee 

selection and right-click copy does not work for select inside. 

Moving objects selected under or inside 

If you need to move a selected object that’s either under others or inside a group, then 

just dragging doesn’t work as it will select and drag a different object. To overcome this 

hold "Ctrl + Alt" and start dragging. This will always drag the existing selected object. You 

can let go of the keys once you’ve started dragging. 
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Or you can use the arrow keyson the keyboard to nudge the object. 

Selecting and layers 

You cannot select objects in locked or invisible layers. 

See "PAGE & LAYER GALLERY (on page 447)" for more details on layers. 

Selecting Photos and SmartShapes 

When you select a photo or SmartShape with the SELECTOR TOOL, you see SmartPhoto 

handles (on page 360) rather than the usual bounds handles. This allows direct editing of 

the photo or SmartShape without having to first switch into the Photo Tool or Quickshape 

Tool. 

 
You can revert to showing the normal selection bounds handles using the toggle 

button on the left of the SELECTOR TOOL INFOBAR. 
 

Selecting all objects 

To select all objects: 

 Choose "EDIT" > "SELECT ALL", 

 Or press "Ctrl + A". 

Deselecting an object 

To deselect all objects: 

 Click anywhere on an unused part of the document, 

 Or choose "EDIT" > "CLEAR SELECTION", 

 Or press "Esc". 

To deselect one object from several: 

 "Shift + click" on the object. This deselects that object. Other objects remain selected. 

Selection markers 

 

Each selected object displays a single 

selection marker to show it is selected. 

This is a useful reminder when selecting 

and deselecting several objects. 

 

Status line 

The status line at the bottom of the window also describes what is selected. 
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Selection bounds handles 

Selection bounds handles let you scale and stretch selected objects. See Stretching and 

squashing objects  for more details. Successive clicks on an object alternate between 

showing selection bounds and rotation handles. 

  

 

Tab 

With any selected object, pressing "Tab" and "Shift + Tab" will move through the selected 

objects (previous and next object in the document). 

Moving objects 

To slide an object across the page 

 

1. Choose the SELECTORTOOL.  

2. Drag the object to the required position. Hold down "Ctrl" to restrict the direction of 

movement to one of the constrain angles. 

The constrain angles are user definable. Refer to "Customizing Web Designer Premium 

(on page 509)" 

Hold down "Ctrl + Alt" and you can drag the selected object even if the pointer is not over 

it. This is useful when the selected object is hidden behind another object or part of a 

group. Release "Ctrl" and "Alt" after you start the move unless you want to constrain the 

move. 

You can also move objects using the arrow cursor keys. This is described on the next 

page. 

Object snapping is a very powerful way of accurately aligning lines, points and the edges 

of objects to any other object so they exactly touch. It also helps you align to the 

horizontal and vertical center lines of the page. 
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To toggle object snapping, click the SNAP TO OBJECTS button or right click and 

choose "SNAP TO" > "SNAP TO OBJECTS". You can also choose "WINDOW" > 

"SNAP TO OBJECTS".  

Click and drag on the object you want to snap. As you drag, Web Designer Premium 

displays a magnet icon whenever you are near a "point of interest" or potential snapping 

site relative to a visible object on the page.  

To snap in a path relative to the page center (both horizontally and vertically), move the 

object over the lines that appear as you drag on the page. A red dot on the line also 

indicates potential "point to path" snapping points, so that you can snap the object to a 

point such as the center or center line of the page. 

See Snapping (on page 108) for details on snapping to grid and snapping to objects. 

Drop copy 

During a move (and while still holding the left mouse button down) click the right mouse 

button or press + on the numeric keypad to drop a copy of the object. The original object 

doesn’t move. You can do this as many times as you wish to create a series of 

duplicated objects. 

You can also hold down the right mouse button and drag a copy of the object. Left click 

to leave a copy at the current mouse position. 

Fills 

Usually, moving an object also moves the fill with it: 

 

Normal move left to right with a linear filled object. 

This also applies to rotating, skewing, scaling and 

stretching objects. 

Web Designer Premium can also move the object but not the fill origin.  

 

To do this click the "−" key on the numeric keypad during 

the move. 

The same move, but pressing "−" (minus) during the drag. 

 

Nudging objects 

Usually you can move an object a small amount by using the arrowkeys to nudge the 

object (these keys sometimes have other uses, especially in the TEXTTOOL). 

Nudging is not affected by either magnetic or grid snapping (snapping is described later). 



 

Object Handling 97  
 
 

 

Nudge modifiers 

To modify the nudge distance, use these key combinations while using the arrow keys: 

 Ctrl  nudge 5 times the normal distance 

 Shift  nudge 10 times the normal distance 

 Ctrl + Shift nudge by l/5th the normal distance 

 Alt  nudge by 1 pixel 

 Alt + Shift nudge by 10 pixels 

You can change the normal nudge distance under the GENERAL tab in "UTILITIES" > 

"OPTIONS". Refer to "Customizing Web Designer Premium (on page 513)". 

Nudge works in most tools. 

Cut, copy and paste 

These let you move or copy an object in the same document or between different 

documents. The procedure is: 

1. Select the object. 

2. To remove the object, choose "EDIT" > "CUT" (or "Ctrl + X"). To copy the object but 

not remove it, choose "EDIT" > "COPY" (or "Ctrl + C"). Either option puts the object 

(or a copy of it) onto the clipboard. 

3. Choose "EDIT" > "PASTE", "Ctrl + V", or "INSERT". This pastes the clipboard contents 

into the document. 

Note that if the objects you copy are all on the same layer, then you can paste those 

objects to any layer by first making it the current layer and then choosing "EDIT" > 

"PASTE" >  "PASTE IN LAYER" or "PASTE IN PLACE IN CURRENT LAYER". The layer from 

which the objects were copied is ignored in this case. 

However if the objects you copy are on several different layers, then the layer structure 

is maintained when you paste.  

This allows you to copy layered data within a document or to a different document. Any 

layers which are missing in the target document are created automatically by this 

operation. So for example if you copy a mouse-over button, which has one object on the 

MouseOff layer and another object on the MouseOver layer, to a new document, the 

MouseOff and MouseOver layers will be created if they don’t already exist and the button 

objects copied onto them. 

"Ctrl + Shift + V" or "EDIT" > "PASTE IN PLACE" pastes the clipboard contents into the 

same X/Y position from where they were cut or copied or the same position relative to 

the bottom of the page in the case of footer objects. This only applies to objects cut or 

copied from within Web Designer Premium. Objects imported from other programs are 

always pasted into the center of the current view. 

The object remains on the clipboard so you can paste the same object several times. 
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You can paste the clipboard content into multiple pages of your document by simply 

selecting the pages in the PAGE AND LAYER GALLERY.  "Ctrl + click" on a page thumbnail 

to add it to the selection, or use "Shift+click" to add a range of pages to the selection. 

Then paste (Ctrl + V). This is especially useful if you have copied a repeating object that 

you only want on some pages of a document. A simple "Ctrl + V" paste will place the 

object in the center of the page when you have more than one page selected.  

If there is a choice of formats on the clipboard, Xara Web Designer Premium will display 

a PASTE SPECIAL dialog which allows you to choose the format you want to paste in (eg. 

When pasting in text you may have the choice of pasting in unformatted text or Rich 

Text). 

In addition you may see the following paste options, depending on the clipboard 

contents: 

Paste unformatted text 

Pastes any text on the clipboard into your document without any formatting. 

Paste in place (Ctrl+Shift+V) 

The same as Paste, except your object will be pasted in the exact same position from 

which you copied it. This is useful for moving objects from one layer or page to another, 

without changing its X/Y position 

Paste format/attributes (Ctrl+Shift+A) 

Preserves the format (e.g., font and font size) or style attributes (e.g., line and fill color) of 

the pasted object.  It is a quick way of applying multiple attributes. When you Paste 

Attributes, the attributes of the objects on the clipboard are applied to all the objects 

currently selected  

Paste position 

This option applies the position of a copied object on the clipboard to a currently selected 

object, which moves to the exact same position as the copied object. 

If multiple items have been copied to the clipboard, Web Designer Premium treats them 

as if they are a group and moves the currently selected object to the position of the 

copied group as a whole. 

The currently selected object is pasted or moved into the center position of the copied 

object or group of objects. 

Paste size 

This option applies the size of a copied object on the clipboard to a currently selected 

object, which resizes around its center to the exact size of the copied object. 

If you have multiple items selected when you ‘paste size’, each of those objects is made 

the target size, instead of the selection as a whole. So for example if you copy a 200x200 
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pixel photo, then select 10 other photos and ‘paste size’, all 10 photos each become 

200x200 pixels. This gives a quick way to make a bunch of objects a particular size. 

Paste size and position 

As the name suggests, this option applies both the size and exact position of the object 

on the clipboard, to the selected object. This useful for making text areas have the same 

size and position on each page of your document, if you have previously made them 

different.  

Paste replacing selection 

This is similar to PASTE POSITION, except that the copied object on the clipboard replaces 

the currently selected object and retains the deleted item's position. 

The copied object is pasted into the center position of the deleted object. 

Paste in current layer 

The same as PASTE IN PLACE, except your object will only be pasted into the current 

layer. 

This is useful if you want to display or hide just your pasted object when layers above or 

below are displayed. 

Paste in place in current layer 

The same as PASTE IN CURRENT LAYER, except your object will be pasted into the current 

layer in the exact same position from which you copied it. 

Paste on all pages 

Pastes the copied object at the same size and position on all pages of the document.  

Removing objects from the document 

First select the objects you want to remove. You can then either cut the objects to the 

clipboard or delete them. 

Cutting objects 

Choose "Edit" > "Cut", or press "Ctrl + X".The contents of the clipboard are overwritten 

and you can paste the deleted object(s) somewhere else if desired. 

Deleting objects 

 

Right click and choose DELETE or choose DELETE from the EDIT menu, or press 

the "Delete" key, or click the DELETE button on the STANDARD control bar. 

In this case the deleted objects are not put onto the clipboard. If you accidentally delete 

an object, undo retrieves it. 
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Duplicating and cloning 

Both these options create a copy of the selected object. The original object is deselected 

and the duplicate or clone becomes the selected object. 

You can also duplicate an object during moving, rotating, scaling, or skewing. During the 

drag action (and while still holding the left mouse button down) click the right mouse 

button or press "+" on the numeric keypad to drop a copy of the object. The original 

object doesn’t move. You can do this as many times as you wish to create a series of 

duplicated objects. 

So an easy way to create one or more copies of an object that is exactly horizontally or 

vertical aligned, is to drag the object, hold "Ctrl" to constrain the movement, and right 

click (or press "+" on the numeric keypad) for each copy required. 

 

To quickly create  a line of objects, draw one, then drag while holding "Ctrl" and right click for 
each copy required.  

Duplicating 

Right click and choose DUPLICATE, or choose "EDIT" > "DUPLICATE", or press "Ctrl + D". 

The copy is displaced slightly, usually down and to the right, from the original. 

The duplicate distance is user definable, see "Customizing Web Designer Premium (on 

page 513)" 

Cloning 

 

Choose "Edit" > "Clone", or press "Ctrl + K". This 

places a copy exactly on top of the original. Cloning is 

an easy way to create concentric shapes. 

This example uses an original large letter "A" with a 

black fill and a 4pt thick white outline and a clone with 

no fill and a 1pt black line. 

 

Moving objects forward and backwards 

Complex documents have objects stacked on top of each other, such as this target: 
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The target on the left is made from three circles stacked on top of each other.  

To ensure that objects overlay each other in the correct order, you often need to 

rearrange their order from front to back. The front object always covers lower objects, 

and objects always cover other objects which are further back. Each new object you 

create is always created on top of older ones. 

Right click an object and choose ARRANGE, which gives you these options: 

 BRING TO FRONT ("Ctrl + F"): This makes the selected object the front object, and it will 

hide any other object it covers. 

 MOVE FORWARD ("Ctrl +  + F"): This moves the object up a level towards the front 

rather like climbing a staircase one step at a time. 

 MOVE BACKWARD ("Ctrl +  + B"): This moves the object one level towards the back. 

 PUT TO BACK ("Ctrl + B"): This moves the object to the back. 

These options move objects forwards and backwards within their layer. Right click and 

MOVE TO LAYER IN FRONT/MOVE TO LAYER BEHIND lets you move objects between visible 

layers (invisible layers are skipped when moving objects). 

Read more in Layers (on page 447). 

Rotating using the mouse 

To see the rotation handles (instead of the scaling handles) on a selected shape in the 

Selector Tool, click again on  the selected shape.  

Drag on a corner arrow. As you drag, the object rotates around the transformation center. 

The InfoBar shows the current rotate angle. 

"+ drag" to rotate the object around its center (the transformation center is ignored). 

Hold down Ctrl while rotating to perform a constrained rotation. This means the object will 

rotate to only a limited selection of angles. It will rotate to multiples of the ‘constrain 

angle’ value, which by default is 45 degrees. But additionally it will include angles at 

which any significant straight edges in the object are aligned vertically or horizontally. 

This, for example, makes it easy to rotate a rectangle which has been rotated slightly, so 

that the rectangle is straight (screen aligned) again. Or to make any straight edge in a 

shape either vertical or horizontal. Such edges have to be at least 25% of the width or 

height of the shape in order to be considered significant during a constrained rotation. 
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The constrain angle is user definable. Refer to "Customizing Web Designer Premium (on 

page 513)". 

To create a copy while rotating, click "+" on the numeric keypad while rotating, or click 

the right mouse button. 

Rotating objects 

This is part of the SELECTOR TOOL. 

 When in rotate mode, the transformation center (around which the object rotates) 

initially appears in the center of the object, as shown by a small target like this. 

Simply click on an object again to put the selector into rotate mode. 

To move the transformation center, drag the transformation center target where required. 

Attention: If the rotation center is moved, it remains in this location for any selected 

object until all objects are deselected, at which point it returns to the center of any 

selected object. 

Rotating by exact angles (using the InfoBar)  

Type an angle into the rotate box and press "". Positive angles rotate anti-clockwise 

and negative angles rotate clockwise. 

 

Click the arrows to the right to nudge the rotate angle. 

 

Rotating objects in Resize Mode 

 

It is possible to rotate and skew an object even if not in rotate mode. Using resize mode, 

move the mouse pointer into the according small areas near the selection area handles 
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as illustrated above. The mouse pointer changes into a rotate or skew icon, showing you 

that you are now able to rotate or skew the object by dragging with the mouse. 

Scaling (resizing) objects 

 

This is part of the SELECTOR TOOL. 

Scale Line Widths button 

The SCALE LINE WIDTHS button on the SELECTOR TOOL InfoBar is used in many 

operations where the width and height of the selected objects are important. It controls 

whether the line attributes (not just line widths) are taken into account when working out 

the size and position of the selected object(s). 

 

With the SCALE LINE WIDTHS button set, scaling an object also 

scales its line widths. With this button unset, line widths remain 

unchanged. 

You can toggle this button during drags by clicking "/" on the numeric keypad. 

If you have a rectangle with a 4 pixel line width, as you turn SCALE LINE WIDTHS on and 

off you'll see that the X, Y W And H fields in the SELECTOR TOOL change as the effects of 

the line width are included and excluded. 

 

The following features are affected by SCALE LINE WIDTHS: 

 Position and size as reported on the SELECTOR TOOL InfoBar XYWH fields 

 Changing position and size by entering values into the InfoBar XYWH fields 

 Changing size by entering values in the W% H% fields 

 Scaling/stretching objects by dragging in the Selector tool 

 Alignment 

 Snapping 

The line attributes that are taken into account when SCALE LINE WIDTHS is turned on are: 

 Line width 

 End caps 

 Join type 

 Dash pattern 

 Arrowheads 

 Brush style 

 Stroke type (inc. variable width strokes) 

 

In general, if you are interested in the visual positions of objects you should turn SCALE 

LINE WIDTHS on. If you're interested in the exact positions of lines (e.g. where the centers 

of lines are, as is typical in technical drawings) then you should turn SCALE LINE WIDTHS 

off. 
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Lock Aspect button 

 

With the LOCK ASPECT padlock button set, the width/height aspect 

ratio remains constant as you scale the object.  

In other words, the shape remains in the same proportions as the original. It’s 

recommended that this button remains selected most of the time in order to ensure that 

when you resize objects they do not become squashed. 

With this button unset, you can change the aspect ratio as you scale the object, in other 

words, you can stretch object one way or another when dragging a corner resize handle 

or when entering a new size. 

Smart transform 

Additionally you can right click on the padlock button to display a context menu giving 

you the option to turn on or off both ASPECT RATIO LOCK and SMART TRANSFORM. The 

latter attempts to scale the shape smartly rather than just squashing all members of the 

group and is on by default. 

If you want a simple ‘squashed’ or 'stretched' result, where each member of the group is 

simply scaled - make sure you you have the SELECTION BOUNDS handles selected - click 

the button on the SELECTOR TOOL infobar to display the handles. 

 

Then all you need to is to hold down the Alt key while performing the drag, or else un-

check the SMART TRANSFORM option. Holding down the Alt key will toggle the existing 

selection.  

Scaling using the mouse 

The SELECTORTOOL must be in 

scale mode (the selection 

bounds handles are squares). If 

necessary, click on the object to 

change to scale mode.  

Drag one of the corner handles. The object scales as you move the pointer diagonally. 

The InfoBar shows the current scaling. The object will scale between the dragged handle 

and the opposite one. To use any other point of the object as the fixed point move the 

transformation center to it and use the InfoBar buttons to scale. 

Hold "Shift" while dragging to scale the object around its center. This works 

independently of the position of the transformation center. 

"Ctrl + drag" scales the object in multiples of its original size (x2, x3, and so on). 

To create a copy while scaling (leaving the original in place) right click, or press "+" on 

the numeric keypad. 
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Dragging the side handles stretches or squashes the object. This is described in 

Stretching and squashing objects. 

Scaling using the InfoBar 

 

 
Type into the SCALE TEXT boxes and press "". 

 Scalings below 100% reduce the object. 50 halves the size of the object. 

 Scalings above 100% enlarge the object. 200 doubles the object size. 

 
If LOCK ASPECT is set, you can type into either text box to resize the object by the 

desired percentage. If this button is unset, you can enter separate values for both 

the width and height. 

 
Alternatively, type the required size of the object into the W or H text boxes. 

If the LOCK ASPECT button is on, this scales the object and maintains the aspect ratio. 

You can enter the size in any unit, such as 1 cm. 

Scaling with the InfoBar buttons (or number boxes) always scales around the 

transformation center. You can position this anywhere else in the object, as described in 

Rotating objects.  

Scaling groups 

If you scale a group using its side handles, an attempt is made to scale it smartly rather 

than just squashing all members of the group - we call this SMART TRANSFORM. This is 

commonly useful when attempting to make a narrower ‘mobile-friendly’ website variant of 

a wider website – you need to make wide objects like headers and footers fit the smaller 

page width.  

Take this footer group as an example:  

 

The result you get should look something like this: 
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The text has remained the same size and the rounded corners have been preserved.  

This works better for some groups than others, depending on the design and complexity 

of the group. If instead you want a simple ‘squashed’ result, where each member of the 

group is simply scaled, all you need to do is hold down the Alt key while performing the 

drag.   

 

As you can see the text has been squashed and the rounded corners are no longer 

round. But this can be useful for some groups, typically graphics that don’t include any 

text or rounded corners. 

Turn SMART TRANSFORM on or off by right-clicking on the LOCK ASPECT RATIO (on page 

104) padlock button and selecting or de-selecting the option. It is on by default and 

holding down the Alt key during the drag will toggle the selected option. 

  

Flipping objects 

 

This is part of the SELECTORTOOL. Clicking on the FLIP buttons flips the 

object vertically or horizontally around the transformation center. 

The scale and aspect ratio do not change; the object just flips. 

Stretching and squashing objects 

This is similar to scaling objects except that the object is scaled in one direction only. 

Stretching and squashing are basically the same action — stretching makes the object 

larger, squashing makes it smaller. 

Stretching/Squashing using the mouse 

Make sure you you have the SELECTION BOUNDS handles selected - click the button on 

the SELECTOR TOOL infobar to display the handles. 

 

Also make sure that the SMART TRANSFORM option on the LOCK ASPECT RATIO button is 

unchecked (right-click on the button to display the context menu and uncheck the option). 

Use the side, top and bottom handles, instead of the corner handles, to stretch or squash 

a shape in one dimension only. 
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Drag one of the side handles. The 

object scales as you move the 

pointer in the appropriate direction. 

The InfoBar shows the current 

scaling. 

The LOCK ASPECT button is ignored. 

Right click or press "+" on the numeric keypad while dragging to stretch or squash a copy 

of the object, leaving the original in place. 

Stretching/squashing using the InfoBar 

The LOCK ASPECT button must be unset (if it is set, you scale the object instead of 

stretching or squashing it). 

Type into either the width or height text box (as appropriate) and press "". Alternatively 

enter a % scale (width or height). So entering 200% into the top % scale box will make 

the object twice as wide, but the same height. 

 

Skewing objects 

 

This is part of the SELECTOR TOOL. 

 

 

Left is the original object, to the right with a horizontal 

skew 

Skewing using the mouse 

Switch the SELECTOR TOOL to rotate/skew mode. (The selection handles are arrow 

shaped) by clicking on the object. 

Drag a side, top or bottom arrow to skew the object. Note that these handles are shown 

only on rectangles which are not photo filled, because skewing other objects rarely 

produces useful results (eg. photos become distorted). 

 

As you drag, the object skews in the direction of movement 

(vertical or horizontal).  
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The InfoBar shows the current skew angle. 

"+ drag" to skew the object around its center. Hold down "Ctrl" to restrict the skew to 

the constrain angles. Right click, or press "+" on the numeric keypad as you drag to 

create a copy, leaving the original where it was. Or right-drag with the mouse to create 

instant copies, additional copies by left clicks. 

You can also skew an object in the SELECTOR TOOL's resize mode using the skew areas. 

Read more under Rotating objects in resize mode (on page 102). 

Skewing using the InfoBar 

 

To skew horizontally type an angle into the skew text box and press 

"". 

 

Snapping 

Snapping makes it easier to position edges, or specific points on objects, exactly where 

required. It can be used to align edges to a specific point or line, or to evenly space 

objects, using the grid. 

 Xara Web Designer Premium offers three types of snapping. 

 Snap to grid 

 Magnetic snapping (snap to objects) 

 Snap to guidelines or guide objects 

Grid snap is useful for making objects evenly spaced, or making the sizes exact multiples 

of a given value. Guidelines are useful for aligning edges (although it’s a lot more 

powerful using guide objects) and lastly magnetic snap is a general purpose way of 

accurately positioning lines, points or object edges relative to other objects or to the page 

center or edges. 

Snap to grid 

When SNAP TO GRID is selected, grid points act like magnets. Right click on the 

pasteboard and choose "SNAP TO" > "SNAP TO GRID" or use the menu option "WINDOW" > 

"SNAP TO GRID", (or press "." (decimal point) on the numeric keypad). You can control the 

grid spacing from the options dialog (right click and choose PAGE OPTIONS or use the 

menu command "UTILITIES" > "OPTIONS") on the Grid and Ruler tab.  
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When dragging objects the edges will snap to grid points. If the size of the object is such 

that opposing edges can't both be snapped, the edge that snaps depends on the 

direction the object is dragged in. 

 

This shows a coarse grid with 5 subdivisions between major divisions. The shape has a very 
thick gray outline. Because the object has been dragged down and to the left, the lower and 
left outside edges are snapped to the nearest grid point. 

Note: The default grid spacing is 50 pixel spacing for major grid lines with 50 

subdivisions. This means the grid is spaced at exactly one screen pixel and so may 

appear not to be working at a normal 100% zoom. If you zoom in to say 500% then you 

can see it does snap correctly. 

Alternatively, change the grid values to have, say, 10 subdivisions which means that the 

grid points are on 5 pixel boundaries. 

Snapping and line widths 

 

The SCALE LINE WIDTHS control on the SELECTOR TOOL 

InfoBar affects whether snapping happens to the bounds of 

objects including their outlines. 

The above example shows a shape with a very thick gray outline. It also shows (thin 

black line) the outline of the shape itself (you can see the thick outline is drawn equally 

on either side of the center line so that it partly overlaps the inside of the shape and 

partially goes outside). 

With scale line widths on, the width of the outline is deemed to be important and so ‘snap 

to grid’ will snap the bounds of objects, including outlines, to the grid. Snap to objects will 

allow you to snap using the bounds or the outline center lines. If the outlines as they 

appear on screen are small, so there is little difference between these two snapping 

positions, bounds snaps are favored. So zoom in if you want to snap outline centers in 

this case. 

With scale line widths off, ‘snap to grid’ and ‘snap to objects’ will snap the center lines of 

objects, ignoring the outline widths.  
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Because snapping honors the Scale line widths switch it means that the bounds used by 

snapping are always the same bounds that are reported in the SELECTOR TOOL InfoBar. 

Magnetic object snapping (snap to objects) 

Magnetic object snapping makes it much easier to accurately position objects relative to 

each other or relative to the page center or edges. 

So, for example, if you want several lines to start at exactly the same point, or want a line 

to exactly join the edge of a circle, then using "magnetic object snap" is useful.  

You can even use this to align the centers of objects, or align objects to the center of the 

page, or align them horizontally and vertically anywhere in the middle of the page. 

Magnetic snapping works when either moving or scaling objects using the SELECTOR 

TOOL.  

  

To toggle Magnetic snapping to objects on and off, click the SNAP TO OBJECTS 

button in the top toolbar. Alternatively right click the pasteboard and choose 

"SNAP TO" > "SNAP TO OBJECTS", or use the menu option "WINDOW" > "SNAP TO 

OBJECTS". You can also toggle it on/off during dragging by tapping ‘s’. 

Click and drag on the object you want to snap. As you drag, Web Designer Premium 

displays a magnet icon, blue lines and red points whenever you are near a "point of 

interest" that it has snapped to.  

Snap indicators 

 

Snap indicators are shown whenever a snap occurs. That is whenever a point of interest 

on the object you are dragging comes in range of a point of interest in the document 

(which could be on another object or be part of the page). Web Designer Premium snaps 

to the point of interest and the mouse pointer changes to show a magnet symbol so you 

know a snap has happened. Also further indications are shown dynamically on screen to 

help you see what snap has occurred.  

 A red dot indicates that a specific point has snapped 

 A blue line indicates a snap to some feature of another object (e.g. to the edge of a 

rectangle). 
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 An orange line indicates a snap to a page feature (corners, edges, center) 

The snap indicator lines pulse to show that they are temporary "live" indicators and to 

help them be seen over different background colors. 

The snapping distance is controlled by the MOUSE tab of the OPTIONS dialog box 

("UTILITIES" > "OPTIONS" or right click a page and choose PAGE OPTIONS).  

 

You can specify two snap distances in the "Magetic snap radii" section, which control 

how close things need to be before they will snap together. The size of a circle around 

points (point) and the distance either side of lines (lines). It's usually best to make the 

point value larger than the line value,  so that it's easier to snap to the end points of lines. 

Customizing Web Designer Premium (on page 509) has full details of the Options dialog. 

Guide Objects and Guidelines 

Guide objects and guidelines are objects on a special layer, the guides layer. A guide 

layer is automatically created when you create a guideline (see below), or you can create 

one manually by right clicking in the PAGE & LAYER GALLERY and selecting CREATE GUIDE 

LAYER (see Layers (on page 447) for more information). 
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Use SNAP TO GUIDES in the WINDOW menu (or key 2 on the numeric keypad) to turn on 

snapping to guide objects. 

Any object placed on the guides layer becomes a guide object. These can be any object 

type including lines at any angle, irregular shapes, and QuickShapes. You can create, 

scale, and delete objects on the guides layer as usual, but they always appear as thin 

dotted red outlines; any applied line width or fill color is ignored. This information is 

retained, and if you later move the object from the guides layer to a normal layer, line 

thickness, and colors are shown again. 

You can use guide objects to draw construction lines such as lines passing through a 

vanishing point for perspective drawing.  

Placing objects onto the Guides Layer 

First ensure there is a guide layer in the PAGE & LAYER GALLERY, see above. You can 

create objects directly on the guides layer by selecting it and creating objects as usual. 

 

The Page & Layer Gallery showing a guides layer above 
two other layers, and selected. 

You can also cut or copy 

objects from another layer 

and then paste those objects 

into the guides layer. To 

paste the objects in the same 

relative position on the guides 

layer use the keyboard 

shortcut "Ctrl + Shift + V". 

 

MOVE TO LAYER IN FRONT and MOVE TO LAYER BEHIND on the ARRANGE menu (or right 

click and choose "ARRANGE" > "MOVE TO LAYER IN FRONT/BEHIND") will skip the guides 

layer and so cannot be used to move objects onto the guides layer. 

Creating a guideline 

Guidelines are vertical or horizontal lines and are a quick and easy way to align a series 

of objects on the page. 

 Turn rulers on ("Ctrl + L") or right click and choose "SHOW GRID/GUIDES" > "SHOW 

RULERS" 

 Drag from a ruler onto the page. 

Or 

 Double click on the ruler to create a guideline aligned to the click point. 
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This automatically creates a guides layer and puts the guidelines on that layer. 

Or, using the PAGE & LAYER GALLERY: 

1. Right click in the PAGE & LAYER GALLERY and choose PROPERTIES. 

2. If necessary, click the GUIDES tab. 

3. Select horizontal or vertical. 

4. Click NEW. 

5. Type in the required position. 

Deleting a guideline 

Using the SELECTOR TOOL drag the guideline onto the appropriate ruler (the vertical ruler 

for vertical guidelines, horizontal ruler for horizontal). 

Or, right click on the guideline and then choose DELETE. 

Summary of shortcuts on the numeric keypad 

+ Makes a copy while dragging, resizing, skewing, and so on. The original object 

doesn‘t change. 

/ Toggles leaving line widths unchanged during scaling and scaling with changing 

line widths. 

- Toggles leaving fills unchanged during moves, scaling, skewing, etc.  

* Toggles object magnetic snap on and off. 

2 Toggles snap to guides on and off. 

. Toggles snap to grid on and off. 

 

Conflicts in page layouts 

When too many objects on the page are trying to affect each other's positions or sizes in 

too many ways an error message is displayed which says... 

"THE REQUESTED CHANGE IN PAGE LAYOUT IS TOO COMPLEX TO PROCESS. PLEASE 

SIMPLIFY THE PAGE AND TRY AGAIN" 

To fix this, it is necessary to reduce the interactions between objects on the page. This 

means doing things like: 

 Grouping (on page 114) or Soft-grouping things that should move together 

 Removing push where it's not needed especially on objects that are also stretching or 

have "Footer" or "Auto" (on page 134) page positions 

 Setting page position to "Fixed" or "Footer" 

 Removing stretching markup 

 Removing repelling (on page 227) 
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Grouping and ungrouping objects 

The Shadow and Transparency Tools offer different results depending on whether 

objects are grouped or not. For more information see "Transparency" and "Shadows (on 

page 274)". 

You will often create complex shapes from several different objects. The "ARRANGE" > 

"GROUP" menu option (or right click selected objects and choose GROUP) lets you lock 

those objects together to form what appears as a single object. You can then select the 

grouped objects and copy, rescale, move or perform any other operation on the entire 

group. 

To create a group 

1. Select all the objects you want in the group. 

2. Right click and choose GROUP or choose GROUP from the ARRANGE menu (or "Ctrl + 

G") to create the group. 

Ungrouping objects 

1. Select the group. 

2. Right click and choose UNGROUP or choose UNGROUP from the ARRANGE menu (or 

"Ctrl + U"). 

After this, all the individual objects in the group remain selected. 

Removing objects from a group 

1. Ungroup the objects. 

2. "Shift + click" on the objects you want to remove. This deselects them; the other 

objects remain selected. 

You can then choose "ARRANGE" > "GROUP" to regroup the remaining objects. 

Selecting a single object from within a group  

This feature called SELECT INSIDE, is useful for changing an object's color, for example. 

"Ctrl + click" on the object (you can also use this to select a "group within a group"). 

Pressing "Tab", or "Shift + Tab" moves the selection within the group, to the next, or 

previous object. Once you have selected an object inside a group, you can also use "Alt 

+ click" to select the object under the selected one. 
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Groups and layers 

There’s more about layers in Layers (on page 447). 

If all the objects to be grouped are in one layer, the group is created in that layer. The 

group is at the level of the highest member of the group, i.e. the group does not 

automatically become the front object. 

If the objects are in more than one layer, then the group is created in the layer containing 

the object nearest the front. 

Changing colors in a group 

Most groups use more than just a single color and sometimes it’s useful to change those 

colors (for example to change the colors of a button, which consists of a group of 

objects). You could do this of course by ungrouping, or using SELECT INSIDE, to change 

the color of each object individually, then regrouping. But a much quicker way is to just 

select the group and click a color. If the group contains multiple colors, a dialog appears 

to let you choose which one to replace with the color you clicked on. Or bring up the 

COLOR EDITOR and its list of colors includes the same list of colors that are used in the 

group. Select the color you want to edit. 

Soft Groups 

Ordinary Groups as described in Grouping and un-grouping objects (on page 114) sit on 

a single layer, they cannot span layers. SOFT GROUPS are an alternative way of linking 

objects together where the objects can be across several different layers. 

Selecting one member of a Soft Group also selects all other members of the same Soft 

Group – even members that are on invisible or locked layers. This means when you 

delete, move, rotate or otherwise transform one member of a Soft Group, all the other 

members are similarly modified.  

The status line indicates when a Soft Group is selected. 

Soft Groups are useful for keeping closely related objects together. For example the 

MOUSEOFF and MOUSEOVER states of a web button are Soft Grouped together, so that if 

one state is moved or transformed, so is the other state. 

Creating Soft Groups 

To create a Soft Group, select all the objects that are to be included in it and then choose 

“ARRANGE" > "APPLY SOFT GROUP" (or press “Ctrl + Alt + G”). Note that if the Soft Group 

is to include members on invisible or locked layers, you’ll need to make those layers 

temporarily visible and editable using the PAGE & LAYER GALLERY in order to select the 

objects and Soft Group them.  

An object cannot be a member of more than one Soft Group and Soft Groups cannot be 

nested (soft groups as members of soft groups). 
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Removing Soft Groups 

To disband a Soft Group, select it and choose “ARRANGE" > "REMOVE SOFT GROUP” (or 

press “Ctrl + Alt +U”). The objects don’t get deleted, they are just no longer linked 

together by a Soft Group. 

Text Synchronization 

In some circumstances text objects in a soft group are kept synchronized so that if you 

edit the text of one, the others update too. This is commonly used for mouse-over 

buttons, where both the off and over states of the button need to show the same label at 

all times. When the button off-state label is changed, the mouse-over state changes to 

match.  

Also sometimes "shadow-like" effects can be achieved by placing two or more copies of 

text very close to each other, but slightly offset. Again, editing one causes them all to 

change in sync.  

To stay synchronized, the text objects must: 

 Be all in the same soft group. 

 And have exactly the same text on them at the time when the soft group is created. 

 And either have overlapping bounding boxes, or be on different layers or different 

animation frames. 

 

Alignment 

This lets you accurately align or distribute two or more objects. 

Quick aligning 

Select the objects you want to align, and right click the selection to choose ALIGN from 

the drop-down menu, and then do one of the following: 

 Align the objects vertically by choosing LEFT EDGES, CENTERS, DISTRIBUTE CENTERS or 

RIGHT EDGES. 

 Align the objects horizontally by choosing TOP EDGES, CENTERS, DISTRIBUTE CENTERS 

or BOTTOM EDGES. 

Aligning and distributing space 

If you want to distribute space between the objects as well as align them, select the 

objects, right click the selection and choose "ALIGN" > "ALIGNMENT" to display the Object 

Alignment dialog. Alternatively choose "ARRANGE" > "ALIGNMENT" ("Ctrl + + L"). 
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The small diagram at the top of the dialog box shows 

you the effect of selecting each option. The selected 

objects in the document do not change until you click 

APPLY. 

The alignment dialog is a non-modal dialog, which 

means you can keep it on screen and continue to work 

on the document at the same time. So you can change 

tools, draw, and change your object selection, and then 

easily select from the various alignment options. 

If you’ve got your selection wrong, you can change the 

selection, and just click the APPLY button to apply the 

last alignment settings again. This can be a real-time 

saver. 

 

Within 

This section of the dialog controls the boundaries within which you align or distribute the 

objects. The options are: 

 

SELECTION BOUNDS: The boundaries are the outer 

edges of the selected objects. Their relative position 

on the page or spread has no effect. 

 

BOUNDS OF BACK OBJECT: The boundaries are the 

outer edges of the backmost selected object. This 

object is not affected by the alignment. 

You can use this to define the "reference" object when 

you want to align several objects in a row, for instance. 

With the normal "Selection bounds" options on the 

leftmost object is the reference object (the one that 

won't move) 
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PAGE: If the objects are on a single page, the 

boundaries are the edges of the page. (This lets you, 

for example, center objects on the page or align 

against the page edge.) 

 

WHOLE PAGE: In most cases, this is the same as PAGE 

unless you have a double page spread, in which case 

it will use the bounds of both page 

 

Aligning 

To align objects, for example, so their left edges are aligned to the left. 

1. Select the objects and right click the selection. 

2. Choose "ALIGN" > "LEFT EDGES" from the drop-down list. 

The selected objects move to align the left edges. 

Alternatively: 

1. Choose "ALIGN" > "ALIGNMENT" or press "Ctrl + Shift + L" or choose ALIGNMENT 

from the ARRANGE menu to open the Object Alignment dialog. 

2. Select the required WITHIN option, e.g. Selection bounds. 

3. Select ALIGN LEFT for horizontal positions. 

4. Leave vertical positions to NO CHANGE. 

5. Click APPLY. 

The selected objects move to align the left edges. 

All the align options act in a similar way. For brevity, only the left align option, shown in 

the illustration of the dialog box is described. Experiment to learn about the other options. 

To quick-select any combinations of vertical and horizontal alignment click with the 

mouse in the diagram:  

 A simple mouse click aligns horizontal and vertical positions to the clicked position to 

any of the nine combinations of top-centrally-bottom/left-centrally-right. 

 "Ctrl + mouse click" leaves the horizontal position unchanged and arranges the objects 

in a to a top, centrally, or bottom aligned row. 

 "+ mouse click" leaves the vertical position unchanged and arranges the objects in a 

left, centrally, or right-aligned column. 
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Distribute 

The distribute options will position all the selected objects evenly across the "Within" area 

(usually within the selection bounds, but it could be the PAGE or WHOLE PAGE). 

Again all the distribute options work in a similar way. The following examples show how 

the different vertical position options align objects: 

 

TOP EDGES DISTRIBUTION: the tops of the objects are 

evenly spaced. BOTTOM EDGES distribution is the 

inverse—the bottom of the objects are evenly spaced. 

 

CENTERS DISTRIBUTION: the centers of the objects are 

evenly spaced. 

 

EQUI-SPACED DISTRIBUTION:the objects are evenly 

spaced from each other. 

The horizontal position options are similar but operate in the horizontal direction. 

So, for example, to distribute this collection of randomly positioned ellipses, so they are 

all equally spaced and aligned to the top edge: 

 

 Select the shapes 

 Display the Alignment dialog ("Ctrl + + L") 

 Ensure WITHIN shows SELECTION BOUNDS 

 Select Horizontal positions: Distribute centers 

 Select Vertical position: Align top 

 Click APPLY 

 

And they will now look like this, all equally spaced horizontally 

and aligned to the top. 

Remember if you make a mistake you can always undo the operation. 

Current attributes (styles) 

An ‘attribute’ is some characteristic of an object which you can modify in Xara Web 

Designer Premium. For example a shape’s attributes include its color, its outline width 

and its outline color.  
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You can change the attributes of an object after you’ve drawn it, by selecting it and then 

changing its fill color, line width, or any of its other attributes. But Xara Web Designer 

Premium also keeps track of the ‘current’ attributes, which are the attributes that get 

applied to newly drawn objects as they are created. 

Setting current attributes manually 

If, for example, you want the next rectangle you draw to be red, make sure you have 

nothing selected (press "Esc" or click an empty part of the page) and then click red on 

the color line. You’ve now set the current fill color attribute to red. Now when you draw a 

new shape, it will be filled red. You can set other current attributes the same way – by 

first making sure nothing is selected before changing the attribute’s value.  

Setting current attributes automatically 

By default, Xara Web Designer Premium automatically updates the current attributes for 

you, to match the object you last drew, or last selected. So for example if you draw a 

rectangle and then make it green, the next shape you draw will also be green. If you 

have a blue rectangle in your design and you wish to draw another one just like it, first 

select the blue rectangle (this makes its attributes current) and then the next shape you 

draw will also be blue. So by simply clicking an object, you set the current attributes to 

match that object. 

This allows you to use existing objects as a ‘palette’ of available styles. Click an object to 

select it, then draw new objects in that style. 

You can turn off this behavior in the GENERAL TAB (on page 510) of the "UTILITIES" > 

"OPTIONS" dialog. Select the GIVE NEW OBJECTS MOST RECENT ATTRIBUTES (GNOMRA) 

checkbox. Now the current attributes will only change when you set them manually, as 

described above. 

Attribute groups 

Many designs consist of a combination of closed filled shapes and open shapes (lines 

where the start and end points are not coincident). Normally it wouldn’t be desirable to 

have the attributes of an open shape used for a closed shape, nor vice-versa. Therefore 

the attributes for open and closed shapes are kept separate – these are known as 

attribute groups. Setting the values of one group does not affect the other group. So for 

example, selecting a filled rectangle with no outline will not change the current line width 

to zero for open shapes. 

For the same reasons, text attributes make up a third attribute group. The text attribute 

group is only set when you select text objects, or when you set the attributes manually 

while in the text tool. 

Exempt attributes 

Some attributes do not get set as current automatically even when ‘Give new objects 

most recent attributes’ (GNOMRA) is on. This is because some attributes can cause 

problems if they become current.  
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For example if you applied a 10 pixel feather to a large object (to blur the edges) and 

then drew a new 10 pixel sized shape, that new shape would be invisible if the feather 

attribute was copied to it, due to the amount of feathering!  

Other attributes can adversely affect the way designs export, or significantly increase the 

time taken to render the design and so should not be applied unnecessarily. 

Examples of attributes which are copied automatically: 

 Fill colors, fill styles, line width, line color, line style, line join style, line endcap style, 

arrow heads/tails, text font, text font size, text margins. 

Examples of attributes which are not copied automatically: 

 Feather, transparency, shadow, bevel, 3D extrude. 

Resetting current attributes 

You can reset all current attribute groups instantly by pressing "Esc" when you have no 

objects selected. If you have objects selected, pressing "Esc" clears the selection, so just 

press "Esc" again to reset the current attributes back to their default values. 

Copying Styles: Paste Attributes 

This lets you copy attributes (such as line pattern or fill color) between objects. It is a 

quick way of applying multiple attributes to an object. 

 

The square has a specific color, shadow, 

line and fill style. Copying it and then 

pasting its attributes on to the circle in the 

middle, results in the circle to the right. 

1. Select the object from which you wish to copy the attributes. 

2. Copy the selection to the clipboard. ("EDIT" > "COPY", or "Ctrl + C".) 

3. Select the object(s) to which you want to apply the attributes. 

4. Choose "EDIT" > "PASTE FORMAT/ATTRIBUTES", or "Ctrl + Shift + A". 

The object remains on the clipboard until overwritten by a cut or copy operation. This lets 

you repeat paste attributes as many times as required. 

Style libraries 

It’s quite easy to use this technique to create documents that can be used as style 

libraries. Create a series of small objects with a variety of useful fill, color and other 

attribute styles. Then the quickest way to use one of these styles is: 

 Click on the source object, "Ctrl + C" to copy the style 

 Move to the destination object (which can be in another document, "Ctrl + Tab" to 

quickly switch between open documents), click on the object to apply the style to 
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 Press "Ctrl + Shift + A" to apply the  attributes 

Note: Most attributes can be copied this way, including shadows, feather values, fill 

styles, etc. However bevels can only be copied from one object to another if the object 

the bevel is copied to has already a bevel to apply the bevel attributes to. 

ClipView 

ClipView lets you hide or ‘clip’ parts of a shape within another larger shape. The effect is 

similar to the Intersect shapes option, described in the chapter on Shape handling (on 

page 158). The difference is that the Intersect shapes option actually cuts the objects, 

whereas ClipView just hides the parts outside the ClipView object. What’s more you can 

then adjust the position of the objects inside the ClipView. 

To create a ClipView: 

1. The ‘window’ object must be behind the other objects 

in the ClipView. If necessary move it backwards. In this 

example the dark ellipse is the window object. 

Alternatively draw the ‘window’ shape on the mask 

layer (on page 287). 

2. Select all the objects you want to be inside the 

ClipView (including your ‘window’ object unless it is on 

the mask layer). 

3. Choose "ARRANGE" > "APPLY CLIPVIEW" ("Q"). All of the 

"window" object remains visible plus those parts of 

other objects that overlap the "window" object. 

 

 

 

Setting the ClipView background color 

The fill color of the original object used as the ClipView is the background color. So either 

set this to the desired color before setting the ClipView or perform a "select inside" ("Ctrl 

+ click") on the background, and then adjust the color. 

Select clipping shape 

This selects only the shape that you used to do the clipping. Effectively this is the 

‘window’ through which you see the other object(s) in the clipview. Once it’s selected you 

can move it around or otherwise transform it, to adjust your clipview. 

 

Select clipped objects 

This selects all the objects in the clipview that are being clipped. Therefore once these 

are selected, you can drag them around inside the clipview to adjust their position 

relative to the clipping shape. 
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Selecting objects in the Clipview 

You can perform a "select inside" by holding "Ctrl" and clicking on the desired object. 

This is very like selecting objects inside a group described earlier in this chapter 

(ClipView objects are a type of group). You can now perform most edit operations on the 

object. 

Removing a ClipView 

Just select the object and the menu "Arrange -> Remove ClipView", or press "Alt + Q". 

Soft edged ClipView 

With the whole ClipView object selected, you can adjust the FEATHER slider control on 

the top bar, to give the whole clipped object a soft feathered edge. 

Note: You can have ClipView objects inside ClipView objects. 

Naming objects 

 

You can apply names to any object in Xara Web Designer Premium using the 

APPLY, REMOVE OR INSPECT NAMES OF OBJECTS button on the SELECTOR TOOL 

InfoBar. 

Naming is a general mechanism  which has a variety of uses, some of which are 

described below. Most commonly names are used to form loose sets of objects. 

Example uses of names 

Animations: Names are used in animations to mark objects which are to be tweened. 

See the Animation (on page 460) chapter for full details. 

Adding names 

To add a name to an object, select the object and open the NAMES dialog using the 

button on the SELECTOR TOOL InfoBar or right click on the object and choose NAMES... 

Type the new name into the APPLY NAME field, or use the drop down list on the same 

field to select a name which is already used elsewhere in the current document. Click 

ADD. You should see the name appear in the NAMES APPLIED list. 

Names applied 

The NAMES APPLIED field shows you the names applied to the current selection. If more 

than one object is selected, a list of names is only shown if all objects in the selection 

have exactly the same set of names applied. Otherwise “<many>” is displayed, indicating 

that there are differences in terms of the names applied to different objects in the 

selection. 
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To remove a name from the selected object(s), click the name in the NAMES APPLIED list 

to select it and then click the REMOVE button. 

Repeating Objects 

It's common to have items like navigation buttons, headers or logos repeating on all 

pages of your website. 

Web Designer Premium provides the ability to repeat any item in the same place on any 

of your web pages. When you update one of the copies, Web Designer Premium 

automatically replicates those changes across all pages that have a copy of the 

repeating object. 

On most of the template designs the main navigation buttons are repeating. You can 

make any object such as a button a repeating object by right clicking it and choosing 

"REPEATING OBJECT" > "REPEAT ON ALL PAGES". The object is copied to the same place 

on all pages, displaying the repeating symbol icon in the top right hand corner. If you 

make any further changes to this item all the copies will be automatically updated. 

However if the bar is set to be a SITE NAVIGATION BAR it automatically appears the same 

on all pages of your site and there is no need to make it a repeating object.  

Logo text and footers are also normally set to be repeating objects in the templates. 

Again this means you can edit them on one page, and the same object is automatically 

updated on all other pages. 

Note: This uses the current page as the source of the repeating items to update across 

all the other pages.  
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The red box highlights the repeating object symbol, shown on every instance of the repeating 
object 

If you don't want a copy of the repeating object on a page, just delete it from that page. 

When edited, the repeating object is only automatically updated to those pages that 

already have it. This means you can choose which of the pages in your document should 

have the repeating object and which should not. 

If you want a repeating object on just a few pages of a large website, you can: 

1. First make your object repeat on all pages of your site, using Arrange > Repeat on 

all pages.  

2. Select one of the repeating objects and copy it to the clipboard ("Ctrl + C").  

3. Hit the Delete key and choose the Delete from all pages option when prompted.  

4. Now simply paste the repeating object onto each page that needs a copy of it. 

Editing the contents of a repeating object  

When Web Designer Premium creates a repeating object, the repeating items are placed 

in a containing 'repeating group', similar to a normal group. If you drill down to a layer 

containing a repeating object in the PAGE & LAYER GALLERY, you can see that there's a 

repeating group containing each repeating object on that layer. 

 

Web Designer Premium places each repeating object inside a repeating group 

If you want to edit an item inside this repeating group, press "Ctrl + click" on the item to 

select it inside the repeating group. Alternatively if you go into a specific tool you can 

usually click directly on any object that is applicable to that tool and it will be selected 

inside its repeating group (or any other type of group). So for example you can select a 
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rectangle that’s inside a repeating group by simply going into the Rectangle tool and then 

clicking on the shape. 

If the repeating group consists of a single object you can directly select that object 

instead of selecting the repeating group that encloses it. 

As with any other edits made to a repeating object, any edits you make inside a 

repeating group are applied to all instances of that repeating object on other pages. 

Locking a repeating object 

You can lock a repeating object right clicking it and choosing LOCK REPEATING OBJECT. 

Once locked, the object is not selectable. But editing any other copies of that repeating 

object on other pages, which aren’t locked, will change all copies, including the locked 

copy. 

Stopping objects repeating 

Right click an object and choose "REPEATING OBJECT" > "STOP REPEATING" to turn off the 

repeating nature of an object, or all of its copies in your website. Choosing STOP 

REPEATING from the "ARRANGE" > "REPEATING OBJECT"  menu also allows this.  

You’ll be asked whether you want to just stop the selected object repeating or all copies 

of the object in the website. Choose the ALL option. Now the different copies of that 

object can be independently edited and the next time one is changed it won’t update any 

of them. 

Use this if, for example, you’ve used REPEAT ON ALL PAGES to copy an object to all pages 

of your website, but then you want to make those objects different on each page so that 

they are no longer tied together.  

STOP REPEATING is also useful if you want to make a copy of a repeating object (eg. a 

footer or logo) on one page and you don’t want that copy to be updated. In this case 

choose the JUST THIS COPY option when prompted.  

Note that you can’t use STOP REPEATING on NavBars which have the SITE NAVIGATION 

BAR option turned on in the NAVBAR DIALOG. That’s because site navigation bars always 

update across the whole website. See the Navigation Bar chapter for more information 

on site navigation bars. 

Deleting repeating objects 

If you don't want a copy of the repeating object on a page, just delete it from that page. 

Xara Web Designer Premium displays a prompt asking whether to delete just that copy 

or all copies of that repeating object.  

Pressing "Ctrl + Delete" will delete just the selected repeating object without asking 

whether you want to delete all instances or just this one. 
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Auto-fit to page... 

The AUTO-FIT feature enables you to create flexible documents that adapt to almost any 

size change you might want. This means you can design social media documents once, 

and then easily deploy to a variety of sizes and aspect ratios. You can convert 

documents from A5 to A4, or A3 or vice versa. And even change orientation, from portrait 

to landscape. 

 

Re-sized Facebook, Instagram and Twitter post templates. 
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The feature is controlled by the AUTO-FIT TO PAGE dialog which you can access by right-

clicking on any item on the page and selecting AUTO-FIT TO PAGE… You can also find it in 

"UTILITIES" > "AUTO-FIT TO PAGE...". 

 

The Auto-fit dialog controls how items move or stretch as the page size changes 

The AUTO-FIT ALL OBJECTS checkbox controls the automatic behavior of all items in the 

document. The dialog defaults to AUTOMATIC for all items in your document, but you can 

control the behavior of individual objects using the settings in the lower panel. 

The AUTO-FIT ALL OBJECTS checkbox turns the feature on. Bear in mind that even if this 

option is un-checked existing documents that had items marked as footers, or to stretch, 

will continue to behave as usual. This option just enables a more comprehensive, 

automatic positioning of items on the page. 

Width only or Width & Height 

There are two distinct use-cases where you might want automatic positioning of items on 

the page: 
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1. Websites, particularly ‘blog’ style websites where the pages are of variable length, 

depending on how much text you have. Here you do not want the position of items 

on the page (typically at the top of the page) to be moved as the page grows.  In 

this case select the WIDTH ONLY option. This means things will be repositioned when 

you change the page width, but not when the page height changes. 

2. Print documents, Social Media documents or Presentations, where you want things 

to re-position and stretch (automatically adapt) whenever the page width or height is 

changed. In this case select the WIDTH & HEIGHT option. This is the default when 

you enable AUTOMATIC FIT. 

So to summarize for most document types, print, presentations and social media, select 

WIDTH & HEIGHT. For websites choose the WIDTH ONLY option.  

Click APPLY to effect the change - you can now test the result by dragging the right or 

lower page edge to see how things move as you adjust the page size. Or alternatively in 

the PAGE OPTIONS (on page 517) dialog, select from drop-down list of common page 

sizes. 

Auto-fit for individual page objects 

Once you have enabled the AUTOMATIC FIT option you can control the behavior of 

individual objects on the page. By default everything is marked as AUTOMATIC.  

 

To control the behavior of individual objects just select the item you want to control, un-

check the AUTOMATIC checkbox - which will enable all the lower panel settings. You can 

now set the position rules for your selection. 

Again click APPLY to effect the change - and now test the result by dragging the right or 

lower page edge to see how things move as you adjust the page size. Or alternatively in 

the PAGE OPTIONS dialog, select from drop-down list of common page sizes. 
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The options are... 

 

The TOP, MIDDLE and BOTTOM options for vertical adjustment and the corresponding 

LEFT, CENTER and RIGHT, for horizontal adjustments will keep the items the same size (so 

won't be stretched, enlarged or shrunk) and at the same position relative to the edge or 

center of the page. 

So items marked to be TOP, will stay at the same current absolute position to the top 

edge. Items marked as LEFT will remain positioned at the left edge of the page. 

So if you want a footer to remain at the exact same vertical size and vertical position 

relative to the bottom of the page, set the vertical options to be BOTTOM. Similarly if you 

want an item, perhaps a logo, to remain at the exact same offset in the top right corner, 

irrespective of page size, then set it to be TOP and RIGHT. 

% Position 

 

Items marked with either of these options will not change size as the page is enlarged or 

shrunk, just be moved to remain at the same relative position on the page.  For example 

an item that is 1/3rd of the way across the page will always be 1/3rd across the page. 

% Scale height or width 

 

This is like the AUTOMATIC option - but applying to the selection only, where position and 

stretch occurs with page width or height change. 

Maintain edge offsets 

This option is useful where you want a fixed gap between the edge of the page and the 

item. 

Scale (Locked Aspect Ratio) 
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Items enlarge or shrink as the page size enlarges or shrinks but retain the same aspect 

ratio. 

Reset all objects 

This button will remove any and all manually auto-fit settings you have on everything in 

the document. This puts everything back to the AutomatiC setting. 

An Example 

This is a relatively simple social media graphic that is adaptable to just about any page 

size. With the AUTOMATIC options it would work, but the border width and height would 

not remain the same.  So in this case specific items on the page have been marked to 

behave differently. 

 
Photo: set to STRETCH - MAINTAIN EDGE OFFSETS.  

 
Center text panel: AUTOMATIC - text is set to center vertically and horizontally. 

 
Background rectangle: set to AUTOMATIC. 

 
Footer text panel: set to BOTTOM and % SCALE WIDTH. 
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Previewing and testing Auto-fit pages 

A great way to test the adaptability of your page design is to preview and test using the 

PAGE SIZE dialog - right click on the page background - select PAGE OPTIONS...  and then 

the PAGE SIZE TAB. 

 

In the Page Options dialog - the Paper size field has a drop-down list of common page sizes. 

So you can select a preset paper size from the drop down, but a much easier way is to 

unlock the page, which allows you to drag the width and height to any desired value. To 

enable page size dragging, just un-check the LOCK PAGE SIZE option. Now if you move 

the mouse pointer near the right or bottom edge of the page, the pointer changes to 

indicate you can drag the edge to resize. 

Resizing picture and text 

It’s important to understand that when a page is stretched (e.g. if you drag the right edge 

of the page to be wider), text items and images are resized, but the program does not 

distort the text or images. There’s nothing worse than a photo that has the wrong aspect 

ratio, or stretched text. 
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So in the case of text objects, when the container of the text is resized, the text just re-

flows within the new container size. So, for example, changing a page from A4 portrait to 

A4 Landscape the body text is not stretched, it remains the same point size, but the text 

frame is stretched. 

 

In the example above the page is made wider (and less tall). The text remains the same point 
size, but the text frame, and other items on the page have been resized in proportion.  

This is the out-of-the-box behavior when everything is set to AUTOMATIC. Using the 

manual controls you can optimize the behavior, so that for example the width or height of 

items can be fixed. In the above example you can see the height of the header and footer 

has become reduced as the page height has reduced. This might not be what you want, 

and this is where the individual HORIZONTAL and VERTICAL controls come into play - as 

described. 

Resizing text 

If the page is made taller AND wider, then the text will be resized. The example below 

shows a small page on the left, and a much larger Facebook post size version, with 

approximately the same aspect ratio on the right.  If we did not scale the text, then the 

Facebook one would have unreadably small text. 
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Tip:Always design for the smallest page size, it's easier to enlarge a format than to shrink 

it. 

Tip: Don't fill up your text boxes - leave room for content to flow. 

Push objects 

Push objects are mainly useful in page templates, to help maintain the design of a page 

as text is extended or contracted. Push objects are not allowed to overlap with other 

push objects and so if one extends or moves so as to encroach on the space of another, 

it ‘pushes’ that other object down the page out of the way. And if a push object is pushed 

off the bottom of the page, the page automatically extends to accommodate it. 

To make an object into a push object, right click on it and choose PUSH... from the context 

menu. The PUSH dialog appears. 

 

Select the Push checkbox to turn on Push for the selected object(s). Then you can 

optionally change the top and bottom margins. By default the top and bottom margins are 

locked together – just click the lock button if you want to set them independently. The top 

margin value determines how close another Push object is allowed to get to this one, 

before this object will move down out of its way. So it stops other Push objects coming 

too close. Similarly the bottom margin value specifies how close to another Push object 

below it, this object is allowed to be before it starts to push that object out of the way, It 

also defines the minimum distance that must be maintained between it and the bottom 

edge of the page (the page will extend when required) because often you don’t want the 

object to be right up against the edge of the page. 

The EXTEND SIDES field allows you to make the Push object behave as if it was wider 

than it actually is. This means it can be made to push objects below it (or be pushed from 

above) even if there is some horizontal separation between the objects. So for example a 

100 pixel wide rectangle set to push with EXTEND SIDES set to 50px, will behave as if it 

was 200 pixels wide in terms of its push behavior. 
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As mentioned above, as a Push object gets longer it will push other Push objects below it 

out of the way, down the page, and if necessary the page will extend. But what if the 

Push object subsequently gets shorter again (perhaps some text is deleted from a text 

object)? Now there is space for the Push objects below it to move up the page again. So, 

as long as the objects started off close together before the text was removed, that’s 

exactly what happens – the lower Push objects move up, closing the gap that would 

otherwise have been introduced. Similarly where appropriate the bottom of the page will 

move up, making the page shorter. 
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Drawing Lines and Shapes 

Drawing a line or a shape 

 

You can use any of these tools to draw lines and shapes: 

 The FREEHAND & BRUSH TOOL ("F3"). 

 The STRAIGHT LINE & ARROW TOOL 

 The SHAPE EDITOR TOOL ("F4"). 

The FREEHAND & BRUSH TOOL is the easiest way to draw simple lines, curves, and 

shapes, and it acts rather like a pencil. 

The STRAIGHT LINE & ARROW TOOL is best if you want to draw single segment straight 

lines, or add arrow heads and tails to any types of lines. 

The SHAPE EDITOR TOOL is best for drawing precise curves and lines. It is also the main 

tool to edit lines and shapes. 

  

Note: Although it is not in the Drawing Tools toolbar, you can also use the PEN 

TOOL to create precise shapes. It has limited functionality and works like the line 

tool of other drawing programs. To use the PEN TOOL, choose CONTROL BARS 

from the WINDOW menu and click the BUTTON PALETTE checkbox. Then click the 

PEN TOOL icon in the Button Palette.  

 

The Freehand & Brush Tool 

 

You can use this tool to draw in a freehand manner, as you would with a pencil. 

It can also be used to create brush strokes described below. While using this tool 

the status line provides reminders on how to use the tool. 

1. Position the pointer where you want the line to start. 

2. Press and hold down the mouse button.  

3. As you drag the pointer around the document, your line is drawn in real time. 

4. Release the mouse button to terminate the line.  

 

Smoothing  Re-fit Indicator 

After you’ve drawn a freehand line you 

can control how smooth the curve is (i.e. 

how many control points) by adjusting the 

smoothing control slider on the InfoBar. 

Low values make the line follow your mouse movement more closely by creating more 

control points, and higher values produce smoother curves with fewer control points. 
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Low values are less smooth  

 

Higher values produce a smoother curve 

You can change the smoothing at any time until you make further edits to the line (the re-

fit indicator on the InfoBar tells you when you can still change the smoothing.) 

Erasing while drawing 

Before you release the mouse button you can erase part of the line by holding "Shift".  

 

The pencil icon reverses so the eraser at 

the end is downwards. You can now 

erase back along the line. Release "Shift” 

and you can continue drawing. 

 

Drawing straight segments in the Freehand Tool  

While drawing a freehand line hold down "Alt", move the pointer to a new position and 

release "Alt" to draw a straight line. You can continue drawing a line or hold down "Alt" 

again to draw another straight segment. Remember, you can use "Ctrl" to constrain the 

angle of the line. If you only want to draw lots of single segment straight lines, use the 

STRAIGHT LINE TOOL described below. 

Extending a line 

Make sure the line is selected (a single click on the shape or line in the FREEHAND & 

BRUSH TOOL will do this). Now if you move over the end of the line, a small + sign next to 

the pencil icon will indicate you can just draw to add a new freehand section to the line. 

Joining two lines 

Select both lines, ("Shift + click" on the second line to add it to the selection) and you can 

now just draw from the end of one line to an end of the other. A small + sign next to the 

pencil icon (appearing after a pause) indicates you are over the end. 

Creating a shape 

A shape is a closed object with no start or end handle. Only shapes can be color filled. 

To close a shape: 
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1. Create an open object with the end point handle 

close to the start handle. All the point handles 

(except the end handle) should be in their required 

positions. 

2. Position the pointer over the end handle. 

3. Drag the end handle over the start handle and 

release the mouse button. The two handles snap 

together. 

Or: 

 

1. Create an open object with all the control handles 

in their correct positions. Do not create the final 

line segment. 

2. Move the pointer over the start point. A + appears 

to the right of the pointer when it is over the start 

handle. 

3. Click to create the final line segment and close the 

shape. 

Or: 

1. Choose the SHAPE TOOL. 

2. Click on an end point to select it. 

3. Press the "" key. 

Or you can use the FREEHAND & BRUSH Tool to create the final segment. 

Any of these closes the shape. If there is a current fill color, the shape is filled with that 

color. 

Editing lines/shapes with the Freehand & Brush Tool  

You cannot directly modify shapes created by the QuickShape, Rectangle, or Ellipse 

Tools. First convert them to editable shapes using "ARRANGE" > "CONVERT TO EDITABLE 

SHAPES". See "Shape handling" for more information. 

You can use the FREEHAND & BRUSHTOOL TO EDIT LINES (OR OUTLINES OF SHAPES) BY 

SIMPLY REDRAWING THE SECTION OF LINE YOU WANT TO REPLACE. FOR EXAMPLE: 

To edit the object: 
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Select the object that you wish to edit. 

 

Move the freehand pencil over a part of the line. A ~ shows when 

the pencil is in position. 

 

Draw the required line, then move the freehand pencil over to the 

second point of the existing line. Again, a ~ shows when the 

pencil is in position. 

 

Release the mouse button, and the section of line is replaced. 

 

 

Sketch Mode 

  

Located on the InfoBar this option is useful if you are rapidly sketching lots of 

separate lines close to each other, perhaps using a drawing tablet. 

Hold the mouse pointer over an existing line, or end point, and you’ll notice that there is a 

short pause before the mouse pointer changes to indicate that the line will be edited or 

extended. This pause means you can still edit existing lines if you want, but you won’t do 

so unintentionally when you actually mean to sketch new lines. 

Brush styles 

The FREEHAND & BRUSH TOOL can also be used to apply different brush stroke styles 

along the path of the line. Instead of being a solid, fixed-width line, you can change it to 

be a variable-width line, or one of a huge range of fancy brush styles, like airbrush, felt tip 

marker, and many more. See Brushes for more details. 

The Straight Line & Arrow tool 

 

This tool makes it easy to draw single segment straight lines and to add arrow heads and 

tails to any lines in a way that is much easier and more powerful than doing the same 

thing with the LINE GALLERY (on page 149).  
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Drawing & editing straight lines 

Simply click and drag on the page to draw a straight line. You can click on any existing 

line to select it, and once selected you can click-drag on either end to move the end of 

the line around. 

Adding arrowheads & tails 

The InfoBar has two dropdown lists on the left which allow you to choose an arrow head 

or tail style for each end of the selected line.  

 

 
Arrow head 

 
Arrow tail 

 
Arrow head/tail size 

 
Reverse path 

The slider on the InfoBar allows you to change the size of the arrow head and tail on the 

current selected line. Or you can enter a percentage value into the size text field to the 

right of the slider.  

Enter a value less than 100% to reduce the size of the arrowhead (and tail), or greater 

than 100% to increase. Although the slider only takes the size value up to a maximum of 

800%, you can enter percentage values larger than this into the size text field. 

Reverse path 

 

Press the REVERSE PATH button on the InfoBar to switch around the head and tail 

of the selected line. 

 

Adding more line segments 

Lines created with the STRAIGHT LINE TOOL are of course fully compatible with the other 

drawing tools. So if you want to add more segments to a line, make it curved, or perhaps 

even turn it into a closed shape, use the SHAPE EDITOR TOOL. 

The Shape Editor tool 

 

The SHAPE EDITORTOOL is the main tool used for both creating precise curves, 

lines, and shapes, as well as editing or altering lines and shapes.  
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Add/Change/Edit Indicator 

 
Make curve 

 
Make line 

 
Smooth join 

 
Sharp join 

 
Break at points 

 Delete points 

 
Reverse paths 

 
Positions of handles 

 
Smoothing 

The InfoBar, shown above, provides a wide range of controls as well as precise numeric 

control. 

All lines and shapes in Xara Web Designer Premium are made from a sequence of curve 

and line sections. Curves are sometimes called "Bézier" curves after the mathematician 

who first described them. 

 

The sections or segments of a line are marked by small black point handles. You can 

drag, add and delete these handles to manipulate the shape of the line or outline. 

Some objects such as QuickShapes, rectangles, ellipses, and text have to be converted 

into editable shapes before you can use the SHAPE EDITOR TOOL on them. To do this, 

select an object and choose "ARRANGE" > "COMBINE SHAPES" > "ADD SHAPE". 

To draw a straight line segment 

Using the SHAPE TOOL, start a straight line: 

1. Click where you want to start the line. You can start a line at either end; you don’t 

have to work left to right, or top-to-bottom. This creates a point handle, and is 

displayed as a red square to indicate that it is the selected handle. 

2. If necessary select the MAKE LINE button on the InfoBar ("L"). This ensures the next 

click will draw a straight line segment. 
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Either click where you want the next point 

handle to be, or click and drag, and then 

release the mouse button when the line is 

correct. This creates a line segment and 

selects the new end point handle. 

 

Mixing curved and straight lines 

To create an object which is a mixture of straight and curved segments, just switch 

between the MAKE CURVE and MAKE LINE buttons as you create the object (you can also 

press "L" or "C" on the keyboard.) 

Note: You can also use the keyboard shortcut "X" to create a Cusp Join or "S" to create 

a Smooth Join while using the SHAPE TOOL. These affect the way two line segments 

come together. A Cusp Join creates 2 independent Bezier control handles that you can 

edit separately. With a cusp join, you can create a sharp angle. A Smooth Join creates a 

symmetrical join that works like a see saw. If you drag one Bezier control handle down, 

the opposing control handle goes up. 

To draw a curved line segment: 

 

This is similar to starting a straight line (described above). 

1. Click where you want to start the line. 

2. If necessary select the MAKE CURVE button (shortcut "C".) 

3. Either click or drag (as described for straight lines) to create a second point handle, 

and a curve segment will be added to the line. 

 

A curve segment has CURVE HANDLES associated with 

the selected point handle. You can drag these to 

adjust the angle and radius of the curve. 

 

Extending the line 

Make sure an end point handle is the selected handle (red outline) and then just click 

again to add a new line or curve section.  Each successive click places a new point 

handle and draws a new line segment to the selected point handle. 
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Finishing the line 

+ click completes the line (keeps it selected), or press "Esc" to finish the line and de-

select it.  After this, additional clicks will start a new line. 

Adding a new point handle 

The SHAPE TOOL has three modes, depending on whether no point handles are selected 

(a click will start a new line), an end handle is selected (a click will add a new section), or 

one or more other point handles are selected (you can drag or change the handles).  

The InfoBar shows the current mode. 

 

 NEW: Click to start a new line, 

 ADD: Click to extend the line, 

 CHANGE: Drag or delete point handles to change. 

This applies to the SHAPE TOOL only. 

To the end of a line: 

Make sure the line is selected, then: 

1. If necessary, click on the end point to 

select it. 

2. Position the pointer and click to add 

a new section. 

 

 

To the middle of a line: 

Make sure the line is selected, then; 

1. Click on the line to add a new point handle 

into the line 

2. Drag the point handle to the required position. 

 

 

To the start of a line: 

If the end point is selected, clicking on the start point closes the shape (this is described 

in "Closing a shape (on page 137)” ). To add a new control handle to the start of a line: 

1. Finish the line using "Shift + click". 

2. Click on the start handle. 

3. Position the pointer and click. 



 

 144 Drawing Lines and Shapes 
  

 

 

Selecting multiple point handles 

You may want to select several point handles to delete them, move them as a group, or 

change a region of points to curved or straight lines. To do this: 

1. Select one point handle in the normal way by clicking on it. 

2. "Shift + click" the other point handles to select them ("Shift + click" also deselects.) 

- Or "Ctrl + Shift + click" on a point handle to select all point handles on the line. 

- Or drag the mouse pointer diagonally to create a selection rectangle. All point 

handles in the rectangle are selected. 

- Or "Shift + drag" diagonally to create a selection rectangle. This adds all points 

within the rectangle to those already selected. 

3. If the line has one or more selected point handles: 

- End moves the selection to the end of the line. 

- Home moves the selection to the start of the line. 

- Tab moves the selection to the next point handle towards the end. 

- "Shift + Tab" moves the selection to the next point handle towards the start. 

The start and end points are significant when applying arrows (on page 149). 

Deleting points 

 

Select the point handle(s) as described above and either click the 

DELETE POINTS button (SHAPE TOOL InfoBar), or press "Del". 

 

Moving point handles—Shape Editor Tool 

 

You can move one or more selected handles: 

 Drag the handles using the mouse. 

 Or use the arrow keys on the keyboard. 

Or to move a single handle, type new values into the text boxes on the InfoBar (see 

below). 
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Using the text boxes on the InfoBar 

 

The center pair of text 

boxes always shows the 

X/Y co-ordinates of the 

selected point. 

The surrounding X/Y fields show the co-ordinates of the curve handles on either side of 

the selected point. 

X/Y co-ordinates are relative to the bottom left corner of the page by default for print 

document and top left for web documents. You can change this in the Grid and ruler (on 

page 514) tab in the options dialog. 

If the selected point is on the end of a straight line section, the left fields show the length 

and angle of the line. You can adjust either by entering a new value and pressing return. 

 

 
Length and angle for straight line 

 
Position of selected point 

 
Position of curve handle 

 

Smoothing a line 

Imported shapes or shapes from tracers may have unnecessary points on a line. Lines 

with too many points can be unwieldy and can slow down rendering. Xara Web Designer 

Premium can smooth the line to remove unnecessary points. 
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Select all the points on the part of the line you want to smooth (see above). Drag 

selecting around the region in the SHAPE TOOL is probably the easiest way to select a 

large number of points. 

Drag the smoothing slider on the end of the SHAPE 

TOOL InfoBar.  

 

Tip: to make sure important points are not deleted, make sure they are not selected 

("Shift + Click" on a selected point deselects it). 

Constraining the line 

 

When dragging a point handle, holding down the 

constrain key ("Ctrl") will constrain the movement to 

multiples of the constrain angle (controlled from the 

OPTIONS dialog, GENERAL tab). When dragging a curve 

handle the angle is constrained. 

 

Changing a straight line to a curve (and vice versa) 

1. Select the point handles at both ends of a line segment. For several line segments 

select all bordering point handles. 

2. Click the Make curve   or Make line  button on the InfoBar, or press "L" or "C" 

(these shortcuts only work in the Shape Tool). 

 

After changing the line type, you may need to move the curve handles for a smooth 

transition between curved and straight line segments. 

You can select several line segments and convert them all. The point handles at both 

ends of the segment must be selected. 
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Changing curves 

Using the curve handle 

Dragging the curve handle will adjust the curvature of the adjoining curve segments. 

 

Move the curve handle towards or away from the point 

handle to pull the curve in the required direction. 

 

Dragging the line segment 

You can also change the curve by dragging the line segment between points. 

 

Notice the difference between dragging the line to change its shape, and clicking on the 

line to add a new point handle. Dragging a straight line segment changes it to a curved 

line segment. 

Making sharp corners 

Normally, Xara Web Designer Premium draws a smooth curve through a point handle. 

For this, the two curve handles either side of a point handle are linked. Moving either 

curve handle also moves the other. 

Sometimes you will want a sharp corner, and to achieve this, you need to unlink the 

curve handles: 

1. Double click the point handle, 

2. Or select the point handle and either: 

 

Click the CUSP JOIN button, or press "Z". 

You can now move each curve handle independently. 

Making smooth curves 

To convert a sharp join into a smooth curve: 

1. Double click the point handle, 

2. Or select the point handle and either: 
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Click the SMOOTH JOIN button, or "S". 

The two curve handles become linked and move to opposite sides of the point handle. 

This may change the shape of the curve. 

 

Balancing curves 

Balancing makes the two curve handles the same distance from the point handle, which 

gives smoother, more symmetrical curves. To balance a curve, select the point handle, 

then drag one of the curve handles with "Shift" held down. As you drag one curve handle 

the other one will move to be exactly opposite it and the same distance from the point 

handle. 

Joining lines 

You can only join lines if both are selected (the point handles are shown on both lines): 

Using the SELECTOR TOOL, hold down "" and click on the lines to select them (if you are 

already in the SHAPE EDITOR TOOL, you can press "Alt + S" to temporarily go into the 

SELECTOR TOOL, "+ click" to select the second line, then "Alt + S" again to return to the 

SHAPE EDITOR TOOL). 

Selecting objects is described fully in "Selecting objects (on page 92)". 

Once both objects are selected, in the SHAPE EDITOR TOOL, drag the end handle of one 

line over the end of the other line. As you drag the mouse pointer will show a + symbol to 

indicate that the lines will be joined.. 

 

If the ends of the two lines are already very close to each other (but not joined), then you 

can either zoom in or drag the end point away, and then back again so it’s over the end 

point, and you see the + sign to indicate a join will occur. 
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To create a filled shape, drag the other two end handles together. Because you join the 

end handles, you can only join lines and not shapes. Shapes are closed objects and so 

have no end handles. 

Changing the line width (thickness) 

To change the line thickness or the outline thickness of a shape, first select the object or 

objects: 

Type a new line width into the text box on the STANDARD control bar or 

choose the default line thickness from the menu.  

Or position the mouse pointer over the edge of a line or shape, hold down Ctrl + Shift and 

use your mouse wheel to rapidly adjust the outline width. This works whether or not the 

line/shape is selected. 

Line thickness is traditionally measured in points, abbreviated to pt. 1 point is 1/72nd of an 

inch (about 0.3mm), which is slightly less than the thickness of one screen pixel when 

viewed at 100% zoom. 

You can enter the thickness value in any unit, and Xara Web Designer Premium will 

convert it to the correct number of Points. E.g. you can enter 0.5cm, and you will get a 

line half a centimeter thick, but it will show just over 14pt in the line width field. 

If you have no object selected and you change the line thickness value, this changes the 

default for all new lines. 

Note: A zero width line is a special case, and should not normally be used. This draws a 

line one device-pixel wide. The actual size will therefore depend on the device the 

drawing is displayed on. On a monitor screen one pixel is clearly visible and is never 

shown anti-aliased. On devices such as printers and particularly on image setters, which 

have a much higher resolution, the line is almost invisible (zero width lines in imported 

files are converted to 0.25pt). 

Line Gallery 

 

The LINE GALLERY can be used to apply a range of line styles or attributes, such as brush 

strokes, dash patterns, arrow heads, and more. 

To display the LINEGALLERY: 

 Choose "UTILITIES" > "LINE GALLERY" 

 Or click the LINE GALLERY tab on the GALLERIES tab.  
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The LINEGALLERY is split into sections. To open or close any section, click on the small folder 
icon in the gallery window. 

 

 
Line Width 

 
Join type 

 
Line cap 

To apply any line style or attribute from the gallery you can: 

 Drag and drop the required style from the gallery onto the shape or line. 

 Or double click on the required style in the gallery. 

 Or select the style and then click the APPLY button. 

Line width 

The text box at the top of the gallery duplicates that on the standard control bar. 

Brush strokes 

There are several sections that show a selection of various brush styles. 

Dash pattern 

This section provides a selection of line dash styles. 
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Arrowheads 

The best way to apply an arrowhead is to use the STRAIGHT LINE TOOL (on page 139), as 

described earlier in this chapter. However you can also use the line gallery. Drag and 

drop the arrowhead from the gallery onto the appropriate end of the line. 

Alternatively, to apply an arrowhead: 

 Double click on the arrowhead in the gallery. 

 Or select the required arrowhead and click APPLY. 

Web Designer Premium has two types of arrowhead designs: beginning and end. If the 

line already has a beginning arrowhead, applying an end arrowhead automatically places 

it at the opposite end of the line. 

If the line has no arrowheads, and you use the APPLY button or double click a style to 

apply it, then the arrowhead will be placed at the end of the line. 

The size of the arrow head is related to the thickness of the line. Thicker lines have 

proportionally larger arrowheads. 

If you hold "Ctrl" down and double click an arrow head or tail style, it will apply it to the 

other end of the line. 

 

For general information about galleries see document handling (on page 82). 

Change join type 

This control on the top of the LINE GALLERY sets the style of corners. 

 

To change an existing line, select the line. 

To change the current join type, deselect all lines and 

select the required type from the menu. 

 

Change line cap 

This control at the top of the LINE GALLERY sets the style of the ends of the line. 
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To change an existing line, select the line. 

To change the default line cap, deselect all lines. 

Select the required type from the menu. 
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Shape Handling 

Shape drawing tools 

 

Use any of these tools to create regular shapes. 

 RECTANGLE TOOL ("M")  

 ELLIPSE TOOL ("L")  

 QUICKSHAPE TOOL ("Shift + F2")  

The RECTANGLE TOOL creates rectangles and squares.  

The ELLIPSE TOOL creates circles and ellipses. 

The QUICKSHAPE TOOL creates polygons, stars, and SmartShapes. 

Creating rectangles and squares 

To create a rectangle: 

 

 Use the RECTANGLETOOL ("Shift + F3", or "M").  

Click and drag on the canvas to draw a rectangle. 

Creating a square 

To create a square rather than a rectangle, hold down "Ctrl" while dragging. 

Creating and Editing rounded corner rectangles 

 

To give your rectangle rounded corners, select it and then press the 

“Curved corners” button on the RECTANGLE TOOL InfoBar. 

You can then drag on the selection handles shown on the corners to adjust the diameter 

of the rounded corners. 
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You can resize rectangles using either the RECTANGLE TOOL (by dragging on the handles 

shown at the corners) or the SELECTOR TOOL.  

Note that if you change the aspect ratio of a rounded corner rectangle using the 

SELECTOR TOOL (by stretching it in one dimension only) the aspect ratio of the rounded 

corners is not stretched, it is maintained. However if you have multiple objects selected, 

or if you’re stretching a group containing a rounded corner rectangle, the aspect ratio of 

the corners is not maintained. 

TIP: When rotating rectangles or any shape with straight edges, hold down Ctrl to easily 

rotate so that one of the straight edges is exactly horizontal or vertical. 

Creating circles and ellipses 

To create an ellipse or circle: 

 

Select the ELLIPSE TOOL ("Shift + F4", or "L") from the main toolbar. 

The RADIUS AND DIAMETER buttons on the InfoBar automatically create circles. 

 

 
Radius 

 
Diameter 

 
Bounds creation 

Select the RADIUS option to draw circles. The start point of a drag determines the circle’s 

center. 

Select the DIAMETER option. Now the start point of a drag determines the position of the 

edge of the circle. 

With the BOUNDS CREATION button selected, drag on the canvas to draw an ellipse. Hold 

down "Ctrl" while dragging to create a circle rather than an ellipse. 

You can convert an ellipse into a circle at any time by double clicking on a control handle. 

Creating polygons and stars 

Use the QUICKSHAPE Tool to quickly create almost any regular, symmetrical shape with 

sharp or rounded corners. You can then drag the edges to bend the sides, and at any 

time you can change the number of sides or make the object an ellipse, a polygon, or a 

star.  
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1. Select the QUICKSHAPE Tool ("Shift + F2") from the main toolbar 

flyout. 

2. Select CREATE POLYGONS or STARRED SHAPES from the InfoBar. 

3. Select the number of sides either from the menu, or by typing into 

the text box. 

 

 
Creation Modes: Radius/Diameter/Bounds 

 
Polygon 

 
Ellipse 

 
Starred shapes 

 
Round corners 

 
Restore edges 

 Number of sides 

 
Editable items menu 

 
Editing fields 

 
Insert SmartShapes  

To create the polygon or star drag in exactly the same way as for a circle or ellipse using 

the Radius, Diameter and Bounds Creation buttons to control the origin point of your 

shape. 

 From the center outwards (RADIUS button), 

 Or from an outside edge (DIAMETER button), 

 Or diagonally to create an imaginary rectangle enclosing the polygon (BOUNDS 

CREATION button) letting you distort the polygon or star. 

Polygons or stars with rounded corners 

Select the ROUND CORNERS button or 

double click on a corner point. 

 

 

The polygon has extra handles (radius 

handles) where the rounding starts. To 

increase or decrease the radius, drag any 

of the radius handles. 

To remove the round corners: 

 Click the ROUND CORNERS button. 

 Or double click a control handle. 
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Editing polygons and stars 

The SELECTOR Tool lets you move, rotate, resize, and skew the shapes as normal. The 

SELECTOR Tool is described in Object handling (on page 92). 

Using the QUICKSHAPE Tool, you can resize or rotate: 

 Drag the corner handles. 

 Or select SIZE & ROTATION in the EDITABLE ITEMS menu. Type the required values into 

the text boxes. 

 

Size 

Rotation 

You can also nudge the values using the buttons to the right. 

To move: 

 Drag the handle in the center of the shape. 

 Or use the arrow keys on the keyboard. 

 Or select CENTER in the EDITABLE ITEMS menu. Type the required X/Y values into the 

text boxes. 

 

Apply or remove rounded corners by clicking the ROUND CORNERS button. 

 

Change the polygon to an ellipse by clicking the CREATE ELLIPSE button or 

double clicking the polygon's center.  

Make a polygon star-shaped by clicking the STARRED SHAPES button. Or by 

double clicking on a side.  

Drag the sides to make them curved. Move the pointer over the edge of the polygon (it 

changes to an arrow shape). You can now drag the sides. 

 

On the left are the original polygons. Just drag on 

the sides to create curved sides. 

"Ctrl + double click" on a side, or click the RESTORE EDGES button to make the sides 

straight again. 
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Change the number of sides by typing the number into the menu or 

selecting from it. 
 

 

Editing stars 

To increase or decrease the depth of stellation: 

Drag a star handle or select STELLATION RADIUS & 

OFFSET on the EDITABLE ITEMS menu. Type the 

required values into the text boxes. 
 

The original shape is on the left. 

Or drag the sides to make them curved: 

 

The original shape is on the left. 

You can also nudge the values using the buttons to the right. 

 

Offset from center 

Angular offset 

"Ctrl + drag" one side of a star moves all the sides symmetrically. "Ctrl + Shift dragging" 

moves pairs of sides as mirror images. "Ctrl + double click" on a side, or click the 

RESTORE EDGES button to make all sides straight again. 

Combining shapes 

The menu option "ARRANGE" > "COMBINE SHAPES" (or right click and choose COMBINE 

SHAPES) provides you with a range of advanced options to combine shapes to make new 

shapes, such as adding, cutting, or slicing. You can use combine shapes on any type of 

object, including bitmaps. 

Creating holes in shapes 
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Use "ARRANGE" > "COMBINE SHAPES" > "SUBTRACT SHAPES". This is similar to using join 

shapes (described above). The differences are: 

 The top shape (or top group) becomes a hole through the other shapes. 

 The line attributes and colors of the underlying shapes are unchanged. 

 Combine shapes physically alters the lines. The only way to restore the original 

shapes is by using undo. 

 The number of overlapping shapes has no effect. 

Merging several shapes into one 

For example, to produce the shape on the right from the three shapes on the left: 

     

1. Create the two circles and the rectangle. 

2. Select all three shapes. 

3. Right click and choose "COMBINE SHAPES" > "ADD SHAPES". 

The new shape takes line attributes and colors from the top shape (in this case the 

rectangle in the illustration). 

Intersecting shapes 

With INTERSECTING SHAPES, the new object is created from those parts of lower shapes 

that are covered by the top object. 

Select the shapes you want to mask and the front 

(mask) shape. 

 

Choose "ARRANGE" > "COMBINE SHAPES" > 

"INTERSECT SHAPES". This creates a new shape. The 

top shape disappears. 

 

The line attributes and colors of the underlying shapes are unchanged. Areas not 

covered by the top shape are discarded. The top shape can be a group for more complex 

subtracting. Groups are described in Object handling (on page 114). 
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Splitting a shape 

If you want to split (break) a line or shape: Either select an existing point handle on the 

line or outline of the shape, or create a new one where you want to break the line. Just 

click on the line in the SHAPE TOOL(SEE ABOVE). 

Click on the BREAK AT POINTS button, or press "B". 

 

If you split a line, there is no visible change. However, if you move the point handle, then 

only part of the line moves. If you split a shape, it changes to being a line. Any fill 

disappears. 

Note: "Slice shapes" (part of "ARRANGE" > "COMBINE SHAPES") also lets you split shapes 

into two separate shapes. This is described in "Shape handling (on page 159)". 

Slicing shapes 

Xara Web Designer Premium lets you easily slice shapes into two or more pieces, and 

you can use either a solid object or a line for slicing. For example, to cut a segment from 

a circle: 

1. Create a circle and a triangle on top 

2. Select them both. 

3. Choose ARRANGE" > "COMBINE SHAPES" > "SLICE SHAPES". The 

edges of the triangle cut the circle into two shapes. The triangle 

disappears. 

4. You can now drag the segment out from the circle: 
 

 

You can also use a line to cut an object: 

The line should be drawn completely though the object 

and extend beyond it (as shown in the illustration). If the 

line is too short, this operation cuts out a thin slice. 

 

 

Slicing complex shapes 

When you use the INTERSECT ALL SHAPES option, selected objects are sliced along their 

lines of intersection.  
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Three selected rectangles, with a 1px 

border.  

 

"ARRANGE" > "COMBINE SHAPES" > 

"INTERSECT ALL SHAPES" slices the shapes 

along the intersected lines. The 1pt 

borders show the outlines of the new 

shapes. 
 

You can then pull the rectangles apart to 

reveal the new shapes. 

 

The line attributes and colors of the intersected shapes are unchanged. 

SmartShapes 

SmartShapes are a way enhanced functionality can be added to Web Designer 

Premium. SmartShapes are plug-ins. Each SmartShape incorporates its own editing 

controls, usually in the form of small handles you drag to adjust the shape.  

Find SmartShapes throughout the ONLINE CONTENT CATALOG and under the INSERT 

MENU. For example choose "INSERT" > "SHAPE" from the main menu to choose from a 

selection of simple SmartShapes.  

 

Or with the QUICKSHAPE TOOL selected, click on the INSERT button on the InfoBar.  

 

Simple SmartShapes 
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Although there are simple SmartShapes that are just a single shape, the underlying 

SmartShape architecture supports much more complex examples, including charts, 

percentage rings, photo grids, text panels and charts which can all be customized.  

 

Chart and photo grid SmartShapes 

See the topic Photo Grids (on page 353) in the Photo Handling (on page 351) section for 

more detail on editing the Photo Grid smartshapes. 

 

Editing SmartShapes 

You can edit a SmartShape simply by clicking on the shape in the Selector tool. 

Alternatively, select them using the QuickShape (or rectangle or ellipse) tools from main 

tool bar. 

When selected the SmartShape will show a set of control handles on and around the 

shape, like this: 

 

This is a simple Text Panel 

SmartShape. The blue 

circular handles on the sides 

allow you to stretch the panel 

to be any size. The top right 

corner handle will rotate the 

whole object. The bottom 

right will enlarge or reduce 

the size of the whole 

SmartShape.  

 

  

Each SmartShape has its own set of control handles. Hold the mouse-pointer over any 

handle for a handy tool-tip. The Status Line (bottom of window) also provides some 

description of the function of each handle. In this example the top left orange handle 

adjusts the rounded corner of the panel background (and most rectangular SmartShapes 

have a similar function). The inset handle at the top right, in this case, adjusts the margin 
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around the text. Where SmartShapes contain text, you can edit the text - change its size 

and font, etc. just as for any other text, using the TEXT TOOL. All shapes show dimensions 

when dragging (in document units). 

 

This percentage segment SmartShape has controls 

to drag either end of the segment (doing so will 

update the value), or using the Text Tool you can 

edit the value, in which case the segment bar is 

changed. The handle mid-way around the arc allows 

you to adjust the thickness of the band. 

The top right handle will rotate the whole thing, the 

lower right will resize it. 

To change the colors in a smartshape, you can select the shape and click the colors on 

the color line or open the COLOR EDITOR (on page 180). Or drag and drop colors from the 

color line onto it. Where there are multiple colors in the shape, the Color Replacement 

(on page 184) dialog will appear allowing you to choose which color you want to change.  

Table SmartShape 

The Table Smartshape is a simple table which supports basic table insertion and editing, 

including adding, removing and resizing rows and columns, various table formatting 

options and automatic formatting of the table to fit contents. You can also paste data 

from other sources like Excel and Google spreadsheets to quickly populate a table.  

 

Find the tables in the "INSERT" menu, or in the CONTENT CATALOG under "COMPONENTS" 

> "PRINT & WEB COMPONENTS" > "TABLES", where you will find a range of designs. 

Table Handle Summary 

Hover over the adjustment handles to see what they do. They are... 
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PADDING Drag to adjust the Outer padding, the Inner padding and the Cell 

padding 

SELECT/REPOSITION Click to select columns and rows - drag to reposition them 

ADD/REMOVE Drag to add or remove columns or rows.  

SHOW/HIDE CAPTION Click to show or hide the table caption title - edit using the TEXT 

TOOL 

COLUMN WIDTH Drag to adjust column widths 

ROW HEIGHT Drag to adjust the height of the rows 

RESIZE Drag to scale - Ctrl + Drag to stretch. Drag to stretch either 

horizontally or vertically. 

Cell borders and merging cells 

Select a cell, range of cells, row or column - then click on the green blob in the corner of 

the selection to open a cell border menu.  

The first 4 controls represent the four edges of the selected cells. You can click to 

highlight any, or all, of them. In the above case the right edge is highlighted. If you now 

adjust a line value, say to select a line width of 2pt, it will apply the line to the right edge 

of the selected cells. 

To merge adjacent cells into a single larger cell select two or more adjacent cells, and 

click the MERGE CELL icon - the last one on the right of menu. Merged cells can be 

restored back to  their original un-merged state, by clicking the same control again. 

Note: only while the Border Control UI is visible does applying line values affect the 

selected edges. if you close the border control, then applying a line width, or line color, it 

will apply to all 4 edges of the selection. 

Adding rows and columns 

When you add a row, the last row of the table is duplicated to create the new row. If the 

table has different background colors for alternate rows, that formatting is maintained as 

you add more rows. Adding columns works similarly. If the table cells contain embedded 

objects or symbols however, then these will not be duplicated. Select rows and columns, 

or ranges of cells using standard CTRL and SHIFT keys. 

Deleting rows and columns 

Drag the row or column orange select handle outwards, away from the table. At a certain 

distance a red cross will appear, if you now let go, the row or column will be deleted. 
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Table cells 

Each table cell has a text column and a background shape, which determines the 

background color of the cell. Use the TEXT TOOL to edit and format text within the cell, 

just as you would edit any other text. You can also place any other type of object in a 

table cell by inserting it embedded in the text. To do this select and copy the object you 

want to insert to the clipboard, place the text cursor in the cell and paste (Ctrl+V). Select 

multiple cells using SHIFT + SELECT or CTRL + SELECT 

Colors and tables 

The table as a whole has a background color and that determines the default color of 

each table cell. But each cell can have its own background color and you can set the 

color of a whole row or column of cells. 

If the table is not already selected, the first click on the table will select the whole table 

(you see all the table’s handles appear). Click on a color to change or replace any of the 

colors used in the table. The REPLACE COLOR dialog will appear allowing you to choose 

the color to replace. 

You can also change the color of all cells in a row or column by selecting the whole 

row/column. With the whole table selected, click on the row or column’s 

SELECT/REPOSITION HANDLE. That selects all the background shapes in the row or 

column. You can then set the background color, or reset the background color, of all the 

selected cells. 

Outlines 

With the whole table selected, the line width control on the top bar shows the width of the 

cell outlines for the whole table. You can change the outline width using that control, or 

remove the visible outlines by selecting NONE.  

To set the color of the outline, right-click on the COLOR LINE and choose SET LINE COLOR. 

You can also select the line colors in the same way as cell backgrounds, by selecting the 

color and selecting LINE COLOR in the replace colors dialog. 

Copying data from other sources 

You can paste tab delimited text data to quickly populate a table - so in Excel for 

example:  

 Select and copy cells  

 In Designer place the text cursor in the top left cell of the destination table - make sure 

the cell is empty  

 Paste using the ‘Unformatted Text’ option 

Timeline SmartShapes 

Timelines are common in many types of documents and particularly in presentations. 

The Timeline Smartshape consists of a line with an object (or group of objects) repeated 

along its length with regular spacing. You can increase or reduce the number of objects 
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on the line, adjust their spacing, size, vertical alignment, etc. using the SmartShape’s 

handles.  

 

Timeline Smartshape with editing handles  

To insert a Timeline, use "INSERT" > "FROM CONTENT CATALOG" > "COMPONENTS" > 

"PRINT & WEB COMPONENTS" > "TIMELINES"  

Timeline Handle Summary 

END HANDLES Drag either end to change the length of the line, or rotate the whole line. 

SPACING Drag to adjust the spacing of the objects on the line and therefore determine 

how much of the line sticks out on each end.  

ADD/REMOVE Click to add a copy of the rightmost object, or drag to add or remove multiple 

objects. If nothing happens when you try to add a copy, that means there is not 

enough space on the line to fit another copy.  Try reducing the size of the 

objects using the Size handle, or extending the line length by dragging it out. 

VERTICAL 

OFFSET 

Drag to adjust the vertical positioning of the objects on the line. 

DELETE Delete an object from the line.  

LINE WIDTH Drag to adjust the width of the line. 

SIZE Change the size of the objects on the line.   

Text Editing 

Many of the timelines include text, which of course you can edit using the TEXT TOOL. If 

you find you can’t fit the text you want into the space available, try increasing the size of 

the objects on the line using the Size handle and then select the text and reduce its font 

size, so you can fit more text in. If the change the font size of all the text on one object, 

you should see the text on all the other objects update too, to help you choose the size 

that fits best.  

Symbol Replacement 

Some timelines include symbols that you will want to replace. Select the symbol inside by 

holding down Ctrl and clicking on the symbol. Then right-click and choose REPLACE 

SYMBOL from the context menu. 
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Chart SmartShapes 

With the chart SmartShapes - see "INSERT" > "CHARTS…" You can just edit the values 

and labels on the charts using all the usual TEXT TOOL attributes, and the graphics 

update accordingly.  

 

Bar Chart, Column Chart, and Percentage Ring 

As with all SmartShapes, double-click to go into the QUICKSHAPE TOOL and you will see 

the SmartShape handles appear. Move the mouse pointer over each handle for a tip on 

what each does. On the bar and column charts there are handles for adjusting the bar 

width, chart width/height, the spaces between the bars, the roundness of the bar corners 

and of course for adding/removing bars. Each bar also has a handle for changing its 

position in the chart  and a handle for changing its value by dragging. If you need more 

resolution or accuracy, just zoom in and drag. Alternatively you can enter any precise 

numeric value, even with decimal places, using the Text Tool. 

Customizing Bar & Column Charts 

You can change the colors of charts easily just by selecting the whole chart and clicking 

a color on the COLOR LINE (on page 176). The REPLACE COLORS dialog appears to let you 

choose which of the colors in the chart you would like to replace with your chosen color. 

Similarly you can use the COLOR EDITOR (on page 180) to edit the colors - the list of 

replaceable colors appears at the top of the color editor, so select the color you want to 

edit from that list.  

Sometimes you may need to do more than just replace or edit the existing colors in the 

chart. You can select a specific bar or column by Ctrl+clicking on it in the SELECTOR 

TOOL. That selects just that bar/column inside the chart. Then you can change its color 

directly, or its outline, or even change the type of its fill using the FILL TOOL (on page 

257). If you want to copy the style of one bar onto the other bars, first copy (Ctrl+C) the 

selected bar to the clipboard. Then select one of the other bars and use "EDIT" > "PASTE" 

> "PASTE FORMAT/ATTRIBUTES". 

Changing label and value text styles 

The Chart labels and values can be edited using the TEXT TOOL - you can apply the usual 

text attributes, to adjust the appearance of the text. When you change the appearance of 
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a chart label, such as changing the font, font size or color, that change is immediately 

replicated across the other labels for each bar. However this only happens if those other 

labels have the same text style applied (usually BAR CHART LABELS). So if you want one 

of the labels to be different, perhaps to highlight one of the bars, simply give it a different 

style or use the NO STYLE option in the styles menu to remove the style. The same 

happens with the value text. 

Chart, Bar chart, Column Chart, Graph, Line chart, Pie Chart, Diagram. 

Pie chart SmartShapes 

Find the Pie charts in the Charts section of the Content Catalog. These offer a super-

easy way to create a high-quality vector pie charts, with the program automatically 

calculating the correct percentages for each pie slice. 

 

You can adjust the pie segment values by... 

 By dragging directly on pie segment handles to adjust the % size of each slice. 

 By using a Data Input Form to the enter a simple column of numbers, with optional 

labels 

 By pasting data into the input form from a spreadsheet - you can display the values as 

a percentage or absolute value. It automatically positions the labels around the pie, 

using a common text style. Edit one label style and they all change to match (although 

you can apply different styles to each label if you wish). 

 You can ‘pull out’ to highlight any one segment simply by clicking on it, as shown 

above. 

 The segment colors are based on the Theme Colors used in your document (Theme 

Color 1 to 5 and then shades) so the pie chart will match your document color theme. 

 Or you can easily customize the color of any segment 

As with all the shapes, hover over the adjustment handles to see a function description.  
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The green handle top left opens the shape to allow data input - switch between decimal 

and percentage values. There is a 15 entry limit - but if you enter more than 15 the 

segment labels cleverly reformat to display an indicator pointing to the relevant segment. 

 

Shows the Data Input Form area. You can show / hide this using the green handle top left.  

Using the TEXT TOOL click in the lower data input area and type label, value pairs as 

required. As you edit this the pie chart is updated live. Each time you add a new entry on 

a new line, a new pie segment is created. You can also drag the handles on the edge of 

the pie slices and the corresponding data values change in proportion. 

You can also import data from other sources if you want to - just paste into the data input 

panel. The pie charts also support data taken from Excel and Google spreadsheets, just 

make sure you paste the data as unformatted text. 

Coloring the pie chart 

The pie segments use THEME COLOR 1 TO 5 for the first five segments, and then lighter 

and darker shades of these colors for the next ten segments. If your document contains 

more than five slices, it will use lighter and darker shades of THEME COLOR 1 TO 5 for the 

next ten segments. If you do not have any THEME COLOR defined, the slice will appear 

black and you will have to manually color the segment. 

To color any segment, first click it (this will pull out the selected segment), and now click 

a color on the COLOR LINE (on page 176). 

Editing label text 

If you change the whole text of any label e.g. the color, font or size, they all change to 

reflect this. To change an individual label, give it an alternative TEXT STYLE (on page 

240). You’ll notice labels on the left side are left aligned and right side labels right 

aligned.  

If you want to change the relative size of the pie to the text, use the orange Radius 

handle to resize the pie. 
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Text Panel SmartShapes 

Find the Text Panel SmartShapes in the ONLINE CONTENT CATALOG under 

"COMPONENTS" > "PRINT & WEB COMPONENTS". Or under the "INSERT" > "PANELS" > 

"TEXT PANEL / MORE TEXT PANELS… " menu. 

 

You can freely edit the text using the TEXT TOOL. If you hover over the SmartShape 

control handles (display by selecting using the SELECTOR TOOL or the QUICKSHAPE TOOL) 

you will see a tooltip explaining the function of each handle. The functionality depends on 

the style of the panel. 

Generally the panels allow you to...   

 Adjust the width and height (and the text re-flows),  

 Change the margin width around the text   

 Round the corners of the whole panel.  

 You can also rotate the whole object and it remains fully functional. 
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These text panels are smart in that they grow to accommodate whatever text you put in 

them - drag the bottom centre or top centre handles to change the vertical panel height. If 

you ever add more text than can fit into the panel at that height, the panel will grow to 

accommodate the additional text. But if you later remove text, the panel will shrink back 

no further than the height you last set using the height adjustment handles. This helps to 

keep panel sizes consistent, which is useful where you have a panel occupying a defined 

space or aligned vertically with other panels or objects of the same height. 

Text Alignment 

You can align text vertically within the panels, so it’s TOP, CENTER or BOTTOM aligned. 

This is useful where you have text that you want to edit regularly so the number of lines 

varies. To change the vertical alignment, place the text caret in the text and select the 

VERTICAL TEXT ALIGNMENT button on the text InfoBar.  

 

Then choose an option from the menu. The last option - AUTO-FIT TO CONTAINER, allows 

you to fit any text into any restricted area on a page, so it’s great for text that needs to 

change often where there is restricted space.  

If the panel is full of text with no empty vertical space, then it will look the same no matter 

which of the three alignment options are selected. But the alignment setting also 

determines how the panel grows and shrinks, as text is added or deleted, so the setting 

is still relevant even for ‘full’ panels. Top aligned panels will always grow and shrink from 

the bottom, with the top edge staying fixed. Bottom aligned panels are the other way 

around - they grow upwards with the bottom edge fixed, so these are commonly used at 

the bottom of pages. And centered panels will grow and shrink equally at the top and 

bottom, so the center of the panel is fixed. 

For more info on text area alignment see Vertically aligned text (on page 208) and Auto-

fit to text areas (on page 208). 

  

Many of the panels will allow you to change the width or style of lines or outlines included 

in the panel. For example the Ribbon Panel shown above allows you to change the width 

or style of the dashed circle inside the panel. Just select the whole panel and then use 

the line width control to change the line width. Or with the mouse pointer over the line, 

hold down Ctrl+Shift and use your mouse wheel to adjust the line width. Use the Line 

Gallery (on page 149) to change the line style, corner style, or end cap.  
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A collection of similar panels containing both photo and text can be found in the ONLINE 

CONTENT CATALOG under "IMAGE RESOURCES" > "PHOTO PANELS".  

Packed Photo Grid 

This smartshape lets you display any collection of photos, even those with different 

shapes and aspect ratios, in a compact grid on your website. So for example you can 

display a mixture of portrait, landscape and even panorama images together in the grid.  

 

It consists of rows of photos, with any number of photos in each row. The row heights 

vary depending on the numbers of photos in each row and on their aspect ratios.  

See a selection of examples in the "COMPONENTS" > "IMAGE RESOURCES" > "PHOTO 

GRIDS" folder of the ONLINE CONTENT CATALOGUE ("INSERT" > "IMAGE" > "MORE IMAGE 

RESOURCES"), but you can customise any of the examples to show any number of your 

own photos. The examples that are based on the Packed Photo Grid smartshape in this 

folder all have “Smart” in the title. 

Adding & Replacing images 

To replace an image with your own photo, just drag and drop a photo file from Windows 

Explorer (or from the Bitmap Gallery if the photo is already in the current document). The 

image in the grid that you drop onto is replaced with your photo and the grid 

automatically updates to fit your photo in, no matter what shape it is. To add more 

images click the ‘Add photo’ handle on the end of each row, or drag the ‘Add/Remove 

rows’ handle at the bottom left of the grid to add a complete row.  
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Note that the more images you add into a row, the shorter that row becomes, especially if 

the images are wide such as panorama photos. Similarly rows containing just a single 

image will usually be taller. So distribute your photos around the grid with this in mind, if 

you want similarly sized photos throughout. 

Border 

There’s a Border width handle on the top left photo in the grid that lets you adjust the 

space between each photo. You can have no space at all if you choose, but when you do 

have a border it’s simply empty space between the photos so you see whatever is behind 

your photo grid. Therefore if you want to see something other than the page background 

behind, just draw a rectangle behind and set its color or fill to give the border effect you 

would like.  

Other Photo Grids  

The "COMPONENTS" > "IMAGE RESOURCES" > "PHOTO GRIDS" folder of the ONLINE 

CONTENT CATALOGUE also includes some other new (currently non-smart) photo grids. 

These are fixed designs, so you can only replace the images and resize these grids. 

 Photo grid, Grids, Stacked photo grids, Smart grids, Smart photo grids.  

Arrow SmartShapes 

One of the most popular graphic elements is the arrow. Web Designer Premium includes 

perhaps the most flexible, yet simple-to-use arrow tool - the Arrow SmartShape. 

The great thing about the Arrow SmartShape is that there’s no complex arrow tool to 

learn - the arrow is controlled by dragging a few handles on the shape. So creating and 

customizing an arrow is an interactive, visual experience. As with all the shapes, hover 

over the handles to see a tooltip. 

We provide a library of preset designs, which can be customized as required. Use the 

menu "INSERT" > "SHAPE" > "LINES & ARROWS" to insert an arrow. 
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The arrow shaft is a line, rather than a filled shape. This means it is possible to apply any 

line effects such as dash or line profile. You can use the standard line END CAP (on page 

149) control to control whether the dash lines have rounded caps or square caps. 

 

 Hold Shift to resize or rotate around center. For example to make a line wider, but 

remain centered where it is, use Shift and drag outwards. 

 It snaps to 45° angles by default. Use Ctrl to un-snap. 

 Shift on the orange handle to produce a balanced (symmetrical) curve. 

 It shows the angle from either end. Interactively, live as you drag. And also length 

(when straight line only) is shown in the current page units. 

 Unlike legacy (non SmartShape) arrows the line length includes the space for 

head/tail. 

 Accepts and shows the correct line width via the standard line width control.  

Note that the arrows selection in the ONLINE CONTENT CATALOG includes some different 

types of arrows where the head and shaft are formed from a single shape - these  arrows 

are simple smartshapes of an entirely different design and are filled shapes rather than 

lines.   

 

 

Labeled lines 

These designs are useful as headings, titles, dividers and for labeling in diagrams.  

You can find these in the ONLINE CONTENT CATALOG and in the Insert menu - "INSERT" > 

"SHAPE" > "LINES & ARROWS". As with all SmartShapes, hold the mouse pointer over 

each handle to see a tooltip telling you what the handle does if it’s clicked or dragged. 
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                                                      Various labeled line examples 

 When you set the label text to a number followed by a dimension unit, the line length 

will automatically change to match the length specified. So for example if the label is 

set to 10cm, as soon as you click away from the label text, the line will update to be 

10cm long. You can enter other units such as inches, px (pixels), mm, etc. If you enter 

a number without any indication of units, the units of the current document are 

assumed (as set in "UTILITIES" > "OPTIONS" > "UNITS").  

 When the labeled line is selected, the line width control on the top bar shows you the 

current width of the line. You can change the line width using that control, or drag the 

line width handle on the line. Or with the mouse pointer over the line, hold down Ctrl 

and Shift and use your mouse wheel to adjust the line width.  

 You can also change the line style, by selecting the labeled line and choosing from 

styles in the Line Gallery (on page 149). Or apply a brush stroke or line profile using 

the  

 Freehand Tool, as shown in the last example above.  

 Drag the end style handle on each end of the line to cycle through a variety of different 

end styles. 
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 As you make the label text longer or shorter, the lines adjust their size to fit, without 

changing the width of the overall design.  

 Drag the end handles to move the ends and adjust the length of the line, just as you 

do with arrows . 

Chevron Bar SmartShape 

The Chevron Bar is useful in presentations.  See "INSERT" > "SHAPES" > "ARROWS..." 

 

Chevron Bar smartshape 

Drag on the different handles to add/remove chevron shapes, re-order, change the arrow 

angles, etc. And of course just click on the text in the TEXT TOOL to edit the labels. 

Flowline SmartShapes 

Great for flowcharts, diagrams, exploded views, etc. The Flowlines behave just like 

Arrows, in that you can change the heads and tails, apply rotation, thickness and so on - 

as well as having 90° segments which you can drag to reposition. Find them in the 

Arrows folder - "INSERT" > "SHAPE" > "ARROWS…"   
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Color Handling 

Xara Web Designer Premium gives wide control over applying, creating and altering the 

colors of objects. For simple documents, you can just choose colors from the on-screen 

color palette, the Color Line.  More advanced color operations are described later. 

The color line 

The Color Line is displayed at the bottom of the window. It shows you the current fill and 

line colors, provides access to the color editor and provides a palette of pre-defined 

colors including a special "no color". 

 

 
COLOR SWATCH: The outer rectangle of the color swatch shows the line color and 

the center rectangle shows the fill color. These are the colors of any selected 

objects, or the current color attributes if no objects are selected. 

  This button provides access to the color editor (on page 180)  

 
COLOR PICKER:  Use the eye-dropper to pick a color from any part of the document 

or any part of the computer screen. See Using the eye-dropper to pick colors (on 

page 181) for details. 

 
NO COLOR: Clicking this applies a "no color fill". Shift-clicking applies "no color" to a 

line. Note that this is not the same as 100% transparent. "No color" and 

transparency are different. A shape with transparency applied remains a solid 

shape whereas a shape filled with "no color" is effectively hollow. The NO COLOR 

button can also be used to restore the original colors to a photo which has had a 

contone color applied. 

 
Current Fill color marker 

 
Current Line color marker 

If the length of the Color Line exceeds the window, you can scroll through the Color Line 

with the scroll bar below or by "Alt + dragging" the Color Line. 

Xara Web Designer Premium provides several options for the displayed size of the Color 

Line (described in Customizing Web Designer Premium). 

Colors on the color line 
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Named (Theme) Colors: First comes the Named Colors (if present in the 

document, see below). Named colors are used to give templates and designs 

theme colors, so that the color scheme of a design can easily be changed without 

editing every object in it individually. 

 
Linked Colors are represented differently on the color line by smaller rounded 

rectangles, so it's much easier to distinguish which are normal independent Named 

Colors and which are linked to a parent. See Creating a Tint, Shade or Linked color 

(on page 189). 

 
Palette colors: There are 46 pre-defined palette colors. There are 5 shades of 7 

standard hues and 10 shades of grey, black and white. Palette colors are not 

editable (i.e they are not Named Colors) and are designed as a simple, limited 

selection of colors to apply to objects (either by dragging on to the object or 

clicking). 

Little markers in the color icons shows which of the named colors (if any) or  palette 

colors have been applied to the selected object(s). 

 Diamond markers show the colors used by the selected objects. A diamond 

in the top-left corner  indicates the fill color, in the top-right corner indicates 

the line color. 

 Cross-shaped markers show the current color attributes if there are no 

objects selected. Line color on the right, fill color on the left. 

 Triangular markers show the colors of a fill if you have applied one. 

This works also when choosing a color with the color picker from existing objects, see 

Using the eye-dropper to pick colors (on page 181). The color line markers update 

immediately and indicate the color of the object under the eye-dropper as you're dragging 

around. 

Re-ordering colors on the color line 

Only named colors can be re-arranged on the Color Line. "Ctrl + drag" colors along the 

Color Line. This also reorders the COLOR GALLERY.  

Color line context menu 

Click on a color on the Color Line to show a context sensitive menu with the following 

options: 
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EDIT  Opens the color editor to edit the named color (not 

available for palette colors) 

REPLACE COLOR This option is shown only when the selected object has 

multiple component parts or multiple colors, such as a 

button group. 

SET FILL COLOR / SET LINE 

COLOR 

Set the fill or line color of the selected object with this 

color 

SET TEXT BACKGROUND Set the the color for a text background - like a 

highlighter. 

RENAME Rename a named color (not available for palette 

colors) 

DELETE Delete a named color (not available for palette colors) 

If the selected object is a bitmap, you can also see SET CONTONE DARK COLOR / SET 

CONTONE LIGHT COLOR OPTIONS. See Bitmap coloring (on page 264) for more 

information. 

When clicking the “no color” swatch, the fill and line color options are replaced by: CLEAR 

FILL COLOR / CLEAR LINE COLOR.  

Applying fill & line colors by drag & drop 

 To apply a fill color to an object (selected or unselected), drag a color from the Color 

Line and drop it into the center of the shape.  

 To set the line or outline color, drop it on the outline, not the center. 

 To change the current fill color, drag a color into a blank space. 

 To change the page background color, drag a color onto the page background. 

 To change any color in a complex or multi-colored object such as a button, text panel, 

graduated filled shape, etc. just drop the color anywhere on the object. 

When dragging colors an indicator beside the pointer tells you what effect dropping the 

color will have: 

 

Set flat fill color (seen when you drag over an object) or the intermediary colors of 

a multi-color fill (on page 266) 

 

 

Set line color (seen when you drag over a line). 

 

Set the current fill color (seen when you drag over an empty space). 

 

 

Set start color of graduated fill (seen when dragged over start of fill). 

 

 

Set end color of graduated fill (seen when dragged over end of fill). 
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Set page or pasteboard background color (seen when you drag a color onto the 

page or pasteboard). 

Instead of drag & drop, if you have an object selected, you can just click on the Color 

Line. This opens the Color Line context menu . 

In any other case, you can alter the line color by "Shift + clicking" on the Color Line. 

If a photo or a bitmap-filled shape is selected, then clicking on the Color Line shows the 

context menu with contone options included. Contoning means - the bitmap is converted 

to greyscale (black and white) and the selected color is used as a contone light color. 

The contone dark color is usually black. You can set both contone colors via the Color 

Line context menu (see above). See Bitmap coloring (on page 264) for more information. 

 

To set a fill or line to no color (clear), perform the operations 

as outlined above but use the "No color" option instead of a 

color. 

 

Editing an object’s color 

To edit the fill color of the selected object(s): 

 Choose "UTILITIES" > "COLOR EDITOR" ("Ctrl + E"). 

 Or click the EDIT COLOR icon on the Color Line. 

 Or right click the object and choose FILL COLOR 

 Or double click on the current line and fill color icon on the Color Line (the edge of the 

leftmost panel). 

To edit the line color of the selected object/s 

 "Shift + click" on the EDIT COLOR icon 

 Or double click on the current line and fill color icon (the edge of the leftmost panel). 

This displays the COLOR EDITOR which allows you to select from any color of the 

spectrum. Unlike most graphics programs the Color Editor can remain on screen while 

you continue to work. It changes to reflect the color of the selected objects, and the fact 

that you can also drag the lower right corner to resize the COLOR EDITOR window means 

that you can easily and precisely adjust the color of the selected object.  

Applying a Text background color 

To apply a text background color - in effect a highlighter-style background color...  

 

 Highlight some text using the TEXT TOOL or select text object(s) using the SELECTOR 

TOOL (on page 22) 
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 Right-click on a color in the COLOR LINE 

 Select SET TEXT BACKGROUND 

To get rid of the background color... 

 Select your text 

 Right-click on the 'NO COLOR' swatch on the COLOR LINE (on page 176) 

 Select the CLEAR TEXT BACKGROUND option 

 

The Color Editor 

The Color Editor is used to change the color of objects in the document. 

 

 
When editing a color you can drag the eye dropper to pick colors off screen, even 

from other open windows 

 
Select the color to edit: Fill color/Line color of the selected object or any of the 

named theme colors 

 
Click the label icon to create a Named Color 

 
Click to show extended color controls 

 
Previous color 

 
Actual color 

 Drag here to select any shade of the selected hue 

 
Drag here to select any hue 

 
Drag here to increase the window size 

The easiest way to create a new color is to select the hue along the bottom color strip. All 

possible shades of this hue are then shown in the top section, so just click or drag in the 
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top section to select the new color. You’ll notice the selected objects change color as you 

adjust them in the color editor (called "live preview"). 

For example to select a pink color, which is a pale shade of red, select red along the 

bottom section and then select a very pale red (pink) from the top right area of the top 

section. 

Previous and Current color 

As you drag on the color editor the two small color swatches in the upper right of the 

color editor show the current color and the previous (before you started changing the 

color). This is useful if you want to make a small change and want to compare the old 

and new colors. 

Using the eye-dropper to pick colors 

Instead of selecting hues and shades on the COLOR EDITOR you can instead pick a color 

from any part of the document or any part of the computer screen—even from other 

windows and programs. 

To do this just click and drag on the eye dropper icon. As you drag you see the color 

editor continuously picks up the color under the eye dropper. Release the mouse button 

when you have the desired color.  This is an easy and quick way to use the same color 

again or copy colors from photos or from one object to another. 

If the object under the mouse pointer is complex (eg. has transparency applied) and the 

color cannot be determined, screen RGB color is applied. 

 

The color sampler shows a small popup at the mouse 

pointer which indicates the color that is being sampled at 

that point. This will either be the palette color name, the 

name of a named color, or the color model and color 

value. 

 

Advanced color operations 

 

Click the SHOW ADVANCED OPTIONS icon on the Color Editor to reveal the lower 

part of the dialog that provides more options. 
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No fill color 

 
Make named color local to Frame/Layer 

 
Rename named color 

 
HSV color values 

 
RGB hex value 

 
Color model (HSV, RGB or grayscale)  

 Color type: See Creating a Tint, Shade or Linked color (on page 189) 

Here you can enter precise RGB (or HSV) color values. The most common requirement 

for web graphics is to enter a hex RGB color. The H, S and V fields allow you to specify 

the color as HSV (hue saturation value) values in percent. In the # field you can enter 

RGB value in hexadecimal numbers (0-F). 

Also a 'No fill color' button and a help button is available here. 

Local colors and Theme colors 

Web Designer Premium has two types of color: 

 LOCAL COLORS are used in only one place in the document. Each object has a 

separate color and nothing is shared. This is useful if you want to change the color of 

an object without affecting other objects. Local colors are the easiest method and best 

for simple documents that use relatively few colors. "Applying color" and "Editing an 

object’s color" above describe local color handling. 

 THEME COLORS (OR NAMED COLORS) can be used again and again in the document. (As 

such, they are like styles in a word processor.) Theme colors are used in templates 

and assure a consistent look of your page elements like buttons or navigation bars. 

Any edits you make to a Theme color are immediately reflected on all objects and 

parts of the drawing that use that color. You can also copy Theme colors between 

documents. Theme colors appear on the Color Line. If there are any Theme colors 

already present in the design and you load or paste templates from the ONLINE 

CONTENT CATALOG containing Theme colors with the same name, you will be asked if 

you want to match the actual color of the imported Theme colors to the existing ones. 

The Theme colors in most templates are consistently named so when you import 

elements from different themes colors are matched perfectly. 

Important: If you just select an object on the page that has a named color applied to it, 

and alter it with the Color Editor, this will always turn it into a local color instead of a 

named color (because it is assumed that if you try to edit the color of the object that's 

what you mean to do. If you really want to change the named color so this and all 

occurrences of the color change, then you should do so by editing the named color (on 

page 186)). 

Theme color schemes 

Many of the web themes offered in the ONLINE CONTENT CATALOG include alternative 

color schemes which can easily be applied to websites which use the same theme, to 
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transform the color scheme instantly. The color schemes are normally found in the 

ONLINE CONTENT CATALOG in each theme under WEBSITE THEMES, after all the page 

layouts and separate graphic elements that make up the theme. They all have "Color 

scheme" in their titles in the ONLINE CONTENT CATALOG, so they are easily identified.  

To apply a color scheme to your website, simply drag the scheme from the ONLINE 

CONTENT CATALOG and drop it on your page. You can try applying the color schemes of 

one theme to a website created from the templates of another theme. But you will get 

mixed results doing this and some schemes will not work acceptably with some themes. 

So for best results stick to the color schemes of the theme that you used to create the 

site. 

One of the color schemes provided with each theme matches the default colors used by 

that theme. This allows you to easily return to the original colors if you prefer, after 

experimenting with the alternate schemes. 

Creating your own color schemes 

It’s very easy to create your own color scheme files, which you can pass on to other Web 

Designer Premium users for them to apply to designs created with the same theme. 

1. Load one of the page templates for the theme. Choose one which shows off all the 

colors of the theme most effectively. You can add more elements to the page if 

required, to help show off the range of theme colors. 

2. Edit the named colors of the theme one at a time, as described in the ‘Editing 

named colors’ section (on page 186) below. 

3. Once you are happy with your new color scheme, use "FILE" > "SAVE AS" to save it. 

The filename you choose MUST include "themecolorscheme" as part of the 

filename. That is how Web Designer Premium  identifies color scheme files – just by 

looking for that sequence in the filename. It’s a good idea to also include the name 

of the theme to which the scheme applies. For example a new blue color scheme 

for the "Beta" themeset could be named something like 

"betathemecolorschemeblue.web". 

To test your color scheme, drag and drop it from File Explorer onto a page that still has 

the default theme colors. The page should be instantly re-colored using your color 

scheme. 

Creating new named colors 

If you want to use the same color in different parts of the drawing, and there is any 

chance you might want to change that color in future, it is highly recommended that you 

create a NAMED COLOR. This is easy in Xara Web Designer Premium: 

Select an object whose color you want to use and then click NEW NAMED COLOR in the 

COLOR EDITOR. 
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Click to create a new named color Give the color a suitable 

name, like "car color" and 

click create. You will see 

the new color added to the 

COLOR LINE. 

You can now apply this 

color to any object the 

usual way, by drag-

dropping it from the Color 

Line or just clicking (or right 

clicking to use it as a line 

color) to apply as the fill 

color. 

When you edit a named 

color, all objects that use 

this color will change. 

 

 

Replacing colors 

Web Designer Premium makes it easy for you to recolor complex grouped objects such 

as buttons, text panels, navigation bars etc, by listing the colors used and prompting you 

to choose which one you want to replace. 

 

The color replacement dialog lets you select which color to replace in the group.  

Recolor an item in one of the following ways: 
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 Drag and drop a color from the color line onto the item. 

 Select your item and then click a color on the color line. 

 Select the item and then bring up the COLOR EDITOR (ON PAGE 180) (Ctrl+E).  

The editor will display a list of the item's colors in the drop-down menu at the top of the 

editor. Select the one you want to edit and then use the color editor as normal to edit it.   

Note that when replacing colors in graphics this way, you can replace the use of named 

colors with unnamed/local colors, or vice-versa. So for example you could take a button 

that uses Theme Color 1 and replace Theme Color 1 with Theme Color 2. From then on, 

editing Theme Color 2 in your document would change the button color too. Or replace 

Theme Color 1 with a local color, so the button is no longer linked to any theme colors at 

all. And you can use this facility to quickly apply named colors to graphics that were not 

originally designed to use named colors at all.  

  

The pen item is selected and the Color Editor displays the range of color replacement options 
available.  

Note that when an object with multiple colors is selected, the dropdown list in the color 

editor lists only those colors in it. The Local fill color, Local line color and list of named 

colors are not included in the list in this context, to avoid making the list too long and 

potentially confusing.  
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Changing background colors 

Drag-drop colors from the color line onto the page or pasteboard background to set the 

color of either. If there are multiple colors in the background, the Replace Colors dialog 

will be shown to let you choose which color to replace. It works the same way as 

described above for groups with multiple colors.  

To use the color editor to change the background colors, right click on the page and 

choose "PAGE BACKGROUND">"EDIT PAGE COLOR", or on the pasteboard background and 

choose "PASTEBOARD BACKGROUND">"EDIT PASTEBOARD COLOR".  

Editing named colors 

There are four ways to display the color in the COLOR EDITOR so it can be edited: 

 Choose from the menu in the COLOR EDITOR. 

 Or right click on the color on the COLOR LINE and choose EDIT from the menu that 

appears. 

 Or drag & drop a color from the Color Line onto the COLOR EDITOR. 

 Or drag & drop a color from the COLORGALLERY (described later) onto the COLOR 

EDITOR. 

You can then edit the color as required. All objects that use this color are automatically 

and immediately updated to show the new color across all pages of your document. 

Renaming named colors 

While editing a NAMED COLOR, right click on the COLOR EDITOR and select RENAME 

 Or left click the color on the Color Line and select RENAME. 

Deleting named colors 

To delete a named color click on the color on the Color Line and choose DELETE. 

Deleting unused named colors 

To clear the Color Line of unused colors, click a  Named color and choose DELETE. If the 

color is being used in the current document, Web Designer Premium displays a message 

that allows you to cancel the deletion or use local colors instead. 

However note that by default unused named colors are automatically deleted when a 

document is saved or loaded.  
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Importing named colors 

When a design is imported into the current document (e.g. import from the ONLINE 

CONTENT CATALOG, import a XAR file or paste objects in from another design) if there are 

any named colors in the imported design which have the same names but different color 

values as colors in the current design, an alert appears as follows: 

 

If you want the imported objects to inherit the colors of your current design, choose the 

“MATCH” option. This makes all objects using a given named color use the existing 

instance of that color as it appears in the current document.  

Alternatively if you want the imported objects to keep their own independent colors, 

select the “DON’T MATCH” option. This adds new named colors into your design, with a 

number appended to the color names to distinguish them from the colors already in the 

current design. This allows the imported objects to keep their original colors.  

Note that if you import objects from lots of different designs and choose “DON'T MATCH” 

each time, you will end up with a large number of separate Named Colors on your color 

line. This is rarely useful. So a better option is to use the Replace Color facility described 

above to change the colors of objects where you don’t want them to pick up the theme 

colors of your document.  

The same prompt is shown if there are Text Style definition differences between the 

document and the imported design. So seeing this prompt does not necessarily mean 

that there are different named color definitions – it could just be due to Text Style 

differences. See the Text Styles section of the Text Handling chapter for details. 

The match prompt above includes a “DON’T ASK ME AGAIN” checkbox. If you check this, 

the option you choose will be assumed for all future imports, without asking you again. 

However this only applies during the current session, so after a program restart you will 

be asked again on the next import if there is a color clash. 

Using the MATCH option means that you can choose a template, change its theme colors 

and then import more templates of the same theme and the imported designs will 

immediately pick up your modified theme colors.  

For example, import a red graphical button from the ONLINE CONTENT CATALOG, change 

its main theme color from red to green, then import a red logo graphic of the same theme 

and choose the “MATCH” option. When the logo appears in your design, instead of being 

red it will have picked up your chosen green theme color automatically. Since most 



 

 188 Color Handling 
  

 

 

themes have their main theme color named “Theme color 1”, you will also usually get 

good results when importing graphics from different themes and matching the colors. 

Make Named Color local to Frame/Layer 

 

When you click this button, a new named color is created which is identical to 

the one you have selected.  

This new color is then applied to all objects in the current frame or layer that use the 

selected named color. This means that with one click you can localize a color to the 

frame/layer. You can then independently edit the original color and this localized color. 

This feature is useful when you are creating animations and you want an object's color to 

change part way through the animation. 

This button is dimmed unless you are editing a named color that is also used in another 

frame or layer. 

Normal colors, Tints, Shades and Linked colors 

Normal colors 

These are the normal stand-alone colors you apply to objects. 

Xara Web Designer Premium can also define colors that are linked to another color, that 

is when the parent color changes the linked color will change as well. There are three 

ways you can link a color to its parent TINTS, SHADES, and LINKED COLORS. These are 

very powerful techniques that allow, for example, single-click re-coloring of complex 

shaded drawings. Some of the example clipart uses this technique. 

Tints 

Tints are based on other colors (called the parent color) and are always a paler version 

of the parent. They have two main uses: 

 Where you have paler shades of a parent color and you may want to change the 

parent color in future with the tints automatically updating. 

 To extend the range of colors available from printing inks. 

 

For example, a 25% red tint gives a pink color. Therefore using just a red ink you can 

have both a pure red and a pink using only one ink. Similarly, if just using black-and-

white printing, it’s often useful to be able to use tints to create various shades of gray. 

 

If you are printing with a limited range of colors (it’s usually cheaper to print one or two 

color, instead of full or four color printing). 

A tint can be based on any type of color, including another tint. 

Any changes you make to the parent color also change tints based on it. For example, 

you might define the color pink as 50% of a red parent color. Changing the parent color 

to orange automatically changes pink to light orange. 
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Shades 

These allow both lighter and darker colors to be created all based on a parent color. 

Changing the color of the parent changes all associated shades. For example, a drawing 

of a car might use shades for the highlight and shaded regions of the car body. A single 

edit to the parent changes all the colors of the entire body but keeps the shading correct. 

Setting up shades this way is more time consuming but it is a very powerful way of 

altering colors. 

For best results, the parent color should be a "pure" saturated color. When using the 

HSV color mode, saturation and value should ideally be 100%. When viewed in the 

COLOR EDITOR (on page 180) the cross should be in the top left-hand corner. 

Linked colors 

Linked colors are similar to shades but give greater flexibility. These are also based on a 

parent color but you define which attributes you want the linked color to share with its 

parent. For example you can create a linked color that is a more or less saturated version 

of the parent, but the hue and lightness / darkness follow the parent. 

Creating a Tint, Shade or Linked color 

TINTS, SHADES and LINKED COLOR have to have a master "parent" color, which needs to 

be a named color, so that when you change this parent color, the tint will change as well. 

So, if necessary, first create a named color (see Creating new named colors (on page 

183)). 

To create a tint, shade or linked color: 

1. Select the object or objects to which you want to apply the color. 

2. Open the COLOR EDITOR showing the advanced options. 

3. Select the "normal color" drop-down menu and select the TINT, SHADE, or LINKED 

option. 

4. From the PARENT dropdown menu, select the named color that you want this color 

to be linked to. 

5. Adjust the TINT, SHADE or LINKED COLOR on the top section of the color editor. 
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On the left you can see the new color is a tint of the parent "yellow" and so the editor provides 
only paler tints of the parent color. On the right, if you select a shade, you get to choose any 
lighter or darker shades of the parent color. 

If you want to use this color in many places in the document it’s recommended that you 

also make this a Named Color, so it appears on the Color Line, for easy picking. Just 

click on the NEW NAMED COLOR label icon on the top of the Color Editor and give it a 

name. It will now appear on the Color Line where you can pick it for use on other objects. 

Editing the parent color 

The key point of using tints, shades and linked colors is that they track any changes to 

the parent color. To see this working try editing the NAMED COLOR that is the parent (drag 

it from the COLOR LINE to the COLOR EDITOR and alter the color). You will see the objects 

with the tint, shade or linked color change in sync with the parent. 

NOTE: Be careful not to edit the color of objects on the page to which you’ve applied 

NAMED, TINTS, SHADES, or LINKED COLORS as this will change them to LOCAL COLORS. 
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Text Handling 

Introduction 

The text editing facilities of Xara Web Designer Premium are very like your text editor or 

word processor, but in addition it provides a range of features you won’t find in those 

programs: 

 

You can enlarge or magnify text to a huge degree. 

 

You can apply the range of normal Xara Web Designer Premium 

attributes and effects: fills, feather, transparency, color fades, 

shadows, and still continue to edit the text. 

You can convert the outlines of characters to shapes which can be 

edited just like all normal shapes. 

 

Fit text to a curve. All text can be rotated, skewed and stretched. 

Terminology 

FONT or TYPEFACE: A set of characters with a consistent style. 

FONT FAMILY: A set of similar fonts. For example Garamond and Garamond Italic are 

different fonts from the same Garamond family. 
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JUSTIFICATION: An alternative way of describing text alignment. Left aligned text is 

sometimes called left justified, or flush-left, or ragged right.  

MONOSPACED: All the individual characters of a monospaced font have the same width. 

Sometimes referred to a fixed width fonts. Useful for program listings. Courier is the most 

common monospaced font. Most fonts are proportional spaced fonts, meaning the 

characters vary in width. 

POINT: Text or font sizes are traditionally measured in points, abbreviated to pt. 1pt is 

approximately 1/72nd inch, so 72pt text is approximately 1inch tall, although different 

fonts of a given size can vary. 

The Text Tool 

 

Use the TEXT TOOL ("F8") to enter or edit text. 

 

TEXT TOOL InfoBar Left Side 

 
Font 

 
Font Size 

 
Style 

 
Bold 

 
Italic 

 
Underline 

 Strikethrough 

 

TEXT TOOL InfoBar Right Side 
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Justify 

 
Vertical Text Alignment 

 
Subscript/Superscript 

 
Line Spacing 

 
Bulleted lists 

 
Numbered lists 

 Outdent 

 
Indent 

 
Spell Checker/auto-correction 

 
Paragraph spacing 

 
Advanced Text options (click for flyout) 

 

Advanced text options 

 
Columns 

 
Auto hyphenation 

 
Text Capitalization 

 
Ligatures 

 
Stylistic Sets 

 
Open Types Alternates 

Xara Web Designer Premium supports three basic type of text objects 

 Simple text lines: Click on the page, and type. 

 Text columns: Click and drag to create a column, and type. 

 Text areas: Click and drag diagonally to create a rectangular area, and type. 

After you’ve created any text object you can transform it (rotate, scale, skew) and can 

apply all the normal attributes, fill color, transparency, feather etc, using the normal tools. 

You can also attach it to a curve. The text will remain editable. 
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The Font Menu 
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Live font size pop-up 

 
Fonts used in the current document 

 
Web safe fonts 

 
Style variants available for the selected font. Not all fonts have such variants 

 
Google fonts 

 
All fonts installed 

 Font type - usually either OpenType or TrueType as designated by the 

accompanying symbol. 

The font menu lists all installed fonts, and is split into four sections. The top section 

displays those fonts that are currently used in the document. The second section shows 

the “web safe” fonts. These are the fonts you can safely use in web pages, because all 

commonly used web browsers and devices will support these fonts. See Web Safe Fonts 

section. The third section shows the available Google fonts which can also be safely 

used in websites, and the final section displays an alphabetical list of all installed fonts. 

Each font name is displayed in the menu using its own typeface, making font selection 

easier. 

Those fonts for which multiple font styles are available are shown with small black 

triangles against them on the right hand side of the menu. Simply hold the mouse pointer 

over such a font name for a second or two and a small sub-menu appears to the right of 

the main menu, listing the available variant of that font. While this sub-menu is displayed, 

you can move the mouse pointer over it to select the desired font variant. 

Web Safe Fonts 

These fonts are safe to use in websites because the vast majority of computers and 

other devices will have these fonts installed. You can also use any of the hundreds of 

Google fonts in your website. And you can even use other fonts you have installed if the 

font license permits it. 

Live Font Preview 

As you move the mouse pointer over any entry in the font menu, the selected text in the 

document is instantly updated to preview the font. This is not a permanent change until 

you actually click on the required font. Moving the mouse pointer over the menu will 

revert back to the initial font until you move over another entry. This is great for very 

rapidly previewing large numbers of fonts. 

If you hold down the "Shift" key while traversing the font menu, then the font selection is 

not updated instantly, there is a short pause before it is updated. This is useful if you find 

that instant preview slows down your traversal of the menu (perhaps if you have a large 

amount of text selected).  
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Live Font Size preview 

Next to the font size menu is a small pop-up slider control, like that used elsewhere in 

Web Designer Premium. This provides a direct, live font size control, and will adjust the 

font size of the selected text in real-time as you drag the slider. 

 

Click to display font size pop-up 

As with the pop-up sliders used elsewhere this can be used two ways. "Click + release" 

on the arrow and the pop-up will appear and stay on screen. You can now drag the 

slider, or use the mouse scroll wheel over the control to rapidly adjust the values. So in 

this case, this provides a fast way of adjusting the point size using the mouse wheel to 

see the results directly on the page of the document as you work. 

The alternative method of using the pop-up slider is to "click + drag + release" on the 

button and slider. This is a slightly more direct way of adjusting the control (requires less 

clicks). 

Instant font menu navigation 

While the font menu is displayed, you can type the initial characters of the font name, 

and the menu will be scrolled to that section of the list. E.g. if you type "ver" it will 

instantly scroll and locate the Verdana font. 

Google fonts 

Web Designer Premium also gives you the option of using one of the hundreds of Google 

fonts. These are free, open source web fonts that have the advantage of being hosted by 

Google so you don't have to upload font files with your document when it's exported as 

HTML - the visitor's browser will automatically fetch the fonts from the Google font 

hosting servers.  

The fonts are fully integrated within Web Designer Premium  so you can browse and 

search through the font list using the FONT FINDER to download and install the fonts to 

your own computer. 

To start using Google fonts simply click ADD on the font menu to pull up the Font Finder.  
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Google Font Finder  showing some of the available fonts and font families. 

You can search for fonts by typing the font name into the search box, or else scroll down 

through the list to find a suitable font. Qualify your search by selecting font styles from 

the checkbox lists on the left and use the live preview slider to see the font at a different 

sizes. 

Click on your chosen font and you will be asked if you want to download and install the 

selected font. On many Windows computers, and depending on your Windows settings, 

you’ll be prompted by Windows to give permission for the installation, which is performed 

by a separate FontInstall program that is launched. Each font you install will appear in 

the Google Fonts section of the font menu. 

Some Google fonts, such as Exo, provide a wide range of weights. In these cases the 

‘Bold’ option changes subtly. Font weight values can be from 100 (typically very light or 

skinny fonts) to 900 (very heavy or black fonts). Instead of always selecting a given bold 

weight, applying Bold (selecting the B button, or using Ctrl+B when editing text) works as 

follows: 
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Main Text weight                                             Weight selected when ‘B’ is applied               

100 to 300 (Thin/Extra Light/Light)                             400 (Regular) 

400 to 500 

(Regular/Medium)                                      

700 (Bold) 

600 to 900 (DemiBold/Bold/Extra etc)                      900 (Black) 

Of course you don't have to use the fonts exclusively for webpages, because the fonts 

are TrueType they can also be used with any print document - a PDF for example. 

If you send another Web Designer Premium user a .xar or .web file containing a Google 

font then they will be asked upon loading the document whether they wish to download 

and install the font. 

Note: some browsers do not render Google fonts as effectively as others, so it's always a 

good idea to test your webpages with a variety of browsers to ensure the font quality is 

acceptable.  

 

Symbols 

The symbols are a huge range of scalable icons which are regularly updated as new 

ones become available. Consisting of both Font Awesome symbols and Google Material 

Design Icons - you can either insert them into text as a character font or insert them into 

your document as a standalone graphic.  
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The symbols are divided into various categories such as Web Application Icons, Brand 

Icons, Text Editor Icons, Directional Icons and so on, and can be found on the INSERT 

menu. "INSERT" > "SYMBOL". They also appear in the ONLINE CONTENT CATALOG under 

the SYMBOL FONTS category. Just scroll down to see the full list. 

 

Some of the Font Awesome Symbols. 

There is a SEARCH function - for example type ‘Pay’ and it will show you Shopping cart, 

Credit card, PayPal and other related symbols. 

You can easily replace symbols as they appear in your documents, either with a 

replacement symbol or an image, just right-click on the symbol and select REPLACE. This 

works even if the symbol is inside a group 

This also works for symbols in bulleted lists (on page 240) - simply right click on any 

bulleted list with the text carat and select List properties... from the context menu, and 

then Replace with symbol from the dialog. 

You will be alerted if an updated version of a symbol font is released, or when we add 

more symbol fonts. Installation of the new or updated fonts is automatic. It’s important 

that you choose to accept these updates because the symbol picker and Content 

Catalogue always show symbols from the newest font versions, so if you’re not up to 

date you may find symbols you choose to insert don’t work on your device if it has an out 

of date version of the font. 

The Material Icons font symbols are designed so that the symbol glyphs sit higher than 

those of Font Awesome. You can see this if you insert a Font Awesome symbol and a 

Material Icons symbol next to each other in text.  
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You can correct this by inserting the symbol onto the page ("INSERT" > "SYMBOL" with no 

text caret), which inserts the symbol as a shape. Then copy it to the clipboard and paste 

it into the text. For a bulleted list (on page 240) copy the symbol to the clipboard and 

choose PASTE AS LIST BULLET from the right click context menu. 

Inserting Symbols into text 

Place the TEXT TOOL carat at the point in your text where you wish to place the icon and 

then click on an icon in the collection. The symbol character is inserted into the text.  

When you insert a symbol into your document this way, the symbol characters use either 

the Font Awesome or Material Icons fonts. If you later publish your document as HTML, 

you’ll see a warning telling you that the font will be published with your document or 

website. This is not a problem, because the font licenses permit such use.  

 

A symbol inserted as a font using the Text Tool 

Inserting Symbols as graphics 

To insert the icon as a scalable vector graphic simply make sure that the text caret is not 

present before you click on the symbol to be inserted. To clear the text caret, switch to 

the Selector Tool or any other tool except the Text tool.  

The symbol will appear in the center of the workspace (be aware this may be behind the 

symbol dialog). Use the Selector tool to move it to where you want it in your document, or 

resize it, etc.  

When you insert a symbol this way, your document does not need the appropriate font 

anymore because it’s been converted to a graphic on insertion. So if you publish to 

HTML you won’t see the font warning mentioned above.  

 

A symbol inserted as a scalable graphic 
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Font replacement 

It’s often useful to be able to completely replace one font with another across your entire 

document or website, especially if you don’t have a particular font installed and want to 

replace it with a font you do have.  

In the Text Tool just right-click in the text with the font you want to replace and choose 

the REPLACE FONT WITH … option from the context menu.  

All variants of the font are replaced across your document, each with the matching 

variant and size of your chosen font. 

Simple text 

If you wish to type a small amount of simple text, position the pointer where you want to 

enter text and click. A red cursor appears where you clicked and you can now start typing 

on the keyboard. 

If you make a mistake, use "Delete" and "Backspace" in the usual way. 

Pressing "Enter" completes the line and starts a new line of text below it. The inter-line 

spacing is controlled by the line spacing text box on the InfoBar. 

Simple text is not suitable for large paragraphs of text because there is no automatic line 

wrapping (because the width is unlimited). Use a Text Column or Text Area instead (see 

below). 

By default text has no outline color. "Shift + clicking" on a color on the Color Line will give 

the selected text an outline color - the thickness of which can be controlled by the line 

width control, as usual. You will probably want to set the Line join type (on page 151) to 

be rounded to give it a more smooth appearance (control at the top of the LINE GALLERY).  

Line width is described in Changing the line width (thickness) (on page 149). Applying 

color is described in Color handling (on page 176). 

You can continue to enter text even after rotation, color filling or placing it on a curve. 

Text in a column 

If you are entering larger amounts of text, over multiple lines, using a column is more 

useful. Changing the width of the column will automatically re-flow the text. 

To type a column of text: 
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1. Select the TEXTTOOL. 

2. Move the mouse pointer where you want the column to start. 

3. Drag right to create a horizontal line the width of the column. This green/red dashed 

line just shows you the width of the column and the fact that the column is active. It 

is never exported or printed. 

4. Type in the text, the green/red dash line is replaced with solid red line. You don't 

need to press "Enter" at the end of a line. When the text reaches the edge of the 

column, it automatically flows onto a new line. 

NOTE: If you click away or change tools before you start typing, the green/red dashed 

column line will be replaced with a green line to indicate that you that you have an 

inactive text column. To reactivate the column just click on it again with the Text Tool, the 

line will return to its active state and you can start typing again.  

Instead of typing in the text you can create the text in a separate text editor or word 

processor, copy it to the clipboard and paste it into Xara Web Designer Premium. Copy 

and paste supports RTF-formatted text. 

Changing the width of the column 

Drag either of the two red handles at the ends of the line. If you switch to the SELECTOR 

TOOL and drag one of the corner control handles the font size will scale together with the 

size of the column. 

Changing the angle of the column 

"+ drag" either of the red handles at the end of the line to change the angle of the 

column. Alternatively, "Ctrl + drag" to restrain the line to the constrain angles. Or 

alternatively you can use the SELECTOR TOOL to rotate the object in the usual way. 

For more on constrain angles, see Introduction to Xara Web Designer Premium (on page 

80). 

Text areas 

 

In the TEXT TOOL if you click and drag diagonally on the page you will create a 

rectangular text area. The blinking cursor will be positioned in the top left corner and you 

can type or paste text. 

A text area can contain a "flowing" text story. This is where a single piece of text flows 

from one text area to another. It’s called flowing text because, like water, as you add or 

remove text in one area it overflows into connected text areas or flows back from text 

areas. 

If the text overflows the bottom of the text area the overflowing text is shown gray, 

although you can continue to edit this text as usual. 
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Connecting text areas—text flow 

When text overflows the bottom of the text area, a flow arrow is shown on the bottom of 

the area. If you drag this over any other text area, the overflow text will flow into the new 

text area, and the two areas become connected. This is shown with a flow arrow.   

 

Overflowing text area with flow 
arrow. 

 

If the text cursor is in an area with overflowing text, then just click-drag on the page to 

create a new text area. The new text area is automatically connected and text will flow 

into the new area. 

Tip: You can flow text from one area to another on any page, even earlier pages. If you 

need to flow into an area many pages away, it’s probably easier to use the above 

method, although if you zoom out to a small page size you can drag the overflow arrow 

across pages. 

To disconnect one text area from another, just drag on the overflow indicator and drop it 

away from any text area. Or click on the flow arrow at the bottom of the text area and 

select UNLINK TEXT FLOW. 

If you delete a text area that is connected to another only the area is deleted, the text will 

simply re-flow into the remaining text areas. 
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Multi-column pages 

You can use two or more text areas on your page, linked together as described 

above, to make a multi-column page layout. But Web Designer Premium 

provides a much quicker way to do this. 

 

Select the text area that you want to make multi-column, or place the text caret 

in it, then click the COLUMNS button on the TEXT TOOL InfoBar. Or right-click on 

the text and choose COLUMNS… from the context menu. 
 

The Columns dialog 

appears... 

 

Columns dialog 

By default the number of columns shown will match the number of linked text areas you 

have on the current page. But you can change this number to match the number of 

columns you would like. So enter 3 for a 3 column layout. You can also specify the size 

of the gap you would like between your columns. When done, press CONVERT. Your text 

areas are transformed into a set of matching columns equally spaced.  

The overall width of the set of text areas is maintained when you use the Columns dialog, 

so if your original text areas cover only the left half of the page, so will the set of columns 

created. Therefore if you want the columns to span the full width of the page, move 

and/or resize the text areas so they do cover the full width and then use the Columns 

dialog again to give them all equal size and spacing. 

 

A 1 column page transformed into a 3 column page. 
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You can of course also use the Columns dialog to reduce the number of columns on the 

page if required.  

Where you have exactly the same column arrangements on multiple pages (where they 

are in the same text flow), you will be asked if you want the column changes to be made 

to all those pages too, as described for manual text area changes. Therefore using this 

Columns dialog you can instantly convert an entire document from single column to 

multi-column, or back, if there is just a single text flow.  

Column breaks 

Insert a column break into a text area by using the TEXT TOOL to right-click at the point in 

the text where which you want the break to occur. Then select "INSERT" > "BREAK" > 

"MOVE TO NEXT COLUMN". Or use the shortcut (Ctrl+Shift+Enter). 

 

A break inserted mid-way through the middle column (left) shifts the text into the next column 
(right).  

All the text after the column break now appears in the next linked text area in the current 

flow, whether that area is on the same page or the next page. 

Vertically aligned text 

 

You can align text vertically within text areas, so it’s top, center or bottom aligned. This is 

useful wherever you want to align multi-line text vertically with other features on the 

page, especially text that you want to edit regularly so the number of lines varies. 
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Text areas with top, center and bottom alignments 

To change the vertical alignment of a text area, place the text caret in the text and select 

the VERTICAL TEXT ALIGNMENT button on the text InfoBar. This reveals a menu allowing 

you to choose the vertical alignment.  

 

This option is not available for text columns or simple text lines. 

Auto-fit to text areas 

There are two further options on the VERTICAL TEXT ALIGNMENT menu - AUTO-FIT TO 

CONTAINER and SHRINK TEXT ON OVERFLOW. You can also display the two options by 

clicking on the black flow arrow which appears at the bottom of a selected TEXT AREA. 

You can choose one or the other and both are unchecked by default. 

The AUTO FIT TO CONTAINER allows you to fit any text into any restricted area on a page, 

so it's great for text that needs to change often where there is restricted space. 

With this option on, the font size of the text is automatically adjusted so that the text will 

just fit into the available space. Add more text and the font size reduces, so the text will 

still fit. Remove some text and the font size grows so the text will still fill the container. 

Just select the shape with the TEXT TOOL. You will see a dialog which gives you the 

following options... 
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It works with simple text areas... 

 

And also with text fitted into any shape… 

 

You can use mixed font sizes too, just as you would in a normal TEXT AREA. As you add 

and remove text, the text scales to fit, while always preserving the relative differences 

between the font sizes in the text. 

 

Clearly you can’t use fixed font point sizes with this auto-fit option on, because it works 

by dynamically changing the font sizes. So you will see some perhaps unexpected 

results if you do try to set specific font sizes. In the example above if we try to make the 
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heading 28pt, it immediately changes to 24.19pt, but that’s expected with auto-fit turned 

on. 

Dynamic sizing also works with repelling. The text automatically scales to fit the available 

space, taking into account the reduced space caused by the repel. 

 

  

 

Vertically aligned text 

You can align text vertically within text areas, so it’s top, center or bottom aligned. This is 

useful wherever you want to align multi-line text vertically with other features on the 

page, especially text that you want to edit regularly so the number of lines varies. 

  

Text areas with top, center and bottom alignments 

To change the vertical alignment of a text area, place the text caret in the text and select 

the VERTICAL TEXT ALIGNMENT button on the InfoBar.  

 

This reveals a menu allowing you to choose the vertical alignment. This option is not 

available for text columns or simple text lines. 

Shrink text on overflow 

The last option on the VERTICAL TEXT ALIGNMENT menu - SHRINK TEXT ON OVERFLOW 

controls what happens to the text when it overflows the text area. With the option 
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selected the text will scale down so that it always fits the text area. So useful for 

instances where you need to add more text yet are confined to a specific size. 

 

The left text area has plenty of space, so text appears with the font size it was given. In the 
center example, more text has been added so that it would no longer fit in the text area, so the 
text has been scaled down to fit. In the right example, some text has been removed so it will 
again fit in the text area with its original font size. 

If you subsequently drag the text area out to increase the area or if you delete some text 

then the text size will increase to fill the area but it won't get any larger than the original 

point size. As with AUTO-FIT TO CONTAINER, any relative size differences in the text are 

maintained as the text is scaled down and also as with AUTO-FIT you can't use this 

feature on linked text areas - a warning prompt will appear should you attempt to do so. 

 

Page breaks 

Insert a page break into a text area by using the the TEXT TOOL to right-click at the point 

in the text where you want the break to occur. Then select "INSERT" > "BREAK" > "MOVE 

TO NEXT PAGE". Or use the shortcut (Ctrl+Enter). 

All the text after the page break now appears in the first linked text area on the next 

page. 

Resizing text areas 

Using the TEXT TOOL, you can click and drag on any of the corner control handles. The 

text in the area will be reformatted to fit the new size. If you resize a text area using the 

SELECTOR TOOL, using the corner control handles, the text itself is scaled as well, but use 

any of the other control handles and the text area size is changed and the text reflows in 

it to fit the new size.  

You can also change the size of the text in the text area, by going into the TEXT TOOL, 

select all the text with Ctrl+A and change the font size on the TEXT TOOL InfoBar. 
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You can rotate a text area, using the SELECTOR TOOL as normal, and the text will flow 

through the rotated text area normally. 

 

Text flow is unaffected if you rotate any of the text areas 

Hold down "Ctrl" while rotating to constrain the text rotation angle to 90° angles and 

screen aligned angles. 

Word count 

The word and character count total of the current text is shown in the status line. This 

also shows the number of overflowing words. If any region of text is selected, it shows 

the count of this selection instead. 

Text along a curve 

To place text along a curve of your choice: 

1. Create either basic text, text in a column 

or a text area (see above). 

2. Select your text object and one curve. 

3. Choose "ARRANGE" > "FIT TEXT TO 

CURVE". 

 

Alternatively, select a curve or line and then in the TEXT TOOL, click on the line, where 

you want the text to start, and type. This automatically fits the text along the line. When 

you reach the end of the line the text will wrap onto a new line, immediately below the 

start of the previous one. 

If you do not want the text to wrap to a new line, "Shift + click" on the line. 

To hide the curve so it’s not visible, select the SHAPE TOOL and set the line color to 

NO COLOR or a width of NONE. You can also edit the curve as usual this way.  

To hide the curve so it’s not visible, select the SHAPE TOOL and set the line color to NO 

COLOR or a width of NONE. You can also edit the curve as usual this way. 
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Applying color is described in Color handling (on page 176). 

Adjusting the left and right margin of text on a curve 

If you just start typing or place a column of text on a curve, you can change the start and 

end position of the red handles. Just drag them along the curve as required.  If you 

center text it will be between these two margins. 

Swapping sides of the line 

Right click on the text and select the REVERSE TEXT ON CURVE menu option. 

Alternatively, if you reverse the direction of the line (SHAPE TOOL, REVERSE PATHS button 

on the InfoBar), then the text will move to the other side of the line or, in the case of a 

closed shape, move from the inside to the outside of the shape. 

Text inside shapes 

You can place text inside shapes, so that it flows within the shape’s outline.  

Create your own text filled shapes or have a look in the CONTENT CATALOG where you 

can find some text panel designs that  use this feature. See "COMPONENTS" > "PRINT & 

WEB COMPONENTS" > "TEXT PANELS"  or on the INSERT menu "SHAPE" > "MORE TEXT 

PANELS …"). 

 

In fact you can add text to any type of object, even groups, as long as there is not 

already any text in the object. Simply select the object, then go into the TEXT TOOL and 

click on the object. A text area (on page 202) is created for you on top of the object and 

you can enter your text and it will flow within the object’s outline.  

Alternatively you can right-click on an object and select ADD TEXT INSIDE from the context 

menu. 

You can select, edit and format the text just as you would any other text and it will always 

format within the outline of its containing object.  
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If the text won’t fit in the available space within the outline, it will overflow out of the 

bottom of the text area, as with a normal text area. 

 

In this case you need to take some action so the text will fit. You could reduce the font 

size or line spacing of the text, make the container larger so it will fit more text, or reduce 

the padding margin (see below). 

Padding margin 

The padding margin is the space between the shape outline and the text. Normally you 

will want at least a small margin as text flowing right up to the edge of a shape with no 

margin rarely looks good. You can change the margin in two ways. The easiest is to go 

into the TEXT TOOL and drag on one of the small red arrows in the corners of the text 

area. As you drag, the text reformats inside the margin. The distance between the arrows 

and the corners of the red dotted box mirrors the same margin value, as an additional 

visual cue. 

 

Text inside shape with adjustment handles 
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Alternatively you can set the padding margin by right-clicking on the text area and 

choosing "TEXT INSIDE" > "PROPERTIES…", which allows you to enter a value.   

Selecting the containing object 

When you click on the object with text inside, you select the text area. The object within 

which the text flows (most commonly just a shape) is a child of that text area, so it 

behaves like a group. So if you move, copy, delete or resize the text area in the 

SELECTOR TOOL, the whole combined object is moved, copied, deleted or resized.  

If you want to select and edit the shape that contains the text, you can use CTRL + CLICK 

or right-click "TEXT INSIDE" > "SELECT …" With the shape selected you can resize or edit it 

and then the text will re-flow within the new outline. To detach the text entirely from the 

shape so they become completely separate objects, again right-click and select "TEXT 

INSIDE" > "DETACH".  

  

A Group of 2 circles with text inside and one circle selected 

To make a copy of the shape without the text, select the shape, then copy and paste. To 

make a copy of the text without the shape, select all the text in the TEXT TOOL, then copy 

(CTRL + C) and paste (CTRL + V).  

Shaped text areas 

If you want to create a text area of a specific shape then all you need to do is to create a 

shape, fill it with text and then right-click the shape and select "TEXT INSIDE" > "SELECT 

SHAPE".  

Then just tap on the NO COLOR patch down on the color 

line. And set the line width to NONE if your shape had an 

outline. 

 



 

 214 Text Handling 
  

 

 

 

 

Editing text 

Double clicking on a text object in many of the tools takes you into the TEXTTOOL and 

places the cursor at the click position in the text. 

All the normal word processor-style cursor and mouse operations can be used. For 

example: 

 Click where you want to place the cursor. 

 Use the left and right arrow keys to move left, right, up or down. 

 Use "Ctrl + left and right arrow keys" to move left or right one word. 

 Press "Home" or "End" to move to the start or end of the line. 

 Press "Ctrl + Home", or "Ctrl + End" to move to the start or end of the text object. 

Text selection: 

 "Shift + any" of the above keys to select text 

 Double click to select a word 

 Triple click selects a whole line of text, or "Ctrl + L" 

 Quadruple (4x) click selects a paragraph of text 

 Or just drag across the text in the Text Tool to select the text 

 "Ctrl + A" will select all the text in the text object (you must be in the TEXTTOOL.) 

If you have a text selection any attribute change will apply only to the selected region of 

text. If you have only the cursor in the text, then any attribute change, say selecting a 

new color, will only appear when you type new text. 

Selecting the whole text object 

There is a quick shortcut for selecting the whole text object. Instead of using "Ctrl + A" or 

dragging across all the text, simply press the "ESC" key. This removes the cursor but 

selects the whole text (the status line will confirm 1 text object). This makes it easy to 

apply an effect or attribute to the whole text selection. 

For example, to change the font size of the whole text object, just press "ESC" and select 

the new size from the InfoBar. 
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Switching case 

Use the context menu to change the case of selected text, so right click and choose from 

the following options.. 

 "CHANGE CASE TO" > "LOWER CASE"   

 "CHANGE CASE TO" > "UPPER CASE" 

 "CHANGE CASE TO" > "SENTENCE CASE" 

Additionally... 

Pressing "Ctrl + Shift + F1" will make selected text toggle between all uppercase and all 

lowercase.  So, if you've accidentally typed a section of text with the caps lock key on, 

just select the text and press "Ctrl + Shift + F1". 

Pressing "Ctrl + W" will swap the case of the character after the cursor and move the 

cursor on. You can swap the case of a selected region of text, the same way. Uppercase 

characters will become lowercase and vice versa. The cursor will not be moved. 

Smart Quotes 

When you type quote ' or double quote " characters, Xara Web Designer 

Premium will automatically convert these into the more appropriate and aesthetically 

accurate opening or closing quotes. It is also smart enough to understand the use of 

single quotes within words to signify missing characters.  

Entering special characters 

There are a number of useful shortcuts to allow insertion of special characters, like © or 

™. See Special characters (in Text Tool) (on page 543) section in "Menus and keyboard 

shortcuts". 

All these shortcuts (with the exception of the hard space) are compatible with Microsoft 

Word. 

Entering dummy text ('Lorem Ipsum') 

You can insert a paragraph of dummy "Lorem ipsum" text by pressing "Ctrl + Shift + L" 

("L" for Lorem) while using the TEXT TOOL. To insert a larger block of text, just press the 

key combination a few times.  

The function is also available on the main INSERT menu or else as part of the right-click 

context menu. "INSERT" > "LOREM IPSUM TEXT" 
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Spell checker 

 

The TEXT TOOL includes a spell checker, click on the "SPELL CHECKER / AUTO 

CORRECTION" icon on the Text Tool InfoBar, and you will see a dropdown menu.  

 

To use the spell checker select “CHECK SPELLING 

AS YOU TYPE”. Now all unrecognized words - both 

in your document - and as you type, are shown 

with a red dashed underline. 

To correct a misspelled word, right-click on it, and 

the context menu will suggest alternative 

replacements. Simply select one of the 

suggestions to replace the underlined word. 
 

ff 

 

 

 

 

Language selection 

The menu shown when you click on the Spell Checker icon on the InfoBar lists all the 

languages for which you have dictionaries installed.  

To change the language associated with all the text objects in your document, choose 

the required language from the "DOCUMENT LANGUAGE" submenu. Now all the text 

objects in the document will be checked against the dictionary for the language you 

chose.  

To change the language associated with an individual text object, select the text object 

with the TEXT TOOL and choose the required language from the Spell Checker menu. 

Now the text object will be checked against the dictionary for the language you chose. 

When you change the current document language, you will be asked whether all existing 

text in the document should also be set to the chosen language, or left unchanged.  

If you don't want any of the text objects in your document spell checked at all, then select 

"DOCUMENT LANGUAGE" > "NO LANGUAGE (IGNORE)". And If you have individual text 

objects which you don’t want to be spell checked, select the object using the TEXT TOOL 

and choose the "NO LANGUAGE (IGNORE)" option from the Spell Checker menu 

When you open an older document, the document language is automatically set 

according to the language on the Normal text style in that document. Newly created 

documents have their document language set to match the language setting of the 

current device, as with previous versions of Web Designer Premium.  
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User dictionary 

Words that you use regularly which are not in the dictionary provided with Xara Web 

Designer Premium can be added to your own personal dictionary. Right click on the word 

and choose “ADD TO USER DICTIONARY”. Now the word is no longer shown as being 

misspelled. The user dictionary applies to all documents that you use on your computer 

and it applies to all languages. 

 

Auto correction 

 

Click on the SPELL CHECKER / AUTO CORRECTION  icon on the TEXT TOOL InfoBar, 

to use the auto correction feature. Select AUTO CORRECTION OPTIONS...  from the 

dropdown menu.  

A dialog will open allowing you to add and replace words as well as keyboard symbols 

with symbols from the symbol (on page 198) catalog. The feature is always on by default 

but you can turn it off within the dialog.  

There is a selection of useful items already listed, and you can add your own. Click on 

ADD to create a new field and then type a word or a character in the REPLACE column, 

then click in the WITH column to either type a replacement, or click on PICK SYMBOL to 

choose a replacement from the symbol catalog. The symbol you've chosen appears in 

the WITH column. Close the dialog by clicking OK.   

Now when you type a word or character listed in the options it will be replaced with your 

alternative word, character or symbol.  

So for example if you want to be able to type “Rwd” and have that instantly replaced with 

“Responsive Web Design”, simply press the ADD button and enter “rwd” in the REPLACE 

field, and “responsive web design” in the WITH field. All text in the dialog is forced to lower 

case but the replacement tries to be smart about use of case.  

So if you type... 

 "RWD" will be replaced with "RESPONSIVE WEB DESIGN"  

 "rwd" will be replaced with "responsive web design" 

 "Rwd" will be replaced with "Responsive Web Design" 

Hyphenation 

Words only split across lines if they contain a hyphen character (minus key) and while it 

is possible to do this manually using the keyboard (see below), Web Designer Premium 

enables you to do this automatically using the auto hyphenation feature. 

Auto hyphenation is a paragraph attribute - like line spacing and paragraph styles. You 

can have hyphenation on in some paragraphs and off in others, all in the same text flow. 

Just place your text caret in the appropriate paragraph. 
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To turn the Auto hyphenation feature on or off - click on the HYPHENATION 

button on the Advanced text bar. Or enable it from the dropdown menu of the 

SPELLCHECKER / AUTOCORRECTION / HYPHENATION button. 

 

To change the hyphenation settings click on the HYPHENATION SETTINGS... 

option on the dropdown menu of the SPELLCHECKER / AUTOCORRECTION / 

HYPHENATION button.  

The settings dialog will appear, allowing you to control how hyphens are inserted into 

your document. 

 

You can decide the SMALLEST WORD to which a hyphen will be applied, and the position 

of the hyphen within that word.  

Adjusting the HYPHENATION ZONE will change the degree of "raggedness" before 

hyphenation is applied. So for example, with left justified text this would be the size of the 

margin to the right that would be empty without trying to fit in more text using automatic 

hyphenation. With right justified text this would be the margin to the left, and with fully 

justified text this would be empty areas - "rivers of white" between words. 

Increasing the zone allows less hyphenation - and consequently more white space. The 

Hyphenation zone can be expressed as an absolute value as in pixels, mm's, or as a 

percentage of the width of the text object (the default is 5%). 
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Use the CONSECUTIVE HYPHENS fields to limit the number of consecutive lines ending in 

hyphens. The ATTENUATION setting creates a "soft" limit on this, so that you can set a 

balance between having consecutive hyphenated lines and lots of white space on 

following lines. A useful value is between 5% and 10%. Values higher than 20% often 

inhibit consecutive hyphens so much that they no longer occur at all. 

The final three checkbox options allow you to hyphenate ALL-CAPS WORDS, CAPITALIZED 

WORDS, and the LAST WORD IN A PARAGRAPH. These are options which you would 

normally leave unchecked as they generally look odd when hyphenated, but there may 

be instances where you want them to be hyphenated. 

Lastly you can create your own hyphenation list. Click on EDIT DOCUMENT HYPHENATION 

LIST...  to open the DOCUMENT HYPHENATION LIST dialog, and add words that you want to 

hyphenate in a specific way. Place a tilde (~) where you want the hyphen to appear. You 

can also add words that you don't want hyphenated to the list. Just add the un-

hyphenated word. 

  

The list remains with the document so that if you share the document the hyphenation 

preferences remain active. You can also import your own list to a document, which will 

add your own preferences to the list.  

Inserting hyphens manually 

If you type "Ctrl + -" (minus key) it inserts a soft hyphen which is a hyphen that only 

appears if the word can wrap at the end of a line. It's called a 'soft' hyphen because when 
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the word appears in the middle of a line the hyphen vanishes (unlike a normal dash or 

minus character), so it intelligently hyphenates the words only if it needs to. 

When editing the text a soft hyphen is treated as an invisible character (it takes no 

space), but you can tell it's in the text by moving the cursor left/right over where the 

invisible character is. 

A hard hyphen can be inserted by typing "Ctrl + Shift + -" (minus key). A hard hyphen is 

one that will not cause a wrap at all. This is useful in situations where you have dashes in 

words that you do not want split at the end of lines.  

Find & Replace 

The Find & Replace function performs live search so that as you type the search query 

the text is searched and highlighted in real-time. 

To search for some text select the menu "EDIT" > "FIND/REPLACE..." or "Ctrl + Alt + F" and 

the following dialog is displayed: 

 

Enter the search term and it's shown highlighted in the text. You can choose to search 

just the current text flow, or the whole document (all text flows on all pages). 

The WHOLE WORD option will only search for whole words that match the search term. 

E.G. searching for 'met' will not find 'metro'.  The CASE SENSITIVE option will match only 

the exact case. E.g., with this option on, searching for 'aBc' will not find 'abc'. 

Synchronising Text using Soft Groups 

In some designs, you may find you need multiple text objects to always show the same 

text, but perhaps using different styles. Normally when you want to change the text 

shown on these objects, you’d need to edit each one individually. 

By adding such related text objects into a Soft Group, you can ensure that they will 

always show the same text. To add the related text objects into a Soft Group, first make 

sure that they all already have exactly the same text (otherwise they will not become 

synchronized). Then select them all using the Selector Tool. Then select "ARRANGE" > 

"APPLY SOFT GROUP" ("Ctrl + Alt + G").  
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Now when the text is edited on one text object, the others will be updated automatically, 

even if they are stampeded across different layers throughout your document. Note that 

this synchronization still works even if some of the text objects are on locked or invisible 

layers. 

To ungroup a Soft Group, select "ARRANGE" > "REMOVE SOFT GROUP" ("Ctrl + Alt + U"). 

See the Soft Groups section of the Object Handling (on page 92) chapter for more 

information on Soft Groups. 

Smart Fields 

Smart Fields are any commonly used text phrases that you may want to insert in multiple 

places in text. Each Smart Field has a name and a value and when its inserted into text 

you see the value. 

For example you could have a Smart Field named Camera Price which you define to 

have a value of $499. You can then insert that into your document(s) wherever you want 

to show the price. But at any time you can edit the definition of the Smart Field to change 

the price and it will be updated everywhere it appears in your document. 

There are two types of Smart Field. PERSONAL SMART FIELDS are stored on your device, 

so once you've set them up you can easily insert them into any documents. DOCUMENT 

SMART FIELDS are stored only in the current document. 

Find the Smart Fields dialog on the INSERT or UTILITIES menus… 
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By default it opens with the PERSONAL SMART FIELDS selected - click the DOCUMENT 

SMART FIELDS button to switch to viewing the DOCUMENT SMART FIELDS. 

There are a default set of PERSONAL SMART FIELDS the first time you use Designer Pro. 

You can edit the values of each of these by clicking in the VALUE field. When you've done 

this once the values you entered are saved on your device and will be available for 

insertion into any document you edit on that device. 

Adding and deleting Smart Fields 

You can add as many additional Smart Fields as you like - just click the ADD button, then 

choose a unique name for your new Smart Field and enter a value. If you select an 

existing Smart Field before clicking ADD, the new field is added following the selected 

field. Otherwise it's added at the bottom of the list. The order of the PERSONAL SMART 

FIELDS is remembered too. 

To delete a Smart Field you don't need, click on it to select it and then click the Delete 

button. 

Inserting & Editing in Text 

To insert a Smart Field into your document, make sure you are in the Text Tool, place 

the text caret where you want to insert, select the field you want to insert, and click the 

INSERT button. If you want to insert multiple Smart Fields you can keep the dialog open, 

move the text caret to a new position and then select and insert another field. 

mk:@MSITStore:C:/Xara/DESIGN~1/HelpAndSupport/ENG/XaraX.CHM::/2800.htm
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You can select Smart Fields in text just as you select ordinary text, and apply text 

attributes to them in the usual way. You can't place the text caret in the middle of a Smart 

Field - it behaves as a single object in the text, similar to how embedded objects work. 

If you want to edit the value of a Smart Field, you can right-click on it in the text and 

choose Edit Smart Field from the context menu. The Smart Fields dialog opens showing 

the DOCUMENT SMART Fields and the target Smart Field is pre-selected, so you can edit 

its value and it will update wherever that field appears in text of the current document. 

Updating Smart Fields 

The UPDATE button in the SMART FIELDS DIALOG checks the current values of your 

PERSONAL SMART FIELDS against those in the current document, and updates the fields in 

the document if they differ. So use this to update existing documents if you have 

changed your PERSONAL SMART FIELDS since the document was edited. 

 

 

 

  

mk:@MSITStore:C:/Xara/DESIGN~1/HelpAndSupport/ENG/XaraX.CHM::/8380.htm


 

 224 Text Handling 
  

 

 

 

 

Tabs, Margins and Indents 

Rulers 

To adjust tabs, margins and indents you need to turn on rulers in your document. 

To do this: 

 Choose "WINDOW" > "BARS" > "RULERS" or right click a page and choose "SHOW 

GRID/GUIDES" > "SHOW RULERS". 

 Or press "Ctrl + (Shift) + R". 

 Or press "Ctrl + L" (when not in the TEXT TOOL). 

The enhanced text features will only appear on the ruler when you are using the 

TEXT TOOL and when the text cursor is in a text story or the text object is selected 

when in the TEXT TOOL. 
 

In the TEXT TOOL when you drag the margins or tabs on the ruler, you get a temporary 

vertical guide to make it easier to align the tabs or margins to objects elsewhere on the 

page. In addition when dragging tabs or margins, if you have magnetic snap switched on, 

these will snap to each other making it easier to position tabs and margins. 

Margins and indents 

Any changes you make are made to the current paragraph of text. (i.e. the paragraph 

containing the text cursor) or, if you have a selected region of text,  to the paragraphs of 

the selected region. 

You can apply changes to all text in a text story by selecting all the text within that story 

("Ctrl + A"). To change more than one text story, select the text objects while in the 

SELECTOR TOOL then change to the TEXT TOOL and make the required changes. 

 Left margin. Drag this to change the left margin of the text. 

 First line margin. Drag this to change the left margin for the first line of the 

paragraph (useful for lists, as shown below). 

 Right margin. Drag this to change the right margin of the text. 
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Demonstrating the left margin and first line margin  

Demonstrating a right margin 

 

Text along a curve 

If you have fitted a single line of text to the curve using the FIT TEXT TO CURVE option, 

then the curve line is the margin. If the text is longer than the line it will just flow off the 

end. 

If you have clicked on the line or fitted a column of text to a curve or line then you have 

left and right margin indicators (small red squares) that can be dragged along the line to 

adjust the margins used for justification. 

Tabs 

By default, text stories are created with tabs set 0.5 cm apart. This means you can just 

press "Tab" and your text will be moved along to the next tab stop. You only need to 

define new tab stop positions if you want alternative tab spacing. 

These default tabs are shown as faint Ls on the ruler: 

 

Standard tabs, indicated by faint "L"s 

Custom tabs 

To create a custom tab position, just click on the ruler where you wish to place the new 

tab. It will replace default tabs up to that point on the ruler. 

For example: 

 The triangle indicates a custom 
tab 
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 To set more than one tab click multiple times on the ruler. 

 To move a custom tab drag it along the ruler. 

 To remove a tab drag it off of the ruler (default tabs will come back). 

Custom tab types 

You can set different types of custom tab. By default, custom tabs are left align tabs. This 

means that text will be aligned with the tab on the left of the text. 

To change the tab type, click the tab icon on the ruler. 

The following custom tab types are available. You are not 

limited to just one type in a story, and can choose a different 

type then set additional tabs. 

 

 Left align: The text will be aligned with the tab to the left. 

 

 

 Right align: The text will be aligned with the tab to the right. 

 

 

 Center align: The text will be centered on the tab. 

 

 

 Decimal point align: The decimal points in the text will be aligned with the tab. This 

is useful for lists and, however long the number, the decimal points  will be tab-

aligned. 
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How to creating hanging indents 

Hanging Indents, as they are known, are where the first line of a paragraph has a 

negative margin or a margin that hangs to the left of the normal left margin. Numbered or 

bulleted lists are examples of hanging indents. 

To create hanging indents: 

1. Drag the left margin inwards. 

2. Click on the ruler away from the left margin (creates a new tab stop) and drag this 

tab stop to be exactly over the left margin. 

3. Now each line will start outdented—you can insert any special character or number 

and press "Tab" to move to the left margin. And (as with this paragraph) all 

subsequent lines of text are indented to the left margin. 

Repelling text objects 

You can make any object in Xara Web Designer Premium repel text so that text 

underneath it automatically flows around the object, instead of appearing underneath it. 

This makes it easy to lay out pages containing long passages of text combined with 

photos and graphics. Once you've set them to repel, you can adjust the positions of your 

graphics and photos and the text will automatically adjust and reflow around them. 

You can also choose to only repel text within a layer, which stops objects within a layer 

from repelling text on other layers and also stops text on the layer being repelled by 

objects on higher layers.  
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Making an object repel 

To make an object repel text, right click it and select the REPEL TEXT UNDER option. Any 

text object in the same layer but below the repelling object (look in the Page and Layer 

Gallery (on page 447)) will be repelled with a default margin of 5 pixels between the text 

and object. Note that repelling text objects only repel text that is underneath the objects, 

not any text that is on top. 

Alternatively right click on the object and select REPELLING & ANCHORING to display the 

TEXT REPELLING & ANCHORING dialog. 

 

Click the REPEL TEXT AROUND THIS GRAPHIC checkbox. And if you want the text to repel 

as a rectangle around an object, click the RECTANGULAR REPELLING option as well. With 

this option what happens is that the text repels around the rectangular bounding box of 

the object, ignoring its outline. This is also more efficient if your document or website has 

long text flows and has a lot of repelling objects that are also anchored to the text. It is 

also the default option when you turn repelling on for rectangular objects.  

 

Text repelling around an object (left) and rectangular repelling (right). 
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If desired, set a repel margin for the object to set the space between the text and the 

object. If you want a different height and width for the repel margin, click the padlock 

symbol and enter the margin height in the H (horizontal) box and width in the V (vertical) 

box. Click OK. 

To turn off repelling right click the object and choose the REPEL TEXT UNDER option again 

to deselect it. Or right click and select REPELLING & ANCHORING to display the Text 

repelling & anchoring dialog again. Click the REPEL TEXT AROUND THIS GRAPHIC checkbox 

to deselect it and click OK. 

Note that single lines of text do not respond to repelling objects, only text areas and text 

columns do. 

To only repel text within the same layer as the repelling object, see Layer Properties (on 

page 449). 

Anchored Graphics 

You can position any graphic, or group, so it's tied (anchored) to a position in some text, 

so that as the text moves because of editing, the graphic object will move to remain at 

the same relative position. However anchoring should only normally be used for objects 

that sit outside the margins of the text (eg. A photo sitting to the right or left of a text 

column), or behind the text. Use Embedding for objects that sit within the text bounds 

(see below).    

1. The quickest way to anchor a graphic or group is to right click it and choose the 

ANCHOR TO TEXT option. However, if you also want to edit anchoring properties, you 

can right click on the object and select REPELLING & ANCHORING to display the TEXT 

REPELLING & ANCHORING dialog.  

2. Click the MOVE GRAPHIC WITH TEXT checkbox.  

3. By default MOVE VERTICALLY ONLY is also selected, so that your anchored graphic 

will only move vertically as the text is edited. This is usually the most useful option – 

if you want the object to track the anchor position horizontally as well, embedding 

the object is usually a better option. 

4. An anchor symbol appears in the top left of the object, indicating it's now anchored.  

5. Using either the SELECTOR TOOL or TEXT TOOL, click and drag the anchor symbol so 

that a red arrow appears.  

6. Move the arrow head and drop it in the location in the text where you would like the 

object anchored. A red caret (inverted 'T' mark) indicates the anchor position.  

7. As you edit the text around this caret mark, the anchor point and anchored object 

moves with the text. 

8. When an anchored object reaches the bottom of the text area to which it is 

anchored the text to which the object is anchored flows to the next page or column, 

taking the anchored object with it. This is the default behavior for newly anchored 

objects. However it’s controlled with the AFFECT TEXT FLOW checkbox in the 

REPELLING & ANCHORING dialog, so you can turn this off if required. For legacy 

documents the setting is turned off to avoid changing the way these documents are 

formatted.   
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An anchored object displays an anchor symbol and an arrow pointing to the anchor point, 
shown as a red caret mark.These disappear as you type, unless you're close to the anchor 
point. 

Note: If you drag the anchoring arrow to a place on the page where there is no text, the 

arrow turns into a red anchor that indicates the object's anchoring properties will be lost if 

it's dropped here. This also happens when the arrow is dropped on the object itself. 
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This is an example column of text with various graphic elements hanging to the left. Each of 
these is anchored to the start of a line of text immediately to its right. 

It's possible to anchor any graphic object or group, including groups containing text, such 

as the example side-panel, shown above. If the group consists of a single object you can 

directly select that object instead of selecting the group that encloses it. Look at the 

STATUS BAR and the PAGE & LAYER GALLERY to see this in action.  

It's also possible to anchor objects to appear on top of, or below the text. The example 

pale blue flower graphic, shown above, is anchored this way and will flow with the text.  

NOTE: If an anchored object is also set to repel, only the text that the object is anchored 

to is repelled.  

NOTE: Repelling is restricted for repeating objects: Text inside a repeating group is only 

repelled by repelling objects inside the repeating group. Individual repelling objects inside 

a repeating group only repel text that is also inside the repeating group. Repeating 

groups as a whole can repel any text stacked below on the page. 
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Moving Anchored Objects 

As new text is added or deleted, the object moves as the text flows, but will always 

maintain its new position relative to the anchor point. You can move an anchored graphic 

by dragging on it as usual. This changes its position relative to the anchor point, but does 

not move the anchor point, which remains visible at the end of the anchor symbol arrow 

as you click/move the graphic.   

If you want to move the anchor point to another location within the text, click and drag on 

the anchor symbol again to create a new arrow and drag it to the new location. 

If you cut and paste the text containing the caret mark, the anchored object is also cut 

and pasted. 

Viewing the anchor point 

The anchor point of an anchored object is only visible if you click the anchored object in 

the SELECTOR TOOL or click in the surrounding text area in the TEXT TOOL.  

When you click in a region of text with the TEXT TOOL, it shows any anchors points within 

an inverted 'T' symbol, and also draws an arrow from the anchor point to the anchor 

symbol in the top left of each anchored object. So the easiest way to see all the anchor 

points for any text is to click in it with the TEXT TOOL. 

However, when you start to edit the text, the red caret, arrow and anchored symbol 

temporarily disappear until you stop typing. If you are close to the anchor point, Web 

Designer Premium displays the caret mark, along with an arrow pointing to the anchor 

symbol, to let you know when you're close.  

 

Soft Groups 

You can anchor Soft Groups (on page 115) the same way, even where part of the group 

is on another layer. For example web buttons with mouseover effects or pop-ups on 

different layers can be anchored in this way. 

Removing an anchor 

To remove an anchor from an object, right click it and choose ANCHOR TO TEXT again to 

disable the option. Now when you click the object in the SELECTOR TOOL or in the text in 

the TEXT TOOL, the anchor symbol is no longer displayed. 

Embedding Graphics 

If you take a graphic, a photo or other object you can paste it "embedded" into text. You 

can control how the text is formatted around embedded objects, and have the object 

resize automatically according to the width of its containing text area or column. You can 

also embed graphics into repeating text - like that which appears in headers and footers 

and have objects anchored to repeating text too. 
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This is particularly useful when you have the same text content with embedded graphics 

appearing in columns of different widths in multiple variants of a website. See mobile 

websites (on page 318).  

 

An embedded graphic reformatted and resized for a main (left) and mobile (right) variant. 

To embed an object, copy or cut it to the clipboard, go into the Text Tool and place the 

text caret at the point in the text where you want to insert it, and then paste. Now if the 

object you insert is wider than the text area or text column, the object is automatically 

resized down to the width of the text column. Right-click on the embedded object and 

choose "EMBEDDED GRAPHIC OPTIONS..."  from the context menu - or in the ARRANGE 

menu.  
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A dialog appears with the following options...  

 

The SCALING options allow you to specify how the embedded graphic should behave if 

the width of the text column/area is changed, or if the graphic flows into a text area with a 

different width.  

 RESIZE FOR NARROWER COLUMNS - With this option (the default), the object will resize 

down if it’s too wide for the text column, but it will not grow up above its original size if 

the column is wider than the object.  

 RESIZE RELATIVE TO COLUMN WIDTH - This option allows you to specify that the 

embedded object should always be a fixed % of the column width.   

 FIXED SIZE - This option turns off the automatic resizing, so the object will never 

change its size. 

 SCALE ONLY IN HORIZONTAL DIRECTION - This option is useful mainly for simple divider 

or Rule-off graphics, where you want the object to just stretch horizontally without 

getting taller or shorter depending on the column width. It’s useful only for very simple 
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designs because more elaborate graphical divider designs are not likely to stretch well 

without looking distorted.  

Add a simple Rule-off divider at the carat position using the "INSERT" > "RULE-OFF" menu 

option.  

The POSITIONING options allow you to choose how the graphic should be formatted into 

the text.  

 INLINE WITH TEXT - This is the default option. The graphic stays inline with the text with 

no text wrapping, like this , and behaves as though it's a large text character in the 

text.   

 TEXT WRAPS RIGHT - The graphic will be positioned to the left of the text column with 

text wrapping to the right. 

 TEXT WRAPS LEFT - The graphic will be positioned to the right of the text column with 

text wrapping to the left. 

The MARGINS options allow you to add some space around your graphic, so it doesn’t 

appear too close to the text or to the edge of the column. You can specify different values 

for each of the 4 sides of your graphic, or use the lock  buttons if you want to have the 

same margin top and bottom, or left and right, without entering the same values 

repeatedly. 

Additionally in the "INSERT" menu, the "BREAK" > "MOVE BELOW EMBEDDED GRAPHIC" 

option enables you to force the next paragraph of text to start below the graphic when 

you have text flowing to the left or right of the embedded graphic. 

When you embed a single object in text, you can directly select that object in the text 

instead of selecting the “Embedded group” that encloses it. Look at the Status Line (on 

page 67) and the Page & Layer Gallery (on page 447)! to see this in action.  

Bulleted and Numbered lists 

Bullet Lists 

 

You can turn any text into a bulleted list by selecting the text and then selecting 

the bulleted list button on the InfoBar. 

Each paragraph of text becomes a separate bullet. If you press return to finish a line at 

the end of one bullet point, the next line starts with a bullet point too. If you hit backspace 

immediately after the return, the last empty bullet is removed, text cursor remains at the 

same position and allows you to continue adding text to the previous bullet point. 

To finish entering a bulleted list, hit return on the end of the last bullet and then 

immediately hit return again on the new bulleted line. This removes the last empty 

bulleted line and allows you to start entering normal text again. Or you can just turn off 

the list button on the InfoBar. 
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You can nest bulleted lists by pressing the indent button on the InfoBar. This 

indents the current bulleted line and changes the bullet character to a different 

style, to distinguish it from the parent bullet. 

 

Example of a nested bulleted list 

 

To move a bullet point from a sub-list into its parent bulleted list, simply place 

the text caret in it and press the outdent button. 

So it’s easy to make and edit arrangements of nested bulleted lists using the indent and 

outdent buttons.  

Numbered Lists 

 

You can create and edit numbered lists in just the same way as described for 

bullet lists above, using the numbered list button.  

You can choose the numbering scheme to be used for each list, using the NUMBERED 

LIST section of the LIST PROPERTIES dialog. Place the text cursor in one of the numbered 

list points, press the right mouse button and choose ‘LIST PROPERTIES…" from the context 

menu. The dialog is modal, which means it will stay open as you make edits to your list 

items and you can instantly see your changes as you make them.  

 

Numbered list dialog 

In the dialog you can choose from a variety of numbering schemes and also enter the 

value that should be used for the very first entry in the list. Then the number is 

automatically incremented for the second and subsequent entries in the list. 
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Editing List items 

If you want to make edits to the bullets or numbers themselves, perhaps a color, font size 

or position change, the LIST ITEM section of the LIST PROPERTIES dialog lets you do this. 

Place the text caret in one of the list points, press the right mouse button and choose 

LIST PROPERTIES… from the context menu.  

 

List properties dialog 

Link to previous list of the same level 

You can link separate lists so that the list item attributes of a second list continue from 

the previous list at the same level. This allows you to insert gaps, graphics, paragraphs 

etc. in the middle of lists. With numbered lists the numbering of the second list carries 

from the last number used of the previous list. 

The option also works with sub-lists, so when checked, the current list picks up its 

settings from the previous list at the same level and of the same type. So set this option 

on a bulleted sub-list and it will pick up the bullet symbol, margin, indent, color, etc. 

settings from the previous sub-list of the same level.  
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Just place the text carat in the second list and check the LINK TO PREVIOUS LIST OF THE 

SAME LEVEL checkbox to link to the previous list.  

 

A linked numbered list 

Indent 

The indent is the space between the numbers/bullets and the start of the list text. Use the 

Indent controls to adjust this spacing for the list at the caret position. 

 

Indent examples 

Margin 

The margin field controls the space to the left of the bullet/number. Use these controls to 

adjust the horizontal offsets of sub-lists.  

 

Margin examples 

Size 

Adjust the font size of the bullet or number. Enter a value, use the dropdown menu or 

use the slider that appears when you click the arrow to the right.   
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Color 

Create a custom color for the bullet or number by clicking the Edit button to bring up the 

color picker. (on page 180) Once you have opened the color editor in this way you can 

also click on any of the colors on the color line, if you want to choose a standard color. 

Use the dropdown to stick with the default color or pick out one of the current document's 

named colors (on page 184) should it contain any. 

Vertical offset 

Move the bullets or numbers up or down relative to the text list. This is particularly useful 

for bullet symbols because the vertical positions of these can vary, so depending on 

which symbols you choose for your bullets you may need to adjust the position. 

Replace with symbol 

For bullet lists only - choose a replacement symbol from the Symbol picker (on page 

198). Click to open the picker. If you choose any of the MATERIAL ICONS symbols, you will 

probably need to adjust the vertical position of the symbol - see above. 

Replace from clipboard 

Web Designer Premium allows you to use any graphic for your bullets or numbers in 

lists. REPLACE FROM CLIPBOARD performs the same function as the PASTE AS LIST BULLET 

operation in the context menu. See the GRAPHICAL BULLETS AND NUMBERED LISTS 

section below, for more info. 

Reset to default list items 

Revert to the default bullet/number settings. 
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Graphical Bullets and Numbered Lists 

You can use any graphic or symbol for the bullet or number in a list. You can design your 

own bullets and numbered lists by using any of the normal drawing or text tools, or use 

one of the many bullet designs from the Online Content Catalog. Create a simple circle 

using the ELLIPSE TOOL for example, give it a fill and copy it to the clipboard. Then 

highlight the list you want to apply the style to using the TEXT TOOL. Right click the list 

and choose PASTE AS LIST BULLET from the menu. The design will now appear as a bullet 

for each of the list items.  

 

For a numbered list it's exactly the same procedure except you select or group a text 

item with your graphic and then select PASTE AS LIST NUMBER to replace all the numbers 

or text items in your list. The text object in the group is used to show the number. 

Both paste options are also available within the LIST PROPERTIES dialog (Right click the 

list and choose the LIST PROPERTIES... option and select REPLACE FROM CLIPBOARD).  

(Note that you cannot currently use graphical bullets and numbers with List text styles 

(on page 242) - you'll receive a warning prompt if you try) 

Text Styles 

TEXT STYLES are a powerful way to alter the appearance of text throughout a document 

with a few clicks.  

 

A TEXT STYLE is a named collection of attributes, such as font, size, color, line spacing 

and other text attributes. For example, the main heading at the top of this document 

might have a style called ‘Heading 1’, whereas the smaller sub-headings could have a 

style called ‘Heading 2’. 

 

By updating the definition of ‘Heading 2’, say, to be a different font, then every similar 

heading throughout the document will be updated instantly.  

 

Similarly the main text, sometimes called the ‘body text’ of a document is also a particular 

style, which Web Designer Premium calls the "Normal text" style. By updating that style 
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to be, say, 12 point Times New Roman, then all "Normal text" throughout the document 

can be changed in one go, without having to select and apply the same font change over 

and over again. 

 

TEXT STYLES are, therefore, rather like the "Named Colors" feature that Web Designer 

Premium also supports, where you can update "Theme Color 1" to be a new color and all 

parts of the document using that Named Color take on the new color. 

Text Styles InfoBar 

There is a Styles drop-down menu on the TEXT TOOL INFOBAR, that allows you to create 

Styles, apply them to any text, and to update the definition of the Style. 

 

By default there is a small set of pre-defined Styles, including ‘Normal text’, and three heading 
styles - Heading 1,2,3. 

Paragraph Styles and Character Styles 

Text Styles come in two varieties. Paragraph Styles and Character Styles.  

A Paragraph Style is denoted by a ¶ symbol on the style menu. An A symbol denotes a 

Character Style. 

Paragraph Styles apply to whole paragraphs, and are also typically used for headings. 

It’s not possible to apply a Paragraph Style to a smaller section than a paragraph, so you 

cannot, for example, apply a Paragraph Style to a single word within a paragraph. If you 

try, then the whole surrounding paragraph will take on this Style. 

Just place the text cursor anywhere on the line and select a Paragraph Style from the 

style menu, and the whole paragraph will take on that style. 

Character Styles, on the other hand, can be applied to any selection of text, from a single 

character upwards. For example, if you wanted to highlight certain words in your text in a 
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different color a Character Style would be ideal. The advantage is that you can then 

change the color (or font, etc) of all these highlighted words with a single Style update. 

Create a Character Style by clicking CREATE STYLE in the Style menu dropdown and 

checking the CHARACTER STYLE option from the dialog as you create a new text style. 

See Creating new Styles (on page 245) for more info. 

Paragraph styles can define all text attributes even bulleted/numbered list properties. 

Character styles can only define text attributes that can be applied to individual 

characters, such as text color, font size, font weight, etc. 

List Styles 

You can also apply Styles to bulleted and numbered lists. The style will take on all the 

attributes of the bullet or numbered list. Once you have applied a style to a list a "." 

appears in the Style menu to indicate that it is a List Style and to enable you to 

distinguish it from a Paragraph or a Character style.  

  

To make a list style, first create a list and customize it using the LIST PROPERTIES (on 

page 237) dialog. Then place the text caret in the list, or select part of the list, and 

choose CREATE STYLE … from the text styles dropdown list. Choose a name for your list 

style and click ok. 

List styles include all the list settings you see in the LIST PROPERTIES dialog, from indents 

to bullet symbols and colors. Each level within a list can have different settings and these 

are also all recorded in the list style. The example below has only 2 levels of list, but you 

can have as many levels as you like.  

 

To update a list style, simply modify a list that uses the style and then use the UPDATE 

option in the styles list, the same way you update ordinary Paragraph styles. The list will 

update whatever list level the text cursor is placed in - or all selected levels if you have 

more than one level selected - with the UPDATE option reflecting your choice. 

Note: Graphical lists (where you can use any graphical object as the bullet or number) 

are not yet supported with list styles. 
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Next paragraph style 

This is one of the settings for a text style - look at the list's PROPERTIES… option in the 

style menu.  

For Paragraph styles it determines what style should be applied by default to a new 

paragraph created following the current paragraph. For example, heading styles normally 

set the NEXT PARAGRAPH style to NORMAL TEXT, because that’s usually what you want 

immediately following a heading. With a list style however, it’s more likely that you want 

another list item to be added when you hit return at the end of a list item. So for list styles 

the NEXT PARAGRAPH setting is only used when you end a list. End a list by hitting return 

once to add an empty list item, then hit return again. The new non-list paragraph will then 

use whatever NEXT PARAGRAPH style you chose for the list style. 

For more detail on editing lists see Bulleted and numbered lists (on page 235)   

Updating Text Styles 

To update an existing Text Style: 

1.  Select some text already in the style you want to update. 

2.  Apply whatever changes you require, say an alternative font, or font size, or maybe 

in the case of a list style a bullet or number style change. 

3.  Select "UPDATE 'STYLE NAME' TO MATCH" from the Style drop-down menu on the 

Text InfoBar. 

For example to change all the NORMAL TEXT to be a different font, select a few words in 

the NORMAL TEXT Style, change the font (and any other attribute) and then Select UPDATE 

'NORMAL' TO MATCH from the Style Menu on the Text Tool InfoBar. 

When you are working on a web document with RWD variants, it is possible to update a 

Text Style for an individual variant. This is useful for example when you need the text in a 

mobile variant to be a larger and/or different font. To update the style for an individual 

variant, change the text as above and then select UPDATE 'STYLE NAME' IN THIS VARIANT 

from the Style drop down menu on the Text InfoBar. This is an additional option that is 

shown in the STYLES menu when you are working in a document that has multiple 

variants.  

See Responsive Web Design (on page 318) for more information about variants. 

Redefining Text Styles 

Sometimes you may want to make an existing text style to look like some text that does 

not already have that text style applied. Perhaps some text that you imported from some 

other document. You can’t just apply the existing style to that text, because you would 

then lose its appearance. Instead use the UPDATE OTHER STYLE TO MATCH… option in the 

style menu.  

1. Place the text cursor within the text (or select some of the text). 

2. Select UPDATE OTHER STYLE TO MATCH... from the Style drop-down menu on the 

Text InfoBar. 
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3. Choose the Style you wish to update from the UPDATE STYLE TO MATCH... dialog. 

4. Tick the appropriate checkboxes to decide if you want the Text Style to match only 

the new text, and/or all similar text in the document. Uncheck APPLY TO ALL SIMILAR 

TEXT IN THIS DOCUMENT if you only want the Style to be applied to the paragraph 

containing the text cursor. 

5. Click APPLY. The text is now redefined as the selected Text Style. 

The APPLY TO ALL SIMILAR TEXT IN THIS DOCUMENT option is useful for applying text styles 

to existing documents that don’t already use text styles, such as imported PDFs. For a 

style to be applied to all similar text within the document, the text must have the same 

font and font size over more than 50% of a paragraph, and it must also have the same 

justification and indentation settings (within a small tolerance).   

  

Styles based on other styles 

In Web Designer Premium, you can base one style upon another. For example, if you 

wanted another variant of Heading 2 style, that was identical in every respect, except a 

different color, then when you create the new style you would make it based on "Heading 

2" in the CREATE STYLE dialog. This means that if you update "Heading 2" to be, for 

example, a new font or size, your new Style would also take on that new font or font size. 

New Character Styles are typically based on the "Underlying Paragraph Style", but just 

with the changes you want. So this means if you have a Character Style that just sets the 

text color and nothing else, applied to a single word, then when you altered the 

Paragraph Style of the paragraph, this word would change to match, except its color. 



 

Text Handling 245  
 
 

 

Creating new Styles 

To create a completely new Style, change a selection of text to appear how you want and 

then select the CREATE STYLE menu from the Style list drop-down on the TEXT TOOL 

INFOBAR. 

 

If you want to create a new Paragraph Style it’s recommended that you select and apply 

your changes to a whole paragraph, before selecting the CREATE STYLE menu option. 

 

This dialog shows a new style, (NewStyle2) being created that is a PARAGRAPH STYLE, 

based on an existing HEADING 2 style. The NEXT PARAGRAPH option determines what 

style will be used for the subsequent paragraph when typing. 

If the heading style has an OUTLINE LEVEL it will appear in the LINK TO HEADING list in the 

Link Tab of the WEB PROPERTIES DIALOG.  
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The lower section of the dialog shows the complete definition of this Style. In this case 

you can see it’s based on Heading 2, with only a color change. 

 

To create a Style that is based on no other Style, that is to say, it inherits no attributes 

from another style, select (NO STYLE) from the BASED ON: option, as below. 

 

This dialog shows the creation of a NewStyle2, that is a Paragraph Style and based on 

no other style. The lower section lists all the attributes that make up this Style. The 

attributes listed have been taken from selected text, so this Style consists of a complete 

definition, listing all possible text attributes. 

 

In this case when entering text in this Style, the NEXT PARAGRAPH (i.e. when Return is 

pressed) will be in the same style again. 

Removing Styles 

The STYLES list in the STYLES menu includes the entry NO STYLE. Selecting this removes 

the Style (Paragraph and/or Character Style) from the selection whilst retaining the same 

appearance. When you select the option a dialog appears informing you of this. Click on 

the dialog's CLEAR STYLES button to proceed with the operation. Now your selected text 

looks exactly the same as before, but has NO STYLE applied to it. 

    

 

Deleting Styles 

To delete a style select DELETE STYLE from the STYLES menu, the DELETE STYLE dialog 

opens. Now choose the text style you wish to delete from the dropdown menu in the 

dialog. The style will be deleted from the menu as will all references to the style, and the 

style will be returned to its base style. However, the returned style will still retain the 
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deleted style's attributes and appearance. So for example a deleted style based on 

HEADING 1 WILL appear as HEADING 1+ to indicate this.   

If your style was based on nothing, ie NO STYLE then the style will revert to No style 

appearing as NO STYLE + in the menu and again retaining the same attributes and 

appearance.  

Note that you can't delete the default styles and you also can't delete styles which have 

other styles based on them. You will receive a warning prompt should you attempt to do 

so.   

 

Hidden Styles 

Text styles can be marked as HIDDEN in the STYLE PROPERTIES dialog, which means they 

won’t appear in the main styles list unless the text caret is located in text that uses that 

style.  

This is useful to help avoid the styles list becoming too long in documents that use a lot 

of different styles. Some SmartShapes such as the bar and column charts have their own 

text styles and these are now automatically made hidden styles, so they don’t appear in 

the main styles list. Similarly the TOC styles used for Tables of Contents are also hidden. 

Use the SHOW HIDDEN STYLES option in the styles menu to have all styles included in the 

styles list.  

Additionally hidden styles can’t become current, so any new text you add to a design 

should never use a hidden style by default.  

Style Properties 

If you want to change the definition of a style, such as the style it’s based on, or just look 

at its definition, use the PROPERTIES… option in the style menu. You need to select some 

text that has the style applied before you do this, to indicate the style you want to edit. 

The STYLE PROPERTIES dialog appears, which looks the same as the CREATE STYLE 

dialog shown above. 

The style description at the bottom of the dialog describes how the style differs from the 

style on which it is based. So if you want to see all of the style’s attributes, just 

temporarily select NO STYLE from the BASED ON list, to see a full description. Don’t forget 

to reset this to the correct BASED ON style, or click cancel in this dialog, if you don’t want 

to change the style! 

Applying text attributes 

Changing the font size 

 

There are several ways to change the font size: 
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 Type a new value into the size text box on the InfoBar and press . 

 Or select from the FONT SIZE drop-down list on the InfoBar. 

 Or use the Font size pop-up slider (on page 196). 

 Or manually increase/decrease font size with the "Ctrl + Shift + >" and "Ctrl + Shift + <" 

keyboard shortcuts. This applies only if all selected text parts are of the same font 

size. 

 Or use the SELECTORTOOL to scale the whole text object. 

Bold & Italic 

 

Click the BOLD or ITALIC button on the InfoBar ("Ctrl + B" or "Ctrl + I") 

This applies the bold or italic variant of the current font. 

 

Text Underlining 

 

Click the underline button on the InfoBar to apply an underline to the 

selected text. 

The underline color and size is automatically derived from the text color and size. 

Highlighting text 

To apply a text background color - in effect a highlighter-style background color...  

 Highlight some text using the TEXT TOOL 

 Right-click on a color in the COLOR LINE 

 Select SET TEXT BACKGROUND from the menu 

See Applying a Text Background color (on page 179) for more details.  

Justification or text alignment 

Justification always applies to the complete line. Any selected region is ignored. 

 

 
LEFT justification: Align the left-hand edge of the text to the initial click position. 

 
CENTER justification: Centers the text around the click position. 

 
RIGHT justification: Align the right-hand edge of the text to the initial click position. 

When using simple text the initial click position on the page is taken as the origin for text 

justification. 
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Ligatures 

 

A ligature is a connection between two or more characters to improve legibility or for a 

stylistic flourish. The linked sequences of characters then appear as a single glyph. 

Ligatures, where they exist, are contained within the font file and can be displayed 

according to the settings on the OPEN TYPE LIGATURES button on the InfoBar. The ligature 

settings can be used in text styles just like other text attributes. 

The various options are... 

STANDARD  Only the default set of ligatures provided by the font designer will be 

displayed. 

 

 

 

Ligatures off (left) and on (right) 

DISCRETIONARY The discretionary ligatures are decorative - to be applied at the 

discretion of the user. 

 

 

           

HISTORICAL Historical ligatures are mainly ornamental suggesting a historical 

context. 

 

 

          

CONTEXTUAL The glyph applied depends not only on the actual characters replaced 

but also on the context in which those characters appear. So the actual 

ligature used for a given character combination may vary depending on 

what characters precede and follow the combination that is replaced. 

 

             

SELECT ALL All available ligatures for a particular font will be displayed. 
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CLEAR ALL No ligatures will be displayed.  

You can choose which groups to turn on or off independently for any range of characters. 

Select a character range in the TEXT TOOL and then click on the Ligatures button. 

If you select some text and move your mouse pointer over the different options in the 

LIGATURES and STYLISTIC SETS menus, your text will update dynamically to show you a 

preview of what the option will do. This makes it easier to see the effects the different 

options will have on your text if you choose to apply them. 

Stylistic Sets 

  

Some fonts include alternative sets of ligature characters that the user can choose from, 

allowing more flexibility. If any sets are available for any of the characters in the current 

text selection, they are listed under the STYLISTIC SETS menu, where they can be turned 

on and off independently. Select text and mouse over for a dynamic preview.  

 

 Font Gabriola (left) and with stylistic set applied (right)  

Open Type Alternates 
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Some Open Type fonts provide alternative glyph designs for the same ligatures. Click the 

button to see a menu containing the various options.  

 

Font Camper Print Script 3 with no alternates (top) and with alternates (main).  

As with the LIGATURES and STYLISTIC SETS menus, if you select some text and move your 

mouse pointer over the different menu options your text will preview automatically.  

The menu options are... 

None 

No alternates are displayed. 

Contextual Alternates 

Use the CONTEXTUAL ALTERNATES menu option to turn the alternates on and off for any 

character selection. In this example you can see the different glyphs used in the same 

word. 

 

Contextual Alternates off (left) and on (right). 

When you change this option, if you don’t see any differences in the selected text that’s 

because the font you are using doesn’t have any alternates for the characters you have 

selected. 

Titling Alternates 

When this option is turned on, default character glyphs from the font are replaced by 

alternative glyphs designed to look good at larger sizes. So they are intended for use in 
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headings and titles, but you can use them anywhere. Not all fonts provide these 

alternates and not all characters in the font may have them. 

Stylistic Alternates  

Turn this option on to see alternative glyphs that may be provided with a font for some 

characters, as an alternative to the default glyphs. Experiment with these alternatives for 

different aesthetic or design effects, where the font provides them. 

Swashes 

Swashes are highly decorative or ornamental glyphs, typically with elaborate flourishes. 

All 

All the available alternates for the glyph are displayed. 

Text Capitalization 

 

Click the TEXT CAPITALIZATION button on the ADVANCED TEXT BAR to access the 

capitalization options. 

The options are...  

AS TYPED This is the default setting for all text, the case remains as whatever 

you typed.  

ALL CAPS Text is always all upper case, whether it was typed as upper or 

lower case. 

ALL LOWER Text is always all lower case, whether it was typed as upper or 

lower case. 

INITIAL CAPS The first letter of each word is capitalized.  

SMALL CAPS Characters that were typed as lower case are shown as small 

upper case characters. Characters that were typed as upper case 

will appear as normal, so slightly larger.  

 

Many OpenType fonts actually include special character glyphs for SMALL CAPS and if the 

font you are using does, Designer 16 will use them, so you will see Small Caps text 

appear exactly as the font designer intended. If the font you are using does not provide 
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its own Small Caps character glyphs, Designer will use the font’s ordinary upper case 

characters, but at a reduced size. Therefore you can safely use this option with any font, 

whether or not the font has Small Caps support.  

These options are all text settings, so they not only change the case of the selected text, 

they are also applied as settings to the text so that subsequent editing maintains the 

case setting you’ve chosen (in the same way that the Bold and Italic settings on text 

work). 

These settings also work with text styles, just as all other text settings do, so for example 

you can define a heading style to always appear in Capitals by applying ALL CAPS and 

then updating the style definition. 

TOGGLE CASE 

This option is shown in a separate section of the menu because unlike the other options 

above it is not a setting - it simply toggles the case of each letter in the selected text.

  

Subscript & superscript 

 

Click the appropriate button on the InfoBar. 

Normal text   subscript
superscript 

 

Indents and Outdents 

 

Indent a paragraph of text. 

 

Outdent a paragraph of text. 

 

Line spacing 

 

Line spacing allows you to change the space between two lines 

(so affects vertical spacing). 

Line spacing is measured in percentages (120%) or points (12pt). You can either type 

the line space value in the text box or click the arrows to nudge the values. 

A percentage setting has the benefit of scaling accordingly if you change your font size. If 

a percentage is applied to a line of text with more than one font size, the largest font size 

is used. For example, if a line contains 90% and 100% text, the line spacing is calculated 

on 100%. 
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Paragraph Spacing 

 

The last two fields on the end of the TEXT TOOL InfoBar allow you to set 

the spacing above and/or below paragraphs.  

This is particularly useful where you want half line spaces between paragraphs. 

Like Microsoft Word, when you use both spacing above and below paragraphs, the 

spacing between paragraphs is whichever is the greater value (it's not 

cumulative). Paragraph spacing above paragraphs will move the first paragraph down in 

a frame of text. 

Text links 

You can apply a link to any part of a text object, so that when the document is exported 

as HTML the text shows as a clickable link in web browsers.  

Use the TEXT TOOL to select the words or characters that you want to apply the 

link to, then click the link button on the WEB toolbar.   

This brings up the WEB PROPERTIES dialog, with the LINK tab selected. On this tab you 

can choose whether to link to a URL, to another page of your website, or even to a 

heading or a pop-up layer. 

By default when you apply a link to some text, the text is shown as underlined and with 

the text link color that is defined for the current document. You can change the link color 

and whether or not the links are underlined, on the WEBSITE tab of the WEB PROPERTIES 

(on page 292) dialog (right click and choose WEB PROPERTIES or choose WEB 

PROPERTIES from the UTILITIES menu). You can also set the color to be shown when the 

user moves the mouse pointer over a text link in a web browser (“Mouse Over Color”), 

and the “Visited Color” which is used to display links which the viewer has already visited 

with their web browser. 

Text inside groups for websites 

When a document is exported as a website, all groups get exported as images. So any 

text inside groups can’t be selected and copied as text by a visitor to your site.  

For graphical buttons, headings, logos etc. this is usually desirable as the text just forms 

part of the graphic. But you may have more substantial pieces of text inside groups which 

you want to remain as text in your exported web page. To arrange this, all you need to do 

is apply the special name “HTMLText” to your text object. The easiest way to do this is as 

follows: 

1. Go into the TEXT TOOL and click on your text to insert the text cursor. 

2. Press escape so that the whole text object becomes selected. 

3. Open the Name dialog ("UTILITIES" > "NAMES..."). 
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4. Either select the “HTMLTEXT” name from the “APPLY NAME” dropdown list if you’ve 

already used it in the current document, or type in the name “HTMLText”. Then click 

“ADD” to add the name. 

Now, when you export your website, your text will remain as text and the rest of the 

group will be converted to an image. All the text panels provided in the ONLINE CONTENT 

CATALOG already have this name applied to the text objects inside them, so the text on 

the panels will export as text. 

Browsers can’t render rotated text, so you can’t use this name to force rotated text to be 

exported as text. The name is ignored in this case. 

Copying text appearances 

It’s easy to copy the style of any text to any other region of text using the PASTE 

FORMAT/ATTRIBUTES feature: 

 Select the source region from where you want to copy the style. This can be as little as 

a word (just double click). 

 Select "EDIT" > "COPY" ("Ctrl + C"). 

 Select the region of text to which you want to apply the style. 

 Select "EDIT" > "PASTE FORMAT/ATTRIBUTES" ("Ctrl +  + A"). 

If you just have the text cursor positioned in some text when you PASTE 

FORMAT/ATTRIBUTES the paragraph attributes will be pasted to this paragraph. 

If you have a region of text selected, then PASTE FORMAT/ATTRIBUTES will paste all the 

visual attributes of the source text.  

Applying attributes to whole text stories 

When you have the cursor in a simple or column text object, pressing "Esc" will select the 

whole text object. You can then apply an attribute, say a color, and the whole text object 

is altered. This is often quicker than performing "Select all" ("Ctrl + A"). 

With text areas this method only works if all text areas of the story are selected. You can 

do this in the SELECTOR TOOL clicking and "Shift + clicking" on the different text areas to 

select them. But this method is only possible if the text areas are on a single page. If your 

text story flows over several pages and you want to change all the text, then it’s 

necessary to "Select all" ("Ctrl + A"), and then apply the required attributes. 

Copying/Pasting formatted text (RTF) 

You can copy "rich text" (as it's sometimes known) from other applications such as word 

processors or editors and paste into Xara Web Designer Premium as text, and the fonts, 

margins, line spacing and text links will be preserved. This makes it dramatically easier to 

retain the style and appearance of your text.   
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When you paste "Rich Text Format" (RTF) from other applications you are given the 

choice of pasting the text in as "Unformatted text" which means it will appear in the font 

and style at the cursor where you paste, or "Rich Text Format", i.e. it will retain the style 

of the source text. 

This also works the other way around. You can copy text in Web Designer Premium and 

paste into other applications that support rich text editing and the style (font, size, colors, 

margins etc) will be retained. This will only work if you select and copy a single text 

object or from a single text flow.  

 

Document font embedding 

Xara Web Designer Premium will store the character shapes of all the fonts used in your 

document if the font permissions allow it. This means if you give someone else your 

design file, or transfer the file to another computer, the text will still look exactly right, 

even if the correct fonts are not installed on that computer. 

Website font embedding 

Most website documents use only ‘web safe fonts’, which are fonts that the vast majority 

of computers and other devices will have installed and so which can be safely used on 

any website. However you can use just about any font on a website providing the font 

permissions allow it, and Web Designer Premium can automatically publish the font with 

your site in a way that means text using that font will appear correct to everyone viewing 

it, whether or not they already have that font installed.  

To help your website load faster, only Western characters are included in the embedded 

font, unless your document uses other characters also. 

When you export or preview a website document that uses fonts that aren’t web safe,  

Web Designer Premium will show you a warning, listing those fonts that will be 

embedded in your website. This helps to remind you that your site includes embedded 

fonts. You can also see which fonts a document is using, together with its permissions by 

viewing "FILE" > "DOCUMENT INFO..."  See Font permissions (on page 256) for more info. 

Some fonts do not permit embedding in a document or website. Web Designer Premium 

detects such fonts and will show you a separate alert if you attempt to use any such fonts 

in your website document. You should change to a different font that is either web safe, a 

Google font or a font that does permit embedding. 

Font permissions 

When embedding fonts there are four levels of font permissions, that is to say four levels 

of usability depending on how the font has been licensed. The four levels are... 

1. Installable - the most permissive level. Allows the font to be embedded in the 

document and installed permanently on the guest computer. 
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2. Editable - Allows the font to be embedded in the document but only allows it to be 

used temporarily on the system. 

3. Print and Preview -  Allows the font to be embedded in the document but only for 

printing and viewing purposes.  

4. Restricted - The font cannot be embedded in a document. 

 Apart from the warnings Web Designer Premium shows you listing those fonts that will 

be embedded in your website, it is also possible to view their permissions levels by 

looking at the DOCUMENT INFO. Go to "FILE" > "DOCUMENT INFO...". 

 

Document info dialog showing fonts together with their embedding permissions.  

 

The Fill Tool 

Creating a graduated color fill 

 

The process of creating a different fill is almost identical for all the fill types: 

1. Select the object or objects to which you want to apply the fill. 

2. Select the FILL Tool ("G"). 

3. Select the fill type from the dropdown menu. 

4. Click-drag across the object to create the fill. Or, drag one of the fill handles to 

adjust the fill size and position. 

Xara Web Designer Premium provides a smooth interactive live preview of the fill as you 

drag.  

 

As you drag a fill arrow is created indicating the direction of 

the fill. Fill handles can be selected and dragged to adjust 

the position and angle of the fill. 
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Coloring fills 

Select one of the fill handles and click a color on the COLOR LINE or bring up the COLOR 

EDITOR and choose a new color. You can press "Tab" to alternate between the fill 

handles. 

 

Fill types 

Web Designer Premium has these types of color fill: 

FLAT FILLS - the shape has an even color or tone over its surface. 

 

LINEAR FILLS - the color gradually changes from one color to 

another. 

 

CIRCULAR FILLS - the color change radiates out from a single point 

in a circular pattern. 

 

ELLIPTICAL FILLS - similar to circular fills except the change 

radiates out in an elliptical pattern. 

 

CONICAL FILLS - the color change rotates around a single point. 

The effect is of a cone lit from one side with the opposite side in 

another color.  

DIAMOND FILLS - similar to elliptical fills, except the fill is like a 

diamond. 

 

THREE-COLOR FILLS - shows three different colors as if spotlights 

were lighting the object. 

 

FOUR-COLOR FILLS - the same as three-color fills, except four 

colors are possible. 

 

BITMAP FILLS - the object is filled with one or more tiled copies of a 

bitmap or photo. All photos you see in Xara Web Designer 

Premium are bitmap filled shapes (normally rectangles of course). 

Any photo can be used, or any bitmap in the BITMAP or FILL 

galleries. 
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FRACTAL CLOUDS - produces a patchy random fill which is 

especially useful for clouds or mist. 

 

FRACTAL PLASMA - a patchy random fill which has more contrast 

than a fractal cloud fill. 

 

The FILL Tool lets you apply these fill types to the selected object(s) and to edit and 

adjust the fills. 

Automatic select inside 

In the Fill Tool, an automatic "Select inside" is performed when you click on an object 

that is a part of a group, instead of selecting the group as a whole. This makes it easier 

for you to work on photos and fills inside groups. If you want to change the fill attribute of 

a group (which is not very likely), you need to select the group using the SELECTOR TOOL 

first.   

Fill Tool InfoBar 

 

 
Fill type 

 
Fill tiling 

 
Fill effect 

 
Bitmap name 

 
Profile 

 
Fill handle/resolution 

 Handle color/Grain 

FILL TYPE selects the type of fill. Selecting from this menu: 

 with a selected object, applies the fill to the object; 

 without a selected object, sets the current fill type which will then be used for newly 

drawn objects. 

FILL TILING is used when applying bitmap and fractal fills. The options are described later 

in bitmap fills. Fill tiling changes the repetition of the fill effect. The options are: 

 Simple-the fill is used only once, regardless of the size of the object. 

 Repeating/repeating tile-repeats the effect so that it fills the entire object. 

 Repeating tile inverted-only available on fractal and bitmap fills. This is similar to 

repeating tile, but every other tile is inverted. 
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A repeating elliptical fill inside an ellipse shape 

Fill tiling options are not available for 

conical. All other fill types can be made 

to repeat. This can produce some 

useful effects. 

FILL EFFECT is used for all fill types, except 3 and 4-color fills. It controls how the fill colors 

fade from the start color to the end color: 

 FADE: Fades between the two colors in a linear fashion 

 RAINBOW: Blends along the shortest edge of the HSV color wheel. For example, a 

blend from yellow to cyan runs yellow-green-cyan. 

This option has no effect when the two colors are black, white or gray. 

 ALT RAINBOW: Similar to rainbow except the blend is along the longest edge of the 

color wheel. For example, yellow to cyan runs yellow-red-magenta-blue-cyan. 

BITMAP NAME displays a pop-down menu showing thumbnails of all the bitmaps in the 

BITMAP GALLERY and is an easy way to select the required bitmap for a bitmap fill. 

FILL PROFILE - you can change the rate of the color transition between the start and end 

of fills. This applies to all fill types except flat, three color, four color and bitmap (unless 

it's a contone colored bitmap). 

To change the profile of a fill: 

1. Select the filled object. 

2. On the FILL Tool InfoBar click PROFILE. This opens the PROFILE dialog box. 

3. You either select a predefined profile from the dropdown list or drag the sliders to 

create a custom profile. The top option in the dropdown list (the straight line) 

creates a linear transition between the start and end of the fill. 
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Three different black-to-white graduated color fills and their corresponding profile dialogs. The 
center, default, is a linear black-to-white  transition. 

FILL HANDLE: Indicates if the start or end handle is selected. This field is blank for flat fills. 

RESOLUTION (bitmap and fractal fills only) Shows the resolution of the bitmap (as long as 

you don't have a fill handle selected). You can type in a new resolution to change the 

size of the bitmap. Low resolutions show the individual pixels of the bitmap. You rarely 

need a resolution greater than 150 DPI, even for typeset output. 

FILL HANDLE COLOR: (except bitmap fills) Indicates the color applied to the selected fill 

handle.  

Flat fills 

To apply or change a flat fill: 

1. Select flat fill from the fill type menu. 

2. Choose a color from the COLOR LINE. 

 

The Color Line is described in Color handling (on page 176). 

Linear fills 

To apply a linear fill: 
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1. Select linear fill from the fill type menu (not necessary if 

the object currently has a flat fill). 

2. Position the pointer where you want to start the fill (this 

can be outside the object). 

3. Drag the mouse pointer to where you want the fill to end 

(again, this point can be outside the object). 

 

The arrow drawn on the selected object is called the fill arrow. It indicates the direction 

and extent of the fill. You can select either end of the arrow by clicking it. 

Moving the start or end handle of the fill 

To change the direction and extent of the fill: 

 

1. Move the pointer over the handle you want to move. When over the 

handle, the pointer changes shape. 

2. Drag the handle. 

 

Changing the colors in a fill 

To change a color in a fill: 

 Drag & drop the color from the COLOR LINE onto a fill handle (you do not have to select 

the handle first.) 

 Or, drag & drop the color onto the object. Each fill has an imaginary center line halfway 

along the fill arrow. Dropping the color on the start handle side changes the start 

handle color, and the end handle side changes the end handle. 

 Or, if one of the end handles is selected (it's shown highlighted) just click on a color. 

You can press "Tab" to select the other fill handle, and click the color required for the 

other end 

The Color Line is described in Color handling (on page 176). 

Each method changes the color of one handle only; they do not change any other 

selected fill handles, or: 

1. Select the required handle (or handles, also works with multiple objects). 

2. Choose the required color from the Color Line. 

3. This changes all selected fill handles. 

Circular fills 

 

For circular fills, applying the fill, moving handles and changing 

colors are the same as for linear fills. The start handle is the 

center of the fill. 

Circular fills are useful for creating highlight effects. 
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Changing the height/width ratio of the object automatically changes a circular fill into an 

elliptical fill (see below). 

Elliptical fills 

 

Applying an elliptical fill is similar to applying linear fills. As you 

drag the mouse pointer, you first create a circle with two end 

handles. You can then drag the end handles to create a suitable 

ellipse. 

"+ drag" preserves the aspect ratio of the fill. "Ctrl + drag" constrains rotation to the 

preset constrain angles. Moving handles and changing colors are the same as for linear 

fills. 

A quick way to apply a elliptical fill: 

"Shift + drag" to create a elliptical fill. 

Bitmap fills 

 

 
Fill Type 

 
Fill Tiling 

 
Not used 

 
Bitmap name 

 
Resolution 

 
Not used 

The BITMAP GALLERY is described in THE BITMAP GALLERY (on page 363) in the Photo 

Handling chapter, for the FILL GALLERY see below (on page 267). 

Bitmap fills are one of the most powerful fill types. It allows any photo or texture to be 

used as a fill for any shape and you have direct immediate control over the size, angle, 

position and tiling. You can color bitmap fills. You can use any type of bitmap as a fill, 

including JPEG photos, and alpha-channel (semi-transparent) bitmaps. 

When you import a photo file into Xara Web Designer Premium (eg. a JPG or PNG file) it 

appears as a shape with a bitmap fill type. When such an object is selected the status 

line shows it as a “photo”, but it is just the same as a shape that has had the photo 

applied as a bitmap fill. 

To fill a shape with a bitmap or photo fill, do one of the following:  
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 Drag any bitmap from the BITMAP GALLERY or from your Windows File Explorer over 

any shape, hold "Shift" and drop, or  

 Drag any fill from the FILL GALLERY onto the shape (there is no need to hold "Shift" to 

drop in this case)  

 Select 'Bitmap' from the left side drop down menu of the FILL TOOLINFOBAR, and then 

select the required bitmap from the dropdown menu of bitmap names (this only shows 

bitmaps that are or have been previously loaded).  

You can fill an object with single or multiple tiles (repetitions of the bitmap image). 

   

Single tile (photo) Repeating tile Repeat inverted-the tiles fit together 
perfectly. 

The fill has three handles. Use it for Resizing and re-positioning bitmap fills. An 

alternative way to set the size of the bitmap is to type in a resolution into the InfoBar field. 

You first have to un-select the fill handle by clicking anywhere on the image away from a 

fill handle, then just type a new dpi resolution. 

Replacing Bitmap Fills 

If a shape already contains a bitmap, or is a photo, then you can just drag and drop a 

new bitmap from any source, such as Windows Explorer, and it will replace the existing 

bitmap. The new image is ‘best fitted’ into the shape so that it just fits in. Doing this will 

also replace all other instances of that photo on the current page if they are in the same 

SOFT GROUP. 

Holding down SHIFT while replacing a photo in this way causes the position, scale and 

rotation of the bitmap fill to be preserved. 

 

Bitmap coloring 

You can color any bitmap or photo fill by just clicking on a color on the COLOR LINE (make 

sure no fill handles are selected, by just clicking on the image). This will create a 

Contone (technically a Duotone) which uses colors between black and the selected color. 

Alternatively right click on the object and choose CONTONE > SET LIGHT COLOR or 

CONTONE > MAKE BLACK AND WHITE. You can also right click the color line and select 

either the 'SET CONTONE LIGHT COLOR' or 'SET CONTONE DARK COLOR'. 

So, for example, to make a picture black and white, just requires you to click on the 

White color patch on the color line. 
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To cancel any applied color, apply NO COLOR to either fill 

handle. This restores the bitmap to its original bitmap colors. 

The RESOLUTION box on the INFOBAR shows the resolution, which can be altered by 

moving the fill handles or typing in a value. 

Resizing and re-positioning bitmap fills 

If you hold down Shift and click and drag on a shape which already has a bitmap fill, a 

new bitmap fill is created centered on the click point. If you hold the "Ctrl" key down too, it 

limits the angle, so this makes it easy to create an upright bitmap fill. 

 

Once the fill has been created, you can drag 

anywhere on the image to re-position the fill inside 

the shape. 

 

When you mouse over the outer fill handles the 

mouse pointer changes into a “rotate” mouse pointer. 

Dragging on these  handles will stretch and rotate the 

bitmap fill with the current aspect ratio locked; hold 

down "Shift" while dragging to change the horizontal 

and vertical size independently and to skew the fill. 

The InfoBar shows you the resolution of the bitmap fill 

(you can adjust this, and thus the bitmap size, by 

entering a new value). 
 

Fractal fills 

Xara Web Designer Premium supports two types of fractal fill which are mathematically 

created naturalistic fill patterns. They are great for simulating sky and clouds or other 

natural textures. 

Each time you create a new fractal fill a new pattern is created. To replace an existing 

fractal with a new pattern choose fractal from the fill menu again. 

 

The GRAIN control on the INFOBAR 

provides control over the graininess of 

the pattern. Low values give a smooth 

flowing pattern, and high values give a 

grainy pattern. 
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You can adjust the size and position of the fractal fill in the usual way by dragging and 

adjusting the fill handles. De-select the fill handles (click on the fill away from a handle) to 

show the above resolution and grain controls. 

 

Fractal clouds fill. On the left a grain of 1, on the right a grain of 50.  

 

Fractal plasma fill. On the left a grain of 5, on the right a grain of 50. 

Note the difference between grain and resolution. Grain controls the flow of the pattern. 

Resolution sets the size of the fractal bitmap and how noticeable the individual pixels are. 

You can change the start and end colors of a fractal fill. Select the center or outer 

handles and then apply a color using either the Color Line or COLOR GALLERY.  To cancel 

any applied color, apply no color. 

Multi-stage color graduations 

Many of the graduated color fill types support multi-stage graduation fills, which means 

instead of just fading from one color to another, you can go through a number of different 

color fill stages. 

 

To add a new color stage to a graduation, select the Fill Tool so the fill arrow shows and 

then: 

 Either drag a color onto the fill arrow where required. 

 Or double click on the fill arrow to create a new fill handle, and now click a color or 

display the COLOR EDITOR. 

You can re-position the fill handles by dragging. 
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With one fill handle selected pressing "Tab" will select the next. If the COLOR EDITOR is 

open, this is updated to reflect the new fill handle 

To remove a fill stage handle, just click on it to select, and press "Del". 

The Fill Gallery 

The FILL GALLERY contains bitmap textures suitable for use as bitmap fills. Only when 

you use a fill is it copied into the document. 

To display the FILL GALLERY: 

 

To display the FILL GALLERY click its tab in the galleries bar to the right of the 

Web Designer Premium window. Or you can toggle display of the FILL GALLERY 

by choosing UTILITIES > GALLERIES > FILL GALLERY or pressing "Shift + F11". 
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IMPORT - imports the selected bitmap into the document. A copy of the bitmap then 

appears in the BITMAP GALLERY. You can also drag-and-drop the bitmap onto a blank 

part of the page. This is usually easier than clicking IMPORT. 

FILL - imports and applies the selected bitmap as: 

 A bitmap fill to the selected object (if any). 

 Or, if no objects are selected, it inserts the bitmap into the document as a new photo 

object. 

You can also drag-and-drop the bitmap onto an object to apply a bitmap fill.  
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There are some differences between either dragging a bitmap from the BITMAP or FILL 

GALLERY: When dragging bitmaps from the FILL GALLERY and dropping on shapes to 

create a bitmap fill, the fill will be tiled and the bitmap won’t be best-fitted into the shape. 

This different behavior to that seen when dragging from the BITMAP GALLERY is because 

normally textures are applied from the Fill Gallery and these should normally be tiled and 

not best-fitted. 

TRANSP - (transparency) imports and applies the selected bitmap as: 

 A transparent bitmap to the selected object (if any). 

 Or sets the current transparency attribute. 

GET FILLS - download free fills from Xara. 

BACKGROUND - set the selected fill as the page background. 

REMOVE - delete the selected fill or folder. 

DISC FILLS - add new fills from your hard drive or a CD. 

MORE - lets you select the size of the preview icons and whether full information about 

the bitmap is shown, as well as find and sort the fills. 

STOP DOWNLOADING - if you have a slow connection and find getting fills from the Internet 

too slow, you can stop downloading them and then resume later. 

Find & Sort are described in the Document handling (on page 82) chapter. 

Document handling (on page 82) includes general information about galleries. 
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Transparency 

Applying flat transparency 

It's called "flat" transparency because all parts of the objects have the same 

transparency, as opposed to graduated transparency. 

1. Select the object or objects 

2. Select the Transparency Tool ("F6") 

3. Drag the transparency slider on the InfoBar 

Xara Web Designer Premium provides live-preview. As you drag the transparency slider 

the objects on the document are changed so you can see the effect immediately. 

Applying graduated transparency 

Graduated transparency works in a very similar way to graduated color fills (on page 

257). You just drag on the objects in the TRANSPARENCY TOOL to create a fading 

transparency. You have a very similar range of transparency shapes, the simplest being 

linear, but you can also have circular or elliptical transparencies. To create a graduated 

fade: 

1. Select the object or objects 

2. In the TRANSPARENCY TOOL, drag across the objects to create a linear fade across 

the object. 

3. Select alternative transparency shapes from the dropdown menu on the InfoBar 

You can select and adjust the position and transparency strength using the handles 

shown on the object. 

Refer to Fills (on page 257) for more information on manipulating handles and the 

different fill shapes (in this case transparency shapes) 

Multi-stage graduated transparency 

Just as you can add multiple stages to a graduated fill, you can do the same with a 

graduated transparency. This allows you to fade, for example, from opaque to 50% 

transparent then back up to 25% transparent, back to opaque, etc.  

You can set the level of transparency at each stage, by selecting a handle and then 

adjusting the transparency slider. Add additional stages by double-clicking on the 

graduated transparency line then adjusting the slider.  

See the Fills chapter (on page 257) for more information on manipulating the handles. 
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Transparency types 

Web Designer Premium supports the main types of transparency used by many other 

applications and include the following types: 

Normal (Mix) 

The color of the object mixes with the color of underlying objects. The effect is similar to 

spraying a thin coat of color (or paint) over underlying objects.  

Multiply (Stained glass) 

The effect is similar to viewing underlying objects through colored glass. It is useful for 

the simulation of glass and selectively darkening objects. The colors of objects with 

Multiply applied are: 

 White - no effect on the colors of underlying objects. 

 Gray & Black - darkens the colors of underlying objects. 

 Other colors - darken underlying colors towards saturated color (light red over light red 

results in mid-red: green over red results in black).  

Technically the process is subtractive in RGB color space. 

Screen (Bleach) 

Screen has no clear analogy in the physical world. It is useful for highlights when the light 

source is not white. The color of the object with Screen applied: 

 Gray & White - lightens the colors in underlying objects. 

 Black - no effect on the colors of underlying objects. 

 Other colors - lighten underlying colors towards unsaturated color. (Light-red over 

light-red gives a pale-red: green over red gives yellow.)  

Technically the process is additive in RGB color space. 

For these transparency types, the slider controls the amount of transparency from 

opaque (0% transparent) to fully (100%) transparent.  

Applying a flat transparency to an object also applies transparency to the line around the 

object. It is not possible to set different transparencies, but you can remove the line by 

setting it to no color or by selecting "None" as the outline width. To create an object with 

a transparent fill and a non-transparent line, use a non-flat transparency type. 

For more information on colors see Color Handling (on page 176). 

Note that for legacy reasons, Web Designer Premium documents which contain older 

transparency types will still refer to those types by their original names, even though 

those types are no longer supported in Web Designer Premium.  Look for (old) in the 

transparency type list to identify them. 

Blends, Blend modes, Blending   
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Profile 

You can change the rate of change of transition between the start and end of 

transparencies. This applies to all single stage graduated transparency types except 

three point and four point (where the option is not available). 

To change the profile of a transparency: 

1. Select the object. 

2. On the TRANSPARENCY Tool InfoBar click PROFILE. This opens the PROFILE dialog. 

3. You either select a predefined profile from the dropdown list or drag the sliders to 

create a custom profile. The top option in the dropdown list (the straight line) 

creates a linear transition between the start and end of the transparency. 

 
The Transparency profile dialog 

 

Bitmaps 

BITMAP & FILL GALLERIES are described in Photo Handling (on page 363) and Fills (on 

page 267). 

When you select a transparency type of BITMAP, a default bitmap is initially used. Click 

on BITMAP NAME in the transparency InfoBar, or use the BITMAP or FILL GALLERIES to 

change the bitmap used (click the TRANSP button in the gallery or drag-and-drop from the 

gallery). 

By default, the lighter colors in a bitmap are the most transparent (you can, of course, 

alter the relative amounts of transparency later). 
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Handle/resolution 

If you have a handle selected, this box tells you what handle it is. With no handles 

selected, and when using a bitmap transparency, it controls the DPI. 

Applying transparency to several objects 

If you group objects and apply transparency, the whole group is treated as one object 

and the entire group is made transparent. But if the objects are not grouped and you 

apply transparency, each individual object is given a separate transparency and you get 

an entirely different effect when the objects are overlaid. 

 

Individual transparency (left) or group transparency (right) 

Mixing individual and group transparencies 

You can combine the methods above to create complex transparency combinations. For 

example you could set an object to 50% transparency, then group it and apply a 

transparency to the group as well. You are also able to apply a transparency to a group 

first, and then later apply attributes to individual objects within a group. Just hold down 

"Ctrl", click the individual object and change its attributes. 
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Shadows 

The Shadow tool 

 

The SHADOW tool (shortcut Ctrl+F2) lets you apply, remove, and modify semi-

transparent (or "soft") shadows.  

 

 
No Shadow 

 
Shadow Types 

 
Shadow Blur 

 
Shadow Transparency 

 
Shadow Position 

Xara Web Designer Premium has three shadow types: 

 Wall where the shadow is cast on a wall behind the object 

 Floor where the object appears to be standing upright on a surface. 

Glow where the shadow is used to add a halo effect around the object 

 

The transparency of soft shadows increases towards the edges, which gives a very 

realistic effect. Shadows are resolution independent so you can scale them without losing 

quality. 

Applying a shadow 

Applying a shadow 

To apply a shadow: 
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1. Select the object. 

2. Choose the SHADOW Tool. 

3. Select the WALL, FLOOR OR GLOW button on the 

SHADOW Tool InfoBar. 

4. You can drag the shadow away from or towards the 

object to create more or less distance between the 

object and the imaginary wall. 

 

 

Alternatively to create a wall shadow you can: 

1. Select the object. 

2. Choose the SHADOW Tool. 

3. Drag from the center of the object in the direction of the shadow. 

Applying a floor shadow 

1. Select the object. 

2. Choose the SHADOW Tool. 

3. Select the FLOOR button on the SHADOW Tool 

InfoBar. 

4. Drag towards or away from the object to change the 

size or radially to change the direction. 

 

 

 

Applying a glow effect 

Adding a glow or halo behind an object can create dramatic graphics. 

To create a glow effect: 

 

1. Select the object. 

2. Choose the SHADOW Tool. 

3. Select the GLOW button on the SHADOW Tool 

InfoBar. 

4. Drag towards or away from the object to change the 

size of the glow. 
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Blur the edges of the shadow 

 

This changes the size of the shadow. A small 

blur gives the effect of a sharp light source, a 

large blur, a diffused or distant light source. It 

is recommended that shadows are always 

blurred slightly as this is more realistic. 

To blur the shadow edge: 

1. Select the object 

2. Choose the SHADOW Tool. 

3. On the SHADOW Tool InfoBar either drag the blur slider or type a value into the text 

box on the right. 

 

Change the transparency of the shadow 

 

A semi-transparent shadow is more 

realistic than a solid shadow. But you can 

change the transparency level of the 

shadow to suit your needs. 

To change the transparency: 

1. Select the object 

2. Choose the SHADOW Tool. 

3. On the SHADOW Tool InfoBar, drag either the transparency slider or type a value 

into the text box on the right. 

 

Changing the shadow color or fill effect 

After applying a shadow to an object, you can change the shadow's color or fill effect. 

You can apply any of Xara Web Designer Premium's color effects including multi-stage 

fills. 

How to change the shadow color: 
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For more on colors and the Color Line refer to Color handling (on page 176). 

The easiest way is to drag & drop a color from the Color Line onto the shadow (make 

sure you drop the color onto the shadow and not the object). Alternatively - this method is 

slightly more complex, but you have full control over the color: 

1. Select the shadow using the SELECTOR Tool (make sure you select the shadow 

and not the object). 

2. Use the COLOR EDITOR to edit the color. 

Removing a shadow 

To remove a soft shadow: 

1. Select the object 

2. Choose the SHADOW Tool. 

3. Select the NO SHADOW button on the SHADOW Tool InfoBar. 

 

 

 

Applying a shadow to several objects 

The result of applying a shadow depends on whether the objects are grouped: 

 

 If the objects are grouped, 

overlapping shadows merge 

(they do not get darker if they 

overlap). 

 If the objects are ungrouped, 

each object has a separate 

shadow. Overlapping areas of 

shadow are darker. 

 If you have several shadowed objects selected, any changes apply to all the shadows. 

Selecting objects using the Shadow Tool 

Before you can apply or edit a shadow on an object, you must first select that object. The 

regular way of selecting objects is to use the Selector Tool but you can also use the 

SHADOW Tool, simply click on the object while in the SHADOW Tool. 

Copying shadows onto other objects 

Once you've got a shadow looking how you want it on one object, you can copy it onto 

other objects using "PASTE FORMAT/ATTRIBUTES". Simply copy the object that has the 

shadow ("EDIT" > "COPY"), select the object or objects you want to paste the shadow onto 

and choose "EDIT" > "PASTE FORMAT/ATTRIBUTES". 
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Bevels 

The Bevel Tool 

 

The BEVEL Tool (shortcut "Ctrl + F3") gives objects an appearance of depth 

instead of being flat on the page. 

Bevels are resolution-independent so you can scale them without losing quality. 

 

 
Bevel type 

 
Slider type list 

 
Slider and numeric value for selected parameter 

 
Outer bevel 

 
Inner bevel 

 
Join style 

You can apply bevels to most types of object. The exceptions are: 

 Part of a block of text (such as a single letter)-the bevel is instead applied to all the 

text. 

 To the curve in text along a curve. 

 Contoured objects. 

 Live effects (the bevel is applied to the object before the effect is applied if the effect is 

live, or to the bounding box of the effect if the effect is locked). 

Applying a bevel 

To apply a bevel to a single object: 

1. Select the object 

2. Choose the BEVEL Tool. 

3. Choose the bevel shape you want from the BEVEL TYPE list. Note that NONE 

removes any applied bevels. 

Applying a bevel to several objects 

The result of a bevel on several objects depends on if the objects are grouped: 



 

Bevels 279  
 
 

 

 

 If the objects are grouped, overlapping 

bevels merge together. The bevel color is 

the same as the rear-most object in the 

group. 

 If the objects are ungrouped, each object 

has a separate bevel. The bevel color is 

the same as the object color. 

 

Modifying a bevel 

You can change the angle and elevation of the light and change the shape, direction and 

size of the bevel edge. 

Bevel direction 

Bevels can be inside the object or outside. Outside bevels make objects larger; inside 

bevels do not change the object size. 

To change bevel direction: 

1. Select the object. 

2. Click either the INNER or OUTER button.  

 

Changing the bevel light source 

The bevel effect is created by a light shining across the object and highlighting the shape 

(profile) of the bevel. You can change the direction and height of the light and its strength 

(the contrast). 

Changing the light angle (horizontal direction): 

1. Select the object. 

2. Drag the arrowhead to change the position of the light source. 

You cannot move the center of the arrow, only the arrowhead. 

 

For precise angles, select LIGHT ANGLE from the SLIDER TYPE list. Then drag the slider or 

type into the text box. 

 

If you have several beveled objects selected, light angle changes all bevels. Dragging 

the arrow changes just the bevel (or bevels) to which the arrow refers. 
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Changing the light strength (contrast) 

To change the light strength: 

1. Select the object. 

2. Select CONTRAST from the SLIDER TYPE list. Then drag the slider or type into the text 

box. 

 

If you have several beveled objects selected, any changes apply to all the bevels. The 

colors used in the bevel affect the contrast. For example, strong (saturated) colors 

require more contrast than weak colors to get the same effect. For best results, you will 

probably have to adjust the contrast for each object. 

Changing the light elevation (vertical angle)  

This lets you move the light anywhere from immediately above the object (90º) to the 

side of the object (0º). 

1. Select the object. 

2. Select LIGHT ELEVATION from the SLIDER TYPE list. Then drag the slider or type into 

the text box. 

 

For rounded bevels we recommend a light elevation of 30º. At this angle the bevel blends 

smoothly with the object. 

Changing the bevel size 

How to change the bevel size: 

1. Select the object. 

2. Drag any of the outside arrows to enlarge the bevel. 

 

Alternatively: 

1. Select the object. 

2. From the SLIDER TYPE list choose SIZE. 

3. Either drag the slider or type a value into the text box. 

 



 

Bevels 281  
 
 

 

Changing the bevel shape 

1. Select the object 

2. Choose the BEVEL Tool. 

3. Choose the bevel shape you want from the BEVEL TYPE list. 

Changing the bevel color or fill effect 

After applying a bevel to an object, you can change the bevel's color or fill effect. You can 

apply any of Xara Web Designer Premium's color effects including multi-stage fills. 

For more on colors and the Color Line, refer to Color handling (on page 176). 

How to change the bevel color: 

 The easiest way is to drag-and-drop a color from the Color Line onto the bevel (make 

sure you drop the color onto the bevel and not the object.) 

Alternatively, this method is slightly more complex but you have full control over the 

color: 

1. Select the bevel using the SELECTOR Tool (make sure you select the bevel and not 

the object.) 

2. Use the COLOR EDITOR to edit the color. 

Changing the bevel join style 

 

After applying a bevel to an object, you 

can change the shape of the corners 

(joins). 

How to change the bevel join style: 

1. Select the object. 

2. Click the appropriate join button on the BEVEL Tool InfoBar. 

 

 

 
Miter 

 
Round 

 
Bevel 

 

Removing a bevel 

To remove a bevel: 
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1. Select the object(s) from which you want to remove the bevel. 

2. Choose the BEVEL Tool. 

Choose NONE from the BEVEL TYPE list. 
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The Mold Tool 

The Mold tool 

 

The MOLD Tool is used to distort shapes. It is used for both perspectivizing (that 

is, rotating in three dimensions) and enveloping (like distorting a rubber sheet). 

 

Mold tool InfoBar 

 
Mesh 

 
Remove mold 

 
Detach mold 

 
Rotate mold 

 
Copy mold 

 
Enveloping 

 Paste envelope mold 

 
Perspectivizing 

 
Paste perspective mold 

The InfoBar contains two sets of preset mold shapes. Just click a button to apply the 

preset mold. The left-hand button in each group is the default "no distortion" mold which 

you can then manually edit after applying it.  

Perspective 

 

The MOLDTOOL lets you perspectivize shapes to 

give an impression of depth. 

You can perspectivize all types of objects 

including text and bitmaps. Note that bitmaps 

lose perspective if you later blend them or 

convert them to editable shapes. 

1. Select the object or objects. 

2. Select the MOLDTOOL (shortcut "Shift + F6"). 

3. Choose one of the perspective options: 
 

The right-hand button (paste perspective) is described later. 
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Web Designer Premium draws a rectangle around the object or selection. You can drag 

the control handles at each corner of the rectangle to produce the perspective effect. 

You can rotate, resize and skew the perspectivized object using the SELECTORTOOL. 

You may want to move control handles without redrawing the perspectivized object 

(doing this speeds up screen redraws). 

 

To do this select the DETACH MOLD button. To refit the object, deselect the 

button. 

Using vanishing points 

As you reduce the size of the sides of the perspective mold, you see a "vanishing point" 

target. This is similar to vanishing points in conventional perspective drawings. 

 

You can use vanishing points to obtain consistent 

perspective for several objects. 

 

All three objects share a common vanishing point at the small cross. 

The perspective mesh 

 

This button paints a faint series of dots in a grid to preview the degree of 

perspective distortion of an object. 

Using molds 

You may want to apply the same perspective to several objects. To do this you create a 

mold shape, copy it to the clipboard and then use it to perspectivize the other objects. A 

perspective mold shape must have four straight sides: 

 

 

This is acceptable as a mold 
shape 

These are not acceptable. The object on the left has too 
many sides (must be four). The object on the right has 
curved sides (must be straight). 

Removing perspective 

 

Click REMOVE to remove perspective. 
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If the selected object has more than one perspective or envelope mold applied, only the 

most recent mold is removed. 

Rotating the object within the mold 

 

Sometimes you will find that the mold is the correct shape but the object needs 

rotating within it. You can rotate the object by clicking the rotate object button. 

 

Enveloping 

 

The MOLD TOOL lets you envelope shapes in a wide variety of ways.  

The effect is similar to a rubber sheet or balloon that you can stretch in any direction.  

You can envelope all types of objects except bitmaps. 

 Sample enveloped text 

Enveloping is similar to applying perspective. That is: 

1. Select the object or objects. 

2. Select the MOLDTOOL (shortcut "Shift + F6"). 

3. Choose one of the envelope options: 
 

The right-hand button is similar to paste perspective described earlier. 

The left-hand button does not initially alter the object. The other buttons immediately alter 

the object. 

After applying the mold, to edit it: 

1. Drag any of the corner handles. 

2. Or click on a corner handle and then drag the curve handles. 



 

 286 The Mold Tool 
  

 

 

The above example shows the 4 curve handles of the corners have been dragged 

outwards to bend the content of the mold. 

You can also rotate, resize and skew the enveloped object using the SELECTOR TOOL. 

The mold mesh button 

 

The Mesh button displays a series of faint dots which can help preview the 

distortions that the envelope mold is giving. 

Envelope molds 

You can create an envelope mold from any four sided shape, which you can distort as 

you require, and then use as an envelope mold by clicking the PASTE ENVELOPE button 

on the MOLD TOOL InfoBar. 

Editing mold shapes 

You can edit the contents of a mold (essentially a group) using editing inside groups. 

Editing is not possible using direct selection inside (molds do not allow objects inside 

them to become selected). To edit a mold inside, right click on the mold and choose 

OPEN MOLD from the context menu. 

You can edit the shape of envelope or perspective molds with the SHAPE TOOL (or the 

edit handles with SELECTOR TOOL, if shown). According to the nature of molds, there are 

some restrictions: 

 You cannot add point handles to a perspective or envelope mold, because it has to 

stay a  four-sided shape 

 You cannot change a straight line of a perspective mold into a curve. 
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Photo Regions and Masks 

In Xara Web Designer Premium the Mask tools are not presented on the main toolbar at 

startup. If you want to use these tools you can find them in the Button Palette. 

 

To open the Button Palette choose CONTROL BARS... from the WINDOW menu and scroll 

through the list to the bottom. Then click the checkbox next to the Button Palette item. 

(Or right-click on an empty area of any button bar and choose Button Palette from the 

pop-up menu.) 

 

If you want to use these tools regularly you can move them out of the Button Palette by 

dragging them onto the toolbar. (Hold down Alt, then drag the button and drop it onto the 

toolbar, over one of the existing icons). 

 

 

Masks vs Photo Regions 

A mask is used to protect part of a photo from a photo operation. For example when 

using the CONTENT-AWARE SCALE/ZOOM (on page 397) tool to stretch or zoom a photo, 

you often want to ‘protect’ part of the photo to stop it being distorted by the operation. 

You use a mask to mark that area of protection.  

Conversely the Photo Region tools are used to select areas of a photo upon which you 

wish to perform a photo operation. This might involve a Photo enhance operation to 

brighten or tweak the color of a particular area of a photo, or you might want to just 

perform a simple crop, or cut and paste part of a photo. 

Regions and masks are actually interchangeable and the difference between them is 

only really one of presentation. A region identifies the part of a photo you want to operate 

on, while a mask works the other way around and identifies part of an image you don’t 

want to operate on (the masked area is protected from the operation). And in fact if you 

have drawn a region using a region tool and you switch to the mask painter tool, the 

region becomes a mask. And similarly if you start with a mask and switch to a region tool, 

the mask becomes a region. 

Masks have the advantage of being able to show levels of ‘softness’ whereas regions are 

indicated only by a hard outline. So if, for example, you use the Feather Tool on a region, 

you won’t see any change to the region as you apply the feathering. But when you use 

that feathered region to enhance your photo, you’ll see that the enhanced area is indeed 

feathered. If you use a mask instead, the pink fill of the mask shape will show the 

feathering.  
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The Photo Region and Mask tools 

 

The mask drawing tools can be found on the mask tool flyout bar. 

 

The mask tool flyout bar 

 

The MASK PAINTER TOOL is the default mask tool and allows you to 'paint' over 

the area you want to mask. Choose an appropriate nib size from the InfoBar and 

create a mask shape by stroking over the object. Holding down the 'Shift' key 

together with the left mouse button will let you erase parts of the mask.  

 

Use the Freehand Mask tool to draw closed shapes around the areas or objects 

you want to mask in much the same way as you would a pencil. Like the 

Freehand and Brush tool the InfoBar also has a smoothing control and you can 

also hold down the 'Shift' key to erase your line as you draw. 

 

The RECTANGLE MASK tool lets you drag a rectangular mask area. You can 

modify your shape using the width and height settings on the InfoBar. 

 

Use the SHOW MASK OR REGION button to toggle the mask on or off. Turning off a 

mask/region in this way does not delete it, so you can get it back at any time by 

turning it on again, but while turned off it won’t affect any mask/region-aware 

operations.  

 

The INVERT MASK button inverts the masked area so masked areas become 

unmasked and vice-versa. 

 

Use the CLEAR MASK button to remove all the mask shapes. 

The INVERT and CLEAR functions also appear on the infobar. 

On the infobar there is also a toggle for turning mask/region outlines on and off. This is 

only normally useful when using these tools to edit regions inside Photo Groups. All it 

does is turn off the outline, so this toggle is Not the same as the SHOW MASK OR REGION 

button described above, which turns on/off the whole mask/region. See Photo Groups 

(on page 353) for details.  

 

For more information on the smoothing control feature see the Freehand and Brush tool. 

Editing a Mask 

In most cases you edit the mask by using the same mask tools described above. But the 

shapes that make up a mask are actually just ordinary shapes placed on a special ‘Mask’ 

layer, so in some cases it may be useful to edit the shapes on that layer. Use the PAGE & 
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LAYER GALLERY to access the mask layer. This is useful for the fine detail editing of mask 

shapes, or if you want to move the position of a mask, or else to create a soft mask. 

1. Click on the selector tool and open the Page & Layer Gallery. 

2. Click on the mask layer to unlock it. 

3. Select the mask shape you wish to alter and reposition/resize the shape as 

required. 

4. Double click the shape to edit the shape using the SHAPE TOOL. Or if you created 

the shape using the Rectangle Mask tool then a double click will enable editing with 

the RECTANGLE TOOL. (ON PAGE 153)  

 

Soft Masks 

A soft mask is a mask that includes varying levels of masking, instead of consisting 

simply of just masked parts and unmasked parts. For example part of an image may 

have a 50% mask applied, so that a subsequently applied operation has only a 50% 

effect on that part of the image. Or a mask shape could have a graduated mask that 

smoothly graduates from 0% masking to 100% masking. If such a mask is then used with 

the PHOTO ENHANCE TOOL to brighten the photo, the effect of the brightening would be 

similarly graduated. 

 

Creating a Soft Mask 

You can create soft masks by applying the Transparency tool to your mask shapes on 

the mask layer.  

Having firstly created your mask shapes; 

 Switch to the selector tool and open the Page & Layer Gallery 

 Expand the page to view the layers and click on the Mask layer to make it active 

 Click on the mask shape on the canvas and select the transparency tool 

 Drag across the mask shape to create a linear graduated soft mask 

Operations That Use A Mask 

Cut, Copy, Delete 

These operations are useful when used with masks, to cut pieces from photos, but you 

can use them on any objects.  

1. Select one of the mask tools from the MASK TOOL flyout bar and draw whatever 

mask shape you require. 

2. Now select an option from the EDIT menu to perform a Cut/Copy/Delete operation. 

3. The SELECTOR TOOL is automatically selected and the operation performed. 
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The rectangular mask  tool is used to create a mask (left). Cut or Delete removes the 
unmasked area of the Photo (right). 

 

On the left example the mask has been inverted. Now when you Cut or Delete the masked pink 
area is protected, everything else is deleted. 

 

Duplicate, Clone 

This will copy only the selected part of the drawing or photo. The Clone option places a 

copy exactly on top of the original. 

Content Aware photo scaling 

To protect part of a photo from being scaled; 

1. Select one of the mask tools from the Regions and Masks tools flyout bar and draw 

whatever mask shape you require around the area you wish to protect. 

2. Now go into the Content Aware photo scaling tool  (Photo tool fly-out bar on 

the main toolbar) and click on the photo. 
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See the Content Aware Scaling (on page 397) feature for more information. 

Photo enhance tool 

 

Use one of the Enhance tools to apply brightness, contrast, saturation, temperature and 

blur/sharpen changes to any part of a photo.  

1. Select one of the Region tools from the Regions and Masks tool flyout bar and draw 

whatever  shape you require around the area you wish to enhance. 

2. Now go into the Enhance Photos tool (Photo tool fly-out bar on the main toolbar) 

and click on the photo. 

3. Use the Enhance controls from the Photo tool InfoBar. 

Advanced users may wish to use Soft masks to introduce graduated effects to the photo 

enhance operation. See the Photo Tool and Photo Handling chapters for more 

information. 

Combine Shapes 

There are a set of operations under the "ARRANGE" > "COMBINE SHAPES" menu that allow 

you to combine shapes in a number of different ways. You can also use these with the 

region tools. 

For example to slice a piece of a photo out (cookie cutter style),  

1. Select one of the regions tools from the PHOTO REGIONS AND MASKS tools flyout bar 

and draw whatever shape you require. 

2. Select "ARRANGE" > "COMBINE SHAPES" > "SLICE". 

 

Copying Shapes To The Mask Layer 

You may prefer to draw mask shapes using the ordinary drawing tools instead of the 

mask tools, or to use an existing shape on your mask layer. This is particularly useful 

when working with soft masks, where you are applying levels of transparency to the 

mask objects. In the SELECTOR TOOL, select the shape, and copy, or cut it. Now switch 

into one of the mask tools and PASTE. Use PASTE IN PLACE if you want the shape to 

appear in exactly the same place it was copied/cut from. 

To copy shapes from the mask layer to any other, do the reverse. Select the shapes 

while in a region or mask tool, then switch to the SELECTOR TOOL, and paste. 
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Web Properties Dialog 

The Web properties dialog is a multi-tabbed dialog which allows you to add and configure 

most of the web related features in Xara Web Designer Premium and set different web 

properties on objects, on pages and on your whole website. Open it by right clicking an 

object and choosing WEB PROPERTIES or by using the “UTILITIES" > "WEB PROPERTIES…” 

menu option (shortcut Ctrl + Shift + W). 

Each tab of the dialog is also directly accessible using the buttons on the Web Properties 

flyout bar, available on the Website toolbar. 

 

 
Link Tab 

 
Website Tab 

 
Page Tab 

 
Image Tab 

 
Mouse-over properties (on page 454) (part of the Web Animation dialog) 

 
Placeholder Tab 

 Web Animation dialog (on page 454)  

 
Web Sticky/Stretchy dialog  

 
Publish Tab 

 
Analytics Tab (on page 316) 

 
Edit NavBar 

The dialog is modeless, so you can leave it open while you select different pages and 

objects in your document. This makes it easy to quickly set properties on different objects 

and pages in your website. Use the OK button to apply your changes and close the 

dialog, or the APPLY button to apply your changes without closing. 

Note that when you have an animation design as your current document, the WEB 

PROPERTIES dialog appears in a modified form, with some controls different and many 

others disabled because they don’t apply to animations. Refer to the Animations for 

information about using this dialog with animation designs.  

The following sections cover each tab of the dialog in turn.  
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Link Tab 

 

 

The settings on this tab apply to the selected object(s) or selected text. Typically you use 

this tab to add a link to an object on your web page (eg. a button or photo), or to some 

text, so that when a visitor to your site clicks on the object/text, they are redirected to 

another page. You can add links to other pages in your website, to a URL (web address) 

or even cause a pop-up window to appear.  

To add a link to just some of the words in a paragraph of text, go into the TEXT TOOL and 

drag over the text you want to link, to select it. Then set up the link in this tab. 

The main section of this tab allows you to choose what should happen when the selected 

object or text is clicked. 

Link to web address 

Enter a web or email address to link to that address. If you leave the “CORRECT ADDRESS 

AUTOMATICALLY”  checkbox selected, your address will be adjusted if required when you 

click OK or APPLY. For example, if you enter "www.Xara.com" it will correct it to 

"http://www.Xara.com/". 
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You can put an email address in the Link address field, in which case clicking the link will 

launch the reader's email program with the To: field filled in. You can also optionally 

specify the subject line to be used, add CC or BCC email addresses to be copied on the 

email and even specify the default body text to be used. For example this sets the To 

email address and all four optional parameters: 

yourname@wherever.com subject:Email from website cc:another@wherever.com 

bcc:yetanother@wherever.com body:Auto-generated email 

Technical note: Xara Web Designer Premium encodes your email address to reduce the 

likelihood that SPAM robots will find your email address from the web page. This requires 

Javascript to be enabled in the browser (currently >95% of browsers). 

Link to... 

Select this option to link to another page in the current website, or if you are in a 

presentation document, to link to the next or previous presentation step. The drop-down 

list allows you to select which page or step to link to. You can also choose this option to 

link an object to the top of the page - creating a rapid jump from the bottom of a long 

page to the top. 

TIP: If you have many pages in your website document, giving each one a name makes 

it much easier to set up and maintain your page links, because the page list will show the 

page names instead of just “Page 2”, “Page 3”, etc.  

 
See the PAGE TAB (on page 302) section below for details of how to setup page 

names, or edit the names in the PAGE & LAYER GALLERY. 

In addition to an entry for each page in your site, the dropdown list also contains the 

special entries NEXT PAGE/PRESENTATION STEP, PREVIOUS PAGE/PRESENTATION STEP and 

TOP OF PAGE .  

Next/Previous page 

Use these to add a link which leads to the next or previous page in your site. For the 

purposes of such links, the page order is determined by the order of the pages as they 

appear in Xara Web Designer Premium. A “next” link on the last page links to the first 

page and a “previous” link on the first page links to the last page. 

Next/Previous presentation step 

Use these to add a link which leads to the next or previous presentation step in your site, 

if your website is a presentation document. The presentation order is also determined by 

the order of the steps as they appear in Xara Web Designer Premium, similarly to 

next/previous page. 

Top of page 
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If you want to link back to the top of a particularly long page - create an object at the 

bottom of your page (typically a button or a text object) and then select the "TOP OF 

PAGE" link option. The link will then take you straight up to the top of the page. 

Link to anchor 

This option allows you to jump the visitor to a specific part of any page in your website.  

To setup an anchor point, first go to the page and object you want to be jumped to. 

Select the object and add a name to it by right clicking and choosing the NAMES... option. 

Then select the object to which you want to add the link and choose the anchor name 

you added from the list provided with the “Link to anchor” option. 

Note that when you link to an object which is a long way down a web page, the web 

browser automatically scrolls the page down so that your anchor object is visible. 

NOTE: You cannot apply a transition to a link to an anchor. 

 

Link to heading 

Link automatically to any of the headings within the document. This saves you the bother 

of having to trawl through a long document when you want to link to a particular section.  

Click on the dropdown to see the list of headings. Then choose the heading you want 

your selected text or object to link to from the list. Bear in mind that the heading must 

have a heading text style (on page 240) assigned for it to appear in the list.  

The list is divided according to pages, and then subsequent headings with each heading 

occupying an indented position according to its outline level.  

Link to File 

This link option is useful if you want to add a document, movie or any other file to your 

website to make it available to your visitors. For example you may have a PDF document 

that you want to make available. 

Select the object or text that you want to link. Then turn on this Link to file option  and 

use the BROWSE button to browse for the file on your computer. The name of the file 

appears in the text field to the left of the Browse button. Click OK and your link is applied. 

As well as applying the link, Xara Web Designer Premium has now taken a copy of your 

file and placed it in the support folder for your design. This is a folder next to your .web or 

.xar file. If your design is called "MySite.web", the support folder will be called 

"MySite_web_files" alongside it. All the files in the support folder get published along with 

your website and so that means your file will be published with your website and so the 

link you just added will work. See the Document Handling chapter (on page 75) for more 

information on support folders.  
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Note: Because there is a separate copy of your file held in the support folder for your 

design, you need to update that copy whenever you modify the file and want to publish 

the modified version. Or you can just go through the above linking process again and 

browse for your updated file. Also if you move or copy your website design to another 

computer, or give a copy to someone else, you need to make sure the support folder 

accompanies the design file, since it now contains an important part of your website!  

NOTE: You cannot apply a transition to a link to a file. 

Pop-up layer 

You can add any content you like to a separate layer on your page and have that content 

shown as a pop-up only when your visitor clicks on a link. For example you could add 

some descriptive text about a photo on your web page and have that text only shown to 

the user if they click on the photo. 

To add a popup layer, first you need to add the layer itself using the PAGE & 

LAYER GALLERY and add your pop-up content to that layer.  
 

See the PAGE & LAYER GALLERy (on page 444) chapter for full details. Then you can 

select the layer from the layer list provided next to the “Pop-up layer” option. 

You can also add a transition effect which is applied when the layer appears. In the PAGE 

& LAYER GALLERY, open the layer properties so that you can apply a transition directly to 

a layer (on page 59) to achieve an animated effect when the layer contents appear. Or 

you can click the Settings button next to the pop-up layer option in the Link tab, to access 

the same layer properties. 

Now when a visitor clicks on your object, the layer contents appear! By default, clicking 

anywhere else on the page makes the pop-up disappear again. But you can make the 

pop-up layer stay up until it’s explicitly closed by the viewer. Just unselect the CLOSE 

POP-UP AUTOMATICALLY checkbox in the Layer properties dialog. Then a close button is 

included in the top right of the pop-up, and it stays on screen until the close button is 

pressed. 

Note that you can also get to the Layer properties by clicking the "Settings…" button next 

to the pop-up layer option in the Link dialog. 

Note that all the content on the pop-up layer is loaded as soon as the visitor visits your 

page. So if you want to provide a lot of pop-up photos, use the Pop-up Photo feature 

described below instead. 

 

Pop-up photo 

This option gives you a very easy way to add pop-up photos  and other photo gallery 

features to your website, without adding any layers! Simply import your photo and use 

the SELECTOR TOOL to scale it right down so it appears as just a small photo thumbnail 

on your webpage. Then select it and choose this "POP-UP PHOTO" option. 
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Click the SETTINGS button next to this option to go to the IMAGE TAB, where you can set 

the size of the pop-up photo, add a title and caption, and choose from many other 

options. See the Image tab section below (on page 304) for details. Selecting the pop-up 

photo option on this Link tab, also selects the pop-up photo checkbox on the Image tab – 

both turn on the same pop-up behavior. 

Use common website link colors 

This option lets you choose how the selected text link should be displayed. It is selected 

by default, meaning that the text link will show with the link color you have defined for the 

whole website. You can set this color on the Website tab (see Website Tab (on page 

298) section). 

If you uncheck this option, then the selected text link will keep the color that you give it on 

the page. So you can give different links different colors if desired. 

Open link in 

This option does nothing if either of the “Pop-up layer” or “Pop-up photo” link options are 

selected. But for other links it allows you to tell the web browser how the target web page 

should be loaded. By default it is set to “Not specified” which usually means the browser 

will open the link in the same browser window and frame as the link. 

The dropdown list contains four options that cause the browser to do special things. You 

can select one of these options, or type in the name of a frame: 

NEW WINDOW OR TAB (_BLANK) Open the link in a new browser window. 

SAME FRAME (_SELF) Open the link in this frame (the frame that contains this object). 

PARENT FRAME (_PARENT) Open the link into the parent window or frameset that contains 

this frame. 

SAME WINDOW (_TOP) Open the link into the main browser window, replacing any existing 

frames. 

If you want the link to be loaded into a specific frame in the browser, type the name of the 

frame in this field.  

Clickable area 

This option lets you specify what area of the object must be clicked on to invoke the link. 

However it is not supported for HTML websites (the rectangle surrounding the object is 

always used), it works only when exporting to Flash.  

SHAPE OF OBJECT: The user must click inside the exact outline of the object to invoke the 

link.  

RECTANGLE SURROUNDING OBJECT: The user can click anywhere in the rectangle 

surrounding the object (the bounding box) to invoke the link.  
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Website Tab 

 

 

The settings on this tab apply to the entire current document/website, so it doesn’t matter 

what object or page is selected. 

TITLE, DESCRIPTION & KEYWORDS: These fields are just as described in the Page Tab (on 

page 302) section. You can optionally set these fields here so that they apply to every 

page in your site, unless overridden by the Page Tab settings for a page. So for example 

a page that doesn’t have its own title set in the Page Tab will get the title you specify 

here. 

HTML CODE (HEAD) AND HTML CODE (BODY): These buttons serve the same purpose as the 

HTML code (head) and HTML code (body) buttons in the Page Tab section, and allow 

you to enter and edit large amounts of HTML code to either the head or body sections of 

all your website pages.  
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If code is specified here in the WEBSITE TAB it is included in every page of your site in 

addition to any code specified for each page in the Page Tab. This allows you to have 

some code included on every page, while also adding other code to those pages that 

need it. 

Website Link Colors 

This section of the Website Tab allows you to control how text links appear on your 

website. 

UNDERLINE TEXT LINKS: Underlining is commonly used to highlight clickable links in text, 

so this option is selected by default. Uncheck it if you don’t want your text links 

underlined. 

MOUSE OFF: Here you can choose the color you would like to be used for all your text 

links. You can either choose a named Theme Color from the dropdown list (if there are 

any in your current document) or click the Edit button to open the Color Editor so you can 

choose any other color. 

MOUSE OVER: Text links will change to this color when a visitor moves the mouse pointer 

over them.  

VISITED: Text links that point to a page which the visitor has already visited will display 

with this color instead of the Mouse Off color. 

Clip to page edges 

This option is enabled by default. If you have objects in your website that overlap the web 

page borders, click this checkbox to crop these objects so that only the portion on the 

page is visible. Deselect this checkbox if you would like the object to flow over the page 

edge, so that even the portion that overlaps the pasteboard is displayed.  

Note that if you have an invisible page (the default for new web documents, or if you’ve 

applied ‘no color’ to your page), clipping to the page edge does not happen even when 

this option is turned on. 

Presentation website 

Click the PRESENTATION WEBSITE checkbox to convert an existing website into a 

presentation.  

Note: If you created your presentation document by choosing  PRESENTATION 955 PIX 

from the NEW menu, the PRESENTATION WEBSITE check box is automatically selected. 

Note: If you have transitions applied to a layer or presentations step transitions that slide 

in from the sides, top or bottom of the page, disabling this checkbox causes the transition 

to come in at the edge of the browser window, rather than the page edge. 
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Retina (enabled by default) 

When this option is on, Web Designer Premium will export high resolution versions of 

each image in your website, in addition to images at normal screen resolution. This 

means devices with very high resolution screens will see higher quality images.  

See High Resolution Images (on page 351) for more information. 

Web Export Options 

The WEB EXPORT OPTIONS dialog allows you to choose how you want your website to be 

published. You can choose between exporting your website as a CONVENTIONAL WEBSITE 

(with a separate HTML file for each page), where you click through the pages using 

conventional navigation, or a SUPERSITE (the whole site in a single HTML file) which lets 

you present your website with animated transitions between pages, or as a vertical or 

horizontal arrangement of pages, which users can swipe through on mobiles and tablets.  

The default setting for the dialog is CONVENTIONAL WEBSITE. 

Find the options under "UTILITIES" > "WEB EXPORT OPTIONS". Or else right click on your 

page and open the WEB PROPERTIES dialog and then click on "WEBSITE" > "WEB EXPORT 

OPTIONS" 

. 

For the SUPERSITE options check the button and make your choices. You can select 

either the VERTICAL or HORIZONTAL scrolling options, or the PAGE TRANSITIONS. 
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If you choose a VERTICAL or HORIZONTAL scrolling option you can specify the space 

between individual pages in units of pixels (1 to 1000px with a default distance of 8px). 

The little preview windows will reflect your choice giving you an idea of the final output. 

To apply a page transition select PAGE TRANSITIONS and then choose a TRANSITION 

EFFECT from the dropdown menu. You can control the speed of the transition and also 

have the pages SCALE TO FIT SCREEN so that they automatically resize to fit the browser 

window. The transition effect you choose here will apply to all pages in your site. Again, 

the little preview window will update to reflect your choice. 

If you want to add a specific transition to an individual page then go to the PAGE tab of 

the Web Properties Dialog and apply the transition there. Transitions set at the Page 

level take precedence over those set for the whole site in WEB EXPORT OPTIONS. 

Scale To Fit Options 

 The SCALE TO FIT SCREEN option works well for short pages and where all the 

pages of your site are the same height and width. If you use this option with 

long pages, the result is not good because the browser will shrink the page so 

that its height fits into the height of the device/browser. 

 As an alternative use the SCALE TO FIT WIDTH option to make your website or 

web document scale to fit the width of the browser or device screen it's being 

viewed on.You can specify a maximum width to avoid your content looking too 

inflated on very large screens. If the viewing device is wider than the page, the 

page zooms/scales up so it just fits. If the viewing device is narrower than the 

page, the page content zooms/scales down so it will fit with no need for 

horizontal scrollbars. 

 The SCALE TO FIT WIDTH option can be used with any type of document or 

website - either CONVENTIONAL or SUPERSITE except when either the 

HORIZONTAL SUPERSITE or SCALE TO FIT SCREEN options are selected. 

You need to preview your site in a separate web browser to see the transition animations 

perform well - rather than just using the built in browser preview window which does not 

show the animations smoothly. Click on the Preview website button on the web toolbar, 

and then click on one of the browser icons at the top right of the preview window to see 

the transitions in a separate web browser that you have on your device. 
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Page Tab 

 

 

The options on this tab apply to the current page, not to the selected object(s). The 

current page is indicated with black angle lines just outside each corner of the page. All 

fields on this tab are optional; you do not necessarily need to fill in these fields for every 

page of your site.  

If you want the same title, description and keywords on every page of your site, you can 

set these just once on the Website tab instead of setting them on every page here. 

PAGE FILENAME: Use this field to set the name you’d like to be used for this page when it 

is exported. So if you want the page to be exported as “home.htm”, set this field to 

“home”.  

It’s usual to make the first page of a website “index.htm” or “home.htm”, because if a 

visitor specifies a URL consisting of just a domain name with no page name (eg. 

“www.xara.com”) this is usually automatically mapped by the web server to the index.htm 

page if it is present. Note that characters entered in this field are automatically converted 

to lower case and accented characters and some non-alphanumeric characters are not 
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allowed. This is to reduce the chances of compatibility problems with different web 

servers when you publish your website. 

PAGE TITLE: You can optionally choose a title for your page. If set, this is used by web 

browsers to show a page title in the browser window frame, or tab. For example at the 

time of writing the www.xara.com home page has the title “Graphics Software by Xara” 

which you can see is shown by the web browser if you visit the site. 

Advanced: The title is inserted into the page header using the ‘<title>’ HTML element. 

PAGE DESCRIPTION: This page description text can be shown by search engines within 

their search results when visitors find your page with an internet search. The page 

description may also be displayed by browsers and other web services. 

Advanced: The description is inserted as metadata into the page header  

(‘<meta name="description" …..). 

PAGE KEYWORDS: Here you can enter keywords which you want to be picked up by 

search engines to help visitors find your site. Enter words which potential visitors are 

likely to search for if they are looking for pages or sites like yours.  

For those familiar with HTML, the keywords are entered into the page header as 

metadata:- 

Advanced: The keywords are inserted as metadata into the page header  

(‘<meta name="keywords" …..). 

HTML CODE (HEAD): Click to open the HTML Code (head) dialog, where you can paste or 

type HTML code directly into the head of your web page. The code is inserted 

unmodified just before the closing “</head>” tag.  

HTML CODE (BODY): Click to open the HTML Code (body) dialog, where you can paste or 

type HTML code directly into the body of your web page. The code is inserted unmodified 

just before the closing “</body>” tag.  

These dialogs must be used with care because inserting invalid code or script into your 

page may cause serious problems to the web page as a whole.  

If you need to insert exactly the same code on every page of your site, you can use the 

HTML code (head) and HTML code (body) buttons on the Website Tab of this dialog, 

instead of entering it for every individual page using the Page Tab.  

TRANSITION EFFECT: You can only enable individual page transitions if your page is part 

of a SUPERSITE. See the WEB EXPORT OPTIONS dialog on theWEBSITE TAB TO TURN ON 

THIS OPTION. ONCE YOU'VE DONE THIS CHOOSE AN INDIVIDUAL PAGE TRANSITION FROM THE 

DROPDOWN MENU. (on page 298) 
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SPEED (SECS): Drag the slider to choose a transition speed from 0 to 5 seconds. 

By default when a transition is applied, objects will only slide in/out to the edge of the 

web page. If you would like objects to start from the browser window edges, rather than 

the web page edges, deselect the CLIP TO PAGE edges checkbox in the Website tab (on 

page 298) of the Web Properties dialog. 

Note that the individual transitions you set here at the page level take precedence over 

the global transition settings in the Supersite settings.  

Technical Note: Page transitions work by first loading the target page into a hidden 

iFrame and then revealing that iFrame with the visual effect. Then the target page is 

loaded again normally. This second load of the target page is usually not noticeable, but 

depending on the speed of the viewer’s machine and the browser version they are using 

(particularly older browsers), sometimes the page is seen to flash briefly at the end of the 

page transition. 

Image Tab 
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Photo pop-up 

This section of the IMAGE TAB lets you add pop-up photos and other photo gallery 

features to your web page easily.  Simply import your photo and use the SELECTOR TOOL 

to scale it right down so it appears as just a small photo thumbnail on your webpage. 

Then with the photo still selected, select the Pop-up photo checkbox on this tab. Choose 

the size you would like for the pop-up photo by entering a value in the pop-up width field 

(default 500 pixels). Preview your page and click on the photo thumbnail on your page, to 

see the pop-up photo appear. 

When you turn on the pop-up photo feature here in the IMAGE tab using the checkbox, 

the corresponding option on the LINK tab is also automatically selected for you. That’s 

because a click on the photo will show the pop-up photo, so you can’t also set any other 

clickable link on the same object. So any link you previously setup on the object, using 

the Link tab, will be removed. 

One big advantage of these photo pop-ups over pop-up layers (as described in the LINK 

Tab section above) is that the large photo is only loaded by the web browser when the 

visitor clicks on a thumbnail. Therefore this method is much more suited to presenting a 

large number of photos on a gallery page, because only the small thumbnails are loaded 

initially, making the page load quicker. 

Note that this feature works on objects other than photos, such as shapes and groups, 

but can’t be used directly on text. You can put text inside a group (Ctrl+G) to work around 

this restriction. 

Pop-up title 

Give the selected photo a title using this field and it is shown above the pop-up photo. 

Note that you also need to turn on this title option in the Pop-up photo options dialog (see 

below), because titles are not shown by default. 
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Popup Photo Options 

Click the OPTIONS button to bring up the POP-UP PHOTO OPTIONS dialog. Here you can 

choose from a variety of options that change the way your pop-up photos are presented. 

 

Popup Options 

The following options change the appearance of the popup photo. 

DIM PAGE WHILE POPUP IS OPEN: With this option selected, the entire page is dimmed 

whenever a popup photo is displayed. This helps emphasize the popup  photo, so that it 

stands out against the darker background of the page. 

SHOW SHADOW BEHIND POPUP: This option puts a drop shadow behind the popup photo 

window, again to help make it stand out against the page background. 
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SHOW IMAGE TITLE: If you have entered title text (see above) for each of your photos, this 

option causes that title to be above the popup photo.  

 

Note that title text is separate to any caption text, which appears below the photo. See 

below for information on setting caption text.  

Gallery Options 

The following options turn on gallery features for your popup photos. 

SHOW GALLERY BROWSER CONTROLS: Turn this on to show gallery controls on your popup 

photo.  

 

This appears on top of your photo whenever the mouse pointer is over the photo. It 

allows your site visitor to view the other popup photos in the current page, without having 

to close the popup window and click on the thumbnails for the other photos. The visitor 

can move to the previous or next photo, or start and stop an automatic slideshow where 

each photo is shown for a few seconds before moving onto the next. 

SHOW THUMBNAIL STRIP AT BOTTOM OF PHOTO: With this option on a strip of small photo 

thumbnails appears below the popup photo window. This allows the visitor to jump to any 

of your popup photos by just clicking on the thumbnails in the strip, again without having 

to first close the popup photo window. 
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AUTOMATICALLY START SLIDESHOW: Turn this on if you want a slideshow to start as soon 

as the user clicks on any of your popup photos. You can also choose how many seconds 

each photo should be displayed for when the slideshow is playing. 

Note that the only photos included in the photo gallery are those photos on the current 

page which are setup as popup photos. Any other photos on your page will not appear in 

the gallery, so make sure you use the Link tab of the Web Properties dialog to turn on the 

popup photo option on any photos that you want to be included in the gallery. 

Image Captions 

You can optionally show a caption below each pop-up photo. Enter the caption text in 

this field in the Image Tab. 

Note that this feature works on objects other than photos, such as shapes and groups, 

but can’t be used directly on text. You can put text inside a group (Ctrl+G) to work around 

this restriction. 
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For those familiar with HTML, this text is also used as the "ALT" text on the image that is 

exported for the currently selected object, whether or not the image also has a pop-up. 

Web browsers show this text on the page in place of the image, if the image can’t be 

obtained for some reason. 

Web image type 

Due to the nature of HTML websites, most objects you see and can select on the page in 

Xara Web Designer Premium have to be converted to bitmap images during the process 

of exporting your website. This all happens automatically for you when you preview and 

export, but the controls on this tab give you some control over how these images are 

created.  

Remember that each group, shape, heading, logo, photo, panel background, etc. is 

exported as a separate image. By looking at how the objects in your design are grouped, 

you can control how many images are exported to make up your website. So for example 

if you have 2 separate shapes in your design which are not grouped together, they will be 

exported as 2 separate images. You can group the two shapes (Ctrl+G) and then a 

single image is exported instead. 

This section of the Image Tab lets you specify how the currently selected object should 

be exported as an image. By default Xara Web Designer Premium will decide for you. 

This means that normally photos will be exported as JPEG  (which is usually the best 

format for photos) and other objects as PNG (which is usually best for graphics). Photos 

which have been rotated on the page, or which have a semi-transparent shadow applied, 

are exported as PNG because JPEG does not support transparency. 

You can force the selected object(s) to export as a JPEG or as a PNG, by selecting the 

appropriate option. When the JPEG option is selected, you can also choose the JPEG 

quality to be used for that image. Higher quality means a larger JPEG file size. 

Group images 

By default, existing groups and new groups are set to SEPARATE IMAGES FOR GROUP 

MEMBERS and the group members will export individually as if they were not grouped at 

all.  

This is especially useful for groups containing text, so the text remains as text in the 

published site. 

You will also be able to set properties on the objects inside the group. You can use 

Ctrl+click to select objects inside the group and then apply links, reveal animations, etc. 

to the group objects. 

It’s not advisable to use this option on very complex groups such as artwork that is made 

up of tens or even hundreds of vector shapes. It’s more efficient for such groups to 

export into the website as a single image using the ONE IMAGE FOR WHOLE GROUP option. 

But for simpler groups such as a group of photos, it’s best if they are set to export 

separately because then each object can have its own individual settings. For example 

each photo could be set to be a popup, or have its own reveal animation.  



 

 310 Web Properties Dialog 
  

 

 

Use the ONE IMAGE FOR WHOLE GROUP option when you want grouped objects to be 

exported as a single image in your published website. For example if you group a photo 

with its caption text, the whole group appears as an image in your website, so the text is 

not selectable in the web browser. 

 

Mouse-over properties (Web Animations) 

 

Mouse-over properties are part of the WEB ANIMATIONS dialog. When you click this icon 

the Mouse-over tab of the Web Animations dialog opens allowing you to specify what 

should happen when a visitor moves the mouse pointer over the selected object. So for 

example you can animate the mouse-over with a wide range of effects, pop-up some text 

or a whole layer of content when a visitor hovers their mouse pointer over a photo or 

other object on your web page.  

See Web Animations (on page 454) for more details. 
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Placeholder Tab 

 

 

The Placeholder tab is used to add and edit manually editable widgets. These are 

widgets you insert onto your web page by manually pasting in HTML code for the widget 

or by importing a Flash or movie file. You won’t normally need to use the Placeholder tab 

on widgets that you’ve added from the ONLINE CONTENT CATALOG, because the code and 

files that make those widgets function are handled for you automatically. See the 

Website Widgets (on page 436) chapter for full details.  

To turn any normal object into a placeholder for a widget, select it and then open this tab 

of the Web Properties dialog. Choose whether you want the widget to be based on a 

piece of HTML code you’ve obtained from a widget website, a Flash file or a graphic file. 

Browse for the file or paste in the HTML code. Click OK and now your object is a 

placeholder object. 

This means the object represents the dimensions and position of the content you’ve 

added, but in your exported web page the object is replaced by the actual code or file 

that you inserted.  
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However there is an easier way to add files or code to your site. Simply drag and drop 

Flash or animated GIF files from Windows File Explorer onto your page. A placeholder 

image is automatically generated for you and is placed on your page. A copy of the file is 

added to the support folder of your design so that it gets exported and published with 

your site. When you export and publish your site, the placeholder image is replaced by 

the actual file you imported.  

Similarly if you’ve copied some HTML code from a third-party widget website, you can 

simply paste that code into Xara Web Designer Premium (make sure you are in the 

SELECTOR TOOL when you do this, not the TEXT TOOL or it will be inserted as text!). Xara 

Web Designer Premium detects the HTML and uses it to render a placeholder image 

which appears on your page. You can also add a placeholder for HTML code directly into 

either the body or head of a page by clicking the HTML code (body) and HTML (head) 

buttons, which bring up a scrolling dialog where you can paste or edit large amounts of 

code, if necessary.  

When you export/publish your site the placeholder is replaced by the actual code so that 

your widget functions. See the Website Widgets chapter (on page 436) for more details.  

Replace with Flash 

Select this option to replace the placeholder object with a Flash animation. Use the 

Browse button to locate the Flash (.swf) file you want to use.  

The chosen file is automatically copied to the support folder for the current design, so 

that when you export your website the file will be included in the _htm_files folder along 

with all the generated images for your site. See the Document Handling (on page 75) 

chapter for information about support folders. 

 

Replace with graphic file 

Select this option if you want to insert a graphic or image into your website in place of the 

placeholder object (eg. a PNG, GIF or other web compatible image file). Use the Browse 

button to select the file. 

The chosen file is automatically copied to the support folder for the current design, so 

that when you export your website the file will be included in the _htm_files folder along 

with all the generated images for your site. See the Document Handling (on page 63) 

chapter for information about support folders. 

 

Replace with HTML code 

With this option you can paste HTML code which you’ve obtained from somewhere else 

into the head and/or body sections of your page; i.e., between the <body></body> tags 

or <head></head> tags. For example many sites provide widgets that you can add to 

your page by pasting the HTML in here. Follow the instructions given by the provider. In 

most cases you need to add body code only, but some widgets also require you to 

include some code in the head, which is why the head code option is also provided.  

As mentioned above, you can just paste the HTML code directly onto your page instead 

of inserting it in this dialog (while in the SELECTOR TOOL). And using that approach 
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automatically gives you a placeholder image that looks just like the actual widget, so it’s 

the recommended way to insert widget HTML code. 

Warning: You need to be careful to insert only code which you know is safe and from a 

trustworthy source. Invalid or broken code will affect your published web page because 

Xara Web Designer Premium simply inserts the code as you provide it, unmodified and 

unchecked, into your page when it is exported. 

If the HTML code that you enter references external files which are expected to be found 

in your website, then you need to copy those external files into the support folder for your 

design. See the Document Handling (on page 63) chapter for information about support 

folders. Once in the support folder, the files will be automatically copied to the _htm_files 

folder of your website when you export. Therefore you also need to make sure that any 

references to these files in the HTML code references them at the right location.  

Let’s take a simple example to make this clearer. Suppose I want to insert a small piece 

of HTML code which adds an image to my website. The HTML code I add will need to 

reference the image file somewhere. First I copy the image file, say "myLogo.gif", into the 

support folder of my document. If the document is "mySite.web", the support folder will 

be "mySite_web_files". I know that when I export this website, It will export it to the name 

"index.htm" because the default name for the first page of the web site is always 

index.htm regardless of the name of the .web file. This means that all the generated 

images for my site, and a copy of "myLogo.gif" which I put in the support folder, will be 

exported to the folder "index_htm_files". Therefore I must make the HTML code I’m 

inserting reference the image file in that location. So I may insert:- 

<img src="index_htm_files/myLogo.gif" /> 

Note that this references the image file in the exported image folder location (_htm_files), 

NOT directly in the support folder (_web_files), because only the exported image folder 

gets copied to the web server along with my web page when the site is published. 

Of course if I really only wanted to put an image on my website, it’s much easier to just 

import the image into Xara Web Designer Premium directly! But this is a simple example 

that shows how to add HTML code which references an external file. 

Check Embedding YouTube, Flash And Other Widgets (on page 27) for more examples! 

Adding code to page head 

Some code needs to be inserted into the head (<head> tag) section of the exported 

HTML code, instead of to the body (<body> tag) section as it is by default.  

To do this, click the HTML code (head) button in the Placeholder, Website or Page tab of 

the Web Properties dialog and type in or paste your code. 

Placeholder objects 

The placeholder object is actually included in your website and it can be shown to the 

visitor in some circumstances. For example if you’ve added a Flash animation, if the 
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visitors to your page do not have Flash installed in their web browser, or if they’ve 

disabled Flash, the browser will show the placeholder image instead.  

Therefore it’s sometimes a good idea to make your placeholder object more than just a 

black rectangle, or an accurate image of the widget that appears on your page. You may 

decide to use a group as your placeholder object, where the group includes a text 

message asking the visitor to install Flash so that they can see your Flash content. 

REGENERATE PLACEHOLDER IMAGE AUTOMATICALLY: If this option at the bottom of the 

PLACEHOLDER TAB is selected, then the placeholder image gets automatically generated 

from the content you have added, whenever the content changes or when you resize the 

placeholder object.  

When you paste code or import files directly onto your page, as recommended above, 

this option is selected automatically for the placeholder image that gets generated. 

Sometimes it’s useful to turn it off after inserting content this way, if you are happy with 

the preview image and no longer want it to be re-generated if you change the content in 

some way. 

Web Animation 

 

Click on the WEB ANIMATION icon to bring up the Web Animation dialog. Web Animations 

allow you to take an object in your web document and quickly create an animated 

response to a prompt like a mouse-over, a mouse-click or a screen touch. You can 

trigger pop-up layers or pop-up text. You can have objects reveal themselves as you 

scroll down a page and also control all these animations with a wide range of effects. 

See Web Animations (on page 454) for more details. 

Web Sticky and Stretchy Objects 

 

Click on the WEB STICKY AND STRETCHY OBJECTS icon to bring up the Sticky and Stretchy 

objects dialog. The dialog allows you to select objects which will remain at a fixed 

position on your browser window (Sticky). You can also configure objects to stretch the 

width or height of the window (Stretchy). 

See Web Sticky and Stretchy Objects for more details. 

Publish Tab 

The PUBLISH tab of the WEB PROPERTIES DIALOG is where you configure or change the 

settings which allow you to publish your website to the internet. However you don’t need 
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to visit this dialog before doing a publish – the publish operation will prompt you to enter 

the required details, if you haven’t specified them already.   

 

 Click a SETTINGS button to configure settings for either MAGIX ONLINE WORLD or OTHER 

WEB HOST (VIA FTP). 

 Click the SAVE PROFILE button to save the current details shown to a profile. 

 Check the FAST PUBLISH (ONLY CHANGED FILES) box to republish only new files to your 

website 

 Check the SAVE PUBLISH SETTINGS IN DOCUMENT box if you want to retain the FTP 

details for this particular document. 

 Check the SAVE PASSWORD IN DOCUMENT box to store the FTP password with the 

document (not recommended for normal use and not available for MAGIX ONLINE 

WORLD) . 

For full details on publishing your website see the main Website Publishing (on page 

340) chapter. 
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Analytics Tab 

 

 

Google Analytics Tab with some sample tracking code. 

The Google Analytics tab gives you a quick and easy way to add tracking code to your 

webpages allowing you to monitor your website's traffic using Google's reporting tools.  

You need to have an account with Google to use the Analytics features - click the 

"ANALYTICS WEBSITE" button to visit the site and create an account if you don't already 

have one, or to administer an existing account. 
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Follow the simple instructions to get your tracking code and paste it into the Analytics 

Tab and you will then be able to track data via the Google Analytics website for your 

published site. 
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Responsive web design 

About RWD 

With the increasing use of mobile devices for internet access there is an increasing 

demand for website design tailored to mobile and tablet screen formats. 

Although modern mobile devices such as phones have excellent web browsers able to 

view any website, a mobile-optimized website should not require zooming to view the 

text. So typically this means the main content would be a single column, in a larger point 

size to be readable at a glance on a phone. Mobile websites often have reduced content, 

and are navigable with single finger operation to scroll and navigate. 

While you could create two separate websites, one designed for narrow screen mobile, 

another for traditional wider desktop screens, replicating the content across two separate 

websites would be tedious and time consuming, especially if you had to do this every 

time you updated the text or images. 

So Responsive Web Design is a technique that means your websites respond 

dynamically to the screen size. Instead of having two separate websites, that is two 

separate HTML pages, you instead have one web page that can vary its layout, 

depending on screen size (and resolution) of the device being used to view the website. 

 

Two variants of the same website. the first is how it looks on a wide screen display, the second 
is for narrow screens such as mobile devices. The text column is narrower, and the pictures 
and page elements re-arranged to suit a narrow screen. 



 

Responsive web design 319  
 
 

 

Responsive ‘Retina’ or HiDPI Resolution Control 

Mobile and tablet devices differ from most desktop web browsers in that they support far 

higher resolution graphics.Web Designer Premium supports this completely 

automatically, and will produce both normal resolution and Hi-DPI or Retina resolution 

images for all graphics and photos. The website then intelligently uses the correct 

version of the image depending on the resolution of the browsing device. 

Older browsers such as IE8 and earlier do not support RWD, so these will only show the 

main variant of your website. 

Multiple variants 

Traditionally creating RWD sites can involve complex Javascript programming. But since 

Web Designer Premium is a ‘zero programming’ designer focused tool, the user still has 

all the power of freeform layout, ‘anything anywhere’ web design - and can also create 

multiple variants of the same website. You can create one variant designed for narrow 

screen mobile devices, perhaps another layout for intermediate small screen tablets, and 

another variant for a traditional wide screen desktop. 

The important thing is that the content - that is the text, the pictures, the graphics and 

color schemes, are shared between all the variants. The second important point is that 

the multiple layout variants for each page are not separate HTML files, but are all part of 

one HTML file, that can dynamically and instantly change from one layout to another 

depending on the browser width. 

For each variant you produce you can customize the layout as much as you want. You 

can resize and reposition elements on the page and these remain shared between the 

variants. Edit the text for the narrow mobile variant and the text is updated for the other 

variants. You can also choose to update the Text Style of a variant and have the 

changes apply to that variant only. Or you can decide that you want different content or 

graphics on one variant - mobile variants usually have reduced content.  

When you add or delete a page in one variant, it automatically creates or removes the 

page in the other variants. So your website always has the same page arrangement in all 

variants. 

Web pages have to be named in order to be shared across variants, if the page is not 

named then one will be automatically applied. 

Creating RWD Websites from templates 

By far the easiest way to start using variants is to use one of the website template 

designs from the ONLINE CONTENT CATALOG - Just import the website template to open it 

and begin editing.  

When you open a template you will see two document tabs, one will be the main website 

document, referred to as the Main variant, and the other, narrower template will be the 

Mobile variant. Web Designer Premium shows each variant in a separate tab, so you 

can quickly and easily switch between the variants. You might find it helpful to organise 
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your web documents using the "WINDOW" > "ARRANGE VIEWS" menu option to line up 

your variants next to one another.  

Creating RWD Websites from existing sites 

To create a variant of an existing website you will need to open the WEBSITE VARIANTS 

dialog - any of the following steps will do this: 

 Click "UTILITIES" > "WEBSITE VARIANTS" >"WEBSITE VARIANTS".  

 Right-click on the document tab and select "WEBSITE VARIANTS" to open the dialog and 

also to view your variants. 

 Right click anywhere in the document work area and select "WEBSITE VARIANTS" > 

"WEBSITE VARIANTS" to view the dialog. 

 

Website variants dialog 

Click the CREATE button and choose a design width in pixels. The two variants above 

describe webpages of 760 pixels for the larger Main variant, and a Mobile variant which 

has default pixel width of 480 pixels. What happens is that a visiting web browser with a 

width of 620 pixels or greater will see the Main variant, whilst a browser with a width less 

than 620 pixels will see the Mobile variant.  

You can view and edit the dimensions of the existing variants by clicking on the 

PROPERTIES... button. 

When you create a new variant, all the content of the main website appears, mostly 

unchanged, but the page size has changed and the page background is adjusted. It’s 

now up to you to re-arrange the layout as you wish for this new variant. You can move 

items around the page freely, reduce the width of text columns, resize and re-position 

images, and you have to do this for all the pages of your variant website. 

You can change the title and the pixel width of a variant at any time by clicking on the 

PROPERTIES and then UPDATE buttons in the dialog. 

Note: The ‘breakpoint’ between two variants is half way between the widths of the two. 

So in the above case for browser widths less than 620 it will show the narrow one and 
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widths above that it will show the wider one. Also note because most mobile devices 

always try to fit the browser content into the screen, it doesn’t matter that your page is 

wider than their screen pixels - it will be scaled down to fit by the browser.  

Sharing across variants 

When you create a new variant, most of the content is shared or Liveshared across all 

variants, but the size and position of that content is local to each variant. 

 If you edit the text it will be changed in all variants.  

 If you change the size of objects the change will apply to one variant only (it’s likely 

that you will want objects to have different positions and sizes on the different 

variants).  

 If you drag and drop a photo onto an existing photo, it will be replaced in all variants.  

 If you edited the shape of the photo or cropped it, or changed the fill (image size, 

rotation or position inside the picture frame) then these are local to each variant. This 

is useful because it means you can not only change the size and position of photos on 

the variants, but change their aspect ratio and image crop. 

Click on an object to see if it's Liveshared or not. 

 

This photo has a double line marker, 
top right, which indicates it’s 
‘Liveshared’ on one or more variants.  

You can resize, crop and adjust the 
fill as required, and that will stay local 
to each variant. but if you swap the 
picture, say by dragging a new one 
on top, then all variants will change. 

When you create a new object - say a text area, photo or graphic, it's not initially shared 

between variants. If you want to share it use the "UTILITIES" > "WEBSITE VARIANTS" menu 

or just right click on it, and select "WEBSITE VARIANTS" > "SHARE WITH ALL VARIANTS". 

Select "STOP SHARING WITH VARIANTS" if you don't want an object to be shared across 

variants. This menu also gives you the option of deleting the object from all variants.  

Technical note: If you have different variants of photos, say a different size, crop or fill 

position, then Xara has to create multiple versions of the photo for the published website. 

However this does not have a significant performance overhead (it doesn’t slow down 

your website), as the web browser loads the correct version initially, and then, in the 

background, downloads the other variant images. So this means the initial version you’re 

looking at (be in the mobile or desktop version) will always downloaded as fast as it can, 

but that if you do change your browser width or orientation, it will instantly switch to the 

other version. 
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Variants and repeating objects 

When repeating objects (on page 124) like navigation bars, headers and footers appear 

in variants they cannot be shared across the variants. Instead each variant has its own 

separate repeating set of objects.  

 

Variants and Navigation bars 

It’s likely that you will want a different Navigation bar design or layout on a narrow 

variant. NavBars in each variant are independent, so you can customize them as 

required, including changing the design of the bar by importing a NavBar design from the 

ONLINE CONTENT CATALOG and dropping it on the existing bar in the variant you want to 

change. You might for example want a horizontal bar for wide websites and a vertical 

one for narrow devices.  

One space-efficient solution for NavBars on a narrow mobile-friendly site variant is to 

have just a single button NavBar with a menu of links to the other pages in the site, 

instead of a bar with a button for each page. See Single button NavBars (on page 417) 

for more detail. 

Variants and Fit to Width websites 

The FIT TO WIDTH ("UTILITIES" > "WEB EXPORT OPTIONS") option allows your website or 

web document to scale to fit the width of the browser or device screen it's being viewed 

on. If the viewing device is wider than the page, the page zooms/scales up so it just fits. 

If the viewing device is narrower than the page, the page content zooms/scales down so 

it will fit with no need for horizontal scrollbars. 

Depending on the design, the FIT TO WIDTH option may make having multiple variants 

unnecessary, or at least reduce the number of variants required, because your content 

will scale to fit the device it's being viewed on. But since variants allow the page layout to 

be changed too, they are still almost always essential. For example just scaling down 

your website / document may make text too small on a small device, if the text doesn't 

occupy the full width of the page. 

However the good news is you can use both features, VARIANTS and FIT TO WIDTH, 

together. The closest matching variant will be selected automatically, as usual, 

depending on the user's device width. But additionally the content will be scaled to fit the 

device width exactly. This gives a smoother transition between one variant and the next. 

See Web Export Options for more detail. 

 

mk:@MSITStore:C:/Xara/DESIGN~1/HelpAndSupport/ENG/XaraX.CHM::/8289.htm
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Publishing variants 

Publishing your site with variants is easy and no different to publishing an ordinary 

website.  Your website is able to automatically determine the resolution of the viewing 

device and then serve the appropriate variant based on its width.  

You can test this by changing the width of your web browser when previewing your site – 

make it narrow and you should see it switch instantly to show the mobile variant of your 

site.  
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Supersites 

About Supersites 

Modern web browsers support many advanced HTML5 and CSS3 effects, allowing much 

more dynamic and visually exciting websites to be created.  

Supersites use these effects to allow you to add dynamic animated page transitions and 

display options to your webpages as a user clicks through the navigation on your 

website. 

Supersite animations are hardware accelerated, which is supported by almost all modern 

browsers, including those on phones and tablets, to ensure a fast and smooth animation.  

Whilst Supersites are not appropriate for large or complex websites, they are especially 

suitable for smaller sites, or for web documents, presentations and anywhere where a 

slideshow style of content might be called for. Presentations (on page 425) are always 

published as supersites. 

Vertical or horizontal display options allow the viewer to scroll through the pages using a 

mouse, or else swipe through pages when using a tablet or other mobile device. The 

pages are presented as a single scrolling list. Alternatively a selection of Page 

Transitions offer a large range of transitions to choose from.  
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Enabling Supersites 

Open the WEB EXPORT OPTIONS dialog to view the SUPERSITE options. "UTILITIES" > "WEB 

EXPORT OPTIONS".  Or else right click on your page and open the WEB PROPERTIES dialog 

and then click on "WEBSITE" > "WEB EXPORT OPTIONS". 

 

Select the SUPERSITE option and make your choice. You can select either the VERTICAL 

or HORIZONTAL scrolling options, or the PAGE TRANSITIONS.  

If you choose a VERTICAL or HORIZONTAL scrolling option you can specify the space 

between individual pages in units of pixels (1 to 1000px with a default distance of 8px). 

The little preview windows will reflect your choice giving you an idea of the final output. 

To apply a page transition select PAGE TRANSITIONS and then choose a TRANSITION 

EFFECT from the dropdown menu. You can control the speed of the transition and also 

have the pages SCALE TO FIT SCREEN so that they automatically resize to fit the browser 

window. The transition effect you choose here will apply to all pages in your site. Again, 

the little preview window will update to reflect your choice. 

If you want to add a specific transition to an individual page then go to the PAGE tab of 

the WEB PROPERTIES DIALOG and apply the transition there. Transitions set at the Page 

level take precedence over those set for the whole site in WEB EXPORT OPTIONS. 
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Scale To Fit Options 

The SCALE TO FIT SCREEN option works well for short pages and where all the pages of 

your site are the same height and width. If you use this option with long pages, the result 

is not good because the browser will shrink the page so that its height fits into the height 

of the device/browser. 

As an alternative use the SCALE TO FIT WIDTH option to make your website or web 

document scale to fit the width of the browser or device screen it's being viewed on.You 

can specify a maximum width to avoid your content looking too inflated on very large 

screens. If the viewing device is wider than the page, the page zooms/scales up so it just 

fits. If the viewing device is narrower than the page, the page content zooms/scales down 

so it will fit with no need for horizontal scrollbars. 

This option can be used with any type of document or website - either CONVENTIONAL or 

SUPERSITE except when either the HORIZONTAL SUPERSITE or SCALE TO FIT SCREEN 

options are selected. 

You need to preview your site in a separate web browser to see the transition 

animations perform well - rather than just using the built in browser preview 

window which does not show the animations smoothly. Click on the Preview 

website button on the web toolbar, and then click on one of the browser icons at 

the top right of the preview window to see the transitions in a separate web 

browser that you have on your device. 

 

 

Browser icon selection in the Web Preview window. 

 

"Single page website" "Scrolling website" 
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Web Sticky and Stretchy Objects 

Sticky Objects 

Some websites have items on the page that stick on screen, and float over the page that 

scrolls below, often navigation controls, or social network icons. These tend to be stuck 

to the top edge of the browser window, sometimes to the left or right edge, and can’t be 

scrolled out of the window. The benefit of sticky objects is that they are always visible. So 

you can, for example, have direct access to page navigation without having to scroll up 

the page.   

You can make most types of object "sticky" whether it's a graphic, a bitmap (photo) or a 

text object. And you can also add animations to your sticky objects. See Web animations 

(on page 454) for more detail on this. 

 

External links positioned as a sticky object on the far right of a browser window. 

 

To make an object sticky or stretchy, first select it, and then click on the icon 

on the WEB PROPERTIES (on page 292) flyout  

 or choose the menu option "UTILITIES" > "WEB STICKY/STRETCHY..."  

 or  just right-click on it, and choose WEB STICKY/STRETCHY... from the dropdown menu. 
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This will bring up the WEB STICKY/STRETCHY OBJECT PROPERTIES dialog. You can toggle 

the function on or off using the checkbox. 

 

Sticky Object Properties dialog 

Stick at top 

STICK AT TOP objects start off on the page and scroll with the page just like all your other 

page content. But if you scroll the object’s position out of view, the object sticks to the top 

of the browser window and so stays in view. Therefore it’s great for navigation bars.  

Sticky 

For other STICKY objects - in the top half of your page, the distance between the object 

and the top of the page determines the distance from the top of the browser window in 

the published page. So if you place the object 20px from the top of the page, it will be 

stuck to the browser window always 20px from the top, as the main page content scrolls 

below it.  

If the object is closer to the bottom of the page than the top, then it gets stuck to the 

bottom edge of the browser window instead. So again, placing the sticky object 20px 

from the bottom of the page will make it stick 20px from the bottom of the browser 

window. 

All sticky objects that you place on the page (or even just partially overlapping the page) 

will be centered horizontally in the browser window, so they will always appear on the 

page no matter how wide the browser window is, because the page is also centered in 

the browser window. If instead you want the object to stick to the left edge of the browser 
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window, place the object off the page to the left. Similarly if you want it to stick to the right 

edge of the window, place it off the page to the right. 

This is an illustration of items placed on and around the edge of a typical page. 

 

The label text describes where an item placed at that location on the page, will appear on the 
browser window. 

And this is how that page will appear in the browser window. 

  

Sticky items normally float on top of the rest of the page, so would normally be arranged 

to be at the front of all the page content. However you can also have sticky objects 

behind your page content if you place them on the Pasteboard Background (on page 

337) layer.  
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Preview the position of your sticky object in the on-board web browser by using one of 

the web preview buttons.   

 

Stretchy Objects 

Stretchy objects help to create ‘pageless’ designs where there is no obvious page 

boundary, where page backgrounds cover the entire browser window and stretch to fill 

the browser width. The stretchy feature is designed to work only with rectangles and 

photos and is unlikely to work usefully on any other shapes. You can make any rectangle 

or rectangular image stretch to fill the browser window, either horizontally or vertically, 

using the Stretchy dialog (the same dialog as the Sticky controls). These stretchy items 

are normally intended as page backgrounds and so they appear behind everything else 

on the page. You may even want to put them on one of the background layers (on page 

333). 

To create a Stretchy Object...  

 Draw a rectangle on the page or select a rectangular image - typically you would make 

this as wide or wider than the page and placed behind all other objects.   

 Select the menu "UTILITIES" > "WEB STICKY/STRETCHY" or the equivalent option on the 

right-click context menu 

 Select the FULL WIDTH option.  

As with Sticky objects you will need to preview the position (on page 24) of your stretchy 

object in the on-board web browser before you can see your changes. You will see it 

covers the entire width of the browser window. 

 

Sticky/Stretchy properties dialog 
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You may also want a sticky object to be full width or full height, so stretchy objects that 

are also sticky appear in front of your main page content. For example you may want a 

sticky header across the top of your web page, with a sticky navbar on top of it... 

 

Both of these browsers have "stretchy" content which fills the width of the browser window. 
The header/navbar is also "Sticky"  as well as "Stretchy"  and so the page content will slide 
underneath it as it remains visible. 

Stretchy objects can be set to either SCALE or TILE, using the option on the dialog. In 

most cases you will want the stretchy object to scale up and down to fit the browser 

window, so choose the scale option. This works well with photos and solid filled 

rectangles.  

If you have a rectangle with a textured fill you will normally want this to tile rather than 

scale, so the texture looks the same with any browser window size. So select the tile 

option in such cases. Also if you have a vertical graduated fill, choose the tile option. 

Scaling Photos 

You can make an image stretchy to occupy the full width of the browser window. In this 

case the image will scale up as you increase the browser width, but it does so within the 

height of the existing image (so it doesn't’t grow vertically and thus push everything else 

down as you make the browser wider).  This means that the image is progressively 

cropped vertically, as it grows horizontally (the aspect ratio of the photo is never altered 

as that would look poor).  

If you want to use a photo as a stretchy item, make it at least the full width of the page, 

and on the STICKY/STRETCHY dialog select FULL WIDTH.  You can then decide whether 

you want the image to scale around the top, centre or bottom of the image using the 
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controls provided. The FULL HEIGHT stretchy works exactly the same way, but for vertical 

stretched images (a lot less useful). 

A Full width image can be scaled from the Top, Center or Bottom of the image. 

A Full height image can be scaled from the Left, Center or Right of the image. 

Resolution note: The photo needs to be a hi-res image (on page 351) because it’s going 

to get stretched to fit the browser width - and that could easily be an HD screen size of 

nearly 2000 pixels across. So using a low or even medium resolution image will result in 

a blurred image when scaled to maximum width. 

Sticky objects, Sticky animations, Stretchy animations, Stick at top, Scrolling navigation 

bars,  

  

Sticky and Stretchy object combinations 

The table shows which object types work with which Sticky and Width/Height (stretchy) 

combinations. 

Object Type 

 

Sticky Width/Height 

Text Yes No 

Images (including groups) Yes Yes 

Placeholders/Widgets Yes No 

Text Panels Yes No 

Soft Groups Yes Yes 

Stickies N/A Yes 

Full width/height Yes N/A 

Page Background layer objects Yes Yes 

Pasteboard Background layer objects Yes Yes 

Reveal Object Animations Yes No 

Scroll Object Animations No Yes 

Navbars Yes No 

Objects on Pop-up layers Yes Yes 

 

Important: A few of the version 10 gallery widgets are incompatible with the new sticky 

and animation features, if used on the same page or in the same supersite, and so may 

need to be replaced with updated versions from the ONLINE CONTENT CATALOG. Click 

here http://support.xara.com/index.php?/Knowledgebase/Article/View/816/ for details on 

the support site.  

 "Sticky object combinations" "Stretchy object combinations" 

http://support.xara.com/index.php?/Knowledgebase/Article/View/816/
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Website Backgrounds 

Most of the page designs in the ONLINE CONTENT CATALOG have two types of 

background. A wide Pasteboard background that extends across the background of the 

whole browser window when your site is exported. And on top of this sits the Page 

background with the various other elements that constitute the web page.  

By default the ONLINE CONTENT CATALOG web templates have a Main variant and a 

Mobile variant contained within the same web document.  
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Pasteboard/browser background 

 
Page background  

Setting the Page and Pasteboard background colors 

When you create a new blank document ("FILE" > "NEW") the page defaults to being 

transparent (no color) so you just see the pasteboard color behind it which is white by 

default. This page area is where you place all the elements of your website. You will also 

see a faint rectangle guide outline which shows the boundary of the page against the 

pasteboard. You can turn this guide off should you wish - by right clicking on the page 

and de-selecting "PAGE BACKGROUND" > "SHOW PAGE SIZE".   

If you drag a color from the Color Line over the pasteboard, and drop it, the entire 

background will be set to that color. This is because the page background in its default 

state is transparent, thus reflecting the underlying color of the pasteboard. And this is 

exactly what you will see in the web browser when you preview your page. 
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However you can also make the pasteboard one color, as described above, and then set 

the page background to a different color. Just drop a color onto the page background to 

set its color.  Now when you preview your page you’ll see the browser window 

background color is set to the pasteboard color and you can see the page background 

rectangle with its own color. 

 

You can use the color editor to edit these colors. Right click on thepage and choose 

"Page background" > "Edit page color" to bring up the color editor, then you can 

edit the page color. To edit the pasteboard background color, right click on the 

pasteboard and choose "Pasteboard background" > "Edit pasteboard color". 

To reset the pasteboard background back to its default white color right click on the 

pasteboard and choose "PASTEBOARD BACKGROUND" > "RESET". To reset the page 

background to its default clear or transparent state right click on the page background 

and choose  "PAGE BACKGROUND" > "RESET". 

If you have more than one page in your website document and you want to apply 

background and pasteboard colors globally, that is to every page in your website 

document, then you can do this easily. Right click on either the pasteboard or the page 

background and choose COPY PASTEBOARD BACKGROUND or COPY PAGE BACKGROUND 

and then choose PASTE PASTEBOARD/PAGE BACKGROUND ON ALL PAGES.  
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Template Backgrounds  and re-coloring backgrounds 

Xara Web Designer Premium allows you to import a range of pre-designed website 

backgrounds directly from the ONLINE CONTENT CATALOG to your web document. Choose 

from the selection of backgrounds in the WEBSITE BACKGROUNDS section of the gallery. 

You can then customize the textures with your own colors by dragging colors from the 

color line onto the background or  using a right mouse click on the background to bring 

up the "PASTEBOARD BACKGROUND" > "EDIT PASTEBOARD COLOR" menu to display the 

color editor.  

When you change the color of a background that is composed of a range of colors you 

will notice that Web Designer Premium will ask you which color it is you want to change. 

These might be named colors - as would be the case if you were working from one of the 

ready-made website template themes or colors that you had previously named yourself, 

or they might be local colors which would be the case if you were changing your own 

choice of color from an earlier selection. See Replacing Colors (on page 184) for more 

details.    

Note that when you drag one of the stock website backgrounds onto the Pasteboard 

Background it replaces all other objects currently on the Pasteboard Background layer 

and so in this respect is a destructive operation.  

 

 

Fixed, non-scrolling backgrounds 

Normally if you have a long web page that can be scrolled in the browser, the browser 

background scrolls with it, so the page content remains in the same place relative to the 

background. But you can ‘fix’ the background so it doesn’t scroll with the page content. 

Right-click on the pasteboard and select "PASTEBOARD BACKGROUND" > "FIXED". Then 

when you preview, the content slides over the fixed background as you scroll (to see this, 

make sure your page is long enough so the browser shows a scroll bar!). 

To switch back to the default, scrolling, behavior, select "PASTEBOARD BACKGROUND" > 

"SCROLLING". 

Using photos as backgrounds 

Creating photo backgrounds. 

If you want to create your own photo or texture bitmap backgrounds rather than 

customize the ready-made backgrounds from the ONLINE CONTENT CATALOG then it's 

easy to do.  
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First, import the photo or texture into your document, just as you would to place it on a 

page. Then right click on the photo and choose either SET PAGE AS BACKGROUND or SET 

PASTEBOARD AS BACKGROUND, depending on which you want to set. 

Tiling 

Depending on the nature and size of the image, you may or may not want the image to 

be ‘tiled’ repeatedly to fill the background. To change this setting, right click on the page 

or pasteboard background (again depending on which you want to change) and select or 

unselect the ‘tiled’ option in the Page Background / Pasteboard background sub-menu. 

Fill browser window 

When using a photo on the pasteboard background (which becomes the web browser’s 

background), there is a further option. You can opt for your photo to change size 

depending on the size of the visitor’s browser window. As the browser window is resized, 

the photo resizes to match. Right-click on the pasteboard and turn on "PASTEBOARD 

BACKGROUND" > "FILL BROWSER WINDOW". 

Page and Pasteboard Background Layers 

If you open the PAGE & LAYER GALLERY  you will see both the PAGE BACKGROUND LAYER 

and the PASTEBOARD BACKGROUND LAYER. These layers hold the objects that make up 

the two backgrounds in your document. 

These layers are normally locked, so you can’t select and edit their contents. But you can 

unlock them in the PAGE & LAYER GALLERY in order to perform some limited editing in 

order to customize your page or pasteboard backgrounds. Just click on the lock symbols 

next to the layers to unlock them. Once unlocked, you can make a background layer 

current (so new objects are drawn on it) or edit the objects on them just as for normal 

layers.  

If for example you had chosen a different color for your page background, you’d see a 

rectangle become selected (look at the status bar!) when you clicked on your page 

background. You can now do some limited editing of this rectangle, such as give it a 

graduated fill using the FILL TOOL, or give it rounded corners using the RECTANGLE TOOL. 
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If you have placed items on the pasteboard - you might for example have graphics, 

photos or other pieces of work in progress that you don't want to appear as part of your 

web document -  then these items won't appear when you preview the webpage. If you 

do want them to appear as part of the background then you should move them onto the 

PASTEBOARD BACKGROUND layer.  

 

The two stars are on the PasteBoard Layer and so appear as part of the webpage when 
previewed in the browser window. 

Note that once you have unlocked a background layer it behaves exactly like any other 

open layer. So for example when right-clicking on an object on the unlocked background 

layer you'll see the normal layer menu which relates to the objects on the layer, and not 

the menu relating to the background layer itself, which is what you see when the layer is 

in its default locked state.  

 

. 

RWD Variants and Backgrounds 

With a Responsive Web Design (on page 318) website, the main color or design of the 

pasteboard background (the area around the page which determines the browser 

window background when the page is published) can vary between one website variant 

and another and each page and page variant is exported with its own pasteboard 

rectangle. 

The exceptions to this are vertical and horizontal Supersites (on page 324). Because 

only one background can be displayed - only the pasteboard background from the first 

variant of the first page is used.  

You can place additional objects on the Pasteboard Background layer and these can 

also vary between page variants. So for example you could have a shape overlapping 

the page edge and this can be positioned differently in each variant, or be missing in 

some variants. 
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Offsetting the top of your page 

Normally if you just set the page and pasteboard to different colors, when you preview 

you’ll see that the page extends right to the top of the browser window.  You can’t see 

any of the pasteboard color above your page. However you can add an offset so that 

there is some space above your page in the web browser. 

To add an offset, you change the page origin. Normally the page origin is set to be the 

top left corner of your page. By moving the origin up 20 pixels, for example, you add a 20 

pixel margin to the top of your page when it’s viewed in a web browser.  

You can change the origin in two ways. The easiest way is to open the "UTILITIES" > 

"OPTIONS" dialog (or right click a page and choose PAGE OPTIONS), go to the GRID & 

RULER tab and increase the value of the Y coordinate of the origin point. This is normally 

set to the vertical size of your page, so just increase it by the margin size you would like. 

So for example if your page is 700 pixels tall, change the Y value of the origin coordinate 

from 700 to 720, in order to add a 20 pixel offset. 

Alternatively you can set the origin point interactively. Turn rulers on by right clicking and 

choosing "SHOW GRID/GUIDES" > "SHOW RULERS" or by choosing SHOW RULERS from the 

WINDOW menu ("Ctrl + L"). Then click and drag on the crosshairs button, which is located 

where the horizontal and vertical rulers join, at the top left of the canvas. Now you are 

dragging around the origin position, so position it the appropriate distance vertically 

above the top left corner of your page. 

Changing the horizontal position of the origin has no effect on the horizontal positioning 

of your page, so this should be left unchanged. 
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Website Publishing 

Publishing to Xara Hosting 

To get your website onto the internet instantly, you can publish it to Xara Hosting or 

MAGIX Online World (MOW) or to any other web space. Publishing to Xara Hosting is 

simple because it’s integrated into Web Designer Premium.  

Existing users of MAGIX Online World (MOW) can still publish to MOW in the usual way, 

but new users can no longer register for this service - Xara Hosting being the preferred 

option for new users wishing to use the hosting service. MOW users should click PUBLISH 

TO AN ALTERNATIVE WEB HOST... and then follow the sign in instructions from the "MAGIX 

ONLINE WORLD"  > " SETTINGS" dialog. 

Choose "FILE" > "PUBLISH WEBSITE" Or click the publish icon on the 

website toolbar.  

The first time you do this you'll see the Xara Hosting sign-in dialog appear. 

 

Simply sign in using your Xara email and password - you will already have this if you 

purchased or registered Web Designer Premium on the Xara website. Other users can 

click on the REGISTER... button to get a username and password from Xara instantly. You 

can choose to stay signed in which means that if you quit Web Designer Premium and 

then return, you will still be signed in. 
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Once you've signed in you'll see the following dialog: 

 

Select your website address from the drop-down menu . You can optionally enter a sub-

folder name, such as "site1", and you’ll see this gets added to the end of your website 

address in the field above. This is useful if you want to publish multiple sites to the same 

Xara Hosting account – you can put each one in a different sub-folder. Also useful if you 

want to add a password to protect a folder. 

Click PUBLISH. Your website will then publish and you will see the data transfer window 

indicating the progress of the publish. When the publish is finished you'll be able to 

navigate to your website via the link which appears in the data transfer window. 

Publishing to Xara Hosting automatically generates a sitemap which you will see as a 

sitemap.xml file in your Xara Hosting webspace. This is a list of the pages on your 

website, and helps search engines find and list all the pages in your site.   

The PASSWORD PROTECT button will take you to Xara Hosting where you will be able to 

control access to folders by setting passwords. You can create a list of contacts which 

you can then organise into groups of users. Visitors to the password protected area will 

have to provide an email address and a password to gain access. 

The CONTROL CENTRE button will take you to Xara Hosting where you'll be able to 

administer your account as well as being able to browse, view and delete files you have 

uploaded to your web space. 

Click the NEW WEB ADDRESS button if you want to choose a different web address for 

your website. For example you could purchase your own domain name (eg. xara.com), 

instead of having magix.net in your website address. If you do acquire other web 

addresses, these will appear in the "Your website" dropdown list above, when you next 

come to publish. Use the "Refresh" option in that list to update the list if it does not 

include all the addresses you expect to see. 

Publishing to an alternative web host 

If you don't want to publish to Xara Hosting, simply select PUBLISH TO AN ALTERNATIVE 

WEB HOST... from the dialog that appeared when you clicked the publish icon.  
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 on the top toolbar.  

This will bring up the PUBLISH tab of the Web Properties dialog  where you can configure 

the FTP details of an alternate hosting company. You can also configure or change other 

settings which allow you to publish your website to the internet but you don’t need to re-

visit these every time you perform a publish. Users of MAGIX Online World (MOW) can 

also publish here using the MAGIX ONLINE WORLD SETTINGS dialog.  

You will need to find out your FTP details from your web hosting company - these should 

include... 

 Host Address 

 Username  

 Password  

 The full folder path - including sub-folders if necessary - that your web hosting 

company requires you to publish to. 
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Web properties dialog Publish tab 

1. Choose which FTP host you wish to publish to. In this case you will choose OTHER 

WEB HOST (VIA FTP). 

2. Now click on SETTINGS... to configure your custom FTP settings. This brings up the 

following dialog... 
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Other web host settings dialog 

1. Choose how you want to connect from the drop-down menu - choose from FTP, or 

one of the two more secure protocols - FTPS or SFTP.  

2. In the FTP Host Address box, type in your FTP host address. If you have a domain 

name this is often the same as your domain name. For example, for MAGIX Online 

World users, this would be Ftp.MAGIX-online.com.  

3. In the FTP username box, type in your FTP username. 

4. In the FTP password box, type in your FTP password. 

5. The optional Sub-folder box lets you publish your website into a sub-folder. If you 

set a sub-folder here, then all the pages in your website will be published to this 

folder. Whether or not you have to publish to a sub-folder depends on the 

requirements of your web hosting some don’t require you to publish to a sub-folder 

at all, while others require you to publish to a ‘public’ or a ‘www’ sub-folder, for 

example. You must check the full FTP folder path that your own web hosting 

company requires you to publish to before publishing your website, as requirements 

vary widely. As an example, if your web hosting company wants you to publish to 

‘http://yourdomain.com/public_html’, then you need to type ‘public_html/’ into the 

Sub-folder box. 

6. If you want a sitemap generated for your website, you need to enter the full URL of 

your published website in the Website URL field. For the sitemap, a file called 

sitemap.XML is automatically generated. This is a list of the pages on your website, 

and helps search engines find and list all the pages in your site. If no URL is 

specified here when you publish your website, no sitemap is created.  
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7. Click the Explore web space button to browse, view and delete files you have 

uploaded to your FTP server (Optional). You can also set a Sub-folder path which 

will automatically appear in the the Sub-folder (optional) field. 

8. When you are finished click OK to take you back to the Publish tab of the Web 

Properties dialog. 

9. Click OK. Web Designer Premium displays a dialog confirming the publish details 

that it is about to use for publishing. Click Publish. 

 

Publish details dialog 

Transferring data 

1. After you have clicked Publish, Web Designer Premium displays a small window 

that shows the progress of data transmission and tells you when the publish is 

complete. If you entered your website's URL with the FTP details then you can go 

straight to it from this location.  

2. Alternatively, as soon as the transfer is finished, you can open a browser window 

and navigate to the URL of your published website.  

Note: If you entered a sub-folder in the Publish tab of the Web Properties dialog, your 

website is saved there. 

Important: If you have not set any specific page names in the Page & Layer Gallery, then 

the name you exported to last will be used as the basis for all the pages in your website. 

E.g., if you open a template website, and export this as 'test' to your file system, and now 

publish this, it will be published as test.htm to your web server, and all additional pages 

will be test_2.htm, test_3.htm etc. 

index.htm is the usual name for the first page of a website. 

Note: Many web servers use case-sensitive filenames. So, for example, the web 

address xara.com/products.htm is not the same thing as xara.com/Products.htm. To 

reduce confusion and the likelihood of errors Web Designer Premium enforces that all 

page names are all lower-case and contain only allowable characters. This means that 

spaces are not allowed in page names. We suggest using an underscore as an 

alternative separator.  
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Secure FTP Protocols 

Apart from standard FTP (file transfer protocol) Web Designer Premium also supports 

the more secure FTPS and SFTP protocols. Some web hosting require you to upload 

your site using one of these instead of insecure FTP.  

Click on the dropdown menu following CONNECT USING: on the OTHER WEB HOST 

SETTINGS dialog and you will see the following options... 

 

Choose from one of the three options -  there is the normal FTP option and then the 

secure FTPS and SFTP options. You will need to know which of the FTP protocols your 

hosting company supports first - and then fill in your FTP details as described above.  

Now normally what happens is that FTPS is assigned to Port 21 and SFTP is assigned to 

Port 22 as part of the host's IP network address. This is not something you would usually 

have to be concerned about as Web Designer Premium automatically manages this for 

you, but sometimes in the interests of further security, a host's system administrator will 

assign a different port number, and if this is the case you will have to manually enter the 

new port number as part of the FTP host address.  

 

In this example the port number has been changed to 22098 and has thus been added to the 
host's address as :22098 

For further information read our Knowledgebase http://www.xara.com/support/sftp/ article 

on publishing using secure FTP protocols. 

Explore web space 

When you have completed the FTP host address, FTP username and FTP password 

boxes, click the optional Explore web space button to browse, view and delete files you 

have uploaded to your ftp server. 

http://www.xara.com/support/sftp/
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You can view files and open folders to view subfolder contents and also set up a 

subfolder path. You can also delete individual or multiple files. Select multiple files by 

clicking and holding down Shift or Ctrl, as in Windows Explorer. Click on each column 

header to sort files using that column's criteria. 

 

Scroll through a list of files you have uploaded to your ftp server 

 

Returns to the original file view that opened when you launched the Explore 

web space dialog 

 

Takes you up a folder level 

 

Places the current folder path in the "OTHER WEB HOST SETTINGS" > "SUB-

FOLDER" field so you don't have to enter it manually.  

 

Deletes individual or multiple selected files 

 

Fast Publish (Only changed files) 

Normally leave the FAST PUBLISH (ONLY CHANGED FILES) checkbox selected. This makes 

re-publishing much quicker in most cases because only files changed since the last 

publish are re-published. 
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Save Publish settings in document 

Leave the SAVE PUBLISH SETTINGS IN DOCUMENT checkbox selected to have the publish 

details you have entered saved with the current document. That means whenever you 

open the document, it will already have the publish details in it so you can publish 

updates easily. 

When you enable the Save Publish settings in document checkbox, the Save password 

in document checkbox also becomes selectable (but this is not available for Xara 

Hosting/MOW publishing). Select this checkbox to also save the FTP password with the 

current document if you are sure that is what you want. This is not recommended 

because it means anyone who gets a copy of your design file can publish to your website 

without knowing or entering your password!  

Switching between Xara Hosting / MOW accounts 

You can only work with one Xara Hosting/MOW account at once, because you can only 

be signed into one Xara Hosting/MOW account at any one time with Xara Web Designer 

Premium . Therefore if you want to publish a website to a different Xara Hosting/MOW 

account, you need to sign out first, using "SHARE" > "SIGN OUT". Then you can sign into 

the other Xara Hosting/MOW account and publish as described above. 

Similarly if you load a website document that contains Xara Hosting/MOW account 

details that are different to the account you are currently signed into, you’ll see the Xara 

Hosting/MOW sign in dialog appear if you try to publish that document so that you can 

sign into the appropriate account for that document (this will automatically end your 

current Xara Hosting/MOW session).  

Saving profiles 

Profiles allow you to save a set of publish details on your computer, so you can quickly 

retrieve and use those settings again in future, without having to enter them again.  

In the PROFILE drop-down list click the SAVE PROFILE button and enter a suitable profile 

name. Now you can select the profile from the profile list at the top of the dialog, so you 

can use them in other documents without having to re-enter them. You can save a profile 

with either Xara Hosting/MOW settings, or FTP settings.  

Note: You can delete a profile by selecting it in the PROFILE list and clicking the DELETE 

button next to it.  
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Supersites and PDFs 

Perhaps the most common way of distributing print documents to a wider audience is via 

PDF, often published on the web as a download. Websites and HTML have, by contrast, 

been severely restricted from a design point of view. Different browsers wrap and flow 

text differently, and limited font availability make it near impossible to ensure that what 

you design is what your customer sees. This is why, even today, brochures, reports and 

any type of document where the designer wants precise control over the design, fonts, 

layout and pagination, are created as PDF.  

But PDFs have a downside in that they require plug-ins or extra programs to be installed 

to view them.Web Designer Premium  introduces a new way of publishing ‘print' style, or 

DTP style documents that does not involve PDFs and offers the following advantages: 

 Font Freedom. The ability to use a vast range of fonts. Either use your desktop fonts 

(the fonts are automatically embedded, assuming the license allows) or any of the 

600+ fonts from Google Fonts. 

 High resolution photo and graphics. Layout freedom: mix graphics and text, ‘anything 

anywhere’ on the page.  

 Pixel accurate WYSIWYG results. The document you design in Web Designer 

Premium is exactly what all viewers see, with the exact same fonts, word wrapping 

and pagination. 

 No plug-ins or separate readers required. Pages are created using HTML5. Your 

Supersite is just a web document. 

 Compatible with all modern browsers, including mobile and tablet devices where you 

can simply swipe to smoothly and rapidly scroll through your whole document. 
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A published Supersite 

appearing as a single 

continuous page when 

viewed in a browser (vertical 

scrolling option) 

 

Publish your Supersites in exactly the same way as you would for a conventional 

website. See Website Publishing (on page 340) for more details. 
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Photo Handling 

Introduction 

Photos are an integral part of almost all creative work nowadays, from websites, to flyers, 

brochures, DTP work and more. 

Photo handling in Xara Web Designer Premium is different than you may be used to with 

other graphics programs. 

In Xara Web Designer Premium you can color, crop, copy, blend, mask, feather (fade the 

edges of) photos as much as you like. The object oriented, non-destructive nature of the 

photo handling means that, for example, when you resize a photo, you are not really 

altering the original photo, but just resizing a visual copy. The original imported image is 

saved in the .web file, so that you can later edit, and resize again, or apply any of the 

Photo Tool editing options, with no loss of quality.  You can even un-crop cropped 

photos. 

The photo handling is astonishingly fast. You can open a 50 Megapixel photo, and 

perform any of the enhance operations, and rotate the full resolution image in real-time. 

This chapter covers the basic principles of manipulating photos and bitmap images in 

Xara Web Designer Premium. The operation of the Photo Tool is covered in the separate 

Photo Tool chapter. 

*Benchmarks based on photo compositions created with multiple hi-res JPG digital photos 

High resolution images 

High resolution images of the kind used by Apple's Retina(R) displays can be 

automatically created by Web Designer Premium.  

In order to take advantage of Retina type screens it is normally necessary to create all 

your web photos and graphics at twice the normal resolution of 96 dpi - that is twice as 

many pixels per inch both vertically and horizontally which is four times as many pixels 

per square inch. The downside of this is that your files are now up to four times as large, 

thus dramatically slowing down your website for all your visitors. For those visitors to 

your website that do not have high-resolution screens this is an unacceptable penalty.  

Web Designer Premium solves this problem by both automatically creating the high-

resolution photos and web graphics for you and also being smart enough to load the 

correct resolution graphics for the browser being used. 

So this means no speed or download penalty for the non Retina viewers, but for those 

that do have high-resolution web browsers, they get to see the double resolution 

imagery, and a much higher quality website. 
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This high-resolution creation of images is enabled by default - when you export your 

website a Retina or high resolution viewer will see the larger resolution images and 

graphics whilst a standard viewer will see images at a normal resolution. The only thing 

you have to do - is to make sure that the images you want to appear as high-res are 

saved in your web pages at a higher resolution than 100 dpi. as this is is the cut off 

point at which Web Designer Premium assumes you want an image to be rendered as 

high definition. Images at a resolution below 100 dpi remain as standard definition 

images. You would not normally need to worry about this as with the feature in its default 

enabled state all images are optimized at 192 dpi in the OPTIMIZE PHOTO dialog and so 

therefore well above the threshold for the creation of high resolution images.  

 

Note that due to the much larger images and the fact that both normal resolution and 

high resolution images are required, publishing Retina websites takes longer than 

publishing non-Retina sites. If you wish to disable the feature go to the "WEB 

PROPERTIES" > "WEBSITE" tab located on the UTILITIES menu, or else right-click on your 

web document and choose "WEB PAGE PROPERTIES" > "WEBSITE". Then uncheck the 

RETINA (HI-DEF) IMAGES checkbox at the bottom of the dialog. 

If you wish to re-format a standard definition site created in an older version of Designer 

to one with high resolution images then bear in mind that you will have to import your 

photos afresh to Web Designer Premium with the Retina feature turned on. 

See Optimizing Photos and Bitmaps for more detailed information on image resolutions. 

Photo Objects 

In Web Designer Premium photos (or bitmaps) are just another type of object on the 

page. You can drag and drop photos onto the page from your Windows file explorer, and 

then you can resize, rotate, copy and move them around just like any other object. 

Importantly you can adjust the transparency, even graduated transparency, feather 

edges and clip and cut shapes out of photos with ease. The transparency feature lets 

you blend, merge or create composite photos. 

Where you might have to use layers in other photo tools, every object in Xara Web 

Designer Premium is on its own layer and, just as with any object on the page, you can 

move it forward to be in front, or backwards to be behind other objects. 
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Photo Groups 

If you edit a photo using some tools such as the integrated RED EYE TOOL, the photo 

becomes grouped with other objects that modify the image in some way. For example 

with the RED EYE TOOL, the ellipse shapes that are used to modify the red eye areas of 

the photo are grouped with the photo itself. This is called a PHOTO GROUP and you’ll see 

this on the status line when you select such a modified photo.  

Similarly - if you enhance a photo while you have an active Mask or region, an enhance 

region is placed inside the Photo Group. 

You can also clone (Ctrl+K) objects within photo groups - the cloned object then appears 

as the topmost object in the Photo Group (look in the Page and Layer Gallery (on page 

447) to verify!) 

Just like an ordinary group it keeps the photo together with the other objects that have 

been added to modify it, but unlike a group it is still treated as if it was an ordinary photo 

by the PHOTO TOOLS and other tools. Normally photo groups are automatically placed 

inside a clipview object, which clips any objects which overlap the edge of the photo, to 

the boundaries of the photo itself. That’s why when you select a photo group the status 

line usually shows you have a "Clipped photo group" selected. See the Clipview section 

(on page 122) of Object Handling for information about Clipviews. 

Differences between Photo Groups and Photos: 

 Photo Groups collect together a simple photo and some vector edits. 

 You can push a photo around in its clipping shape within the FILL TOOL but you can't 

do quite the same thing with Photo Groups (either select inside and move the base 

photo, or use the right click context menu to select the clipped objects and then drag 

them in the selector tool). 

 Some operations will convert Photo Groups to photos. 

If you want to convert a Photo Group into an ordinary photo object, you can use 

"UTILITIES" > "OPTIMIZE PHOTO". But note that this is destructive in that thereafter you will 

not be able to modify any of the photo edits you’ve applied to the photo. Some other 

operations such as content-aware scaling and contoning also convert photo groups into 

flat photos, because these operations aren’t able to preserve the photo group structure. 

When a photo group needs to be converted in this way a warning alert is shown first.  

Photo Grids, Panels and Frames 

There are essentially two types of Photo Grid, which are a compact array of photos: 

RESIZABLE PHOTO GRIDS, and SMART PHOTO GRIDS. The PHOTO PANELS are a 

combination of photos, text and graphic elements and the PHOTO FRAMES are a collection 

of simple, attractive frames.  

You can find the grids in the ONLINE CONTENT CATALOG under "COMPONENTS" > "IMAGE 

RESOURCES" > "PHOTO GRIDS". All the SmartShape photo grids (as opposed to the 

Resizable ones) have 'smart' in the title. 
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Resizable Photo Grids 

These are aesthetically pleasing arrays of photos, Initially, they are set to sizes that are 

commonly useful, such as square, 16:9, 4:3, etc. but once you’ve added them to your 

document you can change the width and height to make them any size and aspect ratio 

you like, from wide and short to tall and slim.  

 

A resizable Photo Grid. 

Just drag on the side, top and bottom handles to resize. The photos are scaled, cropped 

or uncropped as you do this. Once you have the grid at the dimensions you want, you 

may need to adjust the scale and positioning of each image, to fit nicely within its new 

frame shape. Go into the PHOTO TOOL and click on each image to select, then use the 

adjustment handles on the photo to rotate/scale inside, or move the image in its frame.  

Note you can’t change the number of photos in these designs, or the layout, they are 

fixed designs.  

Smart Photo Grids 

This is a more flexible SmartShape that lets you display any collection of photos, even 

those with different shapes and aspect ratios, in a compact grid. You can adjust the 

number of photos on each row, or number of rows, drag to re-order the photos, and 

adjust the gap between all the photos.  
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To show these SmartShape control handles, click on the grid. As you hover over each 

handle a little info tip appears. 

 

 
Drag the blue handles in the centers of images to re-order images. 

 
Adjusts the gap between the images. 

 
Rotate the whole grid. 

 
Click a green edge handle to add a new image to the row. This will add a 

placeholder image onto which you can drag a new photo. 

 
Resize the whole grid, alternatively, use the Selector Tool. Hold down shift 

to resize the grid around its center. 

 
Drag down to add another row of images. 

 Click an interior green handle to delete the image. This will reshuffle and 

resize the other images on the row.  

You can also use the Smart Photo handles on individual images, by going into the PHOTO 

TOOL and clicking on an image. Each time you replace an image, it puts you into this 

Photo Tool mode. To get back to the SmartShape handles use the QUICKSHAPE TOOL 

(Shift+F2) or go back to the SELECTOR TOOL and click again. 

Adding & Replacing images 

To replace an image with your own photo, just drag and drop a photo file from Windows 

Explorer (or from the BITMAP GALLERY (on page 363) if the photo is already in the current 
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document). The image in the grid that you drop onto is replaced with your photo and the 

grid automatically updates to accommodate your photo.   

To add more images click the green "Add photo" handle on the right end of each row, or 

drag the "Add / remove rows" handle at the bottom left of the grid to add a complete row.  

Note: The height of a row is calculated by fitting the number of images in this row into the 

width of the grid. So the more images per row, the less tall that row is, especially if the 

images are wide such as panorama photos. Similarly rows containing just a single image 

will usually be taller. 

Border 

There is a "Border width" handle on the top left photo in the grid that lets you adjust the 

space between each photo. You can have no space at all if you choose, but when you do 

have a border it’s simply empty space between the photos so you see whatever is behind 

your photo grid. Therefore if you want to see something other than the page background 

behind, just draw a rectangle behind and set its color or fill to give the border effect you 

would like.  

Photo grid, Grids, Stacked photo grids, Smart grids, Smart photo grids. 

Photo Panels 

Most of the Photo Panels are customizable. Resizable usually in width and height, you 

can easily adjust them to fit any space, whether short and fat or tall and thin. Drag the left 

or right handles to change the width and the top or bottom handles to change the height - 

the elements will all re-format to fit the new dimensions.  

All text can be edited and styled using the TEXT TOOL, the same as with ordinary text. To 

replace a photo image, go into the PHOTO TOOL, click on the photo to select it inside the 

panel, then right-click and choose the REPLACE PHOTO option in the context menu. Or 

you can drag a photo from Windows Explorer or from the BITMAP GALLERY and drop it 

directly onto the photo you want to replace. 
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Find the panels on the INSERT menu "INSERT" > "PANELS" or in the CONTENT CATALOG  

under "COMPONENTS" > "IMAGE RESOURCES" > "PHOTO PANELS".  

Photo Frames 

The photo frames are a selection of attractive designs for presenting photos. As with all 

photos, to replace the images with your own, just go into the PHOTO TOOL click on the 

photo to select it and then right-click and choose REPLACE PHOTO from the context menu. 

Find the frames on the INSERT menu "INSERT" > "IMAGE" > "PHOTO FRAME..." or in the 

CONTENT CATALOG under "COMPONENTS" > "IMAGE RESOURCES" > "PHOTO FRAMES"   
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Importing Photos 

Xara Web Designer Premium supports a very wide range of photo or bitmap file formats 

including JPEG, PNG, TIFF and RAW digital camera images. 

 

The easiest way to open an image is to drag the photo or bitmap file from your Windows 

file explorer onto the Web Designer Premium Window. Or you can select the "FILE" > 

"OPEN" or IMPORT menu options. 

When importing high resolution photos (anything above 1920 pixels either wide or high) 

into a web document (including presentation documents), Xara Web Designer Premium 

automatically resizes the photo down to HD screen size without asking you if you want to 

import a lower resolution version. For a web document, even at the reduced size, there 

should be more than enough resolution in your photos for high quality results on your 

website, so it’s rarely necessary to import digital camera images at full resolution for web 

use. 

However, if you are importing a large photo into an animation document, Xara Web 

Designer Premium asks you if you want to import a lower resolution version of your 

photos. If your document is to include many photos, you may want to choose this 
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reduced resolution option. Otherwise with large photos you may find that your saved 

design file is much bigger than it needs to be (because it contains a copy of each of your 

photos) and you may not have enough memory in your computer to load, edit and export 

your documents. 

If you drag and drop onto an existing photo it will be replaced. Drop onto the background 

to import as a stand-alone photo. 

Replacing photos 

If you drag and drop a a photo file (from Windows Explorer or from the Bitmap Gallery) 

onto an existing photo it will replace that photo, but keep the same container or frame 

size. This makes it very easy to replace photos in templates. Or right click on a photo and 

choose REPLACE PHOTO… 

You can then use the smartphoto adjustment handles to alter the size, position and angle 

of the photo inside its outline, as well as the outline itself (on page 360).  This is not true 

for photo documents (on page 380), where dropping a photo on the page will always 

import it as a new document. 

When replacing a photo or bitmap this way, it is sized to best fit in the existing picture 

outline. If you hold "Shift" when replacing a photo, the new one will fit into the same 

dimensions and rotation as the old photo. This is useful where you've manually adjusted 

the scale or rotation of a fill and then want to replace the image with another which has 

the same aspect ratio.  

If there are multiple copies of the same photo on a page in the same soft group, for 

example a small thumbnail and a larger version on a pop-up layer, when you drag and 

drop replace, all copies of the photo in the soft group will be replaced by the new one. 

 

Using photos as fills 

You can also use any bitmap as a fill style for any drawn shape. Simply drag the file over 

the shape (which can be from your file system, or from the Bitmap or Fill galleries), and 

hold the "Shift" key down before you drop. This will replace the existing color fill with a 

bitmap, fitted to the object. Again you can use the smartphoto adjustment handles to 

change the scale, angle, position etc. 

Initial Photo size 

When you import a large photo it's reduced in size to HD (1920x1080) resolution, if it’s 

larger than that (in print and animation documents you are prompted about this first).  

And it’s sized to be a convenient 500 pixels wide on the page. 

To reduce the size, just drag a corner handle using the Selector Tool, or enter a new 

width in the Selector Tool InfoBar width field. 
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If you replace a photo using drag and drop, then the photo is sized to exactly fit the 

container, and this means its size and resolution will depend on the size of the container. 

Resize, rotate and position a photo within its frame 

  

The shape of your photo is really a fully editable outline around the image contained 

inside. So when you crop, or edit the outline shape, you're not affecting the fill, which is 

clipped inside the shape. 

Photos and bitmaps on the page are always contained within an outline shape. Not only 

can you change the shape of the outline, you can also adjust the scale, rotation and 

position of both the photo and its frame using the smart photo adjustment handles, which 

provide a quick and easy way to perform the most common photo editing tasks.  

The handles automatically appear whenever you select a photo with either the Selector 

Tool, the Photo Enhance Tool or the QuickShape Tool.  

 

For example, to scale, rotate and round the image on the left, just drag on the 

appropriate adjustment handle. A little info flag will appear as you hover over a handle. 

As you drag the handles to adjust an image, a 'ghost' copy of the full uncropped image is 

shown behind. This makes it easier to make adjustments because you can see parts of 

the image that fall outside the crop area, as you drag the handles. 

 To rotate and scale drag on the white circular top right icon - the degree of rotation is 

displayed 

 To move the image within the frame drag the "hand" icon on the bottom left 

 To round the frame edge drag the orange corner handle 

 To rotate the entire frame drag on the blue circular top right icon 



 

Photo Handling 361  
 
 

 

 To scale the frame drag on the bottom right + handle (hold down the shift key to scale 

the image from the center) 

To reset a photo back to it’s ‘best fit’ state, double click on the rotate/scale handle. To 

centre the image in its frame, double click on the “hand” icon. The handles on the edges 

of the photo allow you to change the shape of the photo frame (hold down the shift key to 

resize around the centre). These operations are smart and the image inside is 

automatically cropped, scaled or moved in order to preserve the correct aspect ratio. 

Double click any of the edge handles to change the frame to fit the whole photo exactly.  

These smart photo operations also work with photos of any shape, not just rectangular 

photos, and unlike the Fill Tool they also work with PHOTO GROUPS (on page 353) and 

CLIPVIEWS (ON PAGE 122). 

 

For more control over cropping use the CLIP TOOL 

 

"Smartphoto handles", "Photo handles" "Smart photo" "Adjustment handles" 

Horizon Straighten 

  

Using the smart photo adjustment handles as previously described it's easy to straighten 

the horizon of an askew picture. 

 Select a photo - this will show the adjustment handles, which allow you to scale, rotate 

and position the fill inside the shape. 

 Drag on the rotation handle to rotate and scale as required. 
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The following shows a landscape (created using the panorama stitching feature of Web 

Designer Premium) that has a sloping horizon. 

 

Drag on the adjustment handle (circled) to rotate and scale the photo within the frame - 

the degree of rotation is displayed. You can also reposition the photo within the frame 

using the move photo "hand" icon (bottom left).  

The handles on the edges of the photo allow you to change the shape of the photo 

frame. Again these operations are smart and the image inside is automatically cropped, 

scaled or moved in order to preserve the correct aspect ratio. Double click any of the 

edge handles to change the frame to fit the whole photo exactly.  

To reset a photo back to it’s ‘best fit’ state, double click on the rotate/scale handle. To 

centre the image in its frame, double click on the “hand” icon. 
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Zero-memory Copies 

One of the most revolutionary differences between Web Designer Premium and other 

software is that when you copy any photo on the page, it doesn't really make a complete 

new copy of the original imported photo but instead just displays another 'view' of the 

original image.  Web Designer Premium's rendering engine is fast enough that it can 

display any number of copies of the same image 'on the fly' this way. This saves huge 

amounts of memory and dramatically reduces files sizes. 

This doesn't detract or limit what you can do with each copy, and they can be treated as 

completely separate independent copies. Each copy does not have to be identical. You 

can manipulate each as required, resizing, rotating, cropping. coloring, feathering, or 

applying a wide range of photo and transparency effects. All for no memory or native file 

size increase. 

 

This shows separate copies of the same image, each manipulated in a different way. 

Each retaining the full resolution of the original imported JPEG, as you can see from the 

right image. The memory (RAM and file size) is no more than the original JPEG size. 

 

The Bitmap Gallery 

The Document handling chapter (on page 82) has general information about galleries. 

The BITMAP GALLERY shows all the bitmaps or photos used in any document, along with 

information about its pixel size and file size.  

 
You can open it by clicking it in the Galleries bar, or from within the "UTILITIES" > 

"GALLERIES" menu, or "F11". 
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The following useful information is displayed about the original image: 

 Filename of the original JPEG 

 The file type, in this case a JPEG, and the file size, 1,006K. (This is the original size of 

the file, and also how much of the .xar file will be taken up by this image.) 

 The pixel dimensions of the original, the Megapixel size (in this case just under 2MP) 

 The color depth, in this case "24 bit" which is sometimes called true color. 

 The original resolution of the image, in these cases 96dpi 

The BITMAP GALLERY always contains a default bitmap, with the gray default image. This 

is used as the default bitmap for bitmap fills and in cases where other bitmaps are 

missing. It's useful to have as a placeholder as well. 

As with all galleries, you can drag the objects from the gallery onto the page to create a 

new copy. Or you can select an image in the gallery and click one of the buttons across 

the top. The following section details the operation of the BITMAP GALLERY controls, most 

of which are for the more advanced user. 

Filling shapes with a bitmap 

Select the shape on the page, then select the bitmap in the gallery and click the fill 

button. Alternatively drag the image from the BITMAP GALLERY and drop it onto any shape 
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while holding "Shift". You can adjust the size, angle etc using the smart photo adjustment 

handles. 

Setting a Bitmap Transparency 

This is for the more advanced user. You can use any bitmap as a transparency mask on 

any filled shape or bitmap. The lightness of the bitmap affects how transparent the 

selected object is. The bitmap transparency size, rotation and tiling can be controlled 

from the TRANSPARENCY TOOL InfoBar. 

Deleting images from the Gallery 

When you delete a bitmap from the page, it remains in the BITMAP GALLERY. Any unused 

bitmaps will be deleted from the file when saved and re-opened.  However you can force 

the deletion of any bitmap by selecting it and pressing the DELETE button. If the bitmap is 

used in the document, it will be replaced by the standard X bitmap. 

Setting the page background to a bitmap 

Select the bitmap in the gallery and click the BACKGROUND button. This reveals a menu 

allowing you to choose between setting the PASTEBOARD BACKGROUND or the PAGE 

BACKGROUND. When setting the pasteboard background, if the image is narrower than 

the page, it’s assumed you want to have the image tiled to fill the whole browser 

background. Otherwise the image is applied single tiled. You can change these settings 

by right clicking on the pasteboard and looking under the Pasteboard Background sub-

menu.  

You can also apply an image to the background without using this gallery – just right click 

on the image and see the options in the context menu. 

See Website Backgrounds (on page 333) for more information. 

Save 

Select the bitmap and click SAVE will save the original image. In the case of an 

embedded JPEG this will save the original JPEG file.  Other bitmap types are best saved 

as PNG bitmap type. 

Bitmap Properties 

The PROPERTIES button will display information about the selected bitmap in the gallery. It 

also provides a way to stop image smoothing when bitmaps are enlarged. Usually all 

bitmaps are smoothed when enlarged, or zoomed into, on screen. There is a check-box 

option in the Properties dialog to turn this feature off, so that individual pixels are visible 

when you zoom in. 

Embedded JPEG files 

JPEG files are hugely compressed from their original state, being up to 10 times smaller 

than the original uncompressed image.  In the above example, the original 

uncompressed image requires more than 7mb of memory, but as the BITMAP GALLERY 
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shows, this JPEG file is only 1mb. A very significant reduction. This is why JPEG images 

are the standard file type for digital photography and use on the web. 

When you drag and drop a JPEG file (or use the "Open" or "Import" menu options) the 

JPEG (reduced in size if it was large) is stored in the document, and this is what is saved 

in the .xar file when you save your document. 

It's important to understand how this differs from other graphics tools, both vector 

drawing software and photo editing programs. Other products will typically un-compress 

the image and store the un-compressed "raw" image in memory and the native file when 

you save to disc. What's more each copy you make is typically a complete copy of the 

original raw image, as mentioned above. Make four copies of your photo and save your 

file - it will be four times larger. In Xara Web Designer Premium the file is no larger, no 

matter how many copies you make. 

So by embedding the JPEG file instead of saving the un-compressed image, that's a file 

size saving of more than 7:1 compared to other graphics editors. The fact that there are 

four complete copies of the image means that in this particular case the memory used is 

more like 30 times less. So this represents a huge file size (and time) saving over other 

graphics tools*. 

*This is easy to test. Import a JPEG into your favourite graphics editor, make four copies, 
perhaps change each one slightly, to be colored or blurred or rotated. Then save the native file 
and compare it against the original JPEG size, and the equivalent .Xar file. A .Xar native file is 
about the size of the original JPEG, no matter how many copies of the image are made.  

Extracting the original JPEG 

Right click on any image in the BITMAP GALLERY and select the SAVE menu option to 

save the original JPEG back to your file system. 

Photo display quality 

 

Xara Web Designer Premium can display photos in one of five useful quality levels. The 

top two settings smooth the screen pixels so avoiding visible pixels or rough sections 

along the edges (anti-aliasing). Change the quality level using the QUALITY entry in the 

WINDOW menu. 
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VERY HIGH 

QUALITY 

(DEFAULT)   

Displays images using bicubic sampling. This displays images at the 

best quality, particularly for large hi-res images that are scaled down 

or zoomed out a lot. 

HIGH QUALITY Anti-aliasing on, but images are rendered faster and at lower quality. 

FULL COLOR No anti-aliasing, thus showing individual pixels. This can be useful 

when you're zoomed in and you need to clearly see the separate 

image pixels.  The downside is that images generally look poor 

when reduced or enlarged resulting in clearly visible pixelation and 

jagged "staircase" edges, especially if you rotate the image. 

OUTLINE WITH 

BLEND STEPS 

Is particularly useful for seeing outlines of the various steps of a 

blend. Blends are not supported in Xara Web Designer Premium but 

imported .xar files could contain blends. 

OUTLINE  Only object outlines are shown. This is useful for finding and 

selecting objects that are difficult to see due to other objects in front 

of or behind them. 

There is an additional control that allows you to stop all image smoothing or anti-aliasing 

on images that are scaled up or zoomed in. In other words, instead of a smoothed image, 

you see all the pixels when zoomed in. Open the BITMAP GALLERY and right click on the 

image and select "properties". In the dialog un-check the "Smooth when scaled up" 

option. Now, no matter what viewing quality you select the image (and all copies) will 

always show the un-smoothed pixels when enlarged or zoomed in. 

Note: If you use the PHOTO TOOL sharpen / blur control then images have to be displayed 

at maximum quality. So if you think the viewing quality has stopped working, it's almost 

certainly because you have sharpened or blurred the image with the PHOTO TOOL. 

Saving & Exporting Photos 

Selecting the SAVE option will always save a native .web file. To save a photo as a JPEG, 

PNG or other image file type, it's necessary to use the EXPORT option, or the shortcut 

"Ctrl + Shift + E". 

  

There are two icons available on the top bar that are short-cuts to save 

the selection as JPG or PNG. These are in the flyout bar shown when you 

move the mouse pointer over the Export HTML icon. 

For photos we recommend saving as JPEG (sometimes called JPG) as this offers the 

greatest compatibility and the best size / quality compromise. 

When you export a JPEG or PNG, there is a SETTINGS option on the Save Dialog. 

Selecting this provides many advanced export options, as well as compare side-by-side 

alternative settings or even alternative file types such as PNG. 

When you export a JPEG, an export preview dialog is shown where you can adjust many 

export options, as well as compare side-by-side alternative settings or even alternative 

file types such as PNG. 
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The Export Preview dialog allows you to adjust the size, resolution, JPEG quality and 

even select from 3 alternative export file types if you so wish. The default values should 

be fine for all normal purposes and you can just click the export button to save your 

photo. 

Things to remember when exporting: 

 First select the object or objects you want to export 

 The default exported size of the image will be the size you see on screen at 100% 

zoom. 

The Export Preview dialog (on page 496) is described in more detail here. 

Tip: You can control the JPEG quality in the Export Settings dialog on the Options tab. 

The default and recommended value is 85% 

 

The JPEG system is designed that a setting 

of 85 is the optimum value. We recommend 

you do not save JPEGs at 100% quality, as 

the results are visually identical to the 85% 

quality, only the file size and memory use is 

dramatically increased with no benefit.   
 

When saving for use on the web it's quite possible to reduce the quality below 85 to 

increase page view speed. The preview window shows the quality of any value you 

select. 

Tip: If you expect you may want to perform any further edits on your exported image, for 

example to create the image again at another size, we strongly recommend saving the 

.web file as well. This will preserve the lossless master image along with all its edits and 

changes. 

Example: To resize a photo and save as a new JPEG  

This process is very quick and simple: 

 Drop your photo onto Web Designer Premium (either onto a blank page or onto the 

title bar to create a new document) 

 In the SELECTOR TOOL either drag a corner handle to resize the image, or enter the 

required width or height into the "W" or "H" field on the InfoBar. Check the image size 

is correct at 100% 

 



 

Photo Handling 369  
 
 

 

 Click the 'EXPORT SELECTION AS JPG' button  on the top bar. 

 Enter a filename, Click the SETTINGS button if you need to control the compression, or 

just click SAVE 

To save any image as a PNG go through the same process except choose the PNG file 

type. 

Photo Edit Attributes 

All edits performed using the PHOTO TOOL (on page 383), such as any altering of the 

brightness, contrast, color, blur or sharpen values, are all just stored on the photo as 

Web Designer Premium attributes.  

Just as you can alter the color of a shape or line without altering the underlying shape, so 

PHOTO TOOL attributes alter the visible appearance of the photo without affecting the 

original image (this is called non-destructive editing).  Another way of looking at this is 

that Xara Web Designer Premium just stores a list of edits applied to your photo, and you 

can change, remove or add new edits. You can always recover the original untouched 

photo, even after the brightness, resizing, even clipping or cropping. 

Attributes can be copied and pasted between objects. Not only does this apply to 

traditional attributes such as line color and thickness, it also works with all the PHOTO 

TOOL attributes. So this means you can easily copy all the enhancements made on one 

photo to any other using the copy / paste attribute feature. 

This also applies to all other attributes of the photo, such as line width and color, photo 

coloring (contoning), shadows, etc.; all these can be copied from one photo to another 

using the same technique.  

Editing the outline of Photos 

You can use the SHAPE TOOL (on page 153) to directly adjust the outline shape of a 

photo.  Similarly you can apply outlines the same way as for any shape, and shadow, 

etc. 
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Using the SHAPE TOOL you can push or pull on the 

sides. This example also has a black outline and 

soft shadow added. To restore the image back to 

its original rectangular shape, select the "Un-clip"  

in the clip mode of the PHOTO TOOL InfoBar. 

When photos are edited this way, they are treated 

like any normal vector shape, containing a bitmap 

fill. This is why you can use the normal line and 

shape editing features, and indeed you can use the 

Photo adjustment handles (on page 360) to adjust 

the size, angle and position of the photo "fill" inside 

the shape. 

 

Cropping photos 

 

The easiest way to crop a photo is to just drag on one of the smart photo 

adjustment handles (on page 360) which appear when you select a photo using 

the Photo tool or the Selector Tool. Simply hover over one of the handles to see a 

function information flag. 

 

For more advanced cropping control, select the CLIP BUTTON on the PHOTO TOOL 

flyout bar which provides aspect ratio control and precise numeric clipping control.  

This also provides an Un-clip button that will remove any clip rectangle and restore the 

original image. 

One important feature is that this crop feature is really a dynamic clip, in other words it's 

a non-destructive crop, and you can adjust the crop boundary afterwards to reveal 

hidden parts of the photo.  If you want to really crop - i.e. make this a destructive crop, 

that really removes the invisible parts of an image then use the Optimize Photo feature. 

Screenshots 

In combination with a built-in screen capture feature you can easily capture and create 

screen shots.You can either use the SCREEN CAPTURE UTILITY which is included in Xara 

Web Designer Premium or use the screenshot capability built into Windows. 

Using Windows to capture screenshots 

 Press the "Print screen" button on your keyboard. This places a screen capture of the 

whole screen on the clipboard. Alternatively, select "Alt + Print screen" which will 

capture just the current window. 
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 In Xara Web Designer Premium select "Ctrl + V" to paste, and select "Bitmap" to have 

the results pasted onto the page. 

You can now crop, add text annotation, resize as required and save the results. It's best 

to save this type of image as a PNG file.  

Screen capture utility 

This utility offers some advantages over the method above, including the option to 

capture the mouse pointer in the image. Open it by choosing UTILITIES  > SCREEN 

CAPTURE.  

 

SCREEN AREA:  Here you can choose the screen area you would like to capture. You can 

capture the full screen, the active window in its entirety, or just the content of the active 

window without the window border. 

OPTIONS: Here you can choose whether or not the mouse pointer is included in the 

screenshot. Also choose whether you just want to capture one screenshot or whether to 

keep the utility turned on for the session so you can take successive shots each time you 

press the assigned key shortcut.  

The output section lets you choose how to handle the captured screen image. By default 

it will be directly inserted into the current Xara Web Designer Premium design. 

Alternatively you can also save a BMP (Windows Bitmap) or PNG file for each 

screenshot into any folder. The files created are named "ScreenCapture", 
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"ScreenCapture1", "ScreenCapture2", etc. Choose the TARGET FOLDER for the files using 

the BROWSE... button. 

You can define almost any hot-key combination (Shift, Alt, Ctrl + key) to trigger the 

screenshot. Just click in the key shortcut field and then press the desired key 

combination, e.g. “Ctrl+S”. The chosen shortcut appears in the key shortcut field. If it 

clashes with any defined Web Designer Premium shortcut, you'll be warned with a 

message appearing at the bottom of the dialog, but this doesn’t matter if you will have 

other windows active when taking the screenshots. Press RESTORE to return to the 

previous selected shortcut. 

Instead of using a shortcut key to take the screenshot, you can instead use the TIME 

option. This is useful in cases where any keyboard activity can change the display you 

want to capture, such as a pop-up tooltip which may disappear if you were to press a 

key. Select the time option and enter a delay value in seconds. The screenshot will then 

be taken for you automatically once the specified period of time has elapsed. The timer 

starts as soon as you click the START button. 

Pressing the START button closes the Screen capture dialog and activates the system-

wide hotkey. Switch to the window you want to capture and press the chosen key 

combination, or wait for the chosen time period to elapse if the timer option was chosen. 

The screenshot is taken and inserted into Web Designer Premium or saved to file, 

depending on the option chosen. If you selected the “Capture always” option you can 

take additional screenshots by pressing the key combination again (this is unavailable 

with the timer option). To deactivate the utility if you chose this option, close down Xara 

Web Designer Premium to end the session. Alternatively return to the Screenshot dialog, 

choose the “once only” option and take one more screenshot. 
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Coloring photos 

With any photo selected just click on the Color Line and choose from the menu to apply a 

contone color to any photo. Clicking the white color patch and selecting 'SET CONTONE 

LIGHT COLOR' will turn any color photo to be black and white. It's called a contone 

because it's a continuous tone from black to white. 

 

 

 

When you click on the 

COLOR LINE you can select 

any color as either the 

Light or Dark contone 

color. Or you can use the 

COLOR EDITOR (Ctrl+E) and 

choose any color you like. 

The drop down menu at 

the top of the Color Editor 

controls whether you edit 

the light or dark color. 

You can restore the original color of a photo by clicking the cross-hatched "no color" 

patch on the left of the Color Line and selecting the "Restore color" option. 

If you want to color a photo that’s inside a group, Ctrl+click on it to select it inside the 

group and the contone it as described above. 

Photo Filter Presets 

The PHOTO FILTER PRESETS allow you to instantly apply professional photo effects to your 

photos. Find the filters in the Content Catalog under "COMPONENTS" > "IMAGES 
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RESOURCES" > "PHOTO FILTER PRESETS". They are grouped into categories and there is a 

wide range of moods and themes to choose from. 

 

Some of the Photo filter presets in the Online Content Catalog 

To apply a filter to a photo, first select the photo and then click the IMPORT button on your 

chosen filter in the Catalog. The preset filter is then applied to your photo and also 

imported to your LOCAL DESIGNS GALLERY.  

Note: You can keep the Catalog open after an import by holding down the Shift key as 

you click the Import button. Useful if you want to try a range of filters. 

Using presets from the Local Designs Gallery  

Once you’ve imported one preset, you can optionally download all the presets to your 

Local Designs Gallery, for easier access.  

Right click on the "COMPONENTS" > "IMAGE RESOURCES" > "PHOTO FILTER PRESETS" 

folder in the gallery and choose DOWNLOAD ALL. Re-open the folder and now you can 

drag and drop any of the effects onto your photos, or select the target photo and double 

click an effect in the gallery.  

Using multiple filters 

There are multiple different ‘classes’ of filters and overlays that can be applied together. 

The set of filter presets is divided into two folders under "COMPONENTS" > "IMAGE 

RESOURCES" > "PHOTO FILTER PRESETS". The FILTERS folder contains presets that affect 

the overall look of your photo. It would not be useful to apply more than one of these 

presets to a photo and so these will replace each other. In other words, only one of these 

presets can be applied to a photo and applying a second will automatically remove the 

first. 
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However the OVERLAYS folder contains various different classes of presets that can be 

applied in addition to any of the presets under the FILTERS folder.  

 

This photo has had the "Softlight" filter effect applied from "Filters" > "Effects" and also the 
"Stripes" pattern, from "Overlays" > "Patterns".  

Each of the presets in the same sub-folder under OVERLAYS will also replace each other, 

because it wouldn’t be useful to have for example two different patterns applied. But you 

can mix presets from each of the other folders under OVERLAYS as much as you like. So 

you could for example apply a check pattern from the PATTERNS folder, a texture from the 

TEXTURES folder and a transparency effect from the TRANSPARENCY folder all to the same 

photo.  

Replacing photos and removing presets 

If you drop a replacement photo onto a photo with a filter applied the filter preset will be 

maintained. And if you have any existing photo edits in place, for example if you used the 

RED EYE tool then the applied filter will merge with these edits too. 

When you right-click on a photo, you will see a PHOTO FILTER option in the context menu 

that appears. This option has a sub-menu, which allows you to apply filters to your photo 

and remove filters that are already applied.  

The APPLY FILTER… option opens the CONTENT CATALOG onto the PHOTO FILTER PRESETS 

folder so you can apply a filter to the selected photo. Following this option in the menu, 

you will see REMOVE options for each of the filters you currently have applied to the 

photo, so you can remove any of them.  

The final option in the menu allows you to clear all applied filters from the photo. 



 

 376 Photo Handling 
  

 

 

Editing Photo Filter Presets 

Most of the preset filter effects modify the image by adjusting the same settings that you 

see in the PHOTO TOOL. Therefore remember that applying an effect may remove any 

photo enhancements you have applied manually beforehand, using the PHOTO TOOL. 

Similarly if you apply a preset filter and later adjust the settings in the PHOTO TOOL, if you 

later remove the preset it may also remove your enhancements.  

Similarly, the overlay effects under "OVERLAYS" > "TRANSPARENCY" work by applying 

transparency effects to your photo directly. You can see and modify these effects by 

selecting your photo and going into the TRANSPARENCY TOOL.  

Viewing a scaled photo at its full size 

 

The ZOOM TO 1:1 button on the PHOTO TOOL InfoBar adjusts the zoom so that the selected 

image is shown at full size, which is where each pixel of the image is mapped to each 

screen pixel. This is useful if you want to edit an image that’s been scaled down on the 

page, but want to see it at its full size while you work on it. 

Making a photo its full size 

 

The SCALE PHOTO TO 100% button on the PHOTO TOOL InfoBar takes the currently 

selected photo and scales it to its full size on the page. So for example if the selected 

photo is scaled down to 500 pixels wide, but the original imported photo was 1000 pixels 

wide, the photo on the page will be scaled up to 1000 pixels wide. When the document 

zoom is 100%, that means that each pixel of the image is mapped to each screen pixel. 

Optimizing Photos and Bitmaps 

With the ever increasing resolution and file size of digital camera JPEGs, if you have a 

document containing many images, the file size can quickly become very large. For 

example, a multi-page document containing 20 full resolution JPEGs, each of 5mb, 

would produce a .xar file of over 100mb*. 

Furthermore, these photos are often unnecessarily high resolution. Reducing a photo 

from a 8 megapixel digital camera to be 2 inches (5 cm) wide on the page will result in 

this image being around 1500 dpi.  Whilst a very high resolution image gives greater 

flexibility for printing (and you can zoom in, or enlarge small parts of the photo), this is far 

higher than required for even the best quality commercial printing, and even more so for 

web graphics or HTML production. 

If you clip to a small part of the image, or cut-out only a small part of your photos, there 

could be large parts of hidden image outside the visible area. For editing purposes this 
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"live crop" is a great feature, as you can un-crop, alter the size, position and scale and 

everything remains as sharp as possible. But for finished documents you may want to 

remove the invisible parts. 

 

The cut-out butterfly image still has the rest of the photo attached. If you go into the FILL 

TOOL you can easily see this by resizing the fill inside the outline. So the parts of the 

image outside the butterfly will probably be superfluous in your final document. 

Right click a photo and choose OPTIMIZE PHOTO or choose "UTILITIES" > "OPTIMIZE 

PHOTO..".. This dialog performs three important functions: 

 Removing invisible parts of photos 

 Reducing resolution of photos 

 Converting PNG or bitmaps to embedded JPEGs to optimize file size 
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Selecting this menu option for any bitmap will display the OPTIMIZE PHOTO dialog. 

 

The default resolution depends on the type of document you are working on: 

 192 dpi  Web documents with Retina hi-definition images.  

 150 dpi Print documents. 

 96 dpi  Other documents.  

When optimizing non-JPEG images, Web Designer Premium will automatically decide 

whether it’s best to optimize to a PNG or JPEG, depending on the nature of the image 

itself. 

You can click the SETTINGS button on this dialog, if you want to change any settings such 

as the image format used for the optimization, JPEG quality, etc. 
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You can change the resolution used in this dialog, by either choosing the physical size 

you want for the optimized image (width/height in pixels), or by entering a different dpi 

(eg. perhaps 150dpi if you want print quality). 

If you choose the dpi option the value you enter is remembered and becomes the default 

just for the current session. You can also maintain the photo's current resolution by 

choosing CURRENT from the PPI list. 

You can also choose to optimize as a PNG (produces much larger images, but better 

quality for graphics and text images) or change the quality used for JPEG optimization 

(higher quality means larger JPEG sizes). 

If your photo is cropped, only the visible part of the image is preserved in the optimized 

image. 

For printing, a photo resolution of 150dpi gives very good results, whilst 300 dpi will 

provide the highest quality commercial printing (most people cannot tell the difference 

between 150dpi and 300dpi, but the 300dpi requires four times as much memory or file 

space). 

Warning: "OPTIMIZE PHOTO" is a "destructive" operation. When you save the file the parts 

of the image removed are lost, and the resolution changed permanently (you can of 

course undo the changes while the file is open for editing). 

You can optimize multiple photos at once if you want them to all have the same dpi. 

Select the photos you want to optimize and then choose the OPTIMIZE operation as 

described above.  If your photos have different dimensions, the option to optimize by 

pixel size is disabled and you must just choose the required dpi.  

Or you can use the "UTILITIES" > "OPTIMIZE ALL IMAGES" facility to optimize all the bitmap 

images in your document in one operation. 

The optimization process will convert large non-JPEG images to smaller JPEG images if 

it decides that the image can be stored and exported as a JPEG without an unacceptable 

loss in quality. 

Note that after optimizing the original unoptimized and now unreferenced photo remains 

in the BITMAP GALLERY (ON PAGE 363). This means it is still in memory and so the memory 

requirements of your design will not have been reduced. Simply save your design and 

reload after optimizing, to eliminate the original large images. 

Converting objects or drawings to bitmaps 

You can easily create a bitmap from any object, or part of your drawing, including from 

other bitmaps. The bitmaps can be any size or resolution and can contain transparency. 

You can also create bitmaps with reduced numbers of colors which can be useful for web 

use. 
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To create a bitmap from objects: 

1. Select the object/s on the page. 

2. Right click and choose CREATE BITMAP COPY or choose CREATE BITMAP COPY from 

the ARRANGE menu ("Ctrl + Shift + C"). 

3. In the dialog box, select the color depth, the size and other options. 

For maximum quality select a color depth of true color, or if you want transparency to be 

included select "true color + alpha" (alpha transparency is the technical term).  You can 

create bitmaps with fewer colors by selecting a color depth of 256 colors or less. This 

also provides control over the dithering and palette options. These options are described 

in the section on exporting bitmaps (on page 496). 

Note this always creates PNG images, which are the highest quality image type. 

However for full color photo purposes, these require a lot of memory and file space. Use 

the optimize photo option to convert PNG images into embedded JPEG images to 

reduce the file size. 

Photo Documents 

Sometimes it's useful to work on one photo alone, rather than as "objects on a page". 

This is called a photo document or "photo mode" in Web Designer Premium, and it 

behaves more like a traditional photo editor. You can create a photo document in a 

number of ways: 

 Drag a photo file from your file explorer onto the title bar or toolbar of Web Designer 

Premium 

 Select "FILE" > "OPEN" and select a photo file 

 Create a blank photo document by selecting "FILE" > "NEW" > "BLANK PHOTO" 

Photo documents are characterized by the following behavior differences compared to 

traditional Web Designer Premium documents: 

 There is no visible white page. In fact the page dimensions are set automatically to 

match the photo plus any other objects you've added. 

 Photo documents have a 1 pixel grid by default and snap to grid is turned on. This 

makes it easier to get pixel-accurate crop or clip regions. 

 The Pasteboard (the area around the photo) is a darker color. This makes it easy to 

distinguish at a glance between photo documents and drawing documents. 

 The document zoom is set so that the photo fills the view and the PHOTO TOOL is 

automatically selected as the current tool. 

 Dropping additional photo files on top of an existing photo just adds a new photo to the 

document instead of replacing the photo in its frame.  And the view will zoom out so 

you can see the whole image. 

 Images are not resized to be 500 pixels on import as they are in normal documents, 

but are imported at 1:1, so that at 100% zoom you're seeing the image at full size. 

 The pixel smoothing options are altered. By default it selects the "Very high quality" 

display mode, which is best for images scaled down or zoomed out. It also has pixel 
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smoothing turned off when zooming in, so you can see the pixels are very large zoom 

factors. 

 If you’ve opened a JPEG photo file as a photo document, when you save changes 

your JPEG file will be overwritten. See Editing Photo Files below for details. 

In all other respects Photo Documents behave like normal Xara Web Designer Premium 

documents. You can use all the normal drawing and text tools as usual.  If you want to 

create a photo document of a given size, you can alter the "canvas" or page size by 

selecting "UTILITIES" > "OPTIONS" and the "PAGE" tab and entering the required 

dimensions. 

 

In Photo Documents two extra controls become enabled. The PREVIOUS and NEXT button 

will move onto the Previous or Next image in the folder from which this image was 

opened. This will close the current image, so you may be prompted to save the file. 

Editing Photo Files 

You can use Xara Web Designer Premium to easily edit your JPEG photos and save 

back the modified JPEG. And unlike with most photo editors, you can do this multiple 

times without loss of quality, even though the JPEG format is a lossy format. That’s 

becauseXara Web Designer Premium is able to save your edits in a lossless way, along 

with the original photo. Here’s how it works. 

First open the JPEG, using "FILE" > "OPEN", drag and drop, or in Windows File Explorer 

right click and choose Xara Web Designer Premium from the "open with" list. The photo 

is opened as a Photo document. 

Edit the photo using the photo tools as described above. 

If you then do "FILE" > "SAVE" ("Ctrl + S"), the JPEG file you loaded will be overwritten 

with the modified image. However by default Xara Web Designer Premium also saves 

your photo in its native .web format. This file is placed into a "Masters" folder alongside 

your JPEG file. It has the same name as your photo file but with a .web extension. The 

.web file includes within it your original photo without the modifications applied, and of 

course details of your edits. 

In future if you load the modified JPEG file in order to edit it further, Xara Web Designer 

Premium will look in the Masters folder to see if there is a .xar file available for that photo. 

If so, the .web file is loaded instead of the JPEG file and you can continue editing from 

where you left off. When you next save, the JPEG file is again overwritten and an 

updated .web file also saved into the Masters folder. 

Of course if you don’t want to overwrite your original JPEG file with your changes, you 

can use "FILE" > "SAVE AS", to save the modified photo elsewhere, or use the many 

export facilities to export your photo into different formats.  
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You can get hold of the original photo from the .web file by opening it, opening the 

BITMAP GALLERY, right clicking on the photo and choosing the SAVE option. 
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The Photo Tools 

Introduction 

The PHOTO TOOL provides a direct and very fast way of cropping, adjusting the brightness 

levels and sharpening photos, even for ultra high-resolution images. This tool provides: 

 One-click auto-enhance your photos; this is particularly good for dull, underexposed 

images. 

 Manually adjust the brightness, contrast, color saturation, photo color temperature and 

blur or sharpness of photos. 

 Crop images. This is "live crop" so you can un-crop and adjust the crop at any time. 

 A single-click "Compare" function to quickly compare changes against the original. 

 Easy copy / paste all photo enhance edits between different images. 

All these operations are interactive with live update. As you adjust the values, the image 

is updated instantly. They are also all non-destructive, meaning that your original image 

is not altered and you can always adjust or remove any adjustment. 

There is also an anti-redeye tool. 

Photo Tool Benefits 

There are three major benefits of this tool: 

1. It's non destructive 

2. It's very, very fast, even for huge images 

3. Photo Edits require no memory. 

For more information on these benefits over other photo editing tools, see the Photo 

Handling Chapter. 

Using the Photo Tools 

 

To access the PHOTO TOOLS, move your mouse pointer over the Camera icon in 

the main toolbar on the left of the window. A flyout bar appears with icons for 

each of the available photo tools. 
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If you’re in the SELECTOR TOOL a double click on a photo will switch into the PHOTO TOOL. 

Common photo functions 

The following buttons are available on the InfoBar when you are in the ENHANCE, CLIP, 

RED EYE or CONTENT-AWARE SCALING photo tools.  

 

Rotate by 90° controls 

 

The two rotate icons will rotate the selected photo or photos by 90 degrees anti-

clockwise or clockwise. 

 

Previous & Next 

 

When you 'open' a photo using Xara Web Designer Premium the photo is loaded into a 

new Photo Document, because Web Designer Premium assumes you want to edit or 

view the photo itself rather than use it as part of a drawing or other document. When 

you've opened a photo you can use the 'Previous' and 'Next' buttons on the PHOTO TOOL 

InfoBar to close the current photo document and open the next (or previous) photo in the 

same folder as the current photo.  This allows you to browse through the photos in a 

folder, without having to open and close each one individually. If you've made any 

unsaved changes to the photo you'll be asked if you want to save the changes when you 

press previous or next. 

See Photo Handling for more information on Photo Documents. 

 

Zoom 1:1 

 

Select a photo and click the Zoom 1:1 button. 

The ZOOM TO 1:1 adjusts the zoom so that the selected image is shown at full size, which 

is where each pixel of the image is mapped to each screen pixel. Use this option if you 

want to work on a photo at full size in a document where you have scaled the photo 

down. 

 

Scale photo to 100% 

 

The SCALE PHOTO TO 100% operation takes the currently selected photo and 

scales it to its full size. It also puts the photo onto the pixel grid. 



 

The Photo Tools 385  
 
 

 

So for example if the selected photo is scaled down to 500 pixels wide, but the original 

imported photo was 1000 pixels wide, the photo on the page will be scaled up to 1000 

pixels wide. When the document zoom is 100%, that means that each pixel of the image 

is mapped to each screen pixel. 

Enhance Tool 

 

Click the Camera icon to enter the ENHANCE TOOL. 

The PHOTO TOOL provides a direct and very fast way of cropping, adjusting the brightness 

levels and sharpening photos, even for ultra high-resolution images. This tool provides: 

 One-click auto-enhance your photos; this is particularly good for dull, underexposed 

images. 

 Manually adjust the brightness, contrast, color saturation and blur or sharpness of 

photos. 

 Crop images. This is "live crop" so you can un-crop and adjust the crop at any time. 

 Correct color casts or white balance. 

 A single-click "Compare" function to quickly compare changes against the original. 

 Easy copy / paste all photo enhance edits between different images. 

All these operations are interactive with live update. As you adjust the values, the image 

is updated instantly. They are also all non-destructive, meaning that your original image 

is not altered and you can always adjust or remove any adjustment. 

 

The first six InfoBar buttons to the left (not shown above) are common to all tools and are 
described above 

 
Auto-Enhance 

 
Brightness 

 
Contrast 

 
Color Saturation 

 
Color Temperature 

 
Hue Control 

 Blur / Sharpen 

 
Compare with original 

In this tool you can adjust brightness, contrast, saturation, temperature, hue, and 

blur/sharpen. You can either enter values directly into the text fields or use a small pop-

up slider for adjusting the values interactively. 
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Pop-up slider controls 

The pop-up sliders can be used in one of two ways: 

 

1. Click and release the pop-up arrow. The slider control now remains on screen and 

you can adjust the values as many times as you like by dragging the slider control.  

Alternatively, if the mouse is held over the control, the mouse-wheel can be used to 

make small adjustments up or down. The slider will hide when you click anywhere 

else in the document. 

2. Or you can click & hold the mouse button down, and drag over the slider bar to 

adjust the value. When you release the mouse the pop-up vanishes. This is a 

quicker more direct way, since it requires only one click & release to alter the 

values. 

Auto Enhance 

Clicking the "ENHANCE" button will analyze the overall brightness and contrast of the 

picture and automatically adjust the enhance values to obtain the best image. It is 

particularly effective with under-exposed (dark) images. After applying automatic 

enhancement to a photo you can adjust the values that were chosen, using the controls 

to the right of the "enhance" button. Clicking the "COMPARE" button will restore the 

original, clicking it again restores the last enhance values. 

Brightness/Contrast/Color Temperature/Saturation/Hue  

 

Brightness 

 

Contrast 
 
Saturation 

 

Color Temperature 

The image is altered as you adjust these values. The saturation alters the color intensity. 

At the minimum setting of -100 this will make a picture black and white. The Color 

Temperature control makes a picture more ‘warm’ or ‘cool’. The Hue control applies a 

particular color tint to the image and allows you to control the intensity of the selected 

color. 

 

Hue 

The HUE slider lets you choose 

the color to apply and the 

STRENGTH slider sets the 

intensity of the color change 

applied. 
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Blur/Sharpen 

 

This control blurs images if the slider is dragged to a value below 0, and sharpens 

images when dragged above 0. For sharpen it's recommended that only small values be 

used, and typically only on images that have been reduced in size a lot. You can enter 

blur values larger than the -100 maximum value available on the slider. E.g. entering -

400 will produce a very blurred image. 

Using masks or regions 

If you want to just enhance a particular area of your photo, first use one of the Photo 

Region tools (on page 288) to mark the region of the photo you want to modify. Or use a 

Mask tool to protect parts of the photo you don’t want modified.   

Then switch to the Enhance Tool and make your changes. The mask or region is used to 

limit the parts of the photo the enhance operation is applied to and afterwards you are left 

with a region inside the Photo Group. Whenever this region is selected inside the Photo 

Group, its outline is shown with "marching ants". To select such a region inside a Photo 

Group, Ctrl+click on it or select it from the Page and Layer gallery (on page 444) where it 

will appear as a Region within a Photo Group (on page 353). Looking at the Status line 

(on page 67) will also clearly show you when you have a region or mask selected inside 

a Photo Group. 

Note that you should almost always apply feathering to a region inside a Photo Group, to 

soften its edges and blend the enhance effect seamlessly into the photo. Hard-edged 

regions are rarely useful. See the Feather tool for details. You can apply and adjust the 

feathering on the region inside the Photo Group once it’s selected inside, or you can 

apply feathering to the mask or region before you apply the enhance effect. 
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Left photo in partial shadow, right photo enhanced with brightness and feathering to soften and 
blend the outline. 

If you want to make adjustments to the shape of a region inside a Photo Group then just 

switch back to a mask or region tool and make your changes ensuring that the region or 

mask is selected (shown with marching ants outline). Again, even while in the 

Region/Mask tools, you can select regions inside a Photo Group using Ctrl+click.    

 

If you want to be able to work on selected regions inside a Photo Group without 

seeing the marching ants outlines, you can temporarily turn off the outlines 

using the button on the infobar of the region and mask tools. 

The outlines are turned on again as soon as you clear the selection or move to a different 

photo or document.  

In Xara Web Designer Premium the Mask tools are not presented on the main toolbar at 

startup. If you want to use these tools you can find them in the Button Palette. See Photo 

Regions and Masks (on page 287) for more details. 

Compare & Restoring the original 

The COMPARE button can be used to reset all the ENHANCE TOOL values back to their 

defaults, returning your photo to its original state. Press the compare button a second 

time, your previous values are reinstated. Therefore you can use the compare button to 

quickly toggle between your edited photo and the original photo so you can see the 

effects of the changes you've made. 

Because all the enhance and levels alterations are non-destructive, pressing compare 

simply removes the enhance attributes, so restoring the original image. The compare 

button can be used at any time after an image has been altered. 

Cropping or clipping images 

The simplest way to clip a photo is just start dragging on or across the photo with the 

ENHANCE TOOL selected. The clipping is performed instantly after releasing the mouse. 

The resulting clipped photo has clip handles around it, where you can adjust the clip 

borders afterwards. 

 

This is a non-destructive operation meaning that you can both adjust the clip region after 

you've copped the image and even un-crop to restore the whole image. A way to look at 

the process is that it just adjusts the picture outlines, but the whole picture remains 
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clipped inside the rectangular outline. This is why it's called a clip, and not crop, although 

it serves the same goal as a traditional crop tool. 

You can select different photos while using the photo tools by just clicking on them. This 

also works for photos inside groups. 

 

Clip Tool 

Alternatively you can enter CLIP TOOL by selecting the Clip icon on the PHOTO TOOL fly-

out bar. This provides a range of additional crop options. You can enter exact pixel 

values, and select from various crop aspect ratios 

 

For interactive clipping and some more options regarding aspect ratio, enter the 

CLIP TOOL with the CLIP TOOL button.  

This alters the InfoBar to look like this: 

 

As you drag over the photo, the clip rectangle is highlighted. 

 You can adjust the region by dragging on the corner or side handles 

 You can push the region around by just dragging inside the clip region 

 Select the CLIP button or just double click inside the clip region to perform the clip 

operation. 

 

You can tell whether a photo has been clipped or not from the status bar which will 

describe it as a "clipped photo". 
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Clear 

Press the "CLEAR" button, or just click outside the marked clip region to clear the current 

clip rectangle. 

Rule of Thirds 

There's a photography guideline that helps the composition of many photographs called 

the "rule of thirds". Put simply this involves placing key objects in your photos at thirds 

across your picture. For example it's often better to position the horizon one third of the 

way down a picture rather than being across the center. When you drag a clip region 

across your photos lines are displayed at thirds across and down the image to help 

position objects to follow these composition guidelines.  

Tip: Search for "rule of thirds" on Google for more information.  

Un-clip 

Press the UN-CLIP button with any clipped photo selected, to restore the original photo. 

This restores the clip rectangle, which you can adjust or clear by clicking outside it. 

The UN-CLIP button in the CLIP TOOL will change the outline of any clipped photo, and 

also arbitrarily formed shapes with a bitmap fill, to that rectangular outline of the complete 

photo or bitmap used as the fill. You may have to select the Clear button to clear the crop 

rectangle (or click outside the rectangle). 

Adjusting the clip region 

Because the un-clip button restores the clip rectangle (showing the area outside faded), 

you can easily make fine adjustments to a clipped photo. Just select the photo, press the 

Un-clip button and adjust the sides of the clip rectangle as required. Double click inside 

the photo to clip it again. 

Width / Height 

After drawing a clip rectangle, you can enter values directly into the width and height 

fields on the InfoBar to set the clip rectangle dimensions to exact values. 

Lock Aspect 

Select the "LOCK ASPECT" check-box to constrain the clip rectangle to a specific aspect 

ratio as you drag. The radio buttons to the right of the check-box determine the aspect 

ratio used. Select "CURRENT" to maintain the aspect ratio to that of the photo before the 

clip. Note that the clip rectangle automatically changes between landscape and portrait 

orientation as you drag a corner of the rectangle.  So if you drag sideways it tends to 

create a clip in landscape orientation. If you drag downwards more, then it will create a 

clip region in portrait orientation. 

The common preset crop aspect ratios are available of 4:3 (most consumer digital 

cameras and old-style TVs and monitors), 3:2 (that of traditional film cameras and higher 

end SLR digital cameras), and 16:9 (aspect ratio of widescreen TVs). 
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You can override the lock-aspect option by using "Ctrl" while dragging. So if you're 

dragging out a clip rectangle (or adjusting one) without aspect ratio lock, then holding 

"Ctrl" will lock the aspect to the last selected aspect ratio. Similarly if you have lock 

aspect option on then "Ctrl" will temporarily un-lock the aspect ratio. 

Clipping in Photo Documents 

In photo mode, there is a one-pixel grid applied to the photo (when at 96dpi, the default 

resolution) and the clip rectangle snaps to this grid. This makes it very easy to get pixel 

exact clipping. For highly accurate or exact pixel snapping, it's recommended to operate 

in photo mode and to zoom in so you can see the pixels clearly. 

See Photo documents (on page 380) for more information. 

Photo Tool Notes 

1. You can select different photos while using the PHOTO TOOLS by just clicking on 

them. This also works for photos inside groups. 

2. If you click and drag, while in the ENHANCE TOOL, it will start a crop on the photo that 

you started dragging on. Or, if you start dragging on the background, the crop will 

be applied to the first photo you touch during the drag. 

3. The UN-CLIP button in the CLIP TOOL will change the outline of any clipped photo, 

and also arbitrarily formed shapes with a bitmap fill, to that rectangular outline of the 

complete photo or bitmap used as the fill. You may have to select the Clear button 

to clear the crop rectangle (or click outside the rectangle). 

4. All photo operations can be fully undone. Unlike traditional photo or pixel editors, 

the original photo is never altered until or unless you optimize the photo to make the 

changes permanent. So this means you can make as many changes as you like, as 

often as you like, and save and load .xar/.web files as often as you like, and there is 

no degradation of the image (all edit operations are non-destructive and loss-less) 

and give no increase in file size. 

5. All the PHOTO TOOL options, including the levels control, operate on bitmap filled 

objects, as well as stand-alone photos. 

6. Opening a photo with Xara Web Designer Premium (using "FILE" > "OPEN") opens it 

as a Photo Document. After editing it, you can overwrite your photo file by just doing 

a "FILE" > "SAVE" ("Ctrl + S"). A .web or .xar file is also saved into a Masters folder 

alongside your modified photo, preserving your original photo and edits. See the 

Photo Handling chapter for more details. 

The Red Eye Tool 

Select the RED EYE TOOL from the PHOTO TOOL flyout bar. 

 

The RED EYE TOOL allows you to quickly remove red eye effects from faces in 

your photos.   
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Click the icon shown above to enter red eye mode. Then: 

 Zoom into the red eyes in your photo using the ZOOM TOOL (ON PAGE 69) OR JUST 

USING "CTRL + MOUSEWHEEL".  

 Click and drag from the centre of the red eye outwards, to drag a circular red eye 

patch. The red color is removed from the area within this circle. 

 Repeat the above for each red eye in your photo. 

 

You can select any red eye patch you’ve applied to a photo by just clicking on it while in 

the RED EYE TOOL. Then you can hit the delete key to remove the selected red eye patch.  
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Or go into the QUICKSHAPE TOOL and you can edit the selected red eye patch 

just as you edit normal ellipse shapes in your documents.  

Therefore if required you can make the red eye patches elliptical if that makes them fit 

the red eye area better. See the Quickshape tool section for information on using this tool 

to edit ellipses. However for most photos the default circular red eye patches are good 

enough for removing red eye effects. 

The edge of the red eye ellipse has a 3 pixel feather applied by default, so there is no 

hard edge to the area from which the red is removed. You can easily adjust this feather 

value by selecting the red eye ellipse (as above) and adjusting the feather value with the 

main feather control (on the right hand side of the top bar), in the same way that you edit 

the feather values of ordinary shapes. 

After applying the RED EYE TOOL the red eye patches are grouped with the photo inside a 

PHOTO GROUP. This is so that as you move the photo around in your document, or 

otherwise transform it, the red eye patches move with the photo. Note that this means if 

you want to select a red eye ellipse when you are not in the RED EYE TOOL, you need to 

hold "Ctrl" down while clicking on the ellipse (which is called a ‘select inside’ operation). 

See the Photo Handling chapter for information on Photo Groups (on page 353). 

Click the CLEAR ALL button on the RED EYE TOOL InfoBar to delete all red eye ellipses 

from the current selected photo. 

Live Effects 

 

Live Effects are bitmap effects that can be applied to any object using Xara Picture Editor 

tools or Adobe® Photoshop® plug-ins.  

The LIVE EFFECTS TOOL is located on the PHOTO TOOL flyout. 

Browse through the list of available Live Effects by clicking the NEW button on the Live 

Effects InfoBar. 
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Add a new Effect 

 
List of effects applied, in order 

 
Edit the selected effect 

 
Live effect resolution 

 
Delete current effect 

 
Lock/unlock all effects 

 Delete all effects 

 
Configure to find plug-ins 

 

Introduction 

 

NOTE: This tool is included in the 64-bit version of Web Designer Premium for legacy 

reasons only, for documents that use bitmap feathering or bitmap shadow effects, which 

will work in 64-bit Designer. The 64-bit version does not support general 32-bit 

Photoshop plug-ins and no 64-bit effects are included with the product. 

Live Effects are bitmap effects that can be applied to any object using Xara Picture Editor 

tools or Adobe® Photoshop® plug-ins.  

The LIVE EFFECTS TOOL is located on the PHOTO TOOL flyout. 

Browse through the list of available Live Effects by clicking the NEW button on the Live 

Effects InfoBar. 

 

 
Add a new Effect 

 
List of effects applied, in order 

 
Edit the selected effect 

 
Live effect resolution 

 
Delete current effect 

 
Lock/unlock all effects 

 Delete all effects 

 
Configure to find plug-ins 

 

Applying a Live Effect 

To apply a Live Effect: 
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1. Select the object or objects in the usual way. 

2. Select the LIVE EFFECTS Tool. 

3. Click the NEW button on the left side of the InfoBar. This displays a partitioned list of 

available effects in a menu. The first set of effects listed in the menu are PICTURE 

EDITOR effects. The second set are effects provided by the built in Xara Web 

Designer Premium FEATHER and SHADOW (on page 274) Tools. The third set of 

effects are "New-style" Photoshop plug-in effects and the final set are "Old-style" 

Photoshop plug-in effects (see below for an explanation of these diFFERENT TYPES). 

4. Select the effect you want to apply from the list. 

5. This will display a dialog or tool that belongs to the effect. You can adjust the 

various controls and you usually get a small preview of the effect in the dialog. 

Click OK when you're done to return to Xara Web Designer Premium. 

Editing shapes 

If you apply a Live Effect to a shape or text, the object remains fully editable. Each time 

you edit it in any way, the Live Effect is automatically re-applied to the object. For locked 

effects this is not possible, and you must remove the effect using the DELETE button on 

the Live Effect InfoBar, edit the shape, and then re-apply the effect. 

Locking effects 

When you resize or rotate an object which has a Live Effect applied, Web Designer 

Premium takes this to be an edit and re-generates the effect. This may not be what you 

want, so it's useful sometimes to be able to lock an effect. 

Old-style Photoshop plug-ins are LOCKED as soon as you apply them. This means the 

underlying shape can't be edited. You can also lock a Live Effect and then when you 

resize or rotate the object the effect remains fixed, as if you were resizing/rotating a 

bitmap. 

As an example of this, imagine a plug-in that always applies horizontal ripples (the 

"Television" Live Effect shown does something similar). Apply this effect to a shape, and 

you'd then see horizontal lines across it. If you then rotated the shape, would you want 

the ripples to rotate with it? If so, lock the effect before the rotation. Or would you want 

the horizontal ripple effect to be re-applied to your now rotated rectangle? If so, leave the 

effect unlocked. 

 

When a Live Effects is locked the effect rotates with the object (left).  
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When giving designs to other people to load, if they do not have the plug-ins that are 

used in the design, then they won't see the effects applied. To get around this problem, 

you can lock the effects. Locked effects are saved as bitmaps in the document so 

anyone can see them, even if they don't have the plug-ins that generated the effects. 

 

To lock an effect, select the object or objects and in the LIVE EFFECTS InfoBar 

click the PADLOCK icon. To unlock an effect that has been locked this way, just 

click the PADLOCK icon again. 

You can still alter the resolution of the effect. For printing, you may want to use a higher 

resolution than if the work is just for screen use. 

Live Effect resolution 

For screen and web use it's best to leave the resolution at the default 96 DPI; the same 

as the screen resolution. If you require a higher resolution image, for example if you're 

printing or wanting to export a high-resolution bitmap, then you can increase this to 150 

DPI or even higher. The higher the resolution, the longer it takes to generate or re-

generate the effect (because it has to work with a much larger bitmap) and the more 

memory is required. 

You can set the resolution of a Live Effect to "Automatic", instead of choosing a fixed DPI 

value. With this setting, the effect will be automatically re-generated when required, at 

the most appropriate resolution. For example, if you print a design containing Live 

Effects, any effects set to AUTOMATIC will be re-generated at print resolution if they are 

not already at that resolution or higher. In a large design with many effects, note that this 

can make printing much slower as each effect has to be re-generated at high resolution. 

You can change the resolution that's used to render effects in THE EFFECTS & PLUG-INS 

tab of the OPTIONS dialog. For more on the Options dialog see Customizing Web 

Designer Premium (on page 509). To change the resolution of an effect that has already 

been applied, use the DPI control on the LIVE EFFECTS toolbar. 

Saving and transferring files 

When you transfer a file to someone else, unless they have the same plug-ins installed 

on their computer, they will not see the effects (this is similar to the problem of fonts; the 

recipient needs to have all the fonts used in the design to see an accurate representation 

of the text in the document). In order to guarantee that recipients can see the effects in 

your design, lock them before saving. 

Because locked effects are saved in the design file as a bitmap, this means the files are 

much larger than for unlocked Live Effects. 

Copying Live Effects 

For more on Copy and Paste, see Object Handling (on page 97). 

You can copy Live Effects in your design from one object to another using PASTE 

ATTRIBUTES, just as you can copy other object attributes. Simply select the object with 
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the effect(s) you want to copy and select "Edit -> Copy". Select the object or objects you 

want to copy the effects onto, and select "Edit -> Paste Attributes". 

Note that you cannot copy "old-style" Photoshop plug-in effects in this way because 

those effects do not have the ability to re-apply themselves. 

Content Aware Photo Resize 

In Web Designer Premium the CONTENT-AWARE PHOTO RESIZE tool is not presented on 

the main toolbar at startup. If you want to use this tool you can find it in the BUTTON 

PALETTE. 

To open the Button Palette choose CONTROL BARS... from the WINDOW menu and scroll 

through the list to the bottom. Then click the checkbox next to the BUTTON PALETTE item. 

(Or right-click on an empty area of any button bar and choose BUTTON PALETTE from the 

popup menu.) 

If you want to use this tool regularly you can move it out of the Button Palette by dragging 

it onto the toolbar. (Hold down Alt, then drag the button and drop it onto a toolbar icon). 

It is possible to drag the content-aware resize button onto the photo tool flyout if you 

ensure that the flyout is open before you drag the button but note that it won't be 

remembered in that position when you next start the program. 

Web Designer Premium includes the ability to stretch photos using a new technique that 

retains the proportions of key aspects of the photo. 

The human eye is particularly sensitive to changes in aspect ratio of everyday objects, 

and most people can tell something is wrong with images that are even slightly squashed 

or stretched. 

 

 

Here is an example photo of the famous 
Torii Gate in Japan. Clearly the gate itself is 
the main subject of this picture. 
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Here the photo has 
been stretched using 
the normal stretching 
method of the 
SELECTOR TOOL. 
Even with this 
moderate stretching 
it's obvious the 
proportions of the 
gate have been 
badly distorted. 

 

Stretching using Content Aware Scaling. It still looks perfectly natural. The gate proportions are 
intact, even at this extreme stretch, which is twice as wide as the original.  The stretched 
coastline remains looking natural. 

Preparing Your Photo 

The content aware scaling feature is part of the PHOTO TOOLS.  

  

Select your photo and from the Photo Tool fly-out bar. Select the CONTENT 

AWARE SCALING BUTTON. The right end of the InfoBar will now show a set of 

buttons. 

 

Select a photo, go into the PHOTO TOOL, and the InfoBar should look like this; 

First click the PREPARE button to prepare the photo for the scaling. This starts an analysis 

of the photo to calculate which parts of the image can be stretched and which parts 

should be kept. This process can take some time depending on the resolution of the 

photo, and how many processors your computer has. 

For really high resolution images it's recommended that the image resolution be reduced 

if you do not require the maximum resolution. Do this before you select the Prepare 

buttons. To reduce the resolution of your photo select the OPTIMIZE button and enter a 
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pixel width or dpi resolution into the dialog. The image size on the page will not change, 

only the resolution or number of pixels inside the photo changes. 

Once you've prepared the image, new resize arrows will appear on the sides of the 

photo. Just drag on these to stretch or squash the image in the desired direction. 

Optimize 

Photos that have been prepared to enable Content Aware resizing have a lot of 

additional data stored alongside them, to enable further adjustments.  When you save a 

document this additional data is saved also, meaning that you can load such a document 

and continue to adjust the width or height without having to do a new Prepare operation. 

When you've finished scaling the photo you are recommended to 'fix' the changes by 

using the Optimize feature. This will convert the stretched image back to an embedded 

JPEG image, at any required resolution, and so make a substantial file size saving. 

Reset 

Clicking the 'Reset' button will restore the image back to its original state, removing any 

stretch, and removing any mask that might have been applied. 

Using Masks With Content Aware Scaling 

Using the MASK PAINTER TOOL you can provide further control by protecting areas of the 

picture from being distorted.  Masked areas will not be distorted at all.  See the Masks 

(on page 287) chapter to find out more about masks, but here's a brief summary of how 

to use masks with Content Aware Scaling. 

To protect one or more areas of the photo from being distorted; 

1. Select the MASK PAINTER TOOL from the Mask tool flyout bar and mark the 

part or parts of the photo you wish to protect.   

2. Now go into the CONTENT AWARE PHOTO RESIZE TOOL and click on the 

photo.   

Now when you use the PREPARE button this area will be protected from distortion. You 

may need to select the photo to enable the PREPARE button. 

Note: You can't mask more than half the image. The prepare operation will give an error 

if you try this. 

Adjusting a mask, or adding a new mask 

You can't add a mask to an image that has already been stretched. Instead, if you want 

to add a new mask or adjust an existing one, you have these options: 

1. Click the RESET button and draw a new mask 

2. Click undo as many times as necessary to get back the mask, and then use the 

mask painter tool to adjust the mask shapes. 
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3. Or, before you select the PREPARE buttons, copy the mask to the clipboard. If you 

want to use this later, perform a RESET on the image, then re-enter the MASK 

PAINTER TOOL and paste the shape back onto the mask layer. 

There is another alternative that you can 'fix' a stretched image using the OPTIMIZE 

feature, and then apply a new mask. This is not recommended in most cases because it 

will produce lower quality results than resetting the image and applying a mask to the 

original image. 

Content-aware photo zoom 

An alternative to content aware scaling is the whereby the photo remains the same size 

and the content is intelligently zoomed inside it. Here's an example of the effect. 

 

 Use the zoom slider on the InfoBar to control content-aware 

photo zoom. 

The picture remains the same size, but the program automatically detects and scales 

(zooms) the 'interesting' content. Note this is not just a crop of the girl, but that every 

element, cloud, and grass that appears in the original is still there in the zoomed version. 

The program automatically detects the girl is the 'region of interest' and so enlarges her 

only. 

Alternative Content Aware Scaling 

When stretching photos there are two alternative ways to scale the image. The method of 

just dragging the size arrows sometimes doesn't work so well with some image types. 

However by holding the "Alt" key when dragging one of the side handles in the CONTENT-

AWARE PHOTO RESIZE TOOL (on page 397) performs a different intelligent scale using an 

alternative algorithm. 

Content Aware Scaling notes 

 You can only compress an image to half its initial width or height 

 If you save a document with a photo that has been prepared for Content Aware 

resizing, then it saves the resizing information in the document. The advantage of this 
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is that you can later re-adjust the photo using the Content Aware feature. There is a 

significant file size overhead of saving photos like this. 

Panorama Stitching 

 

Xara Web Designer Premium includes a tool that can automatically stitch 

together up to 8 photographs into a single wide, high-resolution panorama.  

Creating high-quality panoramas can be a very complex and technical process, often 

requiring special equipment or lenses and accurately exposed and aligned photographs. 

The panoramic stitching feature built into Xara Web Designer Premium requires none of 

these, and can use an every-day digital camera so that anyone can create outstanding 

quality panoramic images in a few minutes. 

This tool features: 

 Automatic estimation of the focal length to warp the images to reduce fisheye effects 

 Automatic barrel, pin cushion and vignette adjustments 

 Automatic exposure correction 

 Automatic detection of shared overlap points and seamless blending of joins 

 Automatic cropping of the final result. 

To create a panorama you need to take a series of separate photos from a central 

position. Ideally each photo would overlap the next by approximately 30%, although it will 

work with more or less overlap. 

The process of creating a panorama is very straightforward: 

1. Import each of the photos. There is no need to try and position the overlaps 

correctly 

2. Select all the photos you want to stitch together, they don't have to be in order. 

3. Click the PANORAMA button on the PHOTO TOOL fly-out bar. 
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It will start the process of stitching and continue as a background process. A popup 

status window shows the progress through the various stages, although you can 

continue using Xara Web Designer Premium like normal while this happens. When the 

process is complete the resulting panorama image is imported onto the page.  Note that 

it does not replace the original images, which you can delete if you no longer require 

them. 

 

Three example photos of a landscape. Each overlaps the other (in this case a bit more than 
necessary). 

 

The resulting single panorama image, with seamless integration. 

Optimizing images 

Xara Web Designer Premium will always stitch photos at the full resolution, even if you 

reduce the size of the image on the page. This is often a desirable thing since it produces 

the maximum quality, highest resolution results. But it does mean that the stitching 

process can take a few minutes. So sometimes you may prefer to reduce the resolution 

of the images before you stitch them together, especially if you only require a medium 

resolution final result, perhaps for the web. 

To reduce the resolution of any image, reduce its size on the page to the required size 

and then use the "UTILITIES" > "OPTIMIZE PHOTO" option. Note that the panorama stitcher 

works better with higher resolution images (it's easier for it to find matching points on the 

photos). 
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When you get the stitched image back, this is stored as a PNG image in Xara Web 

Designer Premium. This is the highest quality, but takes a lot of memory and file space, 

especially if it's a high-resolution panorama. (The BITMAP GALLERY will show you how 

much). Therefore you can usually benefit from reducing the resolution of the final image 

and converting it to a JPEG instead. Again use the "UTILITIES" > "OPTIMIZE PHOTO" option 

for this. 

Notes: 

 The panorama stitcher expects the images to be the same resolution and size. 

 Try to avoid taking pictures with moving objects in. These can confuse the system 

since the same object might appear in different places, or not at all. 

 Try to keep the horizon at the same approximate position on each photo 

Hint: By taking photos in a portrait orientation, you can get maximum vertical coverage. 

Upgrades to Panorama Studio 

There is an optional upgrade to a more flexible and powerful panorama studio program. 

This provides more features and controls over the stitching process. Xara Designer Pro 

users get this separate program for free, bundled on the product CD. 

If Panorama Studio is installed, you will be given the option to use it instead of the 

standard version when you select the "Panorama" button. 

Color palette from photo 

 

The COLOR PALETTE FROM PHOTO tool can analyze a photo, identify the most 

predominant colors in the image, and create a color palette of those colors. It adds or 

updates the theme colors in the current document accordingly. This makes it easy to 

match the colors in a document to those of any photo. 

Simply select the photo you want to use to set the document colors, then click the icon 

on the PHOTO TOOL flyout bar. 
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The pages below have been designed to use the standard Xara theme colors that work 

with the PALETTE FROM PHOTO feature. Each of the 3 versions of the page has had the 

photo changed and then PALETTE FROM PHOTO invoked to update the document’s colors 

to match those of the photo. In all other respects these 3 designs are identical. 

 

Web Designer Premium instantly analyzes the photo and chooses up to 5 of the most 

predominant, but independent colors (very similar shades of the same color are 

considered as a single color). It uses these to set the values of the named colors THEME 

COLOR 1 to THEME COLOR 5. If these colors are already in your document, as they 

probably will be if you used a Xara template, they are updated. Otherwise they are added 

and you will see them appear at the bottom left of your color line.  

If the graphical objects that make up your document don’t use these standard Xara 

theme colors, then you won’t see those objects change color. So make sure your 

document uses the standard theme colors, and shades of those colors, to make your 

document easy to re-color. When there are limited numbers of significant colors in the 

image, the program uses shades of gray for the lower theme colors. 

 

The 5 theme colors for each of the 3 examples above - together with their lighter and darker 
linked colors. 
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Using Theme colors  

It’s always good design practice to limit the number of different colors within a document. 

But the use of shades of your predominant color is to be encouraged. To help make the 

use of lighter and darker shades, the program creates two linked paler, and two darker 

shades of each of the THEME COLOR 1 to 5 colors. You can see in the above examples 

the use of brighter and darker shades of THEME COLOR 1 and 2. 

The color analysis is based on an algorithm that determines the predominant colors 

based on their brightness, and coverage area. It automatically combines similar shades. 

For example, a blue sky typically contains many lighter and darker shades of the same 

blue hue. So this would be created as a single blue color. It also adjusts the brightness of 

THEME COLOR 1 and 2 (the two most predominant colors) so it always provides a good 

contrast against a white page background.  

This means you can always use THEME COLOR 1 as a heading color, for example, and it 

will be readable. Or, alternatively you can place white text on THEME COLOR 1 or 2, 

perhaps a colored rectangle of THEME COLOR 1 or 2, and that text will also always be 

readable. 

See Theme colors (on page 182) for more info on the color schemes. 

Text Color 

Another common technique designers use, is to link the main text color to the 

predominant theme color, although obviously this needs to be dark enough to provide 

enough contrast to be legible. Therefore Web Designer Premium also creates a named 

color call TEXT that could be used for the body text of your document. 

Extracting Colors from Logos 

This feature also works with any image - including transparent PNGs so, for example, if 

you add a company logo graphic to your page that includes your brand colors, you can 

automatically set the Theme Colors to match those used in your company logo. 

Customizing  

You can customize The named colors the usual way. Right click on the color patch on 

the color line, and select EDIT.  
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3D Extrude Tool 

Introduction 

The EXTRUDE TOOL provides a fast and easy way of turning 2D drawn shapes and text 

into high quality 3D "extruded" versions, with colored light illumination and very high 

quality shading. It is based on the technology used in the Xara 3D stand-alone program. 

On-screen dragging allows real-time 3D object rotation, dragging of the extrude depth, 

and adjustment of three lights in 3D space around the object. 

 

The InfoBar provides control over the bevel type drawn down the extruded length. You 

can chose from more than 25 different types of bevel. 

 

Extruding a shape 

 

To turn a 2D shape into a 3D extruded object, go into the EXTRUDE TOOL on 

the main toolbar and simply click and drag on your object to rotate it in 3D 

space. 

Initially, your extrusion is given a default depth. The face color of the 3D shape is 

determined by the fill color of the original shape and the color of the extrude (or side) by 
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its line color. After creating an extrude in this way, move your mouse pointer around over 

the 3D object. You'll see that the mouse pointer changes as follows to indicate what will 

happen if you click and drag at any point: 

 

This is shown when the mouse pointer is over the front or back face of the 

object. Clicking and dragging rotates the object in 3D space. 

 

This is shown when the mouse pointer is over the extrusion (the side) of the 

object. Clicking and dragging changes the depth of the extrusion. 

 

This is shown when the mouse pointer is over the extrusion and "Ctrl" is held. 

Clicking and dragging changes the bevel size (see below) 

You can also rotate an extrusion by holding down the Alt key while dragging on the 

extruded side. This is useful when only the side of an extrude is visible and so you aren’t 

able to drag on the face in order to rotate it. As when dragging on the front face, Ctrl and 

Shift can also be used to constrain the rotation. 

Extrude Tool InfoBar 

 

 
Extrude on/off 

 
Slider type list 

 
Slider and numeric value for selected parameter 

 
Bevel type 

 
Bevel size slider and value 

 
Lights on/off 

 Gloss/matt 

 
Rounded/mitred corner 

You can adjust a 3D extruded object by manipulating it directly on the page as described 

above, or by selecting it and using the controls on the InfoBar of the Extrude Tool. 

Turning extrudes on and off 

 

EXTRUDE ON/OFF 

Once a shape or other object has been extruded, there are only limited modifications that 

can be made to the original object with the extrusion in place. For example, if you've 

extruded a shape, it's not possible to then edit that shape in the SHAPE TOOL (on page 

153) because it's no longer a simple 2D shape that you can interact with. However, using 

this control you can temporarily turn the extrusion off, so that you can see and modify the 

underlying object using other tools, before turning the extrude on again. After making a 

modification and turning the extrusion on again the extrusion is re-applied to your 
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modified 2D object, with all the same 3D attributes that it had when you turned off the 

extrude. 

Note that in some cases if you dramatically change the form of the object while the 

extrusion is turned off (such as changing it to a completely different type of object), the 

3D extrude attributes you applied may not be preserved. In such cases you should be 

able to use PASTE FORMAT/ATTRIBUTES to copy the attributes from a copy of your original 

extrude before the modification. See Copying styles: Paste attributes (on page 121). 

Extrusion depth 

The easiest way to adjust the depth of an extrusion is to simply click and drag on it, as 

described above. However, you can also use the slider on the left of the EXTRUDE TOOL 

InfoBar to adjust it. Make sure that EXTRUDE DEPTH is selected in the dropdown list to the 

left of the slider (this is the default setting) and then use the slider to adjust the extrude 

depth. The current extrude depth is shown in a numeric field to the right of the slider, and 

you can also enter extrude depth values directly into that field to set an exact extrude 

depth. 

Bevel Type & Size 

The bevel type determines the profile of the extruded side of your 3D shape and of its 

edges and corners. By default it's set to rounded which gives a flat side with rounded 

corners. The bevel type dropdown list contains a large selection of different bevel types 

you can choose from. You can adjust the size of the bevel using the slider to the right of 

the bevel type list. To the right of the bevel size slider is a numeric field showing the 

current bevel size and you can enter exact bevel sizes into this field.  

An alternative shortcut to adjust the bevel size is to drag on the side of the 3D object 

holding "Ctrl" (while in the EXTRUDE TOOL). 

Lights 

 

LIGHTS ON/OFF 

You can adjust the lighting of your shape in 3D space by turning on the lights. There are 

3 lights, each of which can be given their own color and position in 3D space around the 

3D shape. 
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In this example the face color of 

the shape is set to white. But you 

can see that it appears green 

because there is a green light 

shining almost directly onto the 

front face of the shape. 

By adjusting the colors of the face 

and extrude and the positions and 

colors of the three lights, you can 

enhance the realism of the 3D 

objects in your design.  

Behind the object is a beige / orange colored light and another that is a purple color. Both 

lights cause reflections down the side, and changing the color, or direction of the lights 

behind will change the reflected highlights. 

To move a light around the 3D object, simply drag on the light arrow. If you happen to 

drop a light so that it is behind the 3D object and therefore isn't selectable, you can 

retrieve it by using the left slider on the Extrude InfoBar. Select one of the light angles 

from the dropdown list to the left of the slider (e.g. "Light 2 Angle 1") and then adjust the 

slider. The light moves around the 3D object in your design. The various "light angle" 

options in this dropdown list allow you to move any of the lights in any direction in 3D 

space to achieve the positions you want. However for most purposes you can achieve 

good results most easily by dragging the light arrows directly on the page. 

To change the colors of the lights, you can simply drag colors from the color bar and drop 

them directly onto the light arrows. To edit a light color with the color editor, double click 

on the light arrow you want to change and the color editor opens with that light color 

selected. You can now edit the light's color. With the color editor open, as you click on 

the different light arrows, extrude face and extrude sides, the color selected in the color 

editor dropdown list changes to match your selection, so you can quickly select the 

different colors on your extrude to modify them. 

Gloss / Matt 

 

Use this toggle button to make the surface of a 3D object more or less 

reflective. With the gloss option on lights placed at the correct position behind 

the object will "bounce off" the sides to good effect. 

 

Mitred corner / Rounded corner 

 
You can choose either MITRED or ROUNDED corners for your 3D object. 

"Mitre" gives square edges, while "Round" produces rounded edges. 
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Textures & Photos 

When you extrude a photo, the photo remains on the front face of your 3D object. 

Therefore, you can produce impressive 3D photo effects in seconds by simply importing 

a photo and extruding it. 

 

This effect is created by extruding a photo, rotating it slightly, creating a reflected copy using 
the SELECTOR TOOL, and the 3D angle adjusted to match. It's then given a graduated 
transparency to create the faded reflection. 

You can use any photo or texture on the face of your extrude. Either import your image 

and extrude it as described above, or drag and drop an image onto the face of an 

existing extrude with "Shift" held down. This applies your photo or texture to the face of 

the extrude object. 
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Extruding Text 

Extrude text the same way that you extrude any shape; just click and drag on the text 

while using the EXTRUDE TOOL. As you would expect, doing this on more than a few 

words can be rather slow and is not recommended. 

 

Because text is usually black, unless you change the color the extruded result will also 

be entirely black, so making it difficult to see. So it's recommended that you change the 

color of the text before you extrude it (although you can change this after by just clicking 

on a color). 

As with other extruded objects, if you want to edit the text, just turn off the extrude using 

the button on the left of the Extrude InfoBar, edit the text, and then switch the extrude 

back on again with the same button. 

Copying 3D extrude attributes 

You can copy and paste the style of the 3D extrusion, from one 3D object to any other. 

This works the same way as for all Web Designer Premium attributes. Simply copy the 

source extruded object to the clipboard, and then select a new one and select "EDIT" > 

"PASTE FORMAT/ ATTRIBUTES".  Note this will only paste the 3D attributes onto another 3D 

extruded objects. So you will have to extrude any shape first before pasting the 3D 

attributes. 

This will copy all the 3D attributes such as the extrude depth, light colors, bevel type as 

well as the face and outline colors. 
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Putting shadows behind 

Using the SHADOW TOOL (on page 274) you can enhance the 3D effect by placing a soft 

shadow behind the object. Simply apply the SHADOW TOOL and drag on the 3D object. 

 

The left example is using a wall shadow, the right us using a floor shadow. 
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Navigation Bars 

Web Designer Premium and Navigation bars 

Most websites have a navigation bar, either horizontal or vertical, from which all the 

important pages of the site can be accessed.  

 

Xara Web Designer Premium includes special support for navigation bars (known as 

NavBars for short), making it easy to add, edit and delete buttons. The buttons in a 

NavBar can adjust their widths to match their labels automatically and they are 

repositioned automatically after any changes you make. You can even add dropdown 

menus and sub-menus to your bar and opt to have buttons automatically added and 

deleted as you add and delete pages.  

Advanced users can create their own bars from button designs of their own, and modify 

the button designs used in an existing NavBar and have the new design applied across 

the whole bar. 

Using template Navigation bars 

The ONLINE CONTENT CATALOG contains a wide range of template Navigation bars for 

you to use. There are both horizontal and vertical bars and they are fully customizable. 

Just import a bar from the gallery to place it on your page. Or replace an existing bar by 

dropping the new one onto it – the new bar takes on all the button labels, links and 

menus of the bar it replaces.  

When you drop the bar you may be prompted to match the color scheme of the 

document if the bar does not have the same color scheme. You can also use the Color 

replacement feature to change the bar's colors - all without having to ungroup the bar into 

its constituent objects. Just select the bar and click a color on the color line, or bring up 

the color editor and choose the color you want to edit from the color dropdown list. 

See Theme color schemes (on page 182) for more about editing color themes, and look 

at Replacing colors (on page 184) to see how to easily customize colors.  
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It is of course possible to create NavBars yourself from any button design - If you want to 

create your own, see the later section in this chapter. 

Navigation bar properties dialog 

The best way to edit the labels, links and other attributes of a NavBar, and to add or 

remove buttons, is to use the Navigation Bar properties dialog. Double click on a bar to 

bring up the dialog, or right click on it and choose ‘EDIT NAVIGATION BAR’ from the context 

menu. 

 

The upper half of the dialog allows you to set various properties of the NavBar. The lower 

half allows you to add and remove buttons and menus and to edit the labels and links of 

each button and menu entry. 

 

Orientation 

Choose whether you want your NavBar to be horizontal or vertical. For vertical NavBars 

you will normally want to make all buttons the same width (the width of the widest 

button), so you get a rectangular bar. See the "ADJUST ALL BUTTONS TO WIDEST LABEL" 

option below, which controls this. 
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Justification 

Choose how you want your bar to behave when its length changes as you edit labels and 

add/remove buttons. A LEFT JUSTIFIED horizontal bar will grow to the right as you add 

more buttons or make the button labels longer. And the left edge of the bar stays in the 

same place on the page. Similarly a RIGHT JUSTIFIED bar keeps its right edge in the same 

place and grows to the left. And a CENTER JUSTIFIED bar grows to left and right equally. 

Choose the centered option if, for example, you want a horizontal NavBar centered at the 

top of your page. 

 

Adjust button widths to labels 

Turn this option on if you want your buttons to be stretchy, so they grow and shrink as 

required to fit in the label text applied to the button. With this option off, your buttons will 

remain the same size and so a label that’s too long for the button will extend beyond the 

edges of the button. 

 

All buttons the same width 

This option is enabled only if the above ‘Adjust button widths to labels’ option is on. 

Select this option to make all your buttons the width of the widest button in the bar. For 

vertical NavBars this is almost always desirable so that you get a rectangular bar. For 

horizontal bars it often makes the bar look neater with each button the same size, but it 

requires more space and so you may not be able to fit as many buttons into your bar with 

this option turned on. 

 

Button spacing 

Here you can choose to have some space between each button in your horizontal 

NavBar, if you don’t want each button to sit right up against its neighbor. Simply enter the 

number of pixels of space you would like and see the result on the canvas immediately.  

 

Button order matches page order 

Turning this option on makes the NavBar button order match the the page order in the 

document. If you re-order pages in the PAGE AND LAYER GALLERY this also results in the 

NavBar being similarly re-ordered. This is mainly useful for NavBars in presentation 

websites, where the linear ordering of the pages is important and you want the buttons in 

your bar to be in the same order as the pages in your presentation. 

Site navigation bar 

This is a very important option on the NAVBAR DIALOG, which turns on automatic linking 

so that buttons and links are added to your bar for you, as you add pages. And all 

changes you make to the bar are reflected on every page of the site as soon as you 

close the NavBar dialog. 

Normally you have this option on only if you want your NavBar to appear on all pages of 

your website. However you can manually delete the bar from pages if desired. 
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The site navigation bar is also useful for automatically repopulating the menu items on a 

single button NavBar after converting it from a multi-button NavBar. See Single button 

NavBars (on page 417) for more info. 

Moving and transforming a site navigation bar 

If you move a site navigation bar on the page, the bar is also moved on all the other 

pages on which it appears. Similarly if you scale the bar to make it larger or smaller using 

the SELECTOR TOOL, again the same transformation is applied to the copy of the bar on 

the other pages. No other transformations of a NavBar using the SELECTOR TOOL are 

supported (rotation, skew, scaling in one dimension). 

 

Automatic page linking 

Whenever you add a new page to your site, a link to that page will be added to your site 

navigation bar for you and the new page will be given a copy of the bar, if it doesn’t 

already have one. If your bar has an unused button on it, then the first such button will be 

linked to your new page. If all buttons are already linked, a new button is automatically 

added to the end of your bar and it is linked to the new page. In either case, the label of 

the button is changed to match the name of the new page, if it has a name, or to "New 

page" otherwise. Normally you will want to immediately edit this new label in the NavBar 

dialog. 

When you delete a page from your website, the button linking to it on your site navigation 

bar is automatically deleted for you, on all pages of your site. 

Turning site navigation bars on and off 

When you turn the site navigation option on or off in the NavBar dialog, the change is 

reflected in all copies of that bar on all pages of your website. 

 

Deleting a site navigation bar from a page 

If you don’t want the site navigation bar on a particular page of your site, you can simply 

click on it to select it on that page and hit "Delete". You’ll be asked whether you want to 

delete the bar from just that page, or from all pages.  

However after removing the bar from one or more pages, note that if you subsequently 

turn off the site navigation bar option (perhaps in order to edit the button design, which 

can’t be done with the option on), and then later turn it back on again, the bar will be 

added automatically to all the pages of your site that don’t have it. 

Templates & Site navigation bars 

All the single page templates in the ONLINE CONTENT CATALOG have their NavBars set to 

be site navigation bars when you load them from the gallery to start a new website 

document. This means you can rapidly build a small website with all pages linked to the 

bar, without having to add buttons and page links manually. Similarly all website 

templates have site navigation bars turned on. If you don’t want this behavior, simply turn 

off the site navigation bar option on the NAVBAR DIALOG. 
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The standalone NavBars presented with each theme in the gallery do not have site 

navigation turned on by default. This is because any user adding bars manually is less 

likely to want that bar on every page of their site, with a link to every page. But again, the 

option can easily be turned on in the NavBar dialog if required. 

 

Other points to note 

If you delete a button which points to one of your pages, or change the link on it to point 

elsewhere, no special action is taken to restore a button link to the page. It’s assumed 

you decided that you didn’t want a direct link to that page in your site navigation bar. New 

buttons and page links are only created when a page is added. 

Single button NavBars 

Sites designed to be viewed on small mobile devices have little space for horizontal or 

vertical NavBars, so a more space efficient solution is needed. Using a NavBar with a 

single button and a menu is one such solution that works well, no matter how many 

pages are in the site.  

 

Single button vertical NavBar 

To make a single button NavBar from an ordinary NavBar, simply open the NAVIGATION 

BAR PROPERTIES dialog (double click on the NavBar) and delete all but one of the 

buttons. Then also remove the link from the button (click the URL field next to the button 

in the dialog and choose DO NOTHING in the Link dialog). Now you can either start adding 

menu entries to the button manually in the NavBar dialog, or a menu entry can be added 

automatically for each page in your site. To add the links automatically, turn on the SITE 

NAVIGATION BAR option in the dialog (or turn it off and then on again if it was already on). 

You’ll see your menu becomes populated with a link to each page of your site. Edit the 

names of each entry in the menu if you don’t want them the same as the page names.  

There’s a selection of different NavBar designs in the ONLINE CONTENT CATALOG under 

"COMPONENTS" > "NAVIGATION BARS". Also each of the themes under Website Themes 



 

 418 Navigation Bars 
  

 

 

(General) have their own NavBar designs. Change the design of your NavBar by 

importing a new design from the Online Content Catalog and dropping it on your bar.  

IMPORTANT: Note that some NavBars have first and last button designs that differ from 

the design of their center buttons. These NavBars are unsuitable for single-button use 

because the centre button design is unlikely to look good on its own, so the Navigation 

Bar Properties dialog will not allow you to delete the left and right buttons from these bars 

to leave just a single button. So choose a NavBar design where all buttons on the bar 

look the same.  

 

All buttons the same - suitable for a 
single button NavBar. 

 

Different end button designs - 
unsuitable for a single button NavBar. 

To convert a single button NavBar back to an ordinary multi-button bar, just add more 

buttons and delete the menu entries from the first button, if no menu is required.  

Buttons & Menus 

Edit the button labels, links and other button attributes using the table and tree controls in 

the lower half of the NAVBAR DIALOG. Each row in the table corresponds to a button in the 

bar, or to an entry in a menu under one of the buttons. 

 

 

Adding & editing buttons 

To add a button, double click in the first column where it says "Double-Click To Add 

Button". A new row is added below the row for the last button. Or click the ADD button at 

the bottom of the dialog to add a button following the selected button. You can 

immediately start editing the label for the new button. Press return to complete the label 

edit, or click away from the label. 

You can edit any button label by first clicking the appropriate row to select it and then 

clicking again in the first column to start editing the label. 
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To set the link on a button, double click on the URL field, or if the row is already selected 

you can just single click on it. The WEB PROPERTIES LINK DIALOG appears. This should 

look familiar as it’s the same Link dialog (on page 293) that you use for adding other links 

to your page, so you have the same link options available. A few options are disabled 

because they are not applicable to NavBar and menu links, such as the pop-up photo 

option which only works when applied to a photo. 

You can also set the tooltip text for each button using the 3rd column. Edit the text the 

same way as you edited the label text. In the exported web site the text entered appears 

as a small pop-up tooltip when the mouse pointer is held over your button or menu entry. 

 

Creating Your Own Mouseover Buttons 

You can create your own mouseover buttons from scratch by drawing the necessary 

elements from rectangles, text, etc. Just draw the main parts of the button on the 

MouseOff layer (remember to group it (on page 44)) and place the corresponding 

'highlight' version on the MouseOver layer. As long as the MouseOff version has a web 

address link, then the MouseOver version will automatically be displayed as you move 

the mouse over it on the web page. (The MouseOver layer must be on top of the 

MouseOff layer). 

 

In other words, you give the main object a web address using the link  option, and 

then select the MouseOver Layer in the PAGE & LAYER GALLERY, and place the 

required mouseover versions of your button on this layer so it overlaps the linked 

object. 

Technical note: Any graphic object on the MouseOver layer will be displayed as long as 

at least 50% overlaps with the object on the MouseOff layer. The two versions of 

mouseover buttons are kept in sync by using the Soft Groups feature. When you select 

the button on one layer, it automatically selects the Soft Grouped version on the other 

layer, even if the layer is switched off.  When you edit the text of the button on one layer, 

it's automatically synced with the other version of the button. 

To ensure the text on both the Off and Over states changes when you edit either, Soft 

Group the buttons on both layers. To do this you will need to enable both layers in the 

PAGE & LAYER GALLERY, and lasso select around both buttons. The status line should tell 

you if you have everything selected. Select "ARRANGE" > "APPLY SOFT GROUP".  Now 

when you edit the text on the Off layer it will also change on the over layer, even if it's 

hidden.  (Note this only works if the Off and Over text are the same to start with, and 

relies on the objects being Soft Grouped). 

Once you have a working button, you can easily turn it into a navigation bar. Select the 

button (along with its MouseOver state if it has one) and then choose "ARRANGE" > 

"CREATE NAVIGATION BAR". The navigation bar dialog appears allowing you to configure 

your bar. See the Navigation Bar chapter (on page 413) for more information on this, 

including how to have different first and last buttons in your bar. 
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Adding menus and sub-menus 

In the first (label) column, you’ll notice that there is a plus icon  to the left of each label. 

This is a tree control and clicking the plus icon next to a button label, expands that button 

node, allowing you to add a menu to that button. 

Click on the DOUBLE-CLICK TO ADD MENU ITEM text below the button to start adding a 

menu. Or click the ADD button at the bottom of the dialog to add a menu item below the 

selected item. A new row appears in the table for each menu entry you add. You set the 

label, link and tooltip for each menu entry the same way you do for buttons. And you can 

add sub-menus to any menu the same way – by first expanding the menu entry node of 

the tree. 

 

Note that users with touch screen devices will not be able to see menu items if the top 

level button has a link attached. This is because a touch action on the linked button will 

invoke the link rather than displaying the underlying menu. If this is the case, a warning 

will appear to tell you that you have a button with both a link and a menu attached and 

offering you the option to remove the button link.   

Menu separators 

You can add a separator into your menu by clicking the ADD SEPARATOR button at the 

bottom of the dialog. The separator is added following the currently selected menu item. 

Separators allow you to visually group together related items in your menu. 
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Menu Styles 

Click on the MENU STYLE… button to bring up the MENU STYLE DIALOG. This allows you to 

change how the menus appear and behave on your NavBar. 

 

Font 

Choose a font to be used for the text on your menus. Only the web safe fonts are listed, 

which are the fonts that all visitors to your site should have. There is also an option to 

make the font bold and you can change the font size used. 

NOTE: This doesn’t change the font used for the button labels of your bar, only the font 

used on menus. To change the button label font, see the section about this later in this 

chapter. 

Direction 

Choose the direction in which your menus should open. For horizontal NavBars you’ll 

normally want this to be downwards and for vertical bars either left or right depending on 

where on the page your bar is located. 

Spacing 

With this setting you can add space between the entries in your menu, spreading them 

out and making the menu larger as a result. 
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Border 

Add a border to the panes of your menus by entering a border width in pixels. 

Animation 

By default menus will open instantly, but here you can choose to have the menu 

animating as it opens. 

Transparency 

You can choose to have your menus semi-transparent, so that your page can be seen 

through the menu panes. Enter the level of transparency you would like as a percentage. 

Horizontal offset / Vertical offset 

You can offset the menu panes horizontally or vertically from the buttons. Just enter the 

number of pixels of offset required. 

Updating your NavBar across all pages 

As described above, if you have the SITE NAVIGATION BAR option turned on for a NavBar 

then all changes that you make to the bar on one page are automatically applied to all 

the other pages too, including the location of the bar on the page.  

However if you don’t have that option turned on, set the navigation bar object to be a 

repeating object (right click and choose "REPEATING OBJECT" > "REPEAT ON ALL PAGES") 

that appears on every page and all changes you make to any instance of the object 

automatically update on all pages.  

See Repeating objects (on page 124) for more information. 

On canvas editing 

 

You can edit your button labels directly on the canvas using the TEXT TOOL. Just 

go into the TEXT TOOL and click in the label text to start editing it. You can also 

change the button links directly on canvas – just click on a button in the 

SELECTOR TOOL and then click EDIT in the link pop-up that appears. 

All changes you make to the NavBar are automatically applied to the other copies of that 

bar on other pages. 

 

Changing the font on NavBar buttons 

You can change the font used for the button labels on a NavBar easily. Select the bar by 

clicking on it. Then go into the TEXT TOOL and select from the font list on the left of the 

TEXT TOOL INFOBAR. As you move the mouse pointer over the different fonts in the list, 

the NavBar updates immediately so you can see how that font would look. Select the 

required font. If your bar has a mouseover state, it is also updated to use the same font. 
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Similarly you can change the size of the font using the font size control which is next to 

the font selection list. 

Importing & pasting NavBars 

If you import or paste a NavBar into your document, the site navigation option on that 

NavBar is turned off automatically, if it was on. This is to avoid any conflicts with any 

existing site navigation bar in your document.  

However if the incoming bar is of the same theme and type as the existing site navigation 

bar in your site (ie., are part of the same repeating group), it will immediately be updated 

to match that existing site navigation bar. Hence in this case the bar will not appear on 

your page in its original form.  

If the bar is of a different theme or type (ie., are not part of the same repeating group), it 

will appear unmodified. 

Creating your own Navigation Bars 

You can create a NavBar from any button design. The ONLINE CONTENT CATALOG 

contains many different button designs, or you can draw your own. See the „Creating 

your own Mouseover Buttons (on page 419)" section of the Getting Started chapter for 

information on how to do this.The button may or may not include a mouseover state. 

To create a NavBar, select the button and then select "ARRANGE" > "CREATE NAVIGATION 

BAR". The NAVIGATION BAR DIALOG appears and you can immediately add more buttons 

to your bar, just as for other NavBars. 

You can also create NavBars with more than one button design (so you can have 

different designs for the first and/or last button in the bar). See the section below, which 

describes how to do that. 

Button design restrictions 

There are some rules you must follow when creating your own buttons for use in 

NavBars. 

Stretchy button limitations 

In order to get reliable results when your buttons are automatically stretched you are 

advised to make sure that there are no path control points or graduated fill/transparency 

control points in the horizontal area occupied by the button label text object. 

Text in a button 

Each state of the button design must be a group object containing a text object that can 

serve as the button label. This text object should be a simple text object, not a text 

column or text area. That is, it should be created in the TEXT TOOL by clicking on the 

page and typing, not by first dragging a text line or text box. 
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Your button design cannot consist of text alone. It must include at least one shape in 

order to be used in a NavBar. 

Soft grouping button states 

If there are several states in your button, e.g., mouseoff and mouseover, they need to be 

soft grouped together, so that they stay together when one state is moved or otherwise 

transformed.  
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Website Presentations 

About Presentations 

Xara Web Designer Premium allows you to create web presentations - much like a 

Microsoft PowerPoint® presentation but as a Supersite (on page 324) website with 

effects such as animated step transitions within a page, and smooth animated page 

transitions.  

Presentations are just normal HTML web documents, and are compatible with all modern 

browsers as well as phones and tablets. They automatically scale to fit any browser 

window size.  

Viewers of your web presentation can move through it sequentially, step by step and 

page by page, using the right arrow and Page Down key to view the next step or page, 

and the left arrow or Page Up key to move backwards. There is also a pop-up navigation 

bar, which appears at the bottom left corner of the presentation allowing easy on-screen 

navigation of presentation pages.  

You export your presentation in exactly the same way as you would for a conventional 

website and you can also to export as PowerPoint® (.ppt) presentation too.  

Steps and layers 

Steps in a Presentation are really just layers, that are animated onto the page, one at a 

time. If you open the Page & Layer Gallery (on page 444) you'll see all of the steps, as 

layers, plus a few other layers.  

The 'background' of each slide, in the Page & Layer Gallery, is called the MOUSE-OFF 

layer. Above this there's another MOUSE-OVER layer that holds items that have mouse-

over behaviour, such as buttons, navigation bars, 'next page' arrows, etc. In addition 

there is a PASTEBOARD BACKGROUND and a PAGE BACKGROUND which are special, 

usually locked, layers.  
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It's important to note you don't need to use the Page & Layer gallery to create or edit 

your presentation. The main Presentation toolba (on page 427)r can be used to add, 

delete and jump to any step in your Presentation.  

 

Presentation steps in the Page and Layer Gallery - the arrow shows the current step. 

You can re-order the steps in your presentation by re-ordering the layers in the gallery. 

The step numbers update automatically. 

The current step is indicated by the arrow symbol (in the above screenshot Presentation 

step 2 is current). Simply click on a step to make it current.  

On the canvas, only objects on the current layer and below are shown. This reflects how 

your presentation will look when that step is reached in the presentation. So for example 

in a 3 step presentation, if step 2 is current you won’t see any of the objects drawn on 

step 3 until you make that step or higher current.  

Additionally you can click on the "S" (Solo) icon next to the step you want to view, to 

show only that step on the canvas. Click the icon again to return to normal view.   

As with ordinary layers, you can click and drag an object to move it from one step to 

another in the PAGE & LAYER GALLERY.  
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The Presentation toolbar 

Xara Web Designer Premium automatically displays the Presentation toolbar on the right 

of the standard toolbar when you create or open a presentation document. 

 

The toolbar allows you to: 

 

Make a new presentation step that contains any 

currently selected objects. You can create steps 

quickly by dragging or pasting objects on to the 

page, selecting them and clicking this button. 

Even if the currently selected objects are already 

on a presentation step, clicking this button will 

move selected items to a new step. If you have no 

objects selected when you press this button, a 

new empty step is created and made current, so 

anything you subsequently draw or add will be 

placed on that step. 

 

Move the selected objects to the MouseOff layer, 

so that they are not part of any presentation step 

and so are permanently displayed as 'background' 

objects. 

 

Duplicate a presentation step (perhaps the easiest 

way of creating a new step). The step containing 

the selected object is duplicated in its entirety, not 

just the selected object. The new step is also 

made the current step. 

 

Delete the current presentation step. The entire 

step containing the selected object is deleted, 

including any other objects on that step that may 

not be selected. 

 

Jump to any of the steps in the presentation as 

well as the Background/MouseOff layer.  

 

 

Displays the Web Transition tab of the Layer 

Properties (on page 449) dialog, allowing you to 

choose a transition type for the presentation step 

that the currently selected object(s) are in. 



 

 428 Website Presentations 
  

 

 

 

Creating a presentation 

There are three ways to create a new presentation: 

 Start with a pre-designed template and then customize this with your own text, photos 

and color scheme.  

 Create a presentation from scratch, bringing in all the required elements, text, graphics 

and photos onto the page and ordering the content into the presentation steps and 

pages you require. 

 Convert an existing website/web document into a presentation.  

Creating a presentation from templates 

 
Open the ONLINE CONTENT CATALOG - "FILE" > "NEW FROM ONLINE CONTENT 

CATALOG".  

Find the PRESENTATIONS folder in the catalog and double click to expand it.  

The theme folders contain collections of presentation designs and associated graphic 

files that each follow a specific theme. Browse through the various theme folders until 

you find a design you like and double click on the first thumbnail, named 'Presentation'. 

A new presentation document opens displaying all the template pages, already 

populated with several pages, each containing a number of presentation steps that 

already have content. A number of transitions have already been applied to the pages 

and the steps.  

  

Click  PREVIEW WHOLE WEBSITE to open a preview window - then click on one of 

the browser icons in the top right of the window to launch an external browser. 

You need to preview your presentations in a separate web browser to see the 

transition animations perform well. You can then use the arrows in the top left of 

the presentation (or on your keyboard) to see the steps and transitions in action. 

Also try moving the mouse pointer to the lower left corner of the Presentation 

preview windows to see the pop-up navigation controls 

Close the preview.  

Customize the text and photos using your own content, just as when editing a website 

document. 

Creating your own presentation from scratch  

This section describes the best workflow for creating a presentation page by taking you 

through an example, to help you get started quickly. 

Choose "NEW" > "PRESENTATION (WIDESCREEN)"   or "NEW" > "PRESENTATION (4:3 

NORMAL)" from the FILE menu depending on whether you want a widescreen (16:10) 

presentation, or a normal (4:3) presentation. 



 

Website Presentations 429  
 
 

 

Note: 16x10 is a better compromise for some wide-screen monitors and tablets that are 

not exactly 16:9, and it’s not so squashed. But you can create any aspect ratio you 

require of course. 

  

A new blank document window opens, displaying the presentation document 

icon on its tab at the top of the document window.  

The Presentation Toolbar also appears at the right end of the top bar. The buttons on the 

toolbar are enabled only when you have something selected on the page. 

1. Use the TEXT TOOL to add some text to your blank presentation, perhaps a heading 

at the top of the page. Select this text object using the SELECTOR TOOL and look at 

the status line at the bottom of the Web Designer Premium window.  It will say that 

you have a text object selected on the MouseOff layer. Everything on the MouseOff 

layer will be permanently visible in your presentation, as if it’s part of the 

background. So preview your page and you’ll see your text heading on the page. 

2. Now add another new text object using the TEXT TOOL. Again, this will be placed on 

the MouseOff layer and the status line will show you this when you select it with the 

SELECTOR TOOL. But now let’s make this text appear as the first step in this 

presentation.  

3. With the text selected in the SELECTOR TOOL, click the ‘foot’ button, which is the first 

button on the Presentation Toolbar, called MAKE NEW STEP. Now look at the status 

line – it now shows that the selected object is on "Presentation step 1" instead of 

MouseOff.  

4. Preview the page again. Initially you can see only your initial text heading. Press the 

right arrow key on your keyboard and the second text object will fade in. That’s the 

first step added to your presentation! 

5.  Step 1 is now the current step, so if you draw another shape or add some new text, 

it will also be placed on step 1. Draw a rectangle using the RECTANGLE TOOL. Select 

it with the SELECTOR TOOL and notice that the status line shows the rectangle as 

being on Presentations step 1 which is also the current step. 

6. Preview your page again and you’ll see that when you click the right arrow key, the 

text and rectangle fade in together. 

7. A quick way to create a new step from an existing step is to use the DUPLICATE 

STEP button. Select the rectangle and press this button. The entire step is 

duplicated, including the text that you didn’t select, but which was on step 1 along 

with the rectangle. Select the new text or rectangle and the status line shows you 

it’s on a new presentation step. The new step now becomes the current step - 

Presentation step 2, and any objects you now create will be added to that step. 

8. If you want to move an object to another step, right click on it and you’ll see a 

PRESENTATION sub-menu in the context menu that appears. That sub-menu itself 
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has a MOVE TO STEP sub-menu, that lists all the existing steps on this page. Just 

select the required step. There’s also a NEW STEP option in the menu, that does the 

same thing as the MAKE NEW STEP button you used above.  

9. You can change the effect used by each step easily. Select one of the rectangles 

you just added and then press the last button on the Presentation Toolbar titled 

STEP TRANSITION EFFECT. This brings up a dialog that allows you to select a 

different transition instead of the default "fade" transition. Choose SLIDE IN FROM 

RIGHT. Preview your page again and this time when you press the right arrow key 

the text and rectangle slide in from the right. 

10. If you decide that you want an object to be permanently visible, instead of part of a 

step, select it and choose the MOVE TO BACKGROUND  button on the Presentation 

toolbar. That puts the object back on the MouseOff layer. Try this on one of the 

objects you placed on a step. 

11. The ONLINE CONTENT CATALOG includes some useful components for presentations, 

under "PRESENTATIONS" > "PRESENTATION COMPONENTS". Just drag and drop a 

component onto your page. Each component is added to the current step. If that’s 

not what you want, use the presentation menu to move it to a different step, or to 

the background (MouseOff) layer. (Note that the HEADINGS and TRANSITION 

CONTROLS components are always added to the MouseOff/Background layer). 

12. Remember as described above, the PAGE & LAYER GALLERY shows you all the 

presentation steps on your page, in order, since each presentation step is in fact 

just a separate layer. And only the current step and steps below/before it are shown 

on the canvas.  

Converting an existing website into a presentation  

In the website document, right click a page and choose WEB PAGE PROPERTIES to display 

the Web Properties dialog.  

Click the Website tab and click the PRESENTATION WEBSITE checkbox to select it. 

  

The document's tab at the top of the workspace displays the presentation 

document icon. 

Note: Layers within the document are not automatically turned into presentation steps 

when you turn a website into a presentation. You have to manually convert each layer 

into a presentation step - see Turning a layer into a step. However, when you turn a 

presentation into a website, presentation steps are automatically converted to layers and 

renamed 'step 1' etc. 

Managing presentation steps 

You can typically manage presentation steps by: 
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 Right clicking an object in a step and choosing PRESENTATION then choosing your 

required option from the sub-menu that appears 

 Using the buttons on the Presentation toolbar (on page 427)  

 Using the PAGE & LAYER GALLERY 

Viewing step contents 

Sometimes you may want a clearer view of exactly which objects are in a step. You can 

either use the JUMP TO option in the Presentation toolbar to take you to a particular step 

or layer, or else use the PAGE & LAYER GALLERY.  

For ease of navigation, the JUMP TO menu will only display the Background/MouseOff 

layer and the presentation steps. If you need to select another layer (MouseOver, Page 

Background, Pasteboard Background) simply select it in the PAGE AND LAYER GALLERY 

and it will be displayed as the current layer in the JUMP TO menu dropdown. 

If you click on a step in the PAGE & LAYER GALLERY all the steps above your selected 

step will be hidden and all the steps below will be visible thus giving you a precise view of 

your position in the presentation as shown on the canvas. This is also true if you select a 

step using the JUMP TO option. You can still hide or reveal any steps in the presentation 

by clicking on the eye icon.  

Additionally you can click on the "S" (Solo) icon next to the step you want to view, to 

show only that step on the canvas. Click the icon again to return to normal view.   

Note that the Background in the JUMP TO menu is referred to as the MouseOff layer in the 

PAGE AND LAYER GALLERY. 

Moving objects from one step to another 

You can move objects from one step to another step in one of three ways: 

 In the PAGE & LAYER GALLERY, click and drag the object(s) from one step to another or 

right click the object(s) and choose MOVE TO CURRENT LAYER. 

 Right click the object(s) and choose "PRESENTATION" > "MOVE TO STEP" then choose 

the number of the step you want to move the object(s) to, or BACKGROUND if you want 

to move the objects to the MOUSEOFF layer or NEW STEP to move to a brand new step. 

 Use cut and paste to move objects from one step to another. Cut the object (Ctrl+X), 

then go to the JUMP TO drop down menu on the Presentation Toolbar to select the step 

you want and then paste (Ctrl+V) or paste in place (Ctrl+Shift+V).  

Changing step order 

The order in which steps are revealed is the order in which the steps appear in the PAGE 

& LAYER GALLERY, as indicated by the step numbers. You can click and drag steps above 

or below each other in the PAGE & LAYER GALLERY until all steps are in the order you 

want. 
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Deleting objects from a step 

Right click the object and choose CUT or DELETE, or in the PAGE & LAYER GALLERY right 

click the object and choose DELETE or click the object then press the DELETE button in the 

standard toolbar. 

When you delete an object and it's the only object in a step, Web Designer Premium will 

automatically delete the empty step but only after a Save or a Preview operation. This 

allows the addition of new objects to a step without disturbing the existing step order.  

After a Save or Preview operation, empty steps will be deleted and the remaining steps 

re-numbered accordingly.  

Deleting a step 

 

Select an object in the step and click the DELETE STEP button in the 

Presentation toolbar or right-click and choose PRESENTATION > DELETE STEP. 

Alternatively in the PAGE & LAYER GALLERY right click the layer and choose DELETE 

LAYER.  

 

Adding new presentation pages 

Right click the Xara Web Designer Premium pasteboard and choose NEW PAGE to add a 

new blank page or DUPLICATE CURRENT PAGE to add a copy of the currently selected 

page. 

 

Creating Number and Bullet lists 

When you add bulleted or numbered lists to a presentation, each item on the list is 

automatically made into a separate presentation step when you export your presentation. 

This makes it much easier to create and edit animated list items. To add new list items 

just hit return at the end of one of the existing items. The transition effect used for each 

bullet point during the presentation is that set for the presentation layer on which the list 

resides (you cannot set different effects for different points in the same list). 

To turn the feature off, right click in the text area while the TEXT TOOl is selected, choose 

PRESENTATION > PRESENT BY PARAGRAPH from the menu and deselect the option. Now 

when you export/preview your presentation the list is no longer split into separate steps. 

To find out more about creating bulleted and numbered lists see Text Handling > 

Applying text appearances (on page 191) 
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Deleting presentation pages 

Right click the page and choose DELETE PAGE. Or select the pages you want to delete in 

the PAGE & LAYER GALLERY and hit Delete, to delete multiple pages at once. 

 

Linking to next/previous step 

You can easily add buttons/objects to a presentation page that reveal the next step in the 

page. Just add or create your button, and use the LINK TO list in the Link tab (on page 

294) of the Web Properties dialog to apply a link to the button/object that will display the 

next presentation step.  

When the viewer has displayed all the steps on the page using a 'next presentation step' 

link or the right arrow key, clicking the button or key again displays the next page. 

Note: If you convert a presentation into a web document (PRESENTATION WEBSITE 

checkbox in Web Properties dialog Website tab), any next/previous presentation step 

links automatically turn into next/previous page links. You cannot apply 'next/previous 

presentation step' links to a web document. 

Applying presentation step transitions 

When you create a step, Web Designer Premium automatically assigns the Fade 

transition type to it.  

To change a step transition: 

  

Open the Web Transitions tab of the Layer Properties dialog either by clicking 

the Layer Transition Properties button in the Presentation toolbar or right click an 

object in the step and choose PRESENTATION > TRANSITION. Or in the PAGE & 

LAYER GALLERY, select the step and then click on the PROPERTIES tab. 
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Choose a transition from the TRANSITION EFFECT list, drag the SPEED slider to choose a 

transition time between 0-5 seconds, and click APPLY. 

 

New steps you create get the transition effect of the last step in the presentation by 

default. This means if you want the same transition on all steps, you only need to set it 

once on the first step and then all subsequently added steps will use the same transition. 

Applying presentation page transitions 

Each presentation page can be given its own transition. To add a transition for the 

current page, right-click on the page and select the PAGE TAB (ON PAGE 302) of the WEB 

PAGE PROPERTIES dialog.  

Then select a page transition type from the TRANSITION EFFECT drop-down list and move 

the SPEED slider to apply a transition speed from 0 to 5 seconds. 

Then when your website visitor navigates to the page with the animated transition, they 

see the animated transition. 

You can also set the page transition for multiple pages at once. Just select the pages you 

want to change in the Page & Layer Gallery (use Shift+click and Ctrl+click to extend the 

selection), then change the transition on the Page tab, as above. 
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Note: The page transitions will only work for a website if it's set to be a Supersite. 

Presentation documents are Supersites by default so there is no need to visit this option 

in the WEBSITE TAB of the dialog.   

 

Advanced presentation information 

Pop-up layers and presentation layers 

Presentation layers are just ordinary layers with the presentation option selected in the 

Layer properties dialog. Once this option is turned on for a layer, any name the layer had 

is overridden with "Presentation step (N)" in the PAGE & LAYER GALLERY, where (N) is the 

step number. 

You can mix popup layers and presentation layers in a presentation document, but of 

course only the presentation layers will be revealed as the visitor steps through the 

presentation by pressing the arrow keys.  

Having both layers and presentation steps is useful if you want to keep features such as 

popup layers in your presentation. You can change layers into steps (and turn steps back 

into layers) by toggling the PRESENTATION LAYER checkbox in the Layer Properties (on 

page 449) dialog's Web Transition tab.  

 

When you create a new step, this checkbox is automatically selected.  
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If you deselect it to turn a step into a layer, this removes the step from the presentation, 

even though its contents and any layer transition remain. The converted layer, however, 

will not be displayed when a viewer navigates through a presentation using either the 

arrow keyboard keys or a next/previous presentation step link. 

Website Widgets 

This chapter describes how to add dynamic content to your website, such as movies, 

animations, forms and thousands of the available gadgets such as page counters and 

currency converters. We refer to these using the general term of "website widgets", or 

just "widgets" for short.  

 

 

Widgets & placeholders – it’s all automatic! 

In Xara Web Designer Premium a widget is any object you can place on your web page 

that displays some sort of dynamic content, that may also be interactive. That content 

may be sourced from an external website (e.g., a news feed widget) or may be published 

with the website. On the Web Designer Premium canvas, a widget is represented by a 
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static ‘placeholder’ image that defines the position and dimensions of the widget on the 

page. And attached to that placeholder is the HTML code and files (e.g., Flash, 

Javascript, photos, etc.) that make the widget function in the exported page. 

A placeholder is normally an image that looks like a static snapshot of the widget itself, 

but it can be a simple rectangle or any other object. The placeholder usually has the 

same dimensions as the widget, so that you can sensibly position it with respect to other 

content on your page. 

The good news is that placeholder images are normally rendered automatically for you 

by Web Designer Premium.  

Types of Widget 

There are basically three types of widget, which differ in the way that you customize and 

configure them in Xara Web Designer Premium. A brief description of each type follows, 

but more detail about each type is provided later in this chapter. However for all three 

types of widget you can simply double click on the placeholder image to edit them. 

Web Editable Widgets 

When you customize these widgets, a web browser window opens up onto the remote 

website that provides the widget and you configure and customize the widget using that 

web interface. 

Locally Editable Widgets 

These widgets are edited in Web Designer Premium itself, but typically in a separate 

multi-page document that makes the whole set of content for the widget easily editable. 

For example, for a slide show widget that cycles through 10 photos, all 10 photos would 

be easily visible and editable within the widget’s multi-page document that’s used to edit 

it. Again, usually you’ll insert these widgets from the ONLINE CONTENT CATALOG. 

Manually Editable Widgets 

These are widgets that you add manually by either pasting the HTML code for the widget 

directly into Web Designer Premium or by using the "UTILITIES" > "WEB PROPERTIES" > 

"PLACEHOLDER" tab to insert the code. Or you create them by importing a file such as an 

animation file or movie file onto your page.  

No other interface is provided by Web Designer Premium for editing the widget, other 

than the PLACEHOLDER tab that allows you to change the file or code that defines the 

widget. 

Important: A few of the version 10 gallery widgets are incompatible with the new sticky 

and animation features, if used on the same page or in the same supersite, and so may 

need to be replaced with updated versions from the Online Content Catalog. Click here 

http://support.xara.com/index.php?/Knowledgebase/Article/View/816/ for details on the 

support site.  

http://support.xara.com/index.php?/Knowledgebase/Article/View/816/
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Widgets from the Online Content Catalog 

Many of the elements under the COMPONENTS folder in the ONLINE CONTENT CATALOG are 

widgets (as indicated in the titles). 

To add a widget, just drag and drop it from the gallery onto your page. What happens 

next depends on the type of widget. If it’s a Web Editable Widget, a browser window will 

open to allow you to configure the widget on the widget provider’s website. If it’s a Locally 

Editable Widget, a placeholder image will appear on your page. Double click on the 

placeholder and a new document opens within Web Designer Premium, which allows 

you to customize the widget. 

See the website at http://www.xara.com/widgets for more information. 

Inserting 

Press the HELP button at the bottom of the window to see some information to guide you 

through the process of configuring the widget and inserting it on your page. For most 

widgets, you need to get to the point where the widget website offers you the HTML code 

that needs to be inserted into your web page. As soon as this is visible, you can normally 

click the Insert button at the bottom of the window. Xara Web Designer Premium will then 

find the HTML code and will insert it into your page for you. 

For some widgets, Xara Web Designer Premium is unable to retrieve the HTML code 

from the site directly and you need to first copy the code to the clipboard. Select the code 

in the browser window and press Ctrl+C. Many widgets make this easy for you by 

providing a copy button next to the code. Once you’ve copied the code, click the INSERT 

button. 

Automatic placeholder generation 

When you press the Insert button, if Xara Web Designer Premium found the widget code 

the widget website window is closed and you will see an indication that Xara Web 

Designer Premium is busy rendering a placeholder image. After a few seconds an image 

of your widget appears on your page. Now all you have to do is preview your web page 

and you should see your new widget working on your page! 

 

Widget site membership 

Some widgets may require you to open an account with the widget provider, before you 

can use them. Most are free, but some offer premium services over and above the free 

offering. See each individual widget and the information on the widget provider’s site for 

details. 

 

Editing existing widgets 

At any time you can double click the widget placeholder (or right click and choose EDIT 

WIDGET) in your Web Designer Premium's page to return to the widget provider’s website 

so you can easily modify or replace the widget.  

http://www.xara.com/widgets


 

Website Widgets 439  
 
 

 

Those widget providers who give you an account, will normally also keep a copy of any 

widgets you’ve created. This means you can sign into your account while going through 

the insertion process above and then find, modify and insert a widget that you’ve created 

previously. Inserting existing widgets is just like inserting newly created widgets – just 

click INSERT when you are offered the HTML code, or copy the HTML code for the widget 

to the clipboard and then click INSERT. 

 

Embedding movie, audio, animation and other files 

Xara Web Designer Premium includes direct support for some types of file that you are 

likely to want to add to your website. For these files you can simply drag and drop them 

from Windows Explorer onto your page, or use "FILE" > "IMPORT".  

On import the file type is identified, an appropriate placeholder or link is added to your 

page, and the file is copied into the support folder for your design. The support folder is a 

folder which lives alongside your design file and is created automatically. If your design 

file is called „MySite.web", its support folder is „MySite_web_files". The contents of this 

folder are included along with all the image files for your site, whenever the site is 

exported and published.  

 

MP4 & FLV movie files 

These are the only movie files directly supported by Xara Web Designer Premium. 

Import an MP4 or FLV file and Xara Web Designer Premium inspects the file to 

determine the aspect ratio and other information about the movie.  

You are asked whether or not you want the movie to start playing automatically as soon 

as the page holding it is loaded (auto-play) although bear in mind that browser support 

for this option varies and may change due to explicit restrictions being added to the 

browsers to prevent auto-play. Firefox and Chrome no longer support auto-play.  

The movie file is then inserted, as well as some other files for a Flash movie player, into 

the support folder of your website. A placeholder image resembling the movie player 

appears on your page.  

Position and resize the placeholder using the SELECTOR TOOL, and then preview your 

page. Click on the movie player play button to start the movie. That’s it! The movie player 

includes basic controls for adjusting volume, starting & stopping and for jumping to any 

point in the movie. 

Alternatively you can use some of the widgets in the ONLINE CONTENT CATALOG to 

present your movies instead. This way you have more control over the presentation. See 

"COMPONENTS" > "PRINT AND WEB COMPONENTS" > "AUDIO / VIDEO". 

See this Xara Knowledgebase article https://xara.kayako.com/article/447-why-does-my-

audio-video-media-not-autoplay-within-my-website-after-publishing for up to date 

information on browser support for auto-play. 

https://xara.kayako.com/article/447-why-does-my-audio-video-media-not-autoplay-within-my-website-after-publishing
https://xara.kayako.com/article/447-why-does-my-audio-video-media-not-autoplay-within-my-website-after-publishing
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Flash files 

To include a Flash animation on your website, import the Flash file (.swf). You can simply 

drag and drop the file from Windows Explorer onto your web page document or else use 

"FILE" > "IMPORT".  

The Flash file is copied into the support folder of your design, so it will be exported and 

published with your website. And a placeholder image is rendered and placed onto your 

page.  

You can resize Flash animations, so simply use the SELECTOR TOOL to resize the 

placeholder image to the required size, and position it by dragging it around.  

Preview your page to see your working Flash animation on your web page. You must 

have Flash installed in order for it to play successfully.  

 

MP3 files 

Import an MP3 file to add audio to your web page. A prompt allows you to choose 

whether the audio should start automatically when your page is loaded (some browsers 

may restrict this) or whether it should only start when the play button is pressed on the 

player. 

As with the other file types above, a placeholder image showing the player is generated 

and placed on your page and the MP3 file and all other files needed to make the player 

work are copied to the support folder of your document and will be included in your 

exported website. Preview page to see the player in action. 

The player is simple and unobtrusive. You can start and stop the audio, click on the time 

line to jump to different parts of the audio, adjust the volume (click on the volume 

indicator line) and mute (click the speaker icon). 

Technical note: The player uses the native HTML 5 capabilities of the web browser to 

play the audio, if the browser supports it and if it also supports the MP3 format. 

Otherwise Flash is used. This means the player will work in all major browser versions 

(older browsers don’t support HTML 5 and even some modern browsers don’t directly 

support MP3). 

Animated GIFs 

Add an animated GIF to your page just the same way as for Flash files. Import or drag 

and drop the GIF file onto your page. It gets copied to your design’s support folder and a 

static placeholder image is generated for it. Resize and position the placeholder, then 

preview your page and you’re done! 

 

PDF Files 

You can import PDF files into a web document in two different ways. Either import it so 

that the contents of the file are copied onto your page (as when importing a photo). Or 

you can link to a copy of the file in your website and have the file published with your site. 
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When importing a PDF file a prompt is shown to let you choose between these two 

options. 

When adding a link, the PDF file is copied into the support folder of your design, so it’s 

exported and published with the rest of your site. And a link is added which looks like this 

on the page: 

 

Clicking the link on your exported page normally opens the PDF file, but the exact 

behavior varies depending on the user’s browser settings. 

Widgets from other widget sites 

There are hundreds or thousands of sites offering widgets of some form or another and 

the ONLINE CONTENT CATALOG offers only a tiny subset of what is available on the web. 

Just about all widgets are provided to you in the form of a small piece of HTML code. The 

widget provider will normally give you some simple instructions on how to insert the code 

into your web page, but with Xara Web Designer Premium it really is very simple. 

Copy the code from the widget provider to your system clipboard, just as you copy text in 

a word processor. Sometimes the widget provider may even provide a ‘copy’ button 

which copies the code for you.  

Then in Xara Web Designer Premium go into the SELECTOR TOOL and then do a normal 

paste operation (Ctrl+V). You’ll see that Xara Web Designer Premium recognizes the 

HTML code and immediately starts to render a placeholder image, just as it does when 

inserting a widget from the ONLINE CONTENT CATALOG. The placeholder appears on your 

page, usually with the most appropriate size for the widget. You can then preview your 

page to see your working widget! 

You can also paste widget code into both the head and body of your page using the 

Placeholder tab (on page 312) of the Web Properties dialog. 

NOTE: If you are in the TEXT TOOL when you paste the code, it will be pasted as text 

instead of producing a placeholder! And once you’ve pasted the contents of the clipboard 

as text once, it will continue to paste as text even if you switch to the SELECTOR TOOL and 

paste again. If you get into this position, return to the widget website and copy the code 

again. Then do the paste while in the SELECTOR TOOL. 

Adding a Cookie Consent banner 

Adding a cookie consent banner to your website is easy.  

Most third party applications for creating Cookie consent banners allow you to create and 

customize a banner and then generate code for you to paste into the HTML head of your 
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web document. You can do this using the HTML CODE (HEAD) button on "UTILITIES" > 

"WEB PROPERTIES" > "WEBSITE" tab. 

Follow the guide at help.xara.com https://help.xara.com/article/446-adding-a-cookie-

consent-banner to learn more. 

Resizing widgets 

You can resize the placeholder images for Flash, MP4 movies and animated GIFs to 

similarly resize the content as it appears on your page, because this type of content is 

scalable. Most of the Locally Editable Widgets are also resizable, but some are not and 

won’t allow you to drag the resize handles of the placeholder image. 

Some Web Editable Widgets will allow you to resize them even though the widget 

content won’t scale. For these widgets the placeholder object merely determines the 

bounds of the area in which the widget can render, so making the placeholder too small 

for the widget will mean that the widget gets cropped in your web page. The placeholder 

image gets regenerated whenever you resize it, so it will reflect any cropping of the 

widget too, as shown in this example. 

  

 

Placeholder with default size Placeholder with reduced size 

Similarly making the placeholder larger for such widgets will merely result in empty space 

around the widget, on the page and in the placeholder image. For widgets like these 

which don’t resize correctly when you resize the placeholder, it’s best to stick with the 

original default size. 

There are some widgets which can be improved by resizing the placeholder, even if the 

widget itself doesn’t scale. Some widgets will fill the container into which they are 

inserted, which may mean they come out much bigger than required, with blank areas 

filling the space. You can experiment by resizing the placeholder for such widgets in 

each direction and this may make the widget smaller without losing the key parts of the 

widget. 

For example this Form widget has rendered much too wide and tall and so there is 

wasted space below and to the right of the form controls. Resizing it down doesn’t 

change the size of the form controls, it just results in the form being cropped.  The result 

is a much neater form placeholder taking up much less space on the page. 

https://help.xara.com/article/446-adding-a-cookie-consent-banner
https://help.xara.com/article/446-adding-a-cookie-consent-banner
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Placeholder with default size Placeholder made narrower and shorter 

 

Turning off placeholder re-generation 

The placeholder image will be regenerated whenever you resize it or change the code or 

file it’s attached to. Sometimes you may want to turn off that regeneration so that the 

placeholder image won’t change again. You can do this by deselecting the checkbox at 

the bottom of the PLACEHOLDER TAB in the "UTILITIES" > "WEB PROPERTIES DIALOG". 

 

Adding widget placeholders manually 

If you don’t want Xara Web Designer Premium to create a placeholder image 

automatically, you can set one up yourself. First create a placeholder object (perhaps a 

rectangle of the appropriate size or an imported image that you want to use to represent 

the widget on your page). Select the object and then open the Placeholder tab in the 

"UTILITIES" > "WEB PROPERTIES".  

 

Or press the placeholder button on the Web properties flyout bar on the top bar. 

In this dialog you can choose to associate the selected object with a Flash file or other 

file, or with HTML code that the dialog allows you to paste into the head or body of the 

web page. See the PLACEHOLDER TAB section of the Web Properties Dialog (on page 

311) chapter for details on this dialog.  

Normally you don’t want to select the "Re-generate placeholder" option if you want to 

keep the placeholder object you’ve created yourself. Selecting the option will cause your 

placeholder to be replaced with an image generated from the code or file you have 

specified in this dialog. 
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Page & Layer Gallery 

The Page & Layer Gallery 

By default the PAGE & LAYER GALLERY is displayed on the right hand side of the Web 

Designer Premium window when you open the program. You can pin, move or dock the 

gallery - see Galleries for more information. 

 
You can open and close the gallery by clicking the PAGE & LAYER GALLERY tab 

on the Galleries bar, or press F10. 

The PAGE & LAYER GALLERY lists everything in your document, from the pages and layers 

right down to each individual item on the page. It provides a way to select, hide, lock and 

re-arrange these items. 

It works at many different levels: PAGES, LAYERS, PRESENTATION STEPS and OBJECTS. 

The hierarchy of items is like this: 

Pages    

 Layers/steps   

  Page items, which may include 

groups 

 

   Group contents 

Some of the key features of the PAGE & LAYER GALLERY include: 

Page control 

 Displays a list of pages 

 Pages mode displays a narrow list of page thumbnails for easy page navigation 

 Add new page, duplicate, cut, copy and paste or delete pages. 

 Re-arrange the page order by dragging 

 Rename pages (right-click > RENAME PAGE) 

Layer control 

 Displays a list of all layers on each page, from the bottom (usually background layer) 

to the top most layer 

 In a presentation document, displays a list of all presentation steps and layers on each 

page, from the first to the last 

 Create new layers, delete, re-order and rename layers 

 Hide or show layers 

 Lock layers (which makes the layer non-editable) 

 Solo a layer - turn all other layers off 

Object control 

Display a list of all items (objects) on the page in the stacking order they appear on the 

page, bottom to top. 

 Hide or show any item 

 Move up and down the stack 
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 Lock any object so it becomes non-editable 

 Locate and highlight any object in the gallery by clicking it on the page when in 'Locate' 

mode - toggle the LOCATE button on (enabled) and off (disabled) 

 Solo an object - turn all other objects off 

 Move objects into or out of a group using drag and drop, or move an object from one 

group to another. (Note this is only supported for ordinary groups, not anchored or 

repeating groups for example). 

 Rename objects (right click > RENAME OBJECT) 

In addition the PAGE & LAYER GALLERY shows a thumbnail of each page and a tiny 

thumbnail of each item on the page. Hover the mouse pointer over an item to view a 

larger thumbnail. 

 

This shows the MouseOff layer has been expanded to show the contents of that layer. This 
shows a NavBar group and other various groups, text line and text column items, and a couple 
of shadow group items. 

Hovering the mouse pointer over the tiny thumbnails will display a larger one so you can easily 
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identify each object on the page. 

Note the right two columns indicate (and control) whether the items are editable (a pale arrow) 
or locked (padlock icon) and whether they are visible on the page (pale open eye icon) or 
hidden (darker closed icon). 

Clicking on these icons will change the visibility and / or the locked or editable nature of each 
object. 

Pages 

Clicking the PAGES button on the top of the PAGE & LAYER GALLERY (or right clicking in 

the gallery and choosing SHOW PAGE LEVEL) will open pages mode, displaying only the 

pages in the document and collapsing all other opened levels. 

When in pages mode and the gallery is docked, the width of the gallery is reduced to its 

minimum, to take up as little space as possible. Also the number of buttons at the top of 

the gallery is cut down to just those applicable to pages. To leave pages mode, simply 

expand one of the pages to reveal its layers. The gallery returns to its full width and the 

full button set is restored.  

You can select multiple pages in the gallery by Ctrl+clicking on pages to add them to the 

selection, or by holding Shift down  to select a range of pages. Then you can copy, 

paste, delete or re-order multiple pages at once. You can also paste objects from your 

clipboard to the selected pages.  

You can re-order pages by dragging on the selected pages in the PAGE & LAYER 

GALLERY, or by right clicking a page and choosing MOVE PAGE UP/DOWN. 

You can change the page transitions for multiple pages at once by first selecting them in 

the gallery and then changing the settings on the Page tab of the "Utilities" > "Web 

Properties" dialog. This is particularly useful to quickly change the page transition effect 

used for all pages in a presentation at once. 

You can rename a page by right clicking it and choosing RENAME PAGE. As well as being 

a useful way to identify pages in long documents, the page name is used when exporting 

your document as a website.  

Layers 

Everything in your document has a stacking order but with more complex documents that 

have dozens, maybe hundreds or thousands of items, your work area can be become 

cluttered.  

Using layers you can group a collection of items together and then turn the whole 

collection on or off (make it visible or hidden) in one easy operation. Layers can be made 

invisible, to hide parts of your document. You can give layers names, and you can easily 

create new layers or delete them. And you can open a layer and view its contents. 
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When you select any object, the layer it's on is shown on the status line at the bottom of 

the window. 

The Current Layer 

When you create any new object on the page, it's placed in one of the layers, called the 

active layer or simply the current layer. On a blank document this will either just be called 

Layer 1 or, in the case of web documents, it's called MouseOff. The current layer is 

shown with a selection arrow  . 

Important: All new drawn items, shapes, photos, text, and all pasted items, are placed 

on the current layer marked with the  symbol. 

You can change the current layer simply by clicking on its row in the PAGE & LAYER 

GALLERY.  It's important to understand that you can have a selected object on any layer 

or even multiple layers, and these need not be the current layer. The current layer, with 

the arrow, only indicates where new items will be placed. 
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This example PAGE & LAYER GALLERY shows the current layer is called MouseOff (the current 
page is called news). So if you draw anything new it will be placed on the MouseOff layer.  

It also shows a shadow group item selected in the document (highlighted in blue) inside 
another group which is on a completely different layer called Holiday photo 2.  

Four layers are hidden (called Holiday photo 4, Holiday photo 3, Holiday photo 1 and 
MouseOver). The 'Page background' layer is locked. 

Make the current layer always visible 

It's possible that the current layer can be hidden or even locked. Just clicking on a layer 

to select it and making it the current layer does not normally change its visible or locked 

state. But there is a preference in the General (on page 510) tab of the Options dialog 

(right click a page and choose PAGE OPTIONS or choose OPTIONS from the UTILITIES 

menu) to make the current layers always visible and editable (unlocked). If you select this 

option then whenever you select any layer in the PAGE & LAYER GALLERY it's made visible 

and unlocked. Moving to another layer will restore the previous visible and locked state of 

the layer you just moved from. 

Layers on websites 

In websites saved from Web Designer Premium, layers are used for mouseover or pop-

up effects (in the web browser the contents of these layers are displayed when you click 

on or move over items on the page). 

You can find more details on this in the Web Graphics and Web Sites chapter in the 

Layers, Mouseover (Rollover) & Pop-ups (on page 56) section. 

Soft Groups and Layers 

Soft Groups (on page 115) are unusual because they are groups of objects that can span 

different layers. (Normal groups have to be contained within one layer). When you select 

any part of a soft group the other parts are also selected, even if they are on hidden or 

locked layers. The PAGE & LAYER GALLERY will show all selected items highlighted in 

blue, but in the case of soft groups these items may be on other layers that you've not 

expanded, and so are not immediately visible.  

See the section on Soft Groups (on page 115) in the Object Handling chapter to find out 

more. 

Layer Operations 

Clicking the LAYERS button on the top of the PAGE & LAYER GALLERY will display only the 

layers on the current page. This is a mode - the layers button stays depressed. While in 

layers mode, as you move to different pages the layers for the current page are always 

shown and all other page nodes are collapsed. Click the LAYERS button again to turn off 

layers mode.  

You can re-order the layers, that is the stacking order on the page, by using drag and 

drop on the layers in the PAGE & LAYER GALLERY. 
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You can rename a layer by performing a second (slow) click on the layer name. (The first 

click would select the layer.) This is very like file renaming in Windows Explorer.  

Holding the mouse pointer over the small layer icons  will show a thumbnail of the 

contents of the layer. 

When you have selected a layer (clicked on it, to highlight the layer) the NEW, DUPLICATE 

and DELETE buttons on the top of the PAGE & LAYER GALLERY will do as they imply. The 

NEW button will create a new blank layer and place it at the top of the stack. You can re-

arrange the order by dragging it to the required position. 

The DUPLICATE button will copy the layer and its contents and place it on top of the stack 

- that is on top of all other objects on the page. 

Layer Properties 

This opens the Layer Properties dialog. 

 

Creating layers and editing layer properties 

Using the Layer tab you can: 

 Create a new layer or edit an existing one. 

 Make the layer editable and visible by default. 

 Define the layer as a web page background that will not appear when printed. 
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 Specify that all objects in the layer will only repel text objects (on page 227) within the 

same layer. This prevents text on the layer being repelled by objects in other layers 

and is useful for popup layers in web pages. 

Using guidelines 

The Guides tab allows you to create layer guidelines at precise numeric values and 

choose a color for guide layer objects. 

See the GUIDE OBJECTS & GUIDELINES section in Object handling for more information on 

using  guidelines. 

Pop-up settings 

 

Note: The PRESENTATION LAYER checkbox is only enabled if you are in a presentation 

document. To convert a web document into a presentation document, see Web 

Presentations (on page 425). 

Using this tab you can apply animated transition effects to a layer, if it’s used as a pop-up 

layer on a web page, or if it’s a presentation layer. The layer then appears with the 

transition effect when it’s revealed in the exported web page. Use the slider to set a 

transition time from 0-5 seconds.  

In a presentation document, a layer can be set as a presentation by checking the 

PRESENTATION LAYER checkbox. See Website Presentations (on page 425). 
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Note: Turning off the PRESENTATION LAYER option will remove the step from the 

presentation. 

By default when a transition is applied, objects will only slide in/out to the edge of the 

web page. If you would like objects to start from the browser window edges, rather than 

the web page edges, deselect the CLIP TO PAGE edges checkbox in the Website tab (on 

page 298) of the Web Properties dialog. 

Special Layers 

There are several special types of layer. They appear in the PAGE & LAYER GALLERY and 

can be turned on and off as usual, but behave slightly differently. 

BACKGROUND LAYERS are non-printing layers that appear at the bottom of the document, 

under everything else.  When you apply a color to the page background (drag and drop 

color from the color line) this will create a PAGE BACKGROUND layer automatically. 

Normally this is locked. 

You can also set the color of the pasteboard (the area around the page) by dragging a 

color from the color line and dropping it on the pasteboard. This creates a PASTEBOARD 

BACKGROUND layer automatically. Again, this layer is locked. 

When saving a document as a website, Background layers are converted to web page 

backgrounds. See the Getting Started (on page 17) chapter for more details on setting 

web page backgrounds and using the background layers. 

The GUIDES LAYER is where guidelines or guide objects are placed. When you create a 

guideline this automatically creates a Guides layer. You can select the Guides layer and 

place anything you like on this layer - and it will act like a snapping guide (if you have 

'snap to guide' on).  

See Guide Objects and Guidelines in the Object Handling chapter to find out more! 

Hiding Layers 

The rightmost two columns of icons in the PAGE & LAYER GALLERY control the visibility 

and locking of layers.  

Clicking on the open eye  icon will hide the layer on the page, and the icon will turn to 

a closed eye . Clicking again will revert the layer to be visible. 

When any item is hidden, it becomes invisible on the page and can no longer be seen or 

selected. The way to get hidden items back is to click its closed eye  icon. 

Alternatively you can click the MORE... button and select SHOW ALL option, which un-hides 

all items on the current page. 
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Solo Mode 

If you click any of the  icons in the column next to each layer, it will 'solo' this layer 

which means it hides everything else, except this layer. You can now work on this layer 

in isolation. Clicking the  icon again will restore everything back to how it was before. 

 

You can also click and drag down the column of  icons to quickly browse through the 

layers in isolation from everything else. 

To exit the Solo mode, click the  button again. 

Locking Layers 

Clicking the open padlock icon  on the right end of a layer row will lock the layer (icon 

changes to a closed padlock ). Now you cannot select any object on that layer. Any 

clicks on locked items will go straight through it, as if it's not there, and select items 

underneath. Clicking the padlock icon will unlock that layer again. Alternatively you can 

click the MORE.. button and select the UNLOCK ALL option. 

Soft Groups 

There is one exception to the locked rules. If an item on a locked layer is part of a Soft 

Group (on page 115), then selecting and operating on that Soft Group will also select and 

operate on any locked items in that Soft Group (this is the intended operation of Soft 

Groups). 

Show All & Unlock All 

 

These two controls on the top of the PAGE & LAYER GALLERY are a short-cut to show all 

items on the current page or unlock all items. They are a temporary override of all the 

individual object and layer settings. Clicking the controls again will restore the previous 

state. So this is a quick way of showing or unlocking everything, on all layers, performing 

some operation, and then restoring the previous state. 

The Unlock all button is useful if you have a locked object on the canvas that you want to 

unlock, without having to first locate it in the Page & Layer Gallery. Turn on ‘Unlock all’, 

then right click on the object on the canvas and choose the Unlock option from the 

context menu. Then you can turn ‘Unlock all’ off again. 

When either button is selected (the buttons are shown pressed in), then it's not possible 

to change the state of individual items. Un-select the buttons to enable the normal 

operation of the layer visibility and locking state. 

Clicking the MORE button will display menu options to SHOW ALL ON PAGE and UNLOCK 

ALL ON PAGE. 



 

Page & Layer Gallery 453  
 
 

 

Moving Objects Between Layers 

There are several ways to move objects between layers. First select the object or objects 

you want to move, then; 

 Drag and drop the object onto the desired layer in the PAGE AND LAYER GALLERY 

 CUT the object (Ctrl+X or right click and CUT). Ensure the target layer is the current 

layer (shown with  , click the layer if it's not) and then right click and choose PASTE or 

PASTE IN PLACE. Note that if you cut or copy multiple items that are on different layers, 

the layer structure is preserved when you paste. Items are pasted to the same layer 

they were copied/cut from, instead of being pasted to the current layer. If you want to 

paste all such items to the current layer, ignoring the layer structure, use the PASTE IN 

CURRENT LAYER option instead. If you want to retain layer structure, choose PASTE IN 

PLACE IN CURRENT LAYER. These paste options are also in the clipboard fly-out bar on 

the top bar, as well as the EDIT menu. 

 Right click and choose ARRANGE then MOVE TO LAYER IN FRONT / MOVE TO LAYER 

BEHIND to shift the selected objects one layer up or down. 

 Ensure the target layer is selected as current, then find the selected item in the PAGE & 

LAYER GALLERY (click the LOCATE button), right click and select MOVE TO CURRENT 

LAYER. 
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Web Animations 

Using Web Animations 

Web animations are a great way to add eye-catching visual content to your webpages. 

You can take any object in your web document and quickly create an animated response 

to an event like a mouse-over, a mouse-click or a screen touch. For example the items 

can fade in when first displayed, can have a wobble animation as you mouse-over it, and 

a different animation again when you click the item. You can  also trigger pop-up layers 

or pop-up text and you can have objects reveal themselves as you scroll down a page.  

To animate an object, simply right-click on it and choose WEB ANIMATION from the drop 

down menu, or go to "UTILITIES" > "WEB ANIMATION" .  

 

Or click on the WEB ANIMATION button on the WEBSITE PROPERTIES flyout bar. 
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This will bring up the WEB ANIMATION dialog... 

 

The dialog has got tabs for Mouse-over events, Click/Touch events and Reveal/Scroll 

events. 

The Animation dialog is non-modal, which means it can stay on screen while you select 

different items on the page. Click the APPLY button instead of the OK to keep the dialog 

on screen. You can then select another item to change the animation on that without 

having to re-display the dialog. 

 

Preview your animations by clicking the PREVIEW  CURRENT WEB PAGE button on 

the web toolbar - to see them in the onboard browser.  

 



 

 456 Web Animations 
  

 

 

Mouse-over features 

With Mouse-overs - you can set a document default effect for the whole document - this 

only affects items on the MouseOver layer like navigation bars, or buttons with a 2 state 

property (buttons with a link which change color as you mouse-over them). And you can 

also set a mouse-over effect for an individual, selected object.  

Click on the MOUSE-OVER tab dropdown menus to view and apply the effects. 

 You can choose from one of six speeds for the animation effect ranging from VERY 

FAST to VERY SLOW  

 Enter some pop-up text which will appear when the object is moused over  

 Have the mouse-over trigger a pop-up layer - another layer within your document, and 

have that layer animate as well. Click the EFFECT button to bring up the Pop-up 

settings (on page 60) dialog for the pop-up layer effect. 

See Layers, Mouse-over & Pop-ups for more details.  

Click/Touch animations 

This tab allows you to choose an animation that will play when the object is clicked (or on 

a touch device, touched). As with the Mouse-Over tab you can choose the animation 

type and speed and can setup a default click/touch effect that will apply to all your 

buttons that have a mouse-over graphic.  

Reveal & Scroll animations 

If you select the REVEAL/SCROLL tab of this dialog, you have the choice of applying either 

a REVEAL ANIMATION or a SCROLL ANIMATION. 

Reveal animations  
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A REVEAL ANIMATION will make the object animate into view as it appears in the browser 

window - either the first time, or every time it appears.  

 

 Set an animation effect from the dropdown menu 

 Set a speed for the effect using the SPEED slider 

 Add a timed delay using the slider if so desired, so there is a pause before the object 

reveals 

Trigger object name 

 Normally an object will be revealed as soon as it comes into view. However sometimes 

you may want to have the object revealed only when some other object (the “TRIGGER” 

object) comes into view. 

 To name the trigger object just right click on it and choose NAMES...  then apply a name 

using the NAMES dialog. Now when you click on the TRIGGER OBJECT NAME: dropdown, 

the name will appear for you to select. 

For more information on applying names see Naming Objects (on page 123). 
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Scroll animations 

The SCROLL ANIMATIONS are similar to reveal animations, but they are linked to scrolling 

of the document. So instead of the animations running once when the object appears 

and then finishing, the object animates whenever the document is scrolled and the speed 

of the animation is proportional to the scrolling speed. Scroll slowly and the object 

animates slowly, as you scroll. Scroll faster and the object animates faster too. The 

SPEED slider determines how fast the animation runs relative to the scrolling speed. 

Parallax scrolling 

The PARALLAX scrolling animation is where some objects on your page scroll at a 

different rate to others, giving a parallax effect. PARALLAX appears near the top of the 

scroll animation types. The speed slider determines how fast the object scrolls relative to 

other objects on the page. If set very low, the object hardly moves at all as other objects 

scroll past it. If set very high the object scrolls at almost the same rate as the other page 

content, so the most useful speed values are towards the middle - try experimenting with 

different speeds. 

Note: If you have a low parallax scroll speed, items below the bottom edge of the 

browser window may never appear.  

Animations, Reveal animations, Scroll animations, Scrolling animations, Parallax 

animations, Parallax 

Object types and Animation combinations. 

The table shows which object types work with which animations. 
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Object Type Reveal 

Animations 

Scroll 

Animations 

Mouse-over 

Animations 

Click Animations 

Text Yes Yes Yes Yes 

Images (including groups) Yes Yes Yes Yes 

Placeholders/Widgets Yes Yes No No 

Text Panels Yes Yes No No 

Soft Groups Yes Yes Yes Yes 

Stickies Yes No Yes Yes 

Full width/height No Yes No No 

Page Background layer 

objects 

No No No No 

Pasteboard Background 

layer objects 

No No No No 

Reveal Object Animations N/A No Yes Yes 

Navbars Yes Yes Yes Yes 

Objects on Pop-up Layers Yes Yes Yes Yes 

Important: A few of the version 10 gallery widgets are incompatible with the new sticky 

and animation features, if used on the same page or in the same supersite, and so may 

need to be replaced with updated versions from the ONLINE CONTENT CATALOG. Click 

here http://support.xara.com/index.php?/Knowledgebase/Article/View/816/ for details on 

the support site. 

"Animated Objects"  

 

http://support.xara.com/index.php?/Knowledgebase/Article/View/816/
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Animations 

Introduction 

Xara Web Designer Premium takes a traditional animator's approach to animation. You 

create key frames (or "snap-shots") of your animation through time, and Xara Web 

Designer Premium automatically creates all the in-between frames for you, a process 

called ‘tweening’. 

 

An example start frame 

 

The next key frame has the star shape moved, rotated a little, reduced in size, and changed to 
a different color. 

 

Xara Web Designer Premium will create a smoothly animated Flash or movie file automatically 
creating the interim frames. This process is called "tweening". 

What Flash can and cannot do 

The Flash format does not support some of the advanced effects that Xara Web 

Designer Premium offers, for example complex graduated transparency, feathering and 

most of the advanced color fill types. 

However, it does support a range of effects that include simple transparency. So, for 

example, if you fade the star on the 2nd key frame above to be 100% transparent, you'll 

get an animation where the star moves, reduces in size, and then fades. 
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The same example, showing in-between frames, but  with a transparency change. 

Like Xara Web Designer Premium, Flash is vector graphics-based, which means that you 

can enlarge objects with no loss of detail. It also means that Flash files can be very 

compact, which is of course ideal for the web! 

To illustrate just how small and compact Xara Web Designer Premium Flash animations 

can be, the previous example animated over one second with 24 frames (so the movie 

plays at a smooth 24 frames per second) creates a Flash file that's only 700 bytes. 

The 6 core types of animation 

In order to keep Flash files very compact, the types of shape tweening supported by 

Flash are limited to six basic types of animation. These are sometimes called the 6 core 

transforms, because these are the main ways you can transform an object from one key 

frame to the next. 

1. Move: Move objects from one position to another. 

2. Scale: Enlarge or reduce objects in size. 

3. Squash or skew: Squash or skew objects. 

4. Rotate: Rotate objects. 

5. Transparency: Adjust the overall (flat) transparency of the objects. 

6. Color changes: Change the fill (flat) color of objects. 

The last item, color changes, can be applied to contoned (colored) photos. You can’t  

transform a full color photo into a contoned one, but you can change a photo with one 

contone color into another color. 

Note: the above six transform types are absolutely key to all Flash animations. 

If you look at Flash animation examples on the web, you'll find that almost all consist of 

just these effects. Objects fade in and out; they whiz from one position to another. They 

sometimes spin, grow or shrink. That's the basis for almost all Flash animations, and it's 

very easy to produce such animations in Xara Web Designer Premium. It is also possible 

to tween shape outlines and some PHOTO TOOL attributes in Xara Web Designer 

Premium, but these are less common and only applicable to specific types of object. 

One thing that isn’t possible with Flash is to change the shape of an object between key 

frames though this will work when exporting as a movie clip. 
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It’s not possible to change the shape between key frames in exported Flash animations.  

Because the shape changes (i.e. it morphs from one shape to another), this is not 

possible in Xara Web Designer Premium Flash animations. 

What you can't do with Xara Web Designer Premium Flash  

Xara Web Designer Premium does not support more complex Flash features such as 

scripting (programming), audio, or embedded movies. 

Additionally, since Flash vector rendering is relatively primitive compared to Xara Web 

Designer Premium’s, there are advanced Web Designer Premium effects such as 

feathering that cannot be used in Flash. These are detailed in the "What Xara Web 

Designer Premium Features Does Flash Support? (on page 477)" section towards the 

end of this chapter. 

Core Principles 

In your animation you are likely to have some objects that remain static between key 

frames (i.e. no tweening is necessary) and other objects you will want to animate. 

 

To tell Xara Web Designer Premium which objects you want to animate, it's 

necessary to give each object a name (via the ADD NAMES button on the 

SELECTORTOOL InfoBar). 

For more information on naming objects, see section "Naming Objects" in the "Document 

Handling (on page 63)" chapter. 

Here is an overview of the typical process to create a new animation from scratch, which 

this chapter will guide you through: 

1. Decide what size you would like your animation to be and set the page size 

accordingly (see "FILE" > "PAGE OPTIONS (on page 517)").  

2. Draw your first frame. Name the objects that you want to animate. 

3. Create a new key frame (usually done by copying the earlier frame). 

4. Move and transform the objects as required. 

5. Preview the results. 

6. Repeat steps 3 through 5. 

Your First Animation 

To create a new animation: 

Create a new animation document. To do this: 

Choose "FILE" > "NEW" > "ANIMATION" ("Ctrl + Shift + N"). 
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A new document will open, and you will see the animation button bar appear that 

contains some relevant buttons. 

 

 

 

 

1. Draw a simple shape, such as a rounded rectangle with the RECTANGLE 

TOOL (but it can be any shape). 

2. Click the APPLY NAME icon on the SELECTOR InfoBar and name it "shape". 

3. Click the COPY FRAME button to create your 2nd key frame. 

Transform the shape as required. You can adjust it using any of the six 

animation types described earlier in the chapter. 

4. Press the PREVIEW MOVIE button to see the animation. 

By default the display period for each key frame is half a second. To produce a longer 

animation, see the "Movie Frame Rate and Tween Steps" section later in the chapter. 

You are not limited to just one moving object; you can have as many as you like on each 

key frame. And as long as they appear transformed in some way, on the next key frame 

(and they are each given a unique name) they will animate. 

Here is another example. 

 

The first key frame has some simple text and a simple shape within a static rectangle. 

 

On the next key frame the text has been enlarged and made darker, the blue rectangle has 
been rotated 90 degrees and transparency altered to be mostly transparent.  

This is how the animation is constructed. 



 

 464 Animations 
  

 

 

 

Keyframe 1 

 

 

Intermediate tween steps 

produced by Xara Web 

Designer Premium 

 

 

Keyframe 2 

In this animation, the text object grows, and at the same time the rounded rectangle rotates 
and fades. 

Exporting a Flash File 

To export your animation as a Flash file: 

Select "FILE" > "EXPORT ANIMATION" and then choose Flash under SAVE AS TYPE. 

Or click the EXPORT ANIMATED FLASH button. 

 

This will save the finished SWF file into the location you choose. 

Previewing a Flash file in Xara Web Designer Premium 

 

To view your animation as it would look in a web page, click the PREVIEW  FLASH 

button to instantly see a browser preview. 

The preview page will show your finished animation as well as useful information, such 

as the animation’s dimensions, file size, etc.  It also includes simple instructions on 

inserting your animation into a web page. 

 

Inserting a Flash file into your webpage 

For those using Xara Web Designer Premium you can simply drop the Flash file onto 

your web page to insert it into your website. A static placeholder image is automatically 

created and placed on your page. Preview your page and you should see your working 

Flash animation! 
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Alternatively you can create a placeholder object manually. On your web page, create a 

placeholder object, which can be anything such as a simple rectangle or an image or 

screen grab even.  Position and size your placeholder where you want your Flash 

animation to appear. 

Then in the WEB PROPERTIES DIALOG ("Ctrl + Shift + W") select the PLACEHOLDER TAB 

and the REPLACE WITH FLASH Browse options to locate the required .SWF file. Click 

APPLY.  

Now when you preview your website, the placeholder is replaced by the Flash animation. 

With either option above, the .swf file gets copied into a support folder next to your .xar 

file, so that there is a copy of the file with your .xar file. Therefore if you subsequently 

change your animation and export an updated .swf file that you want to use instead, 

either browSE FOR THE NEW .SWF FILE USING THE "UTILITIES" > "WEB PROPERTIES" > 

"Placeholder tab" as above, or manually replace the file in the support folder with the 

updated file. 

See the Support Folders section (on page 75) of the Document Handling chapter for 

more information. 

Inserting using a different web authoring tool  

To place your SWF animation into your HTML click the VIEW HTML link on the Flash 

preview screen to get code that you can paste into your web page using your preferred 

HTML editor. 

Note: You must change the SWF file name in the code to match the actual name of your 

exported SWF file. You must also place your SWF file into the same directory as your 

web page for the code to work. If you place the SWF file in a different directory, you will 

need to change the HTML code accordingly. 

Exporting animations as AVI 

As well as exporting animations as animated GIFs and Flash animations, you can also 

export in the .AVI file format. 

In an animation document, choose EXPORT ANIMATION from the FILE menu, and choose 

AVI ANIMATION (*.AVI) from the Save As Type drop-down list in the Export File dialog. 

Click the OPTIONS button to choose the export settings, or just click the EXPORT button to 

use the current or default settings. 

AVI options 

Codec selection 

Use the dropdown list to select from the range of codecs that you have installed. This 

determines how your AVI is encoded and compressed. Or choose the "uncompressed" 

option if you want to export an uncompressed AVI. Note that this will give you a very 

large file size! 
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Key frame every N frames 

The default value is provided by the selected codec and it’s normally best to keep that 

value. Reducing the number will tend to result in higher quality but larger files, increasing 

it in lower quality smaller files. 

Frame Rate 

Leaving the frame rate at the default 25 frames per second will result in a smooth 

animation, but you may be able to get away with a lower rate of say 12 or 15 frames per 

second if your movie is fairly static with little fast moving action. This will reduce the file 

size.   

Configure 

Pressing the CONFIGURE button opens a settings dialog specific to the selected codec (if 

available), which may give you more configuration options. The ABOUT button tells you 

more about the selected codec.  

Make background transparent 

Selecting this option will make your AVI have a transparent background, which is useful if 

you want your animation to appear on top of a movie (for movie titling, for example). 

When this option is on, the codec list is reduced to show only the "uncompressed" option, 

because transparency can’t currently be supported using a codec. If you export an 

uncompressed AVI with transparency, it will import into MAGIX movie editing software 

and some other movie editing applications with the transparency.  

Area to save 

Choose whether to save a movie that is the size of your animation page or the size of the 

animated drawing. 

Click OK to export the AVI animation. 

The Animation Frame Gallery 

By default the ANIMATION FRAME GALLERY is displayed open on the right hand side of the 

Web Designer Premium window (next to the PAGE & LAYER GALLERY) when you open or 

create an animation document. 

 

To toggle display of the FRAME GALLERY, choose "UTILITIES" > "GALLERIES" > 

"FRAME GALLERY", or click the FRAME GALLERY icon on the GALLERIES toolbar. 
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A typical FRAME GALLERY. Frame 3 is selected and thus visible. 

This shows a list of the 

key frames in your 

document. To view any 

key frame just click its 

name in the gallery. 

The ANIMATION FRAME 

GALLERY shows frames 

from the top down, so 

the first frame is at the 

top and the each new 

frame you add gets put 

at the bottom of the list. 

You can re-order frames 

by dragging them. 

There are buttons to 

perform the main 

operations of deleting 

frames, copying the 

selected frame (it will 

always get added to the 

end) and creating new 

blank frames. 
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The PROPERTIES button is very important, since it shows the ANIMATION PROPERTIES 

dialog which controls many aspects of not just the selected frame but the whole 

animation. 

 

The Animation Properties dialog 

A shortcut to display the Animation Properties dialog is to simply double click on a frame 

name in the FRAME GALLERY 

 

The ALL FRAMES VISIBLE (the eye) and EDIT ALL FRAMES (the padlocks) 

buttons on the FRAME GALLERY are useful because they allow you to 

view or edit all frames together, one on top of the other. 

This is particularly useful if you want to select objects that are on multiple frames. 

Note: When you copy a frame, it always copies the selected frame and places it at the 

end. So in order to insert a new frame, say between frames 4 and 5, select frame 4, click 

the COPY button, and then drag the new copy from the end to the desired position 

between frames 4 and 5. 
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Note: Frame names do not matter and can be anything you like. They do not have to be 

Frame 1, Frame 2, etc. Animations always play the frames in the order top to bottom, 

irrespective of the names. 

Copying Objects 

You can copy objects from one frame to another in the usual way (i.e. copy the content, 

select the new frame and then paste into the new frame). The "EDIT" > "PASTE IN PLACE" 

option ("Ctrl + Shift + V") is particularly useful when doing this, as this will always paste 

objects back to the exact position they came from but on the new frame. 

When you copy an object its name is copied with it, but be careful not to have more than 

one object with the same name on a given frame; doing so will generate errors. 

Photos 

Because Flash files usually consist of vector shapes, and the transforms are relatively 

simple, the files can be very small. Photos and bitmaps can be embedded into Flash 

animations, but unless you are careful it will result in huge animation files. You can 

perform all core Flash transforms on bitmaps or photos (i.e. you can move, scale, 

squash, rotate, fade and re-color.). 

Flash files can include both PNG and JPEG images just as .xar files do, and Web 

Designer Premium automatically creates photos of the right resolution when creating the 

Flash file. So for example you can load a hi-res digital camera image, size this down to 

be say 200 pixels, and this means that a 200 pixel image will get included, and not the 

full hi-res JPEG. 

When higher resolution photos are converted down for inclusion in Flash files the JPEG 

compression setting (Animation Properties dialog, Flash Options tab) can be used to 

control how compressed your JPEG images are. See below. 

When tweening bitmaps or photos, only one copy of the bitmap is stored in the Flash file, 

so you can perform transformations of the bitmap with little overhead. In other words, just 

because the bitmap appears on frames 1, 2 and 3 of your animation, this does not mean 

three copies of the bitmap are embedded in the Flash file. 

Non-JPEG Bitmaps 

Other types of bitmaps, for example, BMP, TIFF, or PNG bitmaps, are usually a lot larger 

and thus less suitable for use in Flash animations (for photos JPEG compression is a lot 

better than PNG). However if you include a low resolution PNG image (that is one of 

96dpi or less – the status line shows you the resolution of any selected image) then this 

is kept as a PNG image in the Flash file.  Higher resolution images (>96dpi) will be 

converted into a JPEG (transparent JPEG if required) . 

You can control the compression used for this automatic JPEG conversion using a slider 

in the FLASH OPTIONS tab of the ANIMATION PROPERTIES dialog. The usual compression 
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value is 75%, but you can vary the quality, preview the animation and quickly see the 

quality and size savings. 

  

256 color or less bitmaps (such as GIF) are not encoded as JPEG and will be embedded 

using PNG compression, which is usually the best compression type for these types of 

images 

Bitmap Quality 

Flash Player version 8 and later has higher quality bitmap display. This is particularly 

evident when rotating or scaling bitmaps and photos, whereas older versions of the 

player tend to produce pixelated, and rather jerky movements. 

You can tell which version of the Flash Player you have by right clicking on any Flash 

animation in your web browser and looking at the About menu. 

It’s therefore recommended to export your Flash animation as Version 8 if you’re using 

bitmaps or photos. You can control this from the FLASH OPTIONS tab of the ANIMATION 

PROPERTIES dialog. 
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Animation Frame Rate and Tween Steps 

Flash animations run at a fixed frame rate. The faster the frame rate, the smoother the 

resulting animation and the larger the Flash file. Xara Web Designer Premium animations 

default to showing 24 frames per second, but you can change this. 

When you create each key frame, you determine how long the period is until the next key 

frame. For example, if a frame period is set to half a second, this means the animation 

from that key frame to the next will take half a second. At 24 frames per second this 

means there will be 11 intermediate steps generated by Xara Web Designer Premium in 

the Flash animation, so 12 frames in all. (These intermediate "tween" frames are not ever 

seen in Xara Web Designer Premium and are only generated when you create the Flash 

file.) 

 

The FRAME GALLERY 

always shows you the 

display period for each key 

frame. In this example 

three frames are displayed 

for one second each, so the 

whole animation lasts 3 

seconds before repeating. 

 

To create a longer tween effect (in other words to slow the animation down) increase the 

display period using the ANIMATION PROPERTIES dialog. 

The easiest way to alter the display period for any frame is to just double click on the 

frame name you want to alter to bring up the dialog, enter the new period in seconds, 

and click OK or APPLY. 

Move frame forwards/backwards 

These buttons allow you to move a key frame forwards or backwards in the animation, 

without changing the length of the animation. This is useful when working with 

animations that are exported as AVIs and included in movies, particularly if you are trying 

to track an object in the movie with your animation. By Default each click moves the 

frame by 1/25th of a second, which corresponds to one frame of a 25fps movie. You can 

change this value in the FRAME tab of the ANIMATION PROPERTIES dialog. 

 
Move frame 1/25th sec forwards 

 
Move frame 1/25th sec backwards 
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The length of the previous frame is adjusted in order to keep the overall length of the 

animation the same, so effectively you are just moving the key frame forward or 

backward in the animation.   

 

Cropping, Clipping and Animation Size 

Before long you'll start to consider creating some Flash animations like you see on the 

web, say with some wording or a photo that whizzes in from one side. 

 

To create an animation like this, all you need to do is set the page size in Xara Web 

Designer Premium to the size you want for your flash animation. So if for example you 

want a Flash banner which is 468 pixels wide and 60 pixels high, set the page size in 

your animation document to 468x60. To set the page size, go to the PAGE TAB of the 

OPTIONS DIALOG (on page 517) (or choose "FILE" > "PAGE OPTIONS") and set the Width 

and Height fields accordingly. 

When exported or previewed, the flash animation is automatically clipped to the page 

size you have set. So it’s easy to arrange your animation so that objects glide in and out 

of the visible animation. E.g. by placing an animating object to the left of the page on one 

key frame and to the right of the page on the next key frame, in the animation the object 

will be seen to slide in from the left side of the design and disappear off the right side. 

You can also change the page dimensions by going into the SELECTOR TOOLAND 

DRAGGING ON THE BOTTOM EDGE OR RIGHT EDGE OF THE PAGE, TO CHANGE THE PAGE 

HEIGHT OR WIDTH RESPECTIVELY. SEE CHANGING THE PAGE SIZE IN THE DOCUMENT 

HANDLING CHAPTER FOR DETAILS. 
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Note: When opening older documents created with earlier versions of Web Designer 

Premium, these will not clip to the page (the page size was huge), instead they clip to the 

size of the drawing. You can control this in the Animation Properties dialog. 

 

Setting the area to save to be Drawing will create a Flash animation that is only as large 

as it needs to be – i.e. the same as the outer bounds of the animation. This can be useful 

if you don’t need a specific page size. 
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Animation Speed 

When you create a new keyframe, it defaults to having a period of half a second. So the 

animation from that keyframe to the next will take half a second. The longer you set the 

period, the slower the animation. To set the frame period for any frame, first select the 

desired frame in the FRAME GALLERY (click on it), and then click the ANIMATION 

PROPERTIES button (or just double click the frame name). 

 

Setting "Display This Frame For" to 2 seconds means the animation will take 2 seconds  to 
tween from this key frame to the next. 

Note: The ANIMATION PROPERTIES dialog is non-modal and you can keep this on screen 

all the time. By pressing the APPLY button instead of OK, the dialog remains on screen. 

Its contents are updated as you select different frames, and for each of them you can set 

the required display period. 
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Animation smoothness 

Flash movies play at a constant frame rate. The faster the frame rate, the smoother the 

animation. Xara Web Designer Premium defaults to showing 24 frames per second. To 

change the rate select the FLASH OPTIONS tab of the ANIMATION PROPERTIES dialog. 

 

 The Flash Options tab, where you can change the movie speed as well as the Flash export 
version. 

Note: The faster the frame rate, the larger the resulting Flash file. You will find that if your 

animation is mostly objects fading in and out with relatively little fast moving animation, 

then you can reduce the frame rate to under 24 frames per second. If you have a lot of 

fast action, it may be necessary to increase the frame rate, but it’s rarely necessary to 

have it above 50 frames per second. 

Rotation 

Xara Web Designer Premium calculates and generates the tween frames automatically 

by working out how to transform the shapes from one key frame to the next. But 

sometimes it's not possible to know exactly what type of rotation is required. 
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Take this example. Suppose you tween 

from the first clock face to the second: 

 

You might expect it to rotate clockwise, 

but of course it could go counter 

clockwise: 

 

 

In fact there are other ways it could rotate. The above 

examples assume the hand rotates around one end, but you 

could tween from one state into the other by doing a straight 

line rotation of the center of the object, which would result in 

this: 

 

If you look closely, the hand rotates around its center rather than one end, and the center 

point moves in the straight line from one key frame to the next. By default, Xara Web 

Designer Premium rotates objects this way. 

The Rotate command 

To force the rotation to be around any other point you can use a special keyword "rotate" 

appended to the front of the object name. Or you can use "rotate +" to force the rotation 

to go clockwise or "rotate -" to make it go counter clockwise. 

To take the simple two keyframes animation example shown on the previous page, 

where the hour hand needs to move from 12 o’clock to 8 o’clock. If you name the hand 

object "rotate + hand", you'll get an animation showing the clock’s hand moving 

clockwise. If you name it "rotate - hand", then the hand will rotate counter clockwise. 

If there is no rotate command, then the tween takes the shortest direct path between the 

object on one keyframe to the next, rotating around its center. With a "rotate" command 

on the object name, it calculates the actual rotation point, which in the above example is 

the "large end" of the hand. 

Note: It's not possible to rotate an object by a full 360° between keyframes if the rotation 

point is not the center. For example, to do a full rotation of the clock hands in the above 

example, you would need to create an intermediate keyframe. 
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Groups 

Groups are treated specially when creating animations. To save you naming each 

individual part of a group, you can instead name the whole group and then copy the 

group to the next keyframe. Xara Web Designer Premium will animate the whole group 

from one keyframe to the next. And you can apply the normal transformations to the 

group (resize, rotate, squash, but not group transparency – see the next page). 

If members of a group are to animate differently than the rest of the group, then those 

members must be separately named ("Ctrl + click" to select an object inside a group, 

then name it as usual). 

Note: If you ungroup, make some changes to the group contents and then re-group the 

objects: 

 You must re-apply the name to the new group (select the group then double click on 

the name in the NAME GALLERY). 

 You must not change the stacking order of the items in the group. 

 You must not add or remove items to/from the group. 

Group Transparency 

If you want to fade a grouped object, you need to apply transparency to each individual 

object in the group. There are two ways you can do this: 

 Select each object in the group in turn and adjust its transparency. 

 Or un-check the MAKE GROUPS TRANSPARENT AS A WHOLE option in the OPTIONS dialog 

("UTILITIES" > "OPTIONS", then the GENERAL tab). If you do this, when you adjust the 

transparency of the whole group Xara Web Designer Premium applies the 

transparency to each individual item in the group, instead of group transparency. 

What Xara Web Designer Premium features does Flash 

support? 

The Flash vector rendering is quite primitive compared to Xara Web Designer Premium's, 

and so you can't use many of the more advanced Xara Web Designer Premium features 

such as feathering, complex transparency and fill types or soft shadows. Lines (strokes) 

are limited to be being simple constant thickness, round ended lines. No line dashing is 

supported. The minimum line thickness is one pixel—so thinner lines in Xara Web 

Designer Premium will be displayed one pixel thick in Flash. 

There are two aspects to producing Flash-compatible drawings. The first is to limit 

yourself to use only those features supported directly by the Flash player. Secondly, 

when producing animations, there is an even more limited set of characteristics that can 

be tweened or animated. 

Xara Web Designer Premium drawing features that Flash supports: 



 

 478 Animations 
  

 

 

 All normal line and shape drawings (although Flash is a lot less precise than Xara Web 

Designer Premium and so sometimes you may notice inaccuracies in lines and 

shapes). 

 Flat, linear, circular and elliptical gradient color fills. 

 Multi-stage gradient color fills, including linear and elliptical fills. Eight color stops 

maximum. 

 Flat transparency. Mix type only. 

 Graduated transparency is supported for flat color filled objects (non-graduated). So 

you can have graduated color objects with flat transparency or flat color objects with 

graduated transparency, but not both. 

 Constant width outlines (stroked paths) with rounded end caps and line joins (version 

8 Flash files support the other join and cap types). 

 Text, including kerning. You can use any fonts you like. The outlines of the characters 

of any used fonts are embedded into the Flash file. This is much more efficient than, 

say, font embedding in PDF documents. 

 Text on a curve. Note: the line used for the curve must be made invisible for the 

animation to work. 

 Bitmaps and bitmap fills. 

 Contoned (colored) bitmaps and bitmap fills. 

 Photo Saturation, temperature color and blur (but not brightness / contrast change). 

 Fractal Cloud and Plasma fills will work, but are converted to bitmaps, so not efficient. 

So while some Xara Web Designer Premium effects, such as soft shadows do work in 

static files, these are exported as bitmaps into the Flash file, so they are not very efficient 

and not suitable for animating. 

What can be animated: 

As listed at the start of this chapter, these are the golden rules as to what you can 

change from one keyframe to the next: 

 Move: Move objects from one position to another. 

 Scale: Enlarge or reduce objects in size. 

 Squash or skew: Squash or skew objects. 

 Rotate: Rotate objects. 

 Transparency: Adjust the overall (flat) transparency of the object. 

 Color transform: Change the fill (flat) color of objects. 

 Or any combination of the above. 

In addition, there are a few special cases of photo color transformations that are 

supported by Flash. You can alter the saturation (so you can tween a full color photo into 

a black and white one), You can also adjust the temperate color control (warm / cool), 

and also the blur value. The latter enables you to tween a blurred photo into a sharp one. 

But note this only works for blur values and not sharpen.  Also there is a slight difference 

in the way Flash blurs photos. Flash blurs the whole photo including the edge, whereas 

the Photo blur in Xara Web Designer Premium only blurs the inside of the photo and 

keeps a sharp edge. 

Secondly, another special case: you can animate text on a curve. This is special because 

you can use this to seemingly morph text along one curve into text along a completely 
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different curve. In fact what it does is tween from the character position in one keyframe 

to the corresponding character’s position in the next frame. This can produce some 

interesting effects. 

Note: The line used for the curve must be made invisible for the animation to work. 

 

Non-moving Objects 

You can add new objects by just drawing them on any keyframe. They will appear in the 

animation at the start of the frame and will vanish at the next keyframe, unless they 

appear on that frame as well. So the simplest way to have an object appear static on all 

frames is to ensure it's copied to all the frames. Xara Web Designer Premium Flash 

optimization is very efficient and you'll find that having more than one copy takes hardly 

any additional file space (this is true of multiple copies of objects anywhere). 

Color Transforms—Animating Color Changes 

This is what you can and cannot do with color transforms in Xara Web Designer 

Premium Flash: 

 You can animate simple flat color changes of objects from one keyframe to the next. 

 You can change the line color independently of the fill color. 

 You can change photo contone colors. 

 You cannot adjust the position of gradient fills. 

Transparency 

As mentioned earlier, you can adjust the flat transparency of objects (not group 

transparency) and Flash supports this (for both static objects and tweening transparency 

changes), but Xara Web Designer Premium’s graduated transparency is not really 

supported with Flash. There is just one situation where you can use graduated 

transparency, and that is on flat color filled objects. 

 

It's possible to adjust, and animate, flat transparency given to all types of objects, shapes, text 
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and photos. 

  

It's possible to give graduated transparency (linear, circular and elliptical) to flat color filled 
objects, but it's not possible to animate the transparency change. Although you can animate 
the color change (rule six). 

URLs in Flash 

To make an object in your Flash animation a clickable link, just select the object you want 

to make clickable and select "UTILITIES" > "WEB PROPERTIES ("Ctrl + Shift + W"). 

Enter the required URL.  (If you require the link to open in a new browser window or 

browser frame select the target web frame by selecting from the ‘OPEN LINK IN’ dropdown 

menu). 

If you want to make text clickable select the RECTANGLE SURROUNDING OBJECT option. 

This ensures those that viewers of your Flash animation can click anywhere over the text 

(rather than just on the actual letter shapes). 

Making the whole animation clickable 

In the "ANIMATION PROPERTIES" > "FLASH OPTIONS" tab you can set a URL to apply to a 

whole animation. This is useful for banner ads where you want a click on any part of the 

animation to go to a given web address.  

clickTAG 

clickTAGs are often used by advertising networks. Rather than hard-coding a URL into a 

Flash animation, the clickTAG allows an organization to insert their own URL into the 

animation, which is particularly useful for tracking advertising clicks. 

If you need to use this feature, check the clickTAG option. 

Advanced Flash Commands 

Accelerating and Decelerating 

Usually the tween steps are evenly spaced between keyframes, producing a linear 

animation from one keyframe to the next. By appending < and > symbols to the front of 

the object name, you can make objects speed up or slow down. So naming an object  
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>Name  means that it starts fast and slows. The opposite, <Name, would start slow and 

speed up. 

You can even use these in combinations. So an object name <>Name would start slow, 

speed up and then slow down towards the end of the frame period. In traditional 

animator’s terminology this is called ‘easing’, so you can ease in or ease out, and the 

command <> would be an ease in/out. 

You can control the degree of acceleration or deceleration by using numbers from 0 to 9. 

So <2Name  would be a very gentle acceleration, while <9Name would be extreme 

acceleration.  Similar >2 in front of the name would give a slight deceleration. Using the 

name >Name (with no number) is the same as >5Name. 

Example: there is an example file called Pendulum in the FLASH EXAMPLES section of the 

DESIGNS GALLERY (click the DISC DESIGNS button on the DESIGNS GALLERY). The 

pendulum group uses a combination of <> and the rotate command. Another example 

called "Zoom.xar" is also worth examining. 

Stop and Goto Commands 

You can append STOP or GOTO commands onto the Frame names (separated by a semi-

colon ; ) to control the sequence flow. So for example if your first frame was named 

"Frame 1;Goto Frame 6", then the animation sequence would jump to Frame 6 at the 

start of Frame 1.  This may produce tween errors, but these can be ignored. It also waits 

for the specified period of the frame with the GOTO command on before jumping, but 

frames with GOTO or STOP commands do not tween. 

Similarly a frame name with ;STOP appended to the end of the name would stop when 

the animation reaches this frame.  Why is this useful?  Because you can make the 

animation jump to any other key frame with either a click or by moving the mouse over 

objects.  For example you might have an animation that waits for the user to click on or 

move the mouse over an object before continuing. 

Clickable Buttons & Mouse-over Effects 

You can make the animation sequence jump to any keyframe either by clicking on an 

object or just by moving the mouse pointer over any object. 
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To do this select the object you want to use as the trigger, open the WEB PROPERTIES 

dialog (Ctrl+Shift+W) and on the LINK tab, select the JUMP TO FRAME option. 

 

If you want the jump to occur by just moving over an object, select the Mouse-Over tab instead 
of the Link tab, and select from the similar ‘JUMP TO FRAME’ option. 

Now in your animation if you click or mouseover the object the animation will redirect to 

the the new frame and proceed from there. See the "River Thames" example file in the 

DESIGNS GALLERY. This uses a Goto command to loop from frame 4 to 3, and a URL 

frame re-direct to jump to Frame 1 if you click the Replay link in the corner. 

"Ctrl + Shift + W" is a quick way to open the Web Properties dialog. 

Xara Web Designer Premium Flash Animation Summary 

 Xara Web Designer Premium keyframes are "snapshots" of your animation at any 

point in time. Xara Web Designer Premium automatically produces a smooth blend or 

tween of objects from one keyframe to the next to produce a smooth Flash animation. 
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 There is no timeline. Instead, the FRAME GALLERY (on page 466) shows your snap 

shot keyframes though time (top down). Just click the frame name to see and edit that 

keyframe. 

 If you set the Xara Web Designer Premium frame display time to be 2s then it will take 

2 seconds to animate objects from their position at the start of one keyframe to their 

positions at the start of the next keyframe. Use the ANIMATION PROPERTIES dialog to 

set frame display period. 

 To tell Xara Web Designer Premium which objects are to be blended or tweened 

between one keyframe and the next, you name the object you want to tween. For each 

new object you want to animate click the NAMES button on the SELECTOR TOOL InfoBar 

and give it a name (or select the menu "UTILITIES" > "NAMES"..). The object must have 

exactly the same name on subsequent frames. 

 When you create a new keyframe (snap shot) you usually do this by copying the 

current frame, and this copies all objects to the new frame along with their names. 

Then just move the objects as required. 

 All other (non-named) items appear static for the duration (display period) of the 

keyframe. 

 You can move, enlarge, reduce, rotate, stretch, alter the color or transparency 

between Xara Web Designer Premium frames. Transforming objects in this way is 

very efficient. 

 There is an overall frame rate for the whole Flash movie. The more Flash frames-per-

second, the larger the Flash file and the smoother the animation. 

 Because each Web Designer Premium frame is a snap shot of the full animation, all 

objects that should appear at that snap shot should appear in the frame. You can't 

blend an object from frame 1 to frame 3 without it appearing on frame 2. 

 You can change shapes, text or photos as allowed by the six transform rules 

described earlier (move, resize, squash/skew, rotate, flat transparency and color 

change). If you change the shape in any other way it won't work. 

 The Flash animation is clipped to the page dimensions you have specified in Xara 

Web Designer Premium.  

Creating animated GIFs 

Animated GIFs are an alternative way to present animated sequences in the web. An 

animated GIF is just a GIF file that contains a sequence of images, rather like frames in a 

movie. Every Xara Web Designer Premium-frame is one frame in the final animation, just 

like a flip-book. 

Opening an animation document 

To create an animated GIF, you must first open an animation document. To do this 

choose "FILE" > "NEW" > "ANIMATION". You will then have access to the FRAME GALLERY 

(on page 466). 

Creating the animation 

To create an animated GIF: 
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1. Choose "UTILITIES" > "GALLERIES" > "FRAME GALLERY", or click the FRAME GALLERY 

icon on the GALLERIES toolbar. 

2. Draw what you want to appear in this first frame. 

3. In the FRAME GALLERY, click NEW to create the next frame. 

4. Set the background and overlay flags as required. 

5. Create the objects you want to appear in this frame. 

6. Repeat steps 3 through 5 until you have built up the sequence of frames. 

Exporting the animation 

To save the animation, choose "FILE" > "EXPORT ANIMATION". 

Animation properties 

To alter the animation's properties, right click on a frame in the FRAME GALLERY (on page 

466) and select PROPERTIES. You can then change a number of options detailed below. 

The Frame tab 

In the FRAME tab you can set: 

 NAME: The name of this frame. This is just as a reminder to you, and is not exported 

with the animated GIF. 

 BACKGROUND: If this is set, the frame covers all previous frames. This is useful if you 

want to create a background and then build up an animation on top of this background. 

Often the first frame in the animation is a background frame. If the first frame is not a 

background frame, the animated GIF uses the page background as its background. 

 OVERLAY: If this is set, then the frame overlays the previous frame. 

 LOCAL DELAY: Set how long the frame is displayed for in the animation. 

 SHOW FRAME: When checked, the frame will be shown in the animation. 

 MOVING FRAME IN TIME LINE: This value determines the amount by which a frame time 

is changed when the ‘MOVE FRAME FORWARDS/BACKWARDS' buttons are used in the 

Frame Gallery. 

Flash Options 

Here are several options for Flash animations, most of them are described above 

 Link to be applied to whole animation (on page 480) 

 Flash Movie Speed (on page 475) 

 JPEG quality (on page 470) 

 Area to save (on page 472) 

GIF Options 

In the GIF OPTIONS tab you can set the color usage in GIF animations. (Not available for 

Flash animations). Click OPTIONS in the Export Animation dialog to show the GIF OPTIONS 

tab in the Animation Export Options dialog. 

 PALETTE COLORS: Set the preferred color palette for your animated GIF. The help 

guide contains more information on the difference between these options. 

 NUMBER OF COLORS IN PALETTE: This option is available only when using optimized 

palettes. For simple graphics you can reduce the number of colors in the palette. This 
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can produce much smaller files without losing quality. You may need to experiment to 

find the right balance between file size and quality. 

 DITHERING: You can select between three types of dithering. 

 TRANSPARENCY: Select this to make the bitmap transparent where there are no 

objects. 

Animation Loop and Speed 

In the ANIMATION LOOP AND SPEED tab you can alter the animation rate and frequency: 

 LOOP: Lets you specify how many times the animation should repeat itself. 

 DISPLAY EACH FRAME FOR: If you want the same delay between each frame in the 

animation enter a value here. To specify a different delay for individual frames, use the 

frame tab (described above). This field reads "many" if the animation has more than 

one inter-frame delay time. 

Preview in Browser 

You can select options suitable for the graphic and then load it into your browser so you 

can preview it: 

 BACKGROUND OPTIONS: Alter the background of the animated GIF to see which gives 

the best result. 

 ADDITIONAL INFORMATION: The preview page will contain useful information such as 

potential downloading times when placed in a web page. 

 BROWSER PREVIEW: Press this button to launch a preview in your web browser. 

AVI Options 

Options: Select from a range of codecs you have installed 

Quality: Set the quality value of the AVI (up to 100%) 

Key frame every ...: Enable/disable the outputting of key frames and set the frequency. 

Transparency: Select to make the AVI background transparent. 

Area to save: Setting the area to save to be DRAWING will create an AVI animation that is 

only as large as it needs to be – i.e. the same as the outer bounds of the animation. This 

can be useful if you don't need a specific page size. 
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Importing and Exporting 

General notes on exporting and importing 

Web Designer Premium offers a wide range of import and export options. 

Firstly, it is important to note the distinction between saving and exporting files: 

 SAVING deals with storing your work so that you can open it and work on it at a later 

date. Xara Web Designer Premium saves your work in the .web file format. Think of 

this as the "master document" format. 

 EXPORTING deals with converting to other supported formats. Exporting allows you to 

use and distribute your designs. 

Recommended formats 

The universal export formats, that can be read by the widest range of programs and used 

on the web are the bitmap formats, GIF, PNG and JPEG. These are also guaranteed to 

look exactly as you see on screen in Xara Web Designer Premium.  PNG is 

recommended for web graphics and JPEG for photos. 

Web Designer Premium and HTML5 

Web Designer Premium now provides increased compatibility with HTML5. This is 

entirely automatic without the user having to do anything or know anything about HTML 

coding. 

What this actually means is a more efficient and faster website download. For example, 

many graphics features such as background panels, rectangles, rounded rectangles and 

objects with shadows that were previously converted to graphics on export are now 

exported as native HTML features. This makes for higher quality, and resolution 

independent images (they scale when you zoom the web page). 

Features that are now exported as HTML5 include: 

 Rectangles, rounded rectangles, with optional simple outlines, linear graduated fills 

and simple flat transparency. 

 Rotated or skewed rectangles. 

 Box Shadows (black or colored shadows). 

 Text with shadows. 

 Page backgrounds simple graduated fills (or more complex ones made up from the 

above objects). 

 Tiling textures (bitmap fills) for rectangles and backgrounds. 

Grouped objects will not export as HTML5 so you should still export these as a graphic - 

see Grouping and ungrouping objects (on page 114) for more details. 
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Import and Export Supported File Formats 

You can change the order of supported import and export file formats in the FILE > 

EXPORT and FILE > IMPORT dialogs by editing the FileFormats.xml file found in the 

program folder where you installed Web Designer Premium. 

 

Import formats 

It is important that you use the three letter file extensions listed below when you load files 

into Xara Web Designer Premium. 

Bitmap Import Formats 

.BMP Windows Bitmap 

.CUT Halo CUT (256 color) 

.DCM Digital Imaging and Communications in Medicine (DICOM) image format 

.DCX DCX 

.FAX Fax image from a fax received or created with fax software 

.GIF Graphics Interchange Format 

.ICO Microsoft Windows Icon (16 color) 

.JPG JPEG 

.MXB MAGIX Bitmap 

.PBM UNIX monochrome 

.PCD PhotoCD 

.PCT PICT 

.PCX PCX Paintbrush 

.PDF (see importing a PDF file) 

.PGM UNIX grayscale 

.PNG PNG 

.PPM UNIX color (up to 24 bit) 

.PSD Photoshop (see importing and exporting PSD files (on page 494)) 

.RAS Sun Raster 

.SGI Silicon Graphics Image 

.TGA TrueVision TARGA  

.TIF TIFF (RGB, RGBA with alpha-channel transparency).  

Xara Web Designer Premium supports: fax TIFF files (black and white images. Multi-

page faxes will be imported as multiple pages); Mac or PC byte order TIFF files; TIFF 

with layers and transparency (if saved from Photoshop the rules for blend mode 

compatibility are the same as for PSD files); JPEG in TIFF (transparency is not possible 

in this case). 

.XBM X Windows (2 color) 

.XPM X Windows (256 color) 

.WBMP Wireless Bitmap Image. Black and white (1-bit) bitmap image format used by 

mobile devices. 

.RAW camera import formats (see RAW photo import (on page 491) for a list of 

supported file types). 

EPS Import Formats 
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.AI Illustrator EPS 

.EPS ArtWorks 

.EPS Illustrator EPS 

.EPS CorelDRAW 3 & 4 EPS 

.EPS FreeHand 3.0 EPS 

.EPS Photoshop EPS (For importing data from Photoshop into Xara Web Designer 

Premium, use PSD files instead of EPS files for best results). 

.EPS Xara 

Other Import Formats 

.ACO Adobe Color Swatch 

.ACT Adobe Color Table 

.ART Xara Studio 

.CPL CorelDRAW palette 

.WEB Xara Webster files 

.AFF Acorn Draw 

.CDR CorelDRAW (3,4 & 5)  

.CDT CorelDRAW Template 

.CMX Corel CMX 5 & 6 

.DRW Acorn Draw 

.GIF GIF Placeholder 

.HTM. .HTML Graphics on HTML pages 

.ODP (Open Office Impress) 

.DOCX Microsoft Word Document 

.PAI MAGIX Photo Clinic Image  

.PAL CorelDRAW, Windows and PaintShopPro palettes 

.MXB MAGIX Bitmap 

.WMF Windows Metafile (16bit) 

.EMF/ .WMF Enhanced Windows Metafile 

.FLV FLV Placeholder 

.MP3 MP3 Audio Placeholder 

.MP4 MP4 Placeholder 

.PAI MAGIX Photo Clinic Image 

.PDF PDF Placeholder 

.PPTX (PowerPoint 2007 onwards) 

.RTF Text 

.SVG (Scalable Vector Graphics) 

.SWF Flash Placeholder 

.XWR Widget Placeholder 

.WIX For internal use by Xara 

Export formats 

Bitmap Export Formats (see GIF, PNG and JPEG export dialog overview (on page 496)) 

.GIF CompuServe GIF 

.GIF Animated GIF files (see Creating animated GIF files (on page 483)) 

.JPG JPEG  

.PSD Photoshop (see importing and exporting PSD files (on page 494)) 
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.PNG PNG 

Other Export Formats 

.AVI AVI animation (animation documents) 

.EMF, .WMF EMF/WMF documents 

.HTM, .HTML (Web pages and websites) 

.SWF Flash (see Flash Animations (on page 460)) 

.DOCX  Microsoft Word Document 

.PPTX .PPT  Microsoft PowerPoint 

.RTF Rich Text Format 

.WIX, .WEB, .XAR Xara documents 

Importing files 

To import a file: 

 Select "FILE" > "IMPORT" -  This normally merges the file's contents into the existing 

document. With some formats you get the choice of importing the document into the 

current page or adding it as a new page. With some other formats you are given the 

option of either importing the file data conventionally, or adding a link to the file and 

including it in your published website. 

 Or select "FILE" > "OPEN" - This opens the file as a new document. 

Xara Web Designer Premium supports drag and drop import of files. If you drag a file 

from your File Explorer onto an open Xara Web Designer Premium document it will 

import the file and place it on the current page, centered on the drop point. Or drag & 

drop a suitable file from Windows Explorer onto any bar or the title bar of Web Designer 

Premium's window - it will open the file as a new document. 

Replacing Image Files 

You can replace any loaded image or image-filled shape with your own images. To 

replace an image simply drag your own file (JPEG, GIF, PNG, BMP) from your Windows 

File Explorer and drop it on top of the picture that you want to replace. Your photo will 

automatically be scaled appropriately to replace the existing photo. The new photo will be 

selected and you’ll be put into the FILL TOOL (on page 257) so that you can easily adjust 

the position and scale of your photo if desired.  

See the "Replacing photos” section of the Photo Handling chapter for more details. 

Importing a Photoshop PSD file 

To import a PSD file, import the file as normal with File > Import, or just drag and drop 

the .psd file into Xara Web Designer Premium. 

The layers in the PSD file, and the layer visibility setting will be preserved and will 

become Xara Web Designer Premium layers. You can view them by opening the PAGE & 

LAYER GALLERY (on page 444).  
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Tip: if you have separate objects in Photoshop that you wish to be able to move and 

change independently of one another in Xara Web Designer Premium, place them on 

separate layers in Photoshop before exporting. 

PDF Import 

PDF is a complex vector graphics format that has evolved over 10 years or more and 

contains numerous sub-formats and options. PDF was designed as a portable document 

format for viewing and printing only, and was not intended as a file format for transferring 

data between applications. However Xara Web Designer Premium should load the vast 

majority of PDF files. 

PDF is now the recommended way of transferring vector files from Adobe Illustrator to 

Xara Web Designer Premium. Save as PDF and then import the resulting file into Xara 

Web Designer Premium. 

The following points are worth noting: 

 Multi-page PDF files are imported as multi-page documents in Xara Web Designer 

Premium. 

 Text in PDF files is typically broken into many separate small text objects in the PDF 

file. This doesn’t stop it viewing and printing, but means when imported what might 

appear as one or more continuous paragraphs of text is not. Xara Web Designer 

Premium tries to re-assemble the lines of text into lines and paragraphs of editable 

text, but often you will find the text broken into separate text objects. 

 In order to make it easier to extract just the text of a PDF file, a new layer is created 

containing just the text on that PDF page. Use the PAGE & LAYER GALLERY to view this 

layer. 

What might not work: 

 Many PDF files include embedded fonts. It’s not possible to legally extract and install 

these fonts onto your system. So if you do not already have the fonts used in the PDF 

file you will find alternative fonts have been substituted. 

 If you attempt to edit embedded subset fonts with the Print and Preview (on page 256) 

permissions you will receive an restricted license font warning which you can either 

cancel, or ignore (for the current session only).  

 Files that are encrypted or password protected cannot be imported. 

PDF is a highly complex format, and often can't be imported perfectly. The best way to 

import it may depend on how you intend to use it. The "OPTIMISE FOR VIEWING" option 

attempts to make the imported result look as similar to Acrobat as possible, but it may be 

more difficult to edit (it could have many nested clipviews for example). The alternative 

“OPTIMISE FOR EDITING" option strips out some constructs which are difficult to manually 

edit (for example, nested clipviews). 

Importing a Word document  

You can easily import a Microsoft Word document (.docx). Simply drag and drop the file 

from Windows Explorer, or else select "FILE" > "IMPORT".  
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Automatically flowing text areas 

When you import a Word document Web Designer Premium automatically creates new 

pages for you when text areas overflow the current page. So as you add more text or 

images to your document - so the document automatically adds new pages to 

accommodate them. When a new page is created, it's placed immediately following the 

current page. The new page is just as it would be if you’d added it manually (it will have 

the same background and repeating objects of the current page). But in addition it will 

also have a copy of each of the text areas on the current page that are linked to the 

current text flow and they will be linked together similarly. 

Changing linked text areas together 

Often your document will have similar layouts of text areas across multiple pages. If you 

make a change to a text area on one page, you may want that same change to be 

reflected for all similar areas in the same flow. So if you move or resize a text area and 

there are similar areas in the same flow on other pages (that is, they have the same size 

and position on the page) Web Designer Premium will ask you if you want to change 

those areas too.   

See Text areas (on page 202) for more information. 

RAW photo import 

You can import RAW digital camera files, either by using the Import menu option or just 

drag & drop the file onto the Web Designer Premium window. 

Supported file extensions include: *.crw, *.cr2, *.rw2, *.nef,*.mrw,*raf,*.kdc,*.orf, *.dng, 

*.ptx, *.pef, *.anw, *.x3f 

However there are many different extensions used for RAW files by different camera 

manufacturers, so if you have a RAW file with a file extension not listed above it’s worth 

trying to import it anyway. 

Importing from a website 

You can import text and graphics directly from web pages on the Internet into your 

document, or copy and paste text and graphics directly from a web browser onto your 

page.  

To import from an online web page: 

1. Choose "FILE" > "IMPORT FROM WEB ADDRESS" (or "Ctrl + Alt + W"). 

2. Type in the web address (URL) of the page or graphic you want to import.  

3. Click Import. 

If the URL entered is that of a web page, all the text and images on that page will be 

imported and positioned on your page in approximately the same positions as they are 

on the web page. In other words, this function gives you a way to roughly import an entire 

web page in terms of its text and graphics. However note that most modern web pages 

are made up of a complex combination of text, graphics, JavaScript and other features, 
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so such imports are unlikely to give you a complete and accurate representation of the 

page in Xara Web Designer Premium.  

When importing from web pages, the length of your page in Xara Web Designer 

Premium will be automatically extended to accommodate the incoming text and graphics, 

if it is not already long enough. 

 

Exporting files 

To export a file: 

 Right click and choose EXPORT 

 Or select "FILE" > "EXPORT". 

 Or press "Ctrl + Shift + E". 

An EXPORT dialog box will appear. Choose a name for your file, and select the required 

format from the SAVE AS TYPE dropdown list. Some of the supported formats are detailed 

below. 

Exporting as Flash 

You can export a drawing to Adobe's SWF Flash format (static). This is best suited to 

vector designs, and can provide very small file sizes. You can then use the SWF in a 

website, or import it into Flash for use in Flash animations. 

You can also create animated Flash. See Flash Animations (on page 460) for more 

details on Flash export. 

Exporting as AVI 

Select FILE > EXPORT ANIMATION and choose the AVI type from the type list. Click the 

OPTIONS button on the file dialog to change the codec and other settings used for the 

export. 

Exporting to a Word document 

Select "FILE" > "EXPORT" and then choose the MICROSOFT WORD (.DOCX) option from the 

drop-down menu.  

Exporting a Web document 

Sometimes you will want to export a print document as a web viewable HTML page 

rather than a PDF. This has the advantage of being lighter or smaller in size than a PDF. 

and can make for a smoother viewing experience especially when viewed on a tablet or 

iOS devices.  

For more details see Web Document Publishing. 
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Exporting as Windows metafiles (.wmf) 

Files in this format can be read by Word and several other programs. 

Exporting as Extended Metafile Format (EMF) 

Modern Windows applications support this enhanced type of vector graphic format. This 

format is also available to applications that provide a Paste Special menu option. 

Note that Xara Web Designer Premium can contain features, such as advanced fill 

styles, that cannot be represented in vector formats such as EMF. In this case parts of 

the image will be exported as bitmaps. Those vector parts that can be exported as 

vectors are exported as vectors. 

Quick export of HTML and web graphics formats 

You can use the dedicated options in the FILE MENU to quickly export web pages and 

web graphics, without selecting the formats from the full list of available export  formats 

shown when you use "FILE" > "EXPORT". 

 "FILE" > "EXPORT WEBSITE": Export the current website document to a location of your 

choice on your computer. 

 "FILE > "EXPORT JPEG": Export the current selection, or current page, to a JPEG file. 

 "FILE" > "EXPORT PNG": Export the current selection, or current page, to a PNG file. 

For more information, see the Getting Started chapter. 

Exporting as a bitmap 

JPEG, GIF and PNG are universal formats supported by most modern computer 

applications. PNG is the highest quality. JPEG is better suited to photographic work, but 

can produce acceptable, compact files (you can control the quality and file size). 

GIF format only supports 256 colors, and although common on many websites, PNG is a 

better format.  PNG also supports semi-transparent graphics (use the True Color + Alpha 

option), but this is not correctly supported by older Microsoft Internet Explorer versions (it 

is by all other web browsers). 

The fewer colors you have in a file, the smaller the file and the lower the quality. 

However, when using 256 colors or less Xara Web Designer Premium provides very 

advanced techniques to simulate a much wider range of colors, and so you can get very 

high, near photographic quality results using only 256 colors or less. 

See also GIF, PNG, BMP and JPEG export dialog overview (on page 496). 

Important 

Bitmaps are output at the current view quality so for best results make sure that 

"WINDOW" > "QUALITY" is set to anti-aliased. 
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Exporting a Photoshop PSD file 

Photoshop is a bitmap editor, so when exporting to PSD format all the vector objects in 

Xara Web Designer Premium are rasterized. You can select the resolution (dpi) when 

exporting. 

Always save your work in Xara Web Designer Premium prior to exporting. Then, if you 

wish to alter your original objects in the future, just load Xara Web Designer Premium, 

make any changes and then export the required objects again. 

To export as a PSD file choose "FILE" > "EXPORT" then select ADOBE PHOTOSHOP in the 

SAVE AS TYPE list. 

PSD Export settings 

The PSD export dialog gives you several options. 

 

Resolution in DPI 

A DPI of 96 is the normal Windows screen resolution, and so exporting at 96dpi will 

appear in Photoshop at the same size at 100% as it does at 100% in Xara Web Designer 

Premium. For print work you should choose a higher DPI. 

Export each object as a PS Layer     

Xara objects are mapped to PS layers so each object becomes a separate layer in 

Photoshop. This is a good fit between the two applications, because whereas in 

Photoshop effects and blend modes are applied to whole layers, in Xara the same tools 

are applied to objects, not layers. So it’s more useful to map Xara objects to and from 

PSD layers where they will remain editable. This is the default option. 

Export each layer as a PS Layer 
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Each Xara layer is exported as a separate layer in Photoshop. All objects on the same 

layer (including the layer names) are exported as one bitmap.  If you choose this method 

and want to have objects like text and transparency (blends in Photoshop) remain 

editable then they have to be placed on their own separate layers before export. If 

objects using different types of transparency are combined on the same layer in Xara 

Web Designer Premium, an alert - warning you of this will pop up when you export.  

Export just visible objects 

Exports all visible objects on the page and pasteboard areas.  

Export whole page area 

Exports the whole page area together with visible objects on the page area only.  

Text 

You can export text from Xara Web Designer Premium to be editable text in Photoshop, 

but the text must be on a layer on its own (on import you may be asked to update the text 

objects for them to be editable in Photoshop.) 

Text that is on a layer with any other graphic objects will be rasterized into that layer, and 

thus not be editable. So for this reason it is recommended that you choose the default 

export option - EXPORT EACH OBJECT AS A PS LAYER. 

Export DPI 

You will be able to set the DPI of the bitmaps in the exported PSD file. 

 

A DPI of 96 is the normal 

Windows screen resolution, 

and so exporting at 96dpi will 

appear in Photoshop at the 

same size at 100% as it does 

at 100% in Xara Web Designer 

Premium. 

For print work you should choose a higher DPI. 

You can select to export the whole Xara Web Designer Premium page area or just the 

areas of the visible objects only. 
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Summary 

In order to get maximum compatibility and editability in Photoshop: 

 For the parts of your drawing that you want to remain separate layers in Photoshop, 

place them on separate layers in Xara Web Designer Premium. 

 If you want your text to be editable in Photoshop, place it on a layer of its own, with no 

other graphic objects. 

Exporting as SVG 

Export either the currently selected objects or the whole page area as an SVG (Scalable 

Vector Graphic) file. 

The export dialog allows the setting of a dpi value (96 dpi default) for bitmaps should they 

be included on the page and also the following formatting options: 

 PATTERN (INKSCAPE) 

 CLIP PATH (ADOBE) 

 NON-REPEATING AS CLIP PATH 

  

JPEG, PNG and GIF export dialog overview 

 

The Export settings dialog has two 

preview windows, IMAGE A on the left 

and IMAGE B on the right, so you can 

compare alternative export settings 

or file types, side-by-side. Just click 

on the left or right preview window to 

change the active preview. 

Above the preview window is a small 

dropdown that lets you select from 

the most common three export 

types, JPEG, PNG, and GIF. 

When you have selected preview A or B you can then adjust a wide range of export 

options using the five tabs below the preview. Some options, such as the Palette Options 

are only applicable to some file types such as PNG and not relevant to JPEG type. 

Other options under the OPTIONS tab change depending on the file type. e.g. when 

exporting a JPEG this is where you can set the required quality. 

So the process for exporting an image: 

1. Select the object or objects on the page you want to export 
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2. Select the Export menu, or "Ctrl + Shift + E", enter a file name, and select file type 

from the drop down list. The main export type will display the above preview dialog. 

3. In this Preview dialog adjust the settings if you want, or skip this if you're happy with 

the default settings 

4. Click the EXPORT button 

For most commonly used JPEG and PNG formats, at step 2 you can instead use the 

direct operations available in the FILE MENU: EXPORT JPEG and EXPORT PNG. The export 

dialog shown includes a “Settings” button which takes you to the export settings dialog 

shown above. 

Most export settings are remembered for the next time you export. For example if you 

adjust the JPEG quality, the next time you export a JPEG it will remember the last quality 

setting. 

Exported Image Size 

When you export the normal default size is the same as you see on screen at 100% 

zoom. The pixel size is shown under the preview window. You can adjust the pixel 

dimensions either by adjusting the object size on the page before you export, or by 

entering alternative pixel or dpi values in the BITMAP SIZE tab. 

Preview Controls 

These buttons alter the preview of the images, but do not affect the exported file: 

 

 ZOOM TOOL: Click on a preview to zoom in. Shift-click to zoom out. Drag 

over an area of the preview to zoom into that area. 

 PUSH TOOL: Lets you drag the image around in the preview window. 

 ZOOM TO FIT: Scales the preview image to fit the window. 

 ZOOM TO 100%: Scales the image to full-size (100%). 

 ZOOM TO RESOLUTION OF IMAGE (1:1): Has no effect for GIFs. Scales the 

image so one pixel in the bitmap is one pixel on screen. This is useful for 

previewing detail in the bitmap. 

The following tool is only relevant to files using less than 256 colors (but you will see the 

result when you have the PALETTE OPTIONS tab selected): 

 

COLOR SELECTOR: Moving the pointer over the image highlights the color under 

the pointer. Click to select that color in the palette. You can then use PALETTE 

OPTIONS buttons (described below) to alter that color. 

PREVIEW: The preview button is available on all tabs of this dialog. It updates the preview 

windows to reflect any changes you have made to the export options. 
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Palette Options tab 

This tab allows you to alter the color settings of your exported image. 

Dithering & Palette 

The DITHERING and PALETTE options only apply when you export with 256 color or less, 

and affect how the image is displayed and its color palette. It is recommended to always 

use an OPTIMIZED PALETTE. Set DITHER to none, which produces smaller files but may be 

banded, or ERROR DIFFUSION, which creates higher quality results, but larger files. 

Color Depth 

Choose the number of colors your bitmap requires. The more colors, the larger the file 

(usually), and the higher the quality.  The TRUE COLOR option supports up to 16 millions 

colors. TRUE COLOR + ALPHA includes semi-transparent features such as soft shadows 

and transparency. For applications that support alpha-channel PNG files this is the 

recommended format. 

If you choose 256 colors of less, you have the option to use simple transparency (Wine 

glass icon-see below). This doesn't support semi-transparent pixels, only "on/off" fully 

opaque or fully transparency pixels, and so can produce jagged edges. 

Max Colors 

If you select a Color Depth of 256 or less you can control exactly how many colors are 

used in the file. This provides a high degree of control over quality vs. file size. Just enter 

the required number of colors and press the PREVIEW button to preview. 

Buttons 

These buttons (except TRANSPARENT BACKGROUND) apply when exporting 256 color 

images or less. These files are created with a limited palette of colors, and these controls 

provide a great degree of control over those palette colors. See COLOR SELECTOR above 

on how to select a color, or click on a color in the COLOR PALETTE). 

 
Lock a Color 

You can specify the number of colors you want in the palette of exported bitmaps. You 

may want to ensure that certain colors always appear in the palette; you can lock these 

colors. Click on a color to select it, then select the LOCK button. A small square appears 

in the bottom left of the color to tell you it is a locked color. 

 
Make a Palette Color Web Safe 

When clicked this button will shift the selected color to be one of the 216 common web 

browser palette colors. This is a legacy system that is no longer particularly important or 

relevant, as nearly all computers can display millions of colors, and there's no benefit in 

restricting web graphics to only this limited palette. 
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Make the Image Background Transparent 

Make any areas not covered by the selected objects transparent. Selecting this option 

automatically makes one entry in the palette transparent. 

 
Make a Palette Color Transparent 

Make this color entry transparent. Note the difference between this option, which makes 

parts of the selected objects transparent, and Make The Image Background 

Transparent which makes those areas behind the selected objects transparent. 

 
Delete a Palette Color 

Delete this color from the palette. Any areas in the bitmap that use the deleted color then 

use the nearest color in the palette. The fewer colors in the palette, the smaller the 

bitmap file. 

 
Restore a Previously Deleted Color 

Undelete a deleted color. 

 
Add system colors 

Adds 28 colors to the palette. These colors are the regular Windows system colors and a 

number of primary colors. This ensures the palette includes a spread of colors and may 

improve the quality of the image, particularly if it contains a wide range of colors. You 

may need to experiment with this option to get the best results. 

Bitmap Size tab 

With this tab, you can change the size of the exported image. 

Bitmap Size and Resolution 

You can change the size of the exported bitmap by changing: 

 SIZE: Type the required width or height into one of the fields. Note that the aspect ratio 

of the bitmap is fixed, so changing one dimension automatically changes the other. 

SIZE is more suitable than SCALE if you want to create a bitmap of a particular size in 

pixels. 

 SCALE: (Dimmed for JPEG & PNG). This lets you scale the bitmap up or down by a 

percentage. SCALE is more suitable than Size if you want, for example, a bitmap 50% 

bigger than the original. 

 RESOLUTION: (Dimmed for GIF & BMP) Type the resolution into the DPI field. If you are 

exporting an image for viewing on screen (e.g. a website), you do not normally need a 

setting higher than 96dpi. (If you need to export for a Retina device you can 

automatically export a higher resolution 192dpi version as well).    
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Area to Save 

The bitmap can be created using one of these areas of the document: 

 PAGE: The whole page area. 

 DRAWING: The area covered by objects. 

 SELECTION: The area covered by the objects in the selection. Only available when 

objects are selected. 

Anti-aliasing 

Anti-aliasing improves the appearance of graphics by smoothing jagged edges: 

 MAINTAIN SCREEN ANTI-ALIASING: The exported bitmap uses the exact same 

positioning as shown on screen, and so has identical anti-aliasing. This can result in 

the edges of objects being slightly blurred because they do not fall exactly on pixel 

boundaries. 

 MINIMIZE VISIBLE ANTI-ALIASING: This will slightly reposition the objects by fractions of a 

pixel to minimize the anti-aliasing around the edge of the exported bitmap. If in doubt 

which option to use, select this. 

Put HTML Image Tag on Clipboard 

This lets you save out the basic HTML IMG tag information when you save the bitmap. 

You can then paste the tag into your text or external HTML page editor. 

Also export Retina (192dpi) bitmap 

With this option checked you can simultaneously export a 192 dpi high definition Retina 

image. This saves you exporting twice if you have a need to provide a 96dpi as well as a 

192dpi resolution image for Retina devices. For JPEG and PNG the operation is only 

valid when you have the 96dpi option selected.  

See High resolution images (on page 351) for more info on Retina images. 

Options tab 

With this tab you can alter JPEG compression and turn on progressive/interlacing for the 

GIF and PNG options if required. 

JPEG Quality: (JPEG only) A low setting will result in a small file with a loss in quality 

whereas a high value will give only slight file size reductions, but high quality. Note that a 

setting of 100% will still compress the file. A setting of 85% gives good compression 

without causing a noticeable loss in quality for most uses. 

Interlaced: (GIF and PNG only) This is like a JPEG. In the browser the picture first 

appears as a low resolution image. As more of the file loads, the resolution increases. 

Transparent: (GIF and PNG only) This makes any areas not covered by the selected 

objects transparent. Selecting this option automatically makes one entry in the palette 

transparent. 
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Export each layer to a file of its own: (GIF and PNG only) Selecting this option when 

exporting a design that contains multiple layers results in a separate file being exported 

for each layer. The names of each layer (as set in the Page & Layer Gallery) are used to 

name the exported files. 

Browser Preview tab 

Using the A and B preview boxes in the EXPORT dialog box (shown above), you can 

select the best compromise of file size and quality for web graphics. However the best 

test is checking how the graphic looks in a web browser. This tab provides a number of 

options for that preview. Click the BROWSER PREVIEW button to launch your web browser 

and preview the graphics before exporting. 
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Printing 

Show print borders 

The "WINDOW" > "SHOW PRINT BORDERS" menu shows a yellow and red line around the 

page (non-printing) showing the print margins and borders. The page boundary is shown 

by a yellow rectangle and the printing area by a red rectangle. The printing area is 

determined by the margins on the currently selected printer. Some printers let you adjust 

the margins, but few let you print right up to the edge of the page. 

If any objects on the page lie outside the red rectangle they are unlikely to be printed. 

Selecting and setting up a printer 

Select "FILE" > "PRINT" TO open the PRINT dialog box, then click the PRINTER... button.  

This opens the standard Windows PRINT SETUP dialog: 

 

Selecting a printer also selects a suitable paper size and paper orientation. Note that 

these are the size and orientation of the sheets of paper used in the printer. They are 

separate from the size/orientation of the document. PORTRAIT prints the page without 

rotation. LANDSCAPE prints the page turned through 90° (these buttons are duplicated in 

the PRINT OPTIONS dialog box, described later). We recommend leaving the 

LANDSCAPE/PORTRAIT buttons on this dialog box on their default setting. 
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Please note: We cannot give you advice about installing or configuring printers as these 

are standard system operations. In case of difficulties, contact the supplier of your printer 

or computer. 

Properties button 

This displays a dialog box letting you set options for the selected type of printer. This 

dialog box is not controlled by Web Designer Premium. 

Network button 

If your computer is connected to a network, this lets you connect to shared printers on 

the network. This dialog box is not controlled by Web Designer Premium. 

The print dialog box 

Choose "FILE" > "PRINT" ("Ctrl + P"). 

 

Print button 

When you have selected the required options click this to start printing. 

Printer… button 

This opens the "PRINT SETUP" dialog box (described earlier). 
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Options button 

This opens a tabbed dialog box that lets you set additional print options. These are 

described later (on page 505). 

Pages 

ALL PAGES:  Prints every page of the document. 

CURRENT PAGE(S): Prints the currently selected page or spread. 

SELECTED OBJECTS: This option is available when any objects in the document are 

selected. When active, only the selected objects are printed. Note that other objects 

within the bounds of the selected objects are not printed – only the objects which are 

actually selected are printed. 

Objects on hidden layers and the guides layer never print. See PAGE & LAYER GALLERY 

for more details. 

PAGE RANGE: Allows you specific control over which pages you wish to print. You can 

type specific pages numbers, separated by commas, or page ranges by typing two 

numbers with a hyphen in between them. 

Page range examples: 

2 will print just page 2. 

1,3,5-7 will print pages 1, 3, 5, 6 and 7. 

2,3,6-8,11-12 will print pages 2,3,6,7, 8,11 and 12. 

The Options section of the dialog will indicate if your page range is OK or invalid. 

Print to File 

You can select the PRINT TO FILE option to create a document that you can give to a 

printing company (if they are able to accept this type of file). 

After checking this option, when you click PRINT Web Designer Premium displays the 

standard Windows SAVE dialog box so you can specify a file name and location for the 

file. 

Print files have a default extension of .prn. 

Number of copies 

Sets how many copies of the document to print. 
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Print Options: Output tab 

 

Print layers 

There are two options: 

 Print ALL FOREGROUND LAYERS. 

 Print only the currently VISIBLE FOREGROUND LAYERS. 

Note that only foreground layers are printed. Background layers are never printed. 

Print As 

NORMAL is suitable for most types of document. 

However some printers do not reproduce consistent colors when printing bitmaps or 

vector objects that are the same color (this is a fault with the printer driver). This is 

noticeable if objects overlap onto bitmaps or onto objects with transparency applied to 

them. In this case, select BITMAP or ANTI-ALIASED BITMAP and retry. 

The choice between BITMAP and ANTI-ALIASED BITMAP depends on the printer and 

personal preference. Some printers give best results with anti-aliasing turned off 

especially when printing thin lines. As a rule, using anti-aliasing allows lower resolution 

printing. For example, 150 DPI bitmap printing is usually good enough for all uses-even 
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typesetting. Without anti-aliasing, higher resolutions may be needed which gives much 

slower printing. 

Transparency resolution 

When printing, Xara Web Designer Premium's transparency effects are created using 

bitmaps. 

This option controls the resolution of those bitmaps when sent to the printer. Automatic is 

suitable for most drawings, and means Xara Web Designer Premium automatically 

selects a resolution suitable for the current printer.  This might be unsuitable if printing to 

a very high resolution printer such as image setting devices. In this case you may wish to 

control the print resolution manually by entering the desired value. 

Note that modern printers often claim to be able to print at over 1000 dots-per-inch, but 

this is not the same thing as "pixels-per-inch", which is what you see on screen. 

Generally, it's never necessary to print at more than 600 pixels-per-inch, and typically 

300 pixels per inch produces perfectly adequate print results, especially if anti-aliased. 

Fill quality 

Using this option, you can choose how many steps make up the graduated fills in your 

document when it is printed. The NORMAL setting is suitable for most purposes. This 

option is dimmed for PostScript printers. 

Text options 

If your printer has problems reproducing fonts, select the PRINT ALL TEXT AS SHAPES 

option. All text is then converted to vector shapes before the document is sent to the 

printer. This may be slower, but will reproduce exactly what you see on screen. 
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Print Options: Print Layout tab 

 

Most options in print layout are dimmed if you have BEST FIT or AUTOMATIC FIT selected. 

We recommend using these options as they are the easiest way to print. 

However you can choose custom options (see “custom fit” below). 

Best fit 

Your design will be moved to the center of the page and it will be expanded or shrunk to 

suit the paper size. 

This option is best if you have a large or small design and want it to fit on one page. 

Automatic fit 

Your design will be orientated as necessary, but Web Designer Premium will not change 

the size. We recommend this option if you are having any difficulty getting the orientation 

right (there are at least four places where you can set the page orientation, sometimes 

more for some printer drivers). 

This option is best if you have a set size for your design and don't want it altered. 

Custom fit 

Allows you to have control over your print out, including orientation, size and margins. 
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The ORIENTATION buttons can be used to choose the orientation of the printout. The 

scale can be altered using the SCALE field. The top and left margin fields can be changed 

(these set where the top left-hand corner of the page appears on the printer's paper). 

The WIDTH and HEIGHT fields give you an alternative way of setting the print scale (when 

you change one of these settings, the other changes to ensure the page is always 

printed with a 100% aspect ratio). 

Multiple fit 

To print multiple copies on one page, choose MULTIPLE FIT, enter a value for the number 

of copies needed across the page (rows), the number down the page (columns), and the 

distance between each (gutter). 
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Customizing Web Designer Premium 

Changing the blank template document 

The blank template documents are the options available under "FILE" > "NEW".  

To add a template document: 

1. Open an existing document ("FILE" > "OPEN", or "Ctrl + O") or create a new 

one with the NEW button on the Standard control bar or "Ctrl + N". 

2. Make any required changes (these could be changing the page size, 

adding a logo or adding a message). You can edit the template document 

just like an ordinary document. 

3. When you are happy with the changes choose "FILE" > "SAVE TEMPLATE" 

and choose a template name. 

 

To make your new template the default template (i.e. which is there when you first open 

Web Designer Premium, and which appears when you press "Ctrl + N") check the USE 

AS DEFAULT TEMPLATE option when saving the template. 

Options in the Utilities menu 

Keyboard shortcut: "Ctrl + Shift + O" or right click the page/pasteboard and choose PAGE 

OPTIONS. 

This menu option opens the OPTIONS dialog box. This lets you set various options for 

Web Designer Premium. 
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General tab 

This page describes the General tab of the Utilities, Options dialog 

 

Current layer always visible and editable 

With this option selected, selecting a layer in the PAGE & LAYER GALLERY automatically 

makes it visible and editable. 

With this option unset, the visible and editable states of a layer remain unchanged when 

you select that layer. 
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Give new objects most recent attributes (GNOMRA) 

Examples of attributes are line width, dash pattern, arrowheads, color, fill color and type 

of fill. 

With this option set, new objects take the attributes of the object that was last drawn or 

selected. For example, you might give an existing shape a red fill and green line color. If 

you then draw a new shape it will also have a red fill and green line color. See Current 

attributes (on page 119) for a full description of current attributes and this option. 

This option is on by default. 

Ask before setting current attribute 

This applies when changing a current attribute (this happens when you change an 

attribute with no objects selected). With this option set, you are asked to confirm whether 

you want to change the attribute. With this option unset, the change is made without 

confirmation. 

Make groups be transparent as a whole. 

See Transparency for more on transparencies. 

When applying transparency to a group of objects, by default Web Designer Premium will 

apply the transparency to the group as if it were one object (i.e. you will not see individual 

transparencies within the group). Unselecting this option will make Web Designer 

Premium add transparency to each object in the group separately. 

Maintain imported layer names 

With this option set, layer information is preserved when you import templates or other 

files. With IMPORT LAYERS INTO THE ACTIVE LAYER instead selected, all imported objects 

appear in the current layer and the layering information in the incoming data is ignored. 

IMPORT LAYERS INTO NEW LAYERS will create a layer for each imported layer. 

IMPORTANT: Note that you should not change this setting if you use any of the web 

templates in the ONLINE CONTENT CATALOG/DESIGNS GALLERY. Most web templates have 

multiple layers which are used to implement mouseover effects. These typically have 

layers MouseOff and MouseOver and so when importing these designs it’s important that 

these layers are preserved and merged with the same layers in your document. 

Recent files 

The File menu shows a list of the most recently loaded or saved files in its ‘Open recent’ 

sub-menu. This list gives a quick way to reload any of those files. This option lets you 

change the number of files listed (between 1 and 20 files). 
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Marquee Object Selection 

This option enables you to change the default setting for marquee selection (where you 

drag a selection rectangle over the objects you want to select). So you can choose to 

have objects touching the selection rectangle selected or only the objects wholly inside 

the rectangle. 

 

Legacy web browser compatible line lengths 

Older web browsers were not able to render text very accurately. When you asked for a 

certain font size they rounded it up or down, often displaying the wrong size and width 

(compared to the original font design, and how Web Designer Premium, Word, PDF and 

all modern DTP programs would display it). 

Older versions of Web Designer Premium attempted to compensate for these 

inaccuracies, by providing a LEGACY WEB BROWSER LINE LENGTH COMPATIBILITY option 

which meant the text was slightly differently formatted - line lengths would be different 

compared to normal print documents, or the same text in Word, or PDF documents. 

Most modern web browsers are getting better at rendering text accurately - you can now 

specify any px or pt font size, even fractional sizes, and the text will for the most part, be 

rendered accurately*. The text formatting should be the same as in print documents, 

PDF, and page layout documents. This includes auto-kerning, manual kerning and 

tracking (letter spacing). 

If you load an older Web Designer Premium web document, a dialog will appear 

prompting you to update the text formatting. This in effect prepares your web document 

so that it will display accurately on most modern web browsers.  

 

 

A consequence of updating the formatting to support the more modern browsers is that 

text may re-flow because of slightly different line lengths, causing text columns to be 

slightly longer or shorter than before. Once you update formatting the document will 

remain like this and you will not be asked again. 

To turn formatting back to the old style use the GENERAL TAB of "UTILITIES" > "OPTIONS" 

dialog and make sure that the LEGACY WEB BROWSER LINE LENGTH COMPATIBILITY option 

is checked. Or if you are loading an older document into Web Designer Premium just 

choose the KEEP ORIGINAL FORMATTING option. 
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*As of writing the Apple Safari and Chrome browsers when used on mobile devices such 

as phones and tablets still round font sizes to the nearest whole pixel size. 

Document type 

This determines the type of document, as indicated by the icon in the document’s tab.  

 Print – Used for documents that are intended for print work. This type is not normally 

used in Web Designer Premium, but other products in the Designer product range 

work with print documents. 

 Website – Use this type of document for creating websites and web graphics. This is 

the most common document type Web Designer Premium is used with. 

 Photo – If you open a JPEG photo in Web Designer Premium, the document type is 

Photo. Such a document doesn’t have a defined page area for example. See the 

Photo Handling (on page 351) chapter for details.  

 Animation – Used for animation documents. See the Animations (on page 460) 

chapter for details. 

 Presentation (Web) – These are specialized website documents that make a 

presentation. See the Web Presentations (on page 425) chapter for more information.  

Normally you don’t need to change the document type as the type is established when 

you first create it (for example using a template from the Designs Gallery, or choosing a 

blank document from the FILE->NEW MENU). But it’s sometimes useful to convert between 

print, website and presentation documents if the purpose for which your document was 

created changes. You can’t convert to or from Photo or Animation documents.  

Angle constraint 

This applies when rotating or moving an object with "Ctrl" pressed. 

You can either select from the menu or type in a value in degrees. 

Nudge size 

This applies when moving objects using the arrow keys on the keyboard. 

This text box defines how far the object moves for each key press. If the document uses 

scaled units (for example, 1inch to 1mile), this text box shows the distance in the scaled 

units. 

When nudging, "Ctrl" and "Shift" increase the nudge distance by five and ten times, 

respectively. 

Duplication distance 

"EDIT" > "DUPLICATE" (Ctrl + D) creates a duplicate which is offset from the original 

object. These text boxes set the offset distance. 

Positive values create the duplicate above or to the right of the original object. 
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Negative values create the duplicate below or to the left. 

Grid and Ruler tab 

This page describes the Grid and Ruler tab of the Utilities, Options dialog 

 

Grid and Ruler spacing 

MAJOR SPACING defines the distance between the major grid and ruler divisions. The 

units used for the grid and rulers are defined by the units you use for the major spacing. 

For example entering a major grid spacing of 2CM will set the grid and ruler units to 

centimeters regardless of the page units specified in the units options. 

Coordinate Direction 

Here you can change the direction of page coordinates.  
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Mouse tab 

This page describes the Mouse tab of the Utilities, Options dialog 

 

 

Mouse button function 

Web Designer Premium gives you a range of possible actions when you click either the 

left or right mouse buttons. For example, if you're left-handed, you may prefer to use the 

right-hand button as the normal button. You would therefore assign the normal click to 

the right mouse button (you can also set both buttons to have the same action if you 

wish). 

Possible actions: 

 Normal click - At least one button should always be assigned as the normal click. 

 "Shift + click". 

 "Ctrl + click". 

 "Alt + click". 

 Display a pop-up menu (see below). 

 Toggle full-screen mode (described in Document Handling (on page 68)). 

 Zoom in or out -click to zoom in, "Shift + click" to zoom out (described in Document 

Handling (on page 68)). 

 PUSHTOOL (as if you pressed "Shift + F8") 

The pop-up menu contains options suitable for the object you click on. For example, for 

most object types the menu contains CUT, COPY, PASTE, DELETE, DUPLICATE, CLONE 

(these are described in Object Handling (on page 92)). 
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MOUSE WHEEL MOVEMENT: You can change the mouse wheel action here between 

Scrolling and Zooming.  

Click RESET DEFAULTS to return to the original button assignments. This has immediate 

effect; you don't need to click OK or APPLY NOW. 

The Windows Control Panel also lets you swap the left and right mouse buttons. 

Magnetic Snap Radii 

Snapping is described in Object Handling (on page 92). 

These text boxes define how close you can drag an object before it snaps to a magnetic 

object. These are distances on the screen and independent of any document scaling. 
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Page Size tab 

This page describes the Page Size tab wd of the Utilities, Options dialog 

 

If the “ALL PAGES IN WEBSITE THE SAME SIZE” option is unselected, then pages in your 

document can be given different sizes using this dialog. To set the page size, choose 

one of the paper sizes provided in the dropdown list, or choose “Custom” and then enter 

the width and height required in the field(s) provided. 

If the LOCK PAGE SIZE option is turned on, you can’t resize a page by dragging the bottom 

or right edges and any "Push" objects that get pushed off the bottom edge of the page 

will not cause the page to grow. 

The AUTO-FIT TO PAGE... button will open the AUTO-FIT TO PAGE dialog. This enables the 

automatic repositioning and scaling of page content to fit a new page size. The dialog 
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also lets you fine tune the position of document content. This may sometimes be 

necessary especially with items around the margins of the document like headers, 

footers etc. 

 See the Auto-fit to Page (on page 127) section in the Object Handling (on page 92) 

chapter for details. 

Backups Tab 

This tab allows you to turn the automatic backup facility on and off. This facility saves a 

copy of all your modified open documents at regular intervals. It’s recommended that you 

work with this backup option turned on, so your work is saved regularly. You can also 

choose whether you are prompted about unsaved documents when closing the program, 

or if instead all open documents should be backed up and restored for you when you 

next start up. 

See the Document Handling chapter (on page 76) for full details about these facilities. 

Effects & Plug-ins tab 

This page describes the Effects & Plug-ins tab of the Utilities, Options dialog 

 

For more on Live Effects refer to Live Effects (on page 393). 

Photoshop Plug-ins 

Clicking SETUP lets you add and remove folders of Live Effects plug-ins. 

Effects 

Here you can set the default resolution of Live Effects and locked effects. 
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New Effects Are Locked By Default 

This will make any Live Effects you create locked by default, so they will not change if 

you move or resize them. 

Default Live Effect resolution 

If a Live Effect resolution is set to AUTOMATIC, then any Live Effects on an object will, by 

default, be produced at screen resolution. If you wish to print your design you can set 

one Live Effect to a higher DPI and all effects on that object (as long as the other effects 

are set to automatic) will automatically be rendered at the highest DPI. It won't then be 

necessary to alter each effect one by one. Or you can set a different default in this 

window, and all Live Effects will be created at that resolution. 

Default Locked effect resolution 

This is the default resolution for locked effects. If you wish to change the DPI of a locked 

effect, you need to recreate that effect. Please note: this only applies to locked effects, 

and does not apply to a locked Live Effect. 

Control bars 

You can move Web Designer Premium's control bars to different places around the 

window, re-order the buttons, create new control bars, move or copy buttons between 

control bars and many other operations. 

You cannot change the tool-dependent InfoBar or the contents of the fly-out bars which 

are on the main toolbar and top bars. 

Full screen mode 

Web Designer Premium has two configurations of control bars: 

 One configuration appears when the window is its normal size. 

 The second configuration appears after you choose "WINDOW" > "FULL SCREEN". 

Any changes to one configuration of control bars (for example, resizing or moving) have 

no effect on the other configuration. Changes to individual buttons (for example, setting 

an option) apply in both normal and full screen modes. 
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Displaying & hiding control bars 

 

The display of control bars is controlled by 

the CONTROL BARS dialog box ("WINDOW" > 

"CONTROL BARS"). 

Against the name of each control bar is a 

check box. A tick in the check box shows 

that the control bar is currently displayed. 

Click on the required control bar's check 

box to display or hide that bar. 

You can also quickly turn CONTROL BARS on or off if you right-click in any empty area at 

the top of the program window. Use the drop-down menu to choose which bars you want 

to display. 
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Docked and free floating control bars 

Normally, control bars are docked (attached to the edges of the window). Moving the 

window also moves docked control bars. 

Control bars can also be floating. These do not follow movements of the window. 

  

 

Floating control bar Docked control bar 

You can hide a floating control bar either using the CONTROL BARS dialog box (described 

above) or by clicking its CLOSE icon. 

To make a control bar float, drag it away from the edge of the window either onto the 

editing area or off the Web Designer Premium window. 

To dock  a control bar, drag it over: 

 The edge of the window. 

 Or the menu bar. 

 Or another control bar. 

A floating control bar has a double line outline while dragging. This changes to a single 

line when in a docking position. If you want the control bar to remain floating, hold down 

"Ctrl" while dragging. 

Resizing a control bar 

Move the pointer over the edge of the control bar. It changes to a double-headed arrow. 

You can now drag the edge to resize the control bar. 

Creating new control bars 

To create a new control bar: 

 Drag a button onto the editing area or off the window. This opens a new control bar 

containing the button. 

Or click NEW on the CONTROL BARS dialog box. This lets you create a new control bar and 

allocate a name to it. The new control bar is empty. You can then drag buttons to it. 

Moving buttons is described below. 
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Deleting control bars 

You can only delete control bars that are empty. Therefore move any buttons to another 

control bar. Close the control bar (either click on the CLOSE icon or use the CONTROL 

BARS dialog box). The control bar is automatically deleted when you quit Web Designer 

Premium. 

Moving buttons and tools 

To move buttons or tools: 

1. Move the mouse pointer over the button you want to move. 

2. Hold down "Alt" (left ALT) to move the button or "AltGr" (right ALT) to copy the 

button when used on user-defined control bars and other control bars. Although on 

the predefined "Button palette" both ALT-keys do only copy the button. 

3. Drag the button to: 

- A different place on the same control bar. 

- Or another control bar. 

- Or onto the editing area/off Web Designer Premium to create a new control bar. 

You cannot move buttons onto or off the InfoBar. 

Hiding buttons and tools 

Move the unwanted buttons or tools to another control bar and then hide that control bar 

(described above). 

If you need the button or tool in the future, use the CONTROL BARS dialog box to redisplay 

the control bar. 

You cannot delete buttons or tools. 
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Menus and Keyboard Shortcuts 

Introduction 

This chapter describes the operations available on each of the menus and those 

available via keyboard shortcuts. In many cases the operations described in this chapter 

apply to the selected object. In most cases, the described action also applies when you 

have several selected objects. We use selected object as shorthand for selected object 

or objects. 

Often you can select options from either a menu, a control bar or a keyboard shortcut. 

Where a button on a control bar and/or keyboard shortcut exists, these are shown after 

the menu name. For example, the following means there is a button on the STANDARD 

control bar that has the same effect as selecting new, or you can use the shortcut "Ctrl + 

N". 

New (Standard control bar or "Ctrl + N") 

File menu 

New (Standard control bar or Ctrl+N) 

Opens a new document. 

New from Content Catalog (Shift+Ctrl+Alt+K)  

Opens the Online Content Catalog. Choose SmartShapes, templates, widgets and clipart 

from the catalog's web, layout and photo and graphic categories. 

Open (Standard control bar or Ctrl+O) 

Opens a new editing window and loads a file into it. This file can be: 

 A Web Designer Premium .web file to view or edit an existing Web Designer Premium 

document, 

 Or any of the other import formats (see Importing & Exporting (on page 486) for a list 

of formats). This opens a new document with the file. 

Open recent 

A list of the most recently loaded or saved files. Provides a quick way to reload any of 

these files. 

You can change the number of files in this list (refer to Customizing Web Designer 

Premium (on page 509) for details). 

Close (Ctrl+W) 

Closes the current editing window. Web Designer Premium remains loaded. You are 

warned if the file has unsaved changes. 
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Save (Standard control bar or Ctrl+S) 

Saves the selected document. 

Save As 

Lets you save the selected document under a different name or to a different directory or 

drive. 

Save All 

Saves all loaded documents. 

Save Template 

Saves the selected document as a template document (see Customizing Web Designer 

Premium (on page 509)). 

Import (Ctrl+Alt+I) 

Loads a file into the selected document. The file can be any of the import formats (see 

Importing & Exporting (on page 486) for more information). 

Note the difference between OPEN and IMPORT: both load a variety of file formats but 

OPEN opens a new document. IMPORT loads the file into the current open document. 

Import from Web Address (Ctrl+Alt+W) 

Import text and graphics directly from web pages on the Internet into your document. 

Enter the URL (web address) of the site you wish to import into the dialog box. 

Export (Ctrl+Shift+E) 

Or right click and choose EXPORT. 

Lets you export the document in any of the export formats supported by Web Designer 

Premium (see Importing & Exporting (on page 486) for a list of formats). 

Export JPEG 

Lets you export selected objects, a page or the whole document as a JPEG.  

Export PNG 

Lets you export selected objects, a page or the whole document as a PNG.  

Preview web page (Shift + F5) 

Export and preview the current page of the current website document.  

 

You can also preview your page by clicking the web page preview button on the 

Web toolbar. 
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Click a browser type at the top of the preview window to preview your page in your 

preferred browser. 

 

Previews your page in Google Chrome 

 

Previews your page in Mozilla Firefox 

 

Previews your page in Internet Explorer 

 

Previews your page in Opera 

 

Previews your page in Safari 

 

Previews your page in MS Edge (Windows 10 only) 

 

Preview Website (F5) 

Export and preview the current website document. The whole website is exported to the 

same location it was last exported to (overwriting files as necessary without prompting), 

or to a temporary location if the site has not yet been exported. Then a browser window 

is shown displaying the first page of the website.  

 

This is the quickest way to preview your site as you work on it. You can also preview 

by clicking the button on the Web toolbar. 

 

Export Website 

  

Also in Export toolbar. 

Export the current document as HTML. 

Publish Website 

 

This performs the same operation as the button on the Web toolbar. It exports 

and then publishes the current website document to your web space. 

If you haven’t already entered the FTP details for your web space, the PUBLISH tab of the 

WEB PROPERTIES dialog will be displayed first. Then the website is published to your web 

space. A progress indicator appears during the publishing operation. 

See the Getting Started (on page 61) chapter for more details on publishing. 
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Preview supersite 

Preview the current print document as a supersite.  

 

You can also preview your page by clicking the web page preview button on the 

Web toolbar. 

 

Click a browser type at the top of the preview window to preview your page in your 

preferred browser. 

 

Previews your page in Google Chrome 

 

Previews your page in Mozilla Firefox 

 

Previews your page in Internet Explorer 

 

Previews your page in Opera 

 

Previews your page in Safari 

 

Previews your page in MS Edge (Windows 10 only) 

 

Export supersite 

Export the current print document as a supersite. See Supersites (on page 324)  for more 

details. 

Publish supersite 

Exports and then publishes the current print document as a supersite to your web space. 

If you haven’t already entered the FTP details for your web space, you will be prompted 

to do so. You can then publish the supersite to your web space. A progress indicator 

appears during the publishing operation. 

Preview Flash 

This option is only enabled when the current document is an animation document. It 

exports your animation as Flash and brings up a pop-up window showing your Flash 

animation running. The window also includes basic information about your Flash 

animation, such as the size of the Flash file. 
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The button on the animation toolbar is a quicker way to invoke this operation. 

 

Export Animation 

  

Also in the animation toolbar displayed under the standard toolbar in an 

animation document. 

Export an animation for use in a website. 

Document Info 

This displays an information box about the selected document. It includes a 

comprehensive amount of information about the document including which fonts, 

together their permissions are included, as well as which Live Effects plug-ins are used.  

Page Options 

Also right click and choose PAGE OPTIONS. 

Allows you to edit the page layout, size, etc. 

Print (Ctrl+P) 

Sets options relating to printing the document and lets you print the document (refer to 

Printing (on page 502) for more information). 

Exit 

Closes all windows and removes Web Designer Premium from memory. You are warned 

if any files have unsaved changes. 

Edit menu 

Undo (Standard control bar or Ctrl+Z) 

Undo the previous operation. The description of this option reflects the last operation 

performed. For example, UNDO CUT (refer to Undo & Redo (on page 91)). 

Redo (Standard control bar or Ctrl+Y) 

Cancel the last UNDO command. The description of this option reflects the last UNDO 

operation (refer to Undo & Redo). 

Cut (Edit control bar or Ctrl+X) 

Cut the selected object to the clipboard (refer to Object Handling (on page 97)). 

Copy (Edit control bar or Ctrl+C) 

Copy the selected object to the clipboard. The object remains in place in the document 

(refer to Object Handling (on page 97)). 
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Paste (Edit control bar or Ctrl+V) 

Or right click and choose PASTE. 

Paste the clipboard contents into the selected document (refer to Object Handling (on 

page 97)). 

Sometimes, when you paste the contents of the clipboard into a document, it could be 

inserted using several different formats. If this is the case the PASTE SPECIAL dialog box 

will appear so you can choose a format. See Cut Copy and Paste (on page 97) in the 

Object Handling (on page 92) chapter for more detail. 

Paste unformatted text 

Pastes any text on the clipboard into your document without any formatting. 

Paste in place (Ctrl+Shift+V) 

The same as Paste, except your object will be pasted in the exact same position from 

which you copied it. This is useful for moving objects from one layer or page to another, 

without changing its X/Y position 

Paste format/attributes (Ctrl+Shift+A) 

Preserves the format (e.g., font and font size) or style attributes (e.g., line and fill color) of 

the pasted object. 

Paste position 

This option applies the position of a copied object on the clipboard to a currently selected 

object, which moves to the exact same position as the copied object. 

Paste size 

This option applies the size of a copied object on the clipboard to a currently selected 

object, which resizes around its center to the exact size of the copied object. 

Paste size and position 

As the name suggests, this option applies both the size and exact position of the object 

on the clipboard, to the selected object.  

Paste replacing selection 

This is similar to PASTE POSITION, except that the copied object on the clipboard replaces 

the currently selected object and retains the deleted item's position. The copied object is 

pasted into the center position of the deleted object. 

Paste in current layer 

The same as PASTE IN PLACE, except your object will only be pasted into the current 

layer. 
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Paste in place in current layer 

The same as PASTE IN CURRENT LAYER, except your object will be pasted into the current 

layer in the exact same position from which you copied it. 

Paste on all pages 

Pastes the copied object at the same size and position on all pages of the document.  

Delete (Edit & Standard control bars or Delete)  

Or right click and choose DELETE. 

Delete the selected object (refer to Object Handling (on page 92)). 

Select All (Ctrl+A) 

Select all objects in editable layers (editable and locked layers are described in Layers 

(on page 447)). 

Clear Selection / Reset current attributes (Esc)  

Deselect all objects. If nothing is selected, the current attributes (on page 119) are set 

back to its default values. You can easily get this by pressing ESC twice. 

Duplicate (Edit control bar or Ctrl+Alt+D) 

Or right click and choose DUPLICATE. 

Copy the selected object placing the copy slightly offset from the original. The copy 

becomes the selected object. The offset distance can be customized (see Customizing 

Web Designer Premium (on page 513)). 

Clone (Ctrl+K) 

Like DUPLICATE copies the selected object, but places the copy directly over the original. 

The copy becomes the selected object. 

Pages 

Or right click and choose PAGES. 

The Pages submenu lets you add or remove pages from your multi-page document, 

duplicate the current page or move the current page up and down. Read more on multi-

page documents in Multi-page Documents (on page 71). 

Arrange menu 

Move to Layer in Front (Arrange control bar or Ctrl+Shift+U) 

Or right click and choose ARRANGE > MOVE TO LAYER IN FRONT. 
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Move the selected object forward by one layer. The selected object becomes the back 

object in the new layer. In an animation document, this option is MOVE TO NEXT FRAME. 

Bring to Front (Arrange control bar or Ctrl+F)  

Or right click and choose ARRANGE > BRING TO FRONT. 

Move the selected object to the front of all other objects in the same layer. See Object 

Handling (on page 92) for more information. 

Move Forwards (Arrange control bar or Ctrl+Shift+F) 

Or right click and choose ARRANGE > MOVE FORWARDS. 

Move the selected object one step towards the front (refer to Object Handling (on page 

92)). 

Move Backwards (Arrange control bar or Ctrl+Shift+B) 

Or right click and choose ARRANGE > MOVE BACKWARDS. 

Move the selected object one step towards the back (refer to Object Handling (on page 

92)). 

Put to Back (Arrange control bar or Ctrl+B) 

Or right click and choose ARRANGE > PUT TO BACK. 

Move the selected object behind all others in the same layer (refer to Object Handling (on 

page 92)). 

Move To Layer Behind (Arrange control bar or Ctrl+Shift+D)  

Or right click and choose ARRANGE > MOVE TO LAYER BEHIND. 

Move the selected object one layer backwards. The selected object becomes the front 

object in the new layer. In an animation document, this option is MOVE TO PREVIOUS 

FRAME. 

Group (Arrange control bar or Ctrl+G) 

Or right click and choose GROUP. 

Group the selected objects together to appear as a single object (refer to Object 

Handling (on page 92)). 

Ungroup (Arrange control bar or Ctrl+U) 

Or right click and choose UNGROUP. 

Split the group or groups into separate objects.  Dimmed unless the selected object is a 

group. Or, for several selected objects, there is at least one group. 
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Apply soft group (Ctrl+Alt+G) 

Or right click and choose APPLY SOFT GROUP. 

Make the selected objects form a soft group. Unlike groups, soft groups can include 

objects on different layers. Refer to Object Handling (on page 115) for details. 

Remove soft group (Ctrl+Alt+U) 

Or right click and choose REMOVE SOFT GROUP. 

Disband the selected soft group, so the objects are separately selectable objects again. 

Flatten photo group 

Converts a photo group to a single bitmap. 

Alignment (Ctrl+Shift+L) 

Or right click and choose ALIGN. 

Used to align several objects. Has no effect when a single object is selected (refer to 

Object Handling (on page 116) for more information). 

Combine Shapes (Arrange control bar) 

The Combine Shapes sub-menu lets you: 

 Add shapes together. 

 Or subtract the top shape from the other shapes. 

 Or discard parts of other shapes not covered by the top shape. 

 Or use the top shape to slice the other shapes. 

 Or use intersecting shapes to create slices of the grouped shapes. 

Only shapes in the selection are combined. Unselected shapes do not change (refer to 

chapter Shape handling (on page 157) for more information). 

Create Bitmap Copy (Ctrl+Shift+C) 

CREATE BITMAP COPY creates a bitmap version (on page 379) of the selected objects. 

Fit Text to Curve/Remove Text From Curve 

Or right click and choose FIT TEXT TO CURVE/REMOVE TEXT FROM CURVE. 

Lets you fit a line of text to an arbitrary curve or remove text from a curve (see Text 

Handling for more information). 

Repelling and Anchoring 

Or right click and choose REPEL TEXT UNDER, ANCHOR TO TEXT or REPELLING AND 

ANCHORING. 
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Make the object repel underlying text, and anchor an object within a column of text. See 

Repelling text objects (on page 227) and Anchored Graphics (on page 229) for details. 

Create Navigation Bar 

This command allows you to create a navigation bar from a single button. Read more in 

chapter Navigation bars (on page 413). 

Repeating object 

The Repeating object sub-menu lets you: 

 REPEAT ON ALL PAGES (SHIFT+CTRL+ALT+R) The selected object will be copied to the 

same place on all pages. 

 STOP REPEATING (SHIFT+CTRL+ALT+O) Turns off the repeating nature of the object - 

either for the selected object only, or all copies of the object. 

See Repeating objects (on page 124) for more information. 

Live copy 

The LIVE COPY sub-menu lets you: 

 CREATE LIVE COPY (SHIFT+CTLR+ALT+C) - the selected object is turned into an instance 

of a live copy 

 STOP LIVE COPY - turns off the the live copy object, either for the selected object only, 

or all copies of the object. 

See Live Copies for more information. 

Insert menu 

From Content Catalog (Shift+Alt+I) 

Opens the Online Content Catalog. Choose templates, widgets and clipart from the 

catalog's web, layout and photo and graphic categories. 

Image 

 From file - browse your computer to load an image file into the selected document. 

 From Web address - extracts all images from a specified web site. (Ctrl+Alt+W) 

 Stock photo - Opens the relevant section in the Content Catalog 

 Screen Capture - Opens the Screen Capture Tool (on page 371). 

 Photo filter - Opens the relevant section in the Content Catalog. 

 Photo frame - Opens the relevant section in the Content Catalog 

 More image resources... - Opens the relevant section in the Content Catalog 

 From Camera - Detects a web camera or other Windows associated video capture 

device attached to your computer and inserts a still image into the document. 

Shape 

 Rectangle - inserts a rectangle into the current document (Shift+R) 
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 Ellipse - inserts an ellipse into the current document (Shift+Ctrl+Alt+E) 

 Line - inserts a Line SmartShape into the current document. 

 Arrow - inserts an Arrow SmartShape into the current document. 

 More Shapes...  opens the Other Shapes section of the Online Content Catalog 

 More Lines & Arrows... opens the Lines & Arrows section of the Online Content 

Catalog 

See Shape Handling (on page 153) for more information. 

Text Box 

Inserts a text box into the current document. 

Panels 

 Text Panel - Inserts a simple Text Panel into the current document. 

 Photo Text panel - Inserts a simple Photo Text panel into the current document 

 Speech Bubble - Inserts a Speech Bubble into the current document 

 More Text Panels... opens the Text Panels section of the Online Content Catalog 

 More Photo Panels... opens the Photo Panels section of the Online Content Catalog 

Symbol 

Opens the Symbol (on page 198) picker. 

Table 

Insert a table from the Online Content Catalog into the current document. 

Charts 

Opens the Charts section of the Online Content Catalog 

New Page 

 New blank page - inserts a new blank page into the document after the current or 

selected page. 

 Duplicate page - inserts a duplicate page into the document after the current or 

selected page. 

 From Content Catalog - opens the Online Content Catalog 

Lorem Ipsum Text 

Inserts a block of dummy Lorem Ipsum text at the text carat position. Alternatively use 

the shortcut Ctrl + Shift + L. 

Break 

Inserts a page break at the following positions. 

 Move to next page  (Ctrl+Enter) 

 Move to next page (left) 

 Move to next page (right) 

 Move to next column (Shift+Ctrl+Enter) 

 Move below embedded graphic 
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Smart Fields... 

Opens the Smart Field dialog allowing you to insert a Smart Field into the current doc. 

Utilities menu 

Galleries 

Page & Gallery (Galleries control bar or "F10") 

Displays or hides the PAGE & LAYER GALLERY. Only used in non-animation documents 

(see Layers (on page 447)). 

Bitmap Gallery (Galleries control bar or "F11") 

Displays or hides the BITMAP GALLERY (see Bitmap Handling (on page 363)). 

Line Gallery (Galleries control bar or "Ctrl + F9") 

Displays or hides the LINE GALLERY (see Drawing Lines (on page 149)). 

Local Designs Gallery (Galleries control bar or "+ F10") 

Displays or hides the DESIGNS GALLERY (see Importing and Exporting (on page 486)). 

Fill Gallery (Galleries control bar or "+ F11") 

Displays or hides the FILL GALLERY (see Bitmap Handling). 

Frame Gallery (Galleries control bar or "+ F12") 

Displays or hides the FRAME GALLERY. Only used in animation documents (see Flash 

Animations (on page 460) ). 

Color Editor (Ctrl+E) 

Or right click and choose FILL COLOR. 

Opens the COLOR EDITOR (refer to Color Handling). 

Names 

Or right click and choose NAMES. 

Opens the Apply/remove names dialog (on page 123). 

Web Properties (Ctrl+Shift+W) 

Or right click and choose WEB PROPERTIES. 

Opens the WEB PROPERTIES dialog, which allows web features such as links, pop-up 

layers, anchors, etc. to be added to your web page document. You can also control how 

images are exported for the web page and set various other web properties using this 

dialog. See Getting Started (on page 17) for details. 

mk:@MSITStore:C:/SVN/Branchv16.2/prod_XXP/ENG/xarax.chm::/9155.htm
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Website Variants 

 SHARE WITH ALL VARIANTS: Allows the selected object to be shared with all variants, if 

the object is not available to be shared then there is an option to create a non-shared 

copy of the object in the other variants. 

 DELETE FROM ALL VARIANTS: Deletes the selected object from all variants. 

 STOP SHARING WITH VARIANTS: Stops the selected object being shared with all variants. 

 COPY PAGE TO ALL VARIANTS: Copies a selected page to all variants. 

 WEBSITE VARIANTS: Opens the Website Variants (on page 319) dialog. 

Optimize Photo 

Or right click and choose OPTIMIZE PHOTO. 

Optimize bitmap resolution for use in Xara Web Designer Premium designs. See Photo 

Optimization (on page 376) for details. 

Optimize all Images 

Optimizes all photos and bitmaps in the design. See Photo Optimization (on page 376). 

Animation 

This menu is only available in animation documents and offers three choices: 

 ANIMATION PROPERTIES: With this dialog box you can change the options for the 

animation and for each frame. 

 PREVIEW ALL FRAMES: Use this to preview all the frames of your animation. This is not 

very useful for Flash animations as it shows only the key frames with no tweening.  

 PREVIEW GIF ANIMATION IN BROWSER: This item creates an animated GIF file from the 

frames in your document and opens it in your web browser so you can see what it 

looks like. There is a button on the animation bar for quick access to this operation. 

 PREVIEW FLASH ANIMATION IN BROWSER: Pops up a window displaying your animation 

as Flash, as it will appear in a web browser when you export. Use this to preview 

Flash animations. There is a button on the animation bar for quick access to this 

operation. 

Check spelling as you type 

This option activates the SPELL CHECKER (on page 216) in the TEXT TOOL. 

Auto-Fit to page... 

Open the Auto-fit to Page... (on page 127) dialog. 

Smart Fields... 

Opens the Smart Field dialog allowing you to insert a Smart Field into the current doc. 

Options (Ctrl+Shift+O) 

Or right click and choose PAGE OPTIONS. 

mk:@MSITStore:C:/SVN/Branchv16.2/prod_XXP/ENG/xarax.chm::/9155.htm
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Opens the OPTIONS dialog box (described in Customizing Web Designer Premium (on 

page 509)). 

Share Menu 

 Sign into Xara - Sign into your Xara account. 

 Sign into MAGIX Online World - Sign into your MAGIX Online World account. 

 Xara Online Designer - Sign into Xara Online Designer.  

 Publish website - This initiates a publish operation on the current document - the 

same operation that’s available from the File menu and web toolbar. 

 Send to applications - If you have other compatible MAGIX applications installed, the 

Share menu will include options to send the selected image to those applications. 

Window menu 

Clear Selection / Reset current attributes (Esc) 

Deselect all objects. If nothing is selected, the current attributes (on page 119) are set 

back to its default values. You can easily get this by pressing ESC twice. 

Multiple Page View 

Or right click and choose MULTIPLE PAGE VIEW. 

By default Web Designer Premium shows only the current page of the currently open 

document. Choosing multiple page view shows all the pages in your document. 

Arrange Views 

Displays all Web Designer Premium windows as tiles. 

Animation 

In an animation document, toggles display of the animation toolbar. 

New View 

Opens a new window onto the selected document. 

Show Scrollbars 

Toggles display of the scrollbars at the side and bottom of the Web Designer Premium 

window. 

Show Rulers (Ctrl + L) 

Or right click and choose SHOW GRID/GUIDES > SHOW RULERS. 

Toggles display of rulers to the top and side of the Web Designer Premium window. 
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Control Bars 

Displays the CONTROL BARS dialog box (described in Customizing Web Designer 

Premium (on page 519)). 

Quality (Standard control bar) 

Selects how objects are displayed from wire frame to anti-aliased (see Document 

Handling (on page 80)). 

Show Document Tabs 

Toggles display of the document tabs that provide quick access to each open document 

at the top of the Web Designer Premium window. 

Clicking on a tab makes that document the selected document. A "*" after the document 

name indicates that it currently has unsaved changes. 

Full Screen (8 on numeric keypad) 

Toggles between full-screen and normal screen modes. 

Show Grid (#) 

Or right click and choose SHOW GRID/GUIDES > SHOW GRID. 

Makes the on-screen grid visible (see Document Handling (on page 78)). 

Show Guides (1 on numeric keypad) 

Or right click and choose SHOW GRID/GUIDES > SHOW GUIDES. 

Displays or hides the Guides layer which contains all guidelines and guide objects. 

Snap to Grid (. on numeric keypad) 

Or right click and choose SNAP TO > SNAP TO GRID. 

With this option set, an object snaps to any grid point it is dragged close to (see 

Document Handling (on page 63)). 

Snap to Guides (2 on numeric keypad) 

Or right click and choose SNAP TO > SNAP TO GUIDES. 

With this option set, an object snaps to any guide it is dragged close to (see Object 

Handling (on page 92)). 

Snap to Objects (* on numeric keypad) 

Or right click and choose SNAP TO > SNAP TO OBJECTS. 
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With this option selected, dragging a handle close to another object snaps the handle to 

the object; see Object Handling (on page 92) for more details. You can also adjust the 

snapping distance; see Customizing Web Designer Premium (on page 509) for more 

details. 

Documents Loaded 

A list of the currently open documents. Clicking on a name makes that document the 

selected document ("Ctrl + F6" also switches between open documents). A "*" after the 

document name indicates that it currently has unsaved changes. 

Help menu 

Xara Web Designer Premium help 

Use the command <PROGRAMMNAME > HELP in the HELP menu to open the start page of 

the program Help. Here you can work through the Help step-by-step and jump to specific 

sections via the tree structure on the left-hand side. 

Help 

This command is available at almost every point of this program and opens the program 

Help at the corresponding topic. Use this command to get help on any function of Xara 

Web Designer Premium. 

Shortcut:  F1 

Movies 

Goes to a web page containing tutorial movies on how to use Web Designer Premium. 

Knowledge Base 

Opens the Xara Web Designer Premium Knowledge Base, an invaluable source of online 

help containing useful information on such matters as... 

 Sales and Support 

 Purchase and Accounts 

 Product questions 

 News and Updates 

 Installation and Activation 

More Web Designer Premium 

Opens internet links to Xara’s website and other useful online help resources. 

Tip of the Day 

See the tip of the day. There is also a check box below the Tip of the Day where you 

select whether or not you see a tip each time you start Web Designer Premium. 
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Deactivate programme 

Deactivates the Xara Web Designer Premium installation on the current machine freeing 

up the licence key for installation on another one. 

Check for updates 

Check for recent updates to Web Designer Premium 

Info pop-ups 

Allows you to display 'tooltips' containing pop-up information as your mouse pointer 

moves over toolbars, buttons, the color line and other items in the Web Designer 

Premium window.  

About Xara Web Designer Premium 

Displays copyright info and version number of Xara Web Designer Premium. 

Key shortcuts 

The tools 

SELECTOR TOOL F2 or V or Alt + S 

FREEHAND MASK TOOL Alt + F4 

RECTANGLE MASK TOOL Alt + F5 

SHAPE EDITOR TOOL F4 

RECTANGLE TOOL   + F3 or M 

ELLIPSE TOOL  + F4 or L 

TEXT TOOL  F8 or T 

FILL TOOL G 

TRANSPARENCY TOOL  F6 

SHADOW TOOL  Ctrl + F2 

PHOTO TOOL P 

PUSH TOOL   + F8 or H or Alt + X (or the Space bar 

when not in the Text Tool) 

ZOOM TOOL  + F7 or Z or Alt + Z 
 

The galleries 

ONLINE CONTENT CATALOG Shift + Alt + I 

LOCAL DESIGNS GALLERY  + F10 

FILL GALLERY  + F11 

FRAME GALLERY  + F12 

PAGE & LAYER GALLERY F10 

BITMAP GALLERY F11 

LINE GALLERY Ctrl + F9 
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Zooming 

Previous zoom Ctrl + R 

Zoom to selection Ctrl + Shift + Z 

Zoom to drawing Ctrl + Shift + J 

Zoom to page Ctrl + Shift + P 

Zoom in (enlarge) Ctrl + + on the numeric keypad 

Zoom out (reduce) Ctrl + - on the numeric keypad 

Zoom to 100% 1 

Zoom to 200% 2 

Zoom to 300% 3 

Zoom to 400% 4 

Zoom to 50% 5 

You can also zoom and slide the document using a mouse-wheel (Ctrl+Mouse-Wheel 

zooms in/out). 

Manipulating documents 

When in the Text Tool, shortcuts marked with a star (*) have a different action-see below. 

New document Ctrl + N 

New animation document Ctrl + Shift + N 

Web animation dialog Ctrl+Shift+Alt+N 

Open document Ctrl + O 

Close document Ctrl + W* 

Switch document Ctrl + Tab 

Print document Ctrl + P 

Save document Ctrl + S 

Import  Ctrl + Alt + I 

Import graphics from Web Ctrl + Alt + W 

Add Google fonts Ctrl + Shift + Alt + W 

Export  Ctrl + Shift + E 

Time a document redraw Ctrl + Shift + T 

Show grid # 

Show guides 1 on numeric keypad 

Snap to grid . on the numeric keypad 

Snap to guides 2 on the numeric keypad 

Snap to objects * on the numeric keypad 

Select full screen 8 on the numeric keypad 

Show rulers  Ctrl + Shift + R or Ctrl + L* 

Undo Ctrl + Z or < or , 

Redo Ctrl + Y or > or . 

 

Manipulating objects 

When in the Text Tool, shortcuts marked with a star (*) have a different action-see below. 
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Select all Ctrl + A * 

Select next object Tab 

Delete the selection Delete * 

Clear selection Esc 

Bring object to front Ctrl + F 

Put object to back Ctrl + B * 

Move object forwards Ctrl +  + F 

Move object backwards Ctrl +  + B 

Move object to layer in front (drawing 

documents) 

Ctrl +  + U 

Move object to layer behind (drawing 

documents) 

Ctrl +  + D 

Move to next frame (animation 

documents) 

Ctrl +  + U 

Move to previous frame (animation 

documents) 

Ctrl +  + D 

Group objects Ctrl + G 

Ungroup objects Ctrl + U 

Clone object  Ctrl + K 

Duplicate object with offset Ctrl + D 

Copy object to clipboard Ctrl + C 

Cut selection to clipboard Ctrl + X 

Paste object from clipboard Ctrl + V 

Paste object in original position Ctrl +  + V 

Paste format/attributes Ctrl +  + A 

Create bitmap copy Ctrl +  + C 

Add shapes Ctrl + 1 

Subtract shapes Ctrl + 2 

Intersect shapes Ctrl + 3 

Slice shapes Ctrl + 4 

Open the alignment dialog box Ctrl +  + L* 

Web address Ctrl +  + W 

Move the selected objects: cursor (arrow) keys with the SELECTOR TOOL (see Nudging 

objects (on page 96) ) 

Move the selected handles: cursors (arrow) keys in tools other than the selector. 
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Text Tool 

Cursor keys Move the text cursor up up, down, left or right 

one character at a time. 

Home Move the text cursor to the start of the line. 

End Move the text cursor to the end of the line. 

Ctrl + left/right cursor Move the text cursor left/right one word. 

Ctrl + Home Move the text cursor to the start of the first line in a text 

object. 

Ctrl + End Move the text cursor to the end of the last line in a text 

object. 

Ctrl + A Selects all characters in a text object. 

Ctrl + B  Apply the bold attribute. 

Ctrl + I  Apply the italic attribute. 

Ctrl + C Copy the selected region of text to the clipboard. 

Ctrl + L Select all characters in the line containing the text cursor. 

Ctrl + Return Insert page break 

Ctrl + Shift + Return Insert column break 

Ctrl + Shift + L Insert 'Lorem ipsum' dummy text 

Ctrl + V Paste text at the text cursor position (if the clipboard 

contains text). 

Ctrl + W Swap the case of the character to the right of the text cursor. 

Ctrl + Shift + F1  Toggle text selection between uppercase and lowercase. 

Ctrl + - Insert Soft Hyphen (appears only when wrapping at line 

end). 

Ctrl + Shift + - Insert hard hyphen (dash) to prevent a dash being 

misinterpreted as a hyphen at line end. 

Ctrl + < 

Ctrl + > 

Increase/Decrease font size of selected text (only if the 

selection is all the same point size) 

Alt + cursor keys Increase/Decrease kerning/tracking. 

 Start a new line of text. 

Delete Delete the character to the right of the text cursor. If the 

cursor is on the end of a text line, join this line to the line 

below. 

Backspace Delete the character to the left of the text cursor. If the 

cursor is at the start of a text line, join this line to the line 

above. 

Shift + cursor keys Select all text between the cursor position and the beginning 

of the line. 

Shift + End Select all text between the cursor position and the end of the 

line. 
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Special characters (in Text Tool) 

Ctrl + Space  Hard space (words with hard spaces 

between will not wrap at the end of a line) 

Ctrl + NumPad – – EN dash  (An EN dash is longer than a 

minus, and is a more correct ‘dash’) 

Ctrl +  Alt + NumPad – — EM dash (An EM dash is a long dash) 

Ctrl + Alt +.(Full stop) … Ellipsis (An ellipsis is three dots) 

Ctrl + Alt + C © Copyright 

Ctrl + Alt + R ® Registered 

Ctrl + Alt + T ™ Trademark 

Ctrl + Alt + B • Bullet  

 

Pages 

Ctrl + C Copy current or selected pages (with no objects selected) 

Ctrl + X Cut current or selected pages (with no objects selected) 

Ctrl + V Paste page(s) 

Delete Delete current or selected pages (with no objects selected) 

Shift + Ctrl + Delete Delete current or selected pages (with or without objects 

selected) 

Shift + Ctrl + PageUp Move Page Up 

Shift + Ctrl + 

PageDown 

Move Page Down 

 

Masking 

Mask Painter Tool Alt + F3 

Mask Freehand  Tool Alt + F5 

Mask Rectangle Tool  Alt + F6 

Toggle Mask on/off Ctrl + M or Shift + F1 

Invert Mask Ctrl + Shift + I or Ctrl + F1 

Clear Mask Ctrl + D or Alt + F1 

 

Other 

Color Editor Ctrl + E (opens and closes) 

Options dialog Ctrl + Shift + O 

Xara Web Designer Premium Help F1 
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More about Xara Group 

About Xara Group Ltd. 

 

Xara is one of the oldest software developers in the UK, with an 

uninterrupted history of innovation dating back to 1981. 

From Wordwise, one of the earliest microcomputer word processors, to Xara Designer, 

the world's fastest, and many believe the world's best drawing and illustration software, 

Xara has developed a wide range of products covering the whole realm of publishing 

software. Xara has pioneered many technologies taken for granted nowadays. From 

developing the world's first check-as-you-type spell checker, to award winning desktop-

publishing software, to the first drawing software to provide real-time anti-aliasing and 

transparency control, Xara continues to innovate and develop leading edge technical 

solutions. 

Xara's first Windows illustration software, Xara Studio, was licensed to Corel and 

distributed for many years as CorelXARA. Now back under Xara control this product has 

been enhanced and relaunched and is now sold in two versions, Xara Photo & Graphic 

Designer and Xara Designer Pro, and also forms the basis for Xara Web Designer. 

Xara has been involved in the Internet from the very beginning. Xara Networks, a 

subsidiary of the Xara Group, was a pioneer Internet provider in the mid 1990s 

(subsequently sold). Another early innovation was Xara Online, which provided online 

Web Service based web graphic and photo effect add-ons.  Xara's most recent 

development is Xara Cloud https://xara.cloud/, a cloud based service which offers the 

ability to design rich documents in the web browser, using any device, and in 

collaboration with colleagues. Today Xara does all of its business via the web, and has 

millions of online customers, worldwide. 

Xara has offices in Berlin, Germany and Gaddesden Place, a historic house in the UK, 

north of London.  

Xara benefits from a distribution partnership with MAGIX Software GmbH. MAGIX has 

been a leading international provider of high-quality software, online services and digital 

contents for multimedia communications since 1993. Internationally, MAGIX operates 

from branches in the USA, Canada, the UK, Germany, France, Italy and the Netherlands. 

https://xara.cloud/
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The MAGIX product range is targeted towards laymen and professionals alike and goes 

beyond the PC range to include seamlessly integrated online and mobile applications. 

According to its retail sales figures, MAGIX leads in the multimedia software sector in the 

most important European markets, and is one of the most successful competitors in the 

USA 

Web Links 

Xara Home Page - http://www.xara.com 

MAGIX Home Page –  http://www.magix.com 

 

http://www.xara.com/
http://www.magix.com/
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Legal 

Copyright 

This documentation is protected by law. All rights, especially the right of duplication, 

circulation, and translation are reserved. 

No part of this publication may be reproduced in form of copies, microfilms or other 

processes, or transmitted into a language used for machines, especially data processing 

machines, without the express written consent of the publisher. 

All copyrights reserved. 

All other product names are trademarks of the corresponding manufacturers. Errors in 

and changes to the contents as well as program modifications reserved. 

Xara is a registered trademark of Xara Group Ltd. 

MAGIX is a registered trademark of MAGIX Software GmbH.  

Other mentioned product names may be registered trademarks of the respective 

manufacturer. 

This product uses MAGIX patent pending technology. 

Copyright © Xara Group Ltd., 1994 - 2019 All rights reserved. 

Acknowledgements 

The Geotype font is provided by kind permission of Gary Bouton and remain © Gary 

Bouton, see www.theboutons.com. Some fonts copyright © FontBank Inc., all rights 

reserved. Other fonts are provided by third parties who retain the copyright. 

Xara Web Designer Premium uses Font Awesome by Dan Gandy – 

http://fontawesome.io  

In all cases copyright is reserved by Xara or its licensors and is protected by international 

copyright law. 

Xara is a trademark of Xara Group Ltd. The contents of this documentation and the 

associated Xara software are the property of Xara Group Ltd and are copyrighted. Any 

reproduction in whole or in part is strictly prohibited. 

Portions of this software are copyright © 2006 The FreeType Project (www.freetype.org). 

All rights reserved. 
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Redistributable portions of Microsoft MSVC and MFC are copyright of Microsoft 

Corporation. Microsoft, Internet Explorer, PowerPoint, Windows and Windows Vista are 

either trademarks or registered trademarks of Microsoft Corporation in the United States 

and/or other countries. 

Adobe, Encapsulated PostScript, Illustrator, Photoshop, Dreamweaver, Fireworks, 

Freehand, Flash, PostScript and Type Manager and  are either registered trademarks or 

trademarks of Adobe Systems Incorporated in the United States and/or other countries. 

MAGIX is a registered trademark of MAGIX Software GmbH  & Co.  

Apple, Macintosh, Retina and TrueType are registered trademarks of Apple Computer, 

Inc. 

Corel, CorelDRAW and Paintshop Pro are either registered trademarks or trademarks of 

Corel Corporation. 

Xara Web Designer Premium uses Little CMS.  http://www.littlecms.com/ A copy of the 

license is included in littlecms.txt in the HelpAndSupport folder of your program 

installation. 

Xara Web Designer Premium uses the Google Web Fonts API 

Xara Web Designer Premium uses the FontForge library http://fontforge.github.io/en-US/. 

A copy of the FontForge license is included in FontForgeLicense.txt in the 

HelpAndSupport folder of your program installation 

Xara Web Designer Premium includes MiniWeb HTTP server, available under LGPL 

from here: (http://www.sourceforge.net/projects/miniweb/) 

Xara Web Designer Premium uses the Mersenne Twister random number generator , 

Copyright (C) 1997 - 2002, Makoto Matsumoto and Takuji Nishimura, and 2000 - 2003, 

Richard J. Wagner. All rights reserved. Further copyright information can be found in the 

MTRand.txt file located in the HelpAndSupport folder of your Web Designer Premium 

installation. 

Some program code is Copyright (c) 1996 Silicon Graphics Computer Systems, Inc. 

Further copyright information can be found in sg.txt in the HelpAndSupport folder of your 

Xtreme installation. 

Some program code is  Copyright (c) 1994 Hewlett-Packard Company. Further copyright 

information can be found in the hp.txt  in the HelpAndSupport folder of your program 

installation. 

Some import and export filters utilize color profiles from Adobe Systems Inc. The license 

agreement can be found in the HelpAndSupport folder of your Xara Web Designer 

Premium installation. 

Web Designer Premium’s PDF Import function uses a separate pdf2xar conversion 

program, which itself uses the open source Poppler library 

http://www.littlecms.com/
http://fontforge.github.io/en-US/
http://www.sourceforge.net/projects/miniweb/
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(http://poppler.freedesktop.org). The source for pdf2xar is released by Xara as open 

source and is available from http://www.xara.com/pdf-import/. 

This software is based in part on the work of the Independent JPEG Group. 

Xara Web Designer Premium uses the zlib compression library www.zlib.net 

Xara Web Designer Premium uses the ImageMagick library Copyright 1999-2007 

ImageMagick Studio LLC http://www.imagemagick.org. A copy of the ImageMagick 

license is included in ImageMagick.txt in the HelpAndSupport folder of your Xara Web 

Designer Premium installation. 

Web Designer Premium's spell checker is based on the Open Source Hunspell library 

used without any modifications under the Mozilla Public License Version 1.1. You can 

find a copy of the Mozilla Public License in the file MPL-1.1.txt in the "dict" folder of your 

Web Designer Premium installation and a copy of the Hunspell source code at  

http://hunspell.sourceforge.net/.  

The Xara Web Designer Premium distribution includes various language dictionaries 

which are distributed under various different licenses, for use with the spell checker. Xara 

Web Designer PremiumSee the text files in the "dict" folder of your Xara Web Designer 

Premium installation for details of each license. The Russian dictionary is Copyright (c) 

1997-2008, Alexander I. Lebedev. See README_ru_RU.txt in the “dict” folder of your 

program installation for details and license. 

Xara Web Designer Premium uses the libcurl library http://www.curl.haxx.se/libcurl for 

FTP publishing. A copy of the license for this library is included in libcurl.txt in the 

HelpAndSupport folder of your Xara Web Designer Premium installation. 

All other trademarks or registered trademarks are the property of their respective owners. 

  

http://www.xara.com/pdf-import/
http://www.imagemagick.org/
http://hunspell.sourceforge.net/
http://www.curl.haxx.se/libcurl
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Index 

3 

3D Extrude Tool 400 

A 

A Website in a Few Steps 13 
About Presentations 419 
About RWD 313 
About Supersites 318 
About Xara Group Ltd. 537 
About Xara Web Designer Premium 16, 532 
Accelerating and Decelerating 474 
Acknowledgements 539 
Adding & editing buttons 412 
Adding a Cookie Consent banner 435 
Adding a new point handle 143 
Adding arrowheads & tails 140 
Adding code to page head 308 
Adding menus and sub-menus 414 
Adding more line segments 140 
Adding names 123 
Adding New Buttons 49 
Adding New Pages To Your Website 26 
Adding new presentation pages 426 
Adding to a gallery 89 
Adding widget placeholders manually 437 
Adjust button widths to labels 409 
Adjusting the clip region 384 
Adjusting the left and right margin of text on a curve 210 
Advanced color operations 181 
Advanced Flash Commands 474 
Advanced presentation information 429 
Aligning 118 
Alignment 116 
Alignment (Ctrl+Shift+L) 524 
All buttons the same width 409 
Alternative Content Aware Scaling 394 
Analytics Tab 311 
Anchored Graphics 225 
Anchored Groups 45 
Anchored Objects 42 
Angle constraint 506 
Animated GIFs 434 
Animation 528, 529 
Animation Frame Rate and Tween Steps 465 
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Animation Loop and Speed 479 
Animation properties 478 
Animation smoothness 469 
Animation Speed 468 
Animations 454 
Apply soft group (Ctrl+Alt+G) 524 
Applying a bevel 274 
Applying a bevel to several objects 274 
Applying a floor shadow 271 
Applying a glow effect 271 
Applying a Live Effect 388 
Applying a shadow 270 
Applying a shadow to several objects 273 
Applying a Text background color 179 
Applying attributes to whole text stories 251 
Applying fill & line colors by drag & drop 178 
Applying flat transparency 266 
Applying graduated transparency 266 
Applying presentation page transitions 428 
Applying presentation step transitions 427 
Applying settings to popup layers 59 
Applying text attributes 243 
Applying transparency to several objects 269 
Arrange menu 522 
Arrange Views 529 
Arrow SmartShapes 172 
Ask before setting current attribute 504 
Auto correction 216 
Auto Enhance 380 
Auto-fit for individual page objects 129 
Auto-fit to page... 127 
Auto-Fit to page... 528 
Auto-fit to text areas 206 
Automatic backups 44 
Automatic Backups 76 
Automatic fit 500 
Automatic page linking 410 
Automatic placeholder generation 432 
AVI Options 479 

B 

Backup location 77 
Backup open documents 76 
Backup open documents on program close 77 
Backups on system shut down 78 
Backups Tab 511 
Balancing curves 148 
Best fit 500 
Bevel direction 275 
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Bevel Type & Size 402 
Bevels 274 
Bitmap coloring 260 
Bitmap fills 259 
Bitmap Properties 359 
Bitmap Quality 464 
Bitmap Size tab 493 
Bitmaps 268 
Blur the edges of the shadow 272 
Blur/Sharpen 381 
Bold & Italic 244 
Break 526 
Brightness/Contrast/Color Temperature/Saturation/Hue 380 
Bring to Front (Arrange control bar or Ctrl+F) 523 
Browser Preview tab 494 
Brush styles 139 
Bullet Lists 231 
Bulleted and numbered lists 42 
Bulleted and Numbered lists 231 
Button Bars (NavBars) 49 
Button design restrictions 417 
Button order matches page order 409 
Button spacing 409 
Buttons & Menus 412 

C 

Change join type 151 
Change line cap 151 
Change object selection 92 
Change the transparency of the shadow 272 
Changing a straight line to a curve (and vice versa) 146 
Changing background colors 186 
Changing Button Text 49 
Changing colors in a group 115 
Changing curves 147 
Changing step order 425 
Changing the angle of the column 202 
Changing the bevel color or fill effect 277 
Changing the bevel join style 277 
Changing the bevel light source 275 
Changing the bevel shape 277 
Changing the bevel size 276 
Changing the blank template document 502 
Changing the colors in a fill 258 
Changing the font on NavBar buttons 416 
Changing the font size 243 
Changing the light elevation (vertical angle) 276 
Changing the light strength (contrast) 276 
Changing the line width (thickness) 149 
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Changing the page size 71 
Changing the ruler zero points 80 
Changing the shadow color or fill effect 272 
Changing the width of the column 202 
Changing the zoom using the zoom InfoBar/control bar 69 
Changing the zoom value 68 
Changing the zoom value using the mouse 69 
Chart SmartShapes 166 
Charts 526 
Check for updates 531 
Check spelling as you type 528 
Chevron Bar SmartShape 175 
Circular fills 258 
Clear 384 
Clear Selection / Reset current attributes (Esc) 522, 529 
Click/Touch animations 450 
Clickable area 293 
Clickable Buttons & Mouse-over Effects 475 
Clip to page edges 295 
Clip Tool 383 
Clipping in Photo Documents 385 
ClipView 122 
Clone (Ctrl+K) 522 
Cloning 100 
Close (Ctrl+W) 516 
Closing a gallery 90 
Closing the document 75 
Color Editor (Ctrl+E) 527 
Color Handling 176 
Color line context menu 177 
Color palette from photo 397 
Color Select 

Context menu 21 
Color Transforms—Animating Color Changes 473 
Coloring Imported Clipart 34 
Coloring photos 367 
Coloring Photos 34 
Coloring Shapes 34 
Colors on the color line 176 
Column breaks 205 
Combine Shapes 287 
Combine Shapes (Arrange control bar) 524 
Combining shapes 157 
Common photo functions 378 
Compare & Restoring the original 382 
Conflicts in page layouts 113 
Connecting text areas—text flow 203 
Constraining the line 146 
Content Aware Photo Resize 391 
Content Aware photo scaling 286 
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Content Aware Scaling notes 394 
Content-aware photo zoom 394 
Control bars 65, 512 
Control Bars 529 
Converting an existing website into a presentation 424 
Converting objects or drawings to bitmaps 373 
Converting Text To Be A Graphic 45 
Coordinate Direction 507 
Copy (Edit control bar or Ctrl+C) 520 
Copying 3D extrude attributes 405 
Copying and pasting pages 72 
Copying Live Effects 390 
Copying Objects 24, 463 
Copying shadows onto other objects 273 
Copying Shapes To The Mask Layer 287 
Copying Styles 

Paste Attributes 121 
Copying text appearances 251 
Copying/Pasting formatted text (RTF) 251 
Copyright 539 
Core Principles 456 
Create Bitmap Copy (Ctrl+Shift+C) 524 
Create Navigation Bar 525 
Creating a graduated color fill 253 
Creating a guideline 112 
Creating a presentation 422 
Creating a presentation from templates 422 
Creating a shape 137 
Creating a Soft Mask 285 
Creating a square 153 
Creating a Tint, Shade or Linked color 189 
Creating a website 24 
Creating and Editing rounded corner rectangles 153 
Creating animated GIFs 477 
Creating Buttons, Banners And Other Web Graphics 46 
Creating circles and ellipses 154 
Creating holes in shapes 157 
Creating new control bars 514 
Creating new named colors 183 
Creating new Styles 241 
Creating New Text Objects 41 
Creating Number and Bullet lists 426 
Creating polygons and stars 154 
Creating rectangles and squares 153 
Creating RWD Websites from existing sites 315 
Creating RWD Websites from templates 314 
Creating Soft Groups 115 
Creating the animation 477 
Creating your own color schemes 183 
Creating Your Own Mouseover Buttons 413 
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Creating your own Navigation Bars 417 
Creating your own presentation from scratch 422 
Cropping or clipping images 382 
Cropping photos 364 
Cropping, Clipping and Animation Size 466 
Current attributes (styles) 119 
Current layer always visible and editable 503 
Custom fit 500 
Custom tab types 222 
Custom tabs 221 
Customizing Web Designer Premium 502 
Cut (Edit control bar or Ctrl+X) 520 
Cut, copy and paste 97 
Cut, Copy, Delete 285 
Cutting objects 99 

D 

Deactivate programme 531 
Default Live Effect resolution 512 
Default Locked effect resolution 512 
Delete (Edit & Standard control bars or Delete) 522 
Deleting a guideline 113 
Deleting a site navigation bar from a page 410 
Deleting a step 426 
Deleting control bars 515 
Deleting images from the Gallery 359 
Deleting named colors 186 
Deleting objects 99 
Deleting objects from a step 426 
Deleting points 144 
Deleting presentation pages 427 
Deleting repeating objects 126 
Deleting sections from a gallery 90 
Deleting Styles 242 
Deleting unused named colors 186 
Deselecting an object 94 
Displaying & hiding control bars 513 
Displaying a gallery 83 
Displaying your own icons in browser tabs 

favicons 50 
Displaying/hiding rulers 80 
Distribute 119 
Docked and free floating control bars 514 
Document font embedding 252 
Document handling 63 
Document info 13 
Document Info 520 
Document type 506 
Documents Loaded 531 
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Dragging the line segment 147 
Drawing & editing straight lines 140 
Drawing a line or a shape 136 
Drawing Lines and Shapes 136 
Drawing straight segments in the Freehand Tool 137 
Drawing Tools 50 
Drop copy 96 
Duplicate (Edit control bar or Ctrl+Alt+D) 522 
Duplicate, Clone 286 
Duplicating 100 
Duplicating and cloning 100 
Duplication distance 506 

E 

Edit menu 520 
Editing a Mask 284 
Editing an object’s color 179 
Editing existing widgets 432 
Editing lines/shapes with the Freehand & Brush Tool 138 
Editing List items 233 
Editing mold shapes 282 
Editing named colors 186 
Editing Photo Files 375 
Editing Photo Filter Presets 370 
Editing polygons and stars 156 
Editing shapes 389 
Editing SmartShapes 161 
Editing stars 157 
Editing text 213 
Editing the contents of a repeating object 125 
Editing the outline of Photos 363 
Editing the parent color 190 
Effects 511 
Effects & Plug-ins tab 511 
Elliptical fills 259 
Embedded JPEG files 359 
Embedding Graphics 228 
Embedding movie, audio, animation and other files 433 
Embedding Movies, Flash And Other Widgets 27 
Enabling Supersites 319 
Enhance Tool 379 
Entering dummy text ('Lorem Ipsum') 214 
Entering special characters 214 
Enveloping 281 
Erasing while drawing 137 
Example 

To resize a photo and save as a new JPEG 362 
Example Graphics 55 
Exit 520 
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Explore web space 340 
Export (Ctrl+Shift+E) 517 
Export Animation 520 
Export DPI 489 
Export formats 482 
Export JPEG 517 
Export PNG 517 
Export supersite 519 
Export Website 518 
Exporting a Flash File 458 
Exporting a Photoshop PSD file 488 
Exporting a Web document 486 
Exporting animations as AVI 459 
Exporting as a bitmap 487 
Exporting as AVI 486 
Exporting as Extended Metafile Format (EMF) 487 
Exporting as Flash 486 
Exporting as Windows metafiles (.wmf) 487 
Exporting files 486 
Exporting the animation 478 
Exporting to a Word document 486 
Exporting websites with support folders 75 
Extend Selection 93 
Extending a line 137 
Extending the line 142 
Extracting the original JPEG 360 
Extrude Tool InfoBar 401 
Extruding a shape 400 
Extruding Text 405 
Extrusion depth 402 

F 

Fast Publish (Only changed files) 341 
Feather 54 
File menu 516 
Fill quality 499 
Fill Tool 52 
Fill Tool InfoBar 255 
Fill types 254 
Filling shapes with a bitmap 358 
Fills 96 
Find & Replace 219 
Finishing the line 143 
Fit Text to Curve/Remove Text From Curve 524 
Fixed, non-scrolling backgrounds 330 
Flash files 434 
Flash Options 478 
Flat fills 257 
Flatten photo group 524 
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Flipping objects 106 
Flowline SmartShapes 175 
Flyout Bars 19 
Font permissions 252 
Font replacement 201 
Font Size 41 
Fractal fills 261 
From Content Catalog (Shift+Alt+I) 525 
Full Screen (8 on numeric keypad) 530 
Full screen mode 512 

G 

Galleries 82, 527 
General notes on exporting and importing 480 
General tab 503 
Getting Help 13 
Getting Started 17 
GIF Options 478 
Give new objects most recent attributes (GNOMRA) 504 
Gloss / Matt 403 
GNOMRA 119 
Google fonts 196 
Graphical Bullets and Numbered Lists 236 
Grid and Ruler spacing 507 
Grid and Ruler tab 507 
Group (Arrange control bar or Ctrl+G) 523 
Group images 304 
Group Transparency 471 
Grouping and ungrouping objects 114 
Grouping galleries 86 
Groups 44, 471 
Groups and layers 115 
Guide Objects and Guidelines 111 

H 

Handle/resolution 269 
Help 531 
Help menu 531 
Hidden Styles 243 
Hiding buttons and tools 515 
Hiding Layers 445 
High resolution images 345 
Highlighting text 244 
Horizon Straighten 355 
How to creating hanging indents 223 
Hyphenation 216 
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I 

Image 525 
Image Captions 303 
Image Tab 299 
Import (Ctrl+Alt+I) 517 
Import and Export Supported File Formats 481 
Import formats 481 
Import from Web Address (Ctrl+Alt+W) 517 
Important 487 
Importing & pasting NavBars 417 
Importing a Photoshop PSD file 483 
Importing a Word document 484 
Importing and Exporting 480 
Importing files 483 
Importing from a website 485 
Importing Large Photos 37 
Importing named colors 187 
Importing Photos 352 
Indents and Outdents 249 
Info pop-ups 532 
InfoBar 23, 66 
Initial Photo size 353 
Insert menu 525 
Inserting 432 
Inserting a Flash file into your webpage 458 
Inserting pages into your document 72 
Inserting Symbols as graphics 200 
Inserting Symbols into text 200 
Inserting using a different web authoring tool 459 
Instant font menu navigation 196 
Intersecting shapes 158 
Introduction 12, 191, 345, 377, 388, 400, 454, 516 

J 

Joining lines 148 
Joining two lines 137 
JPEG, PNG and GIF export dialog overview 490 
Justification 409 
Justification or text alignment 244 

K 

Key shortcuts 532 
Knowledge Base 531 
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L 

Labeled lines 173 
Language selection 215 
Layer Operations 442 
Layer ordering in website documents 58 
Layer Properties 443 
Layers 440 
Layers on websites 442 
Layers, Mouseover (Rollover) & Pop-ups 56 
Legacy web browser compatible line lengths 505 
Legal 539 
Ligatures 245 
Lights 402 
Line Gallery 149 
Line spacing 249 
Linear fills 257 
Link Tab 289 
Link to anchor 291 
Link to File 291 
Link to heading 291 
Link to web address 289 
Link to... 290 
Linked colors 189 
Linking to next/previous step 427 
Links, Buttons & Navigation Bars 47 
List Styles 238 
Live copy 525 
Live Effect resolution 390 
Live Effects 387 
Live Font Preview 195 
Live Font Size preview 196 
Local colors and Theme colors 182 
Lock Aspect 384 
Lock Aspect button 104 
Locking effects 389 
Locking Layers 446 
Lorem Ipsum Text 526 

M 

Magnetic object snapping (snap to objects) 110 
Magnetic Snap Radii 509 
Main toolbar 66 
Maintain imported layer names 504 
Make groups be transparent as a whole. 504 
Make Named Color local to Frame/Layer 188 
Making a photo its full size 370 
Making an object repel 224 
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Making sharp corners 147 
Making smooth curves 147 
Managing presentation steps 424 
Manipulating documents 533 
Manipulating objects 533 
Margins and indents 220 
Marquee Object Selection 505 
Marquee selection 93 
Masking 536 
Masks vs Photo Regions 283 
Menu separators 414 
Menu Styles 415 
Menus and Keyboard Shortcuts 516 
Merging several shapes into one 158 
Minimizing multiple windows 68 
Mitred corner / Rounded corner 403 
Mixing curved and straight lines 142 
Mixing individual and group transparencies 269 
Modifying a bevel 275 
mold 279 
More about Xara Group 537 
More Web Designer Premium 531 
Mouse button function 508 
Mouse tab 508 
Mouseover (Rollover) Buttons 49, 57 
Mouseover Effects 56 
Mouse-over features 450 
Mouse-over properties (Web Animations) 305 
Move Backwards (Arrange control bar or Ctrl+Shift+B) 523 
Move Forwards (Arrange control bar or Ctrl+Shift+F) 523 
Move To Layer Behind (Arrange control bar or Ctrl+Shift+D) 523 
Move to Layer in Front (Arrange control bar or Ctrl+Shift+U) 522 
Movies 531 
Moving Anchored Objects 228 
Moving and docking a gallery 84 
Moving and transforming a site navigation bar 410 
Moving buttons and tools 515 
Moving objects 95 
Moving Objects Between Layers 59, 447 
Moving objects forward and backwards 100 
Moving objects from one step to another 425 
Moving objects selected under or inside 93 
Moving pages within the document 73 
Moving point handles—Shape Editor Tool 144 
Moving the start or end handle of the fill 258 
MP3 files 434 
MP4 & FLV movie files 433 
Multi-column pages 204 
Multiple fit 501 
Multiple Page View 529 
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Multiple pages in the document 71 
Multiple variants 314 
Multi-stage color graduations 262 
Multi-stage graduated transparency 266 

N 

Names 527 
Names applied 123 
Naming objects 123 
Navigating between pages 73 
Navigation bar properties dialog 408 
Navigation Bars 407 
Network button 496 
New (Standard control bar or Ctrl+N) 516 
New Effects Are Locked By Default 512 
New from Content Catalog (Shift+Ctrl+Alt+K) 516 
New Page 526 
New View 529 
Non-JPEG Bitmaps 463 
Non-moving Objects 473 
Normal colors 188 
Normal colors, Tints, Shades and Linked colors 188 
Normal/full screen modes 68 
Nudge size 506 
Nudging objects 96 
Nudging Objects 23 
Number of copies 497 
Numbered Lists 232 

O 

Object Based Web Design 21 
Object Handling 92 
Object types and Animation combinations. 452 
Objects On The Page 20 
Offsetting the top of your page 333 
On canvas editing 416 
Online editing in the Cloud 63 
On-screen grid 78 
Open (Standard control bar or Ctrl+O) 516 
Open link in 293 
Open recent 516 
Open Type Alternates 246 
Opening a second window 68 
Opening an animation document 477 
Opening an existing document 63 
Operations That Use A Mask 285 
Optimize 393 
Optimize all Images 528 
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Optimize Photo 528 
Optimizing images 396 
Optimizing Photos and Bitmaps 370 
Options (Ctrl+Shift+O) 528 
Options button 497 
Options in the Utilities menu 502 
Options tab 494 
Ordering multiple windows 68 
Orientation 408 
Other 536 
Other points to note 411 

P 

Packed Photo Grid 171 
Padding margin 211 
Page & Layer Gallery 74, 438 
Page and Pasteboard Background Layers 331 
Page breaks 208 
Page Options 520 
Page Size 43 
Page Size tab 510 
Page Tab 297 
Pages 440, 497, 522, 536 
Palette Options tab 491 
Panels 526 
Panorama Stitching 395 
Paragraph Spacing 250 
Paragraph Styles and Character Styles 237 
Paste (Edit control bar or Ctrl+V) 521 
Pasteboard backgrounds 327 
PDF Files 434 
PDF Import 484 
Perspective 279 
Photo display quality 360 
Photo Documents 374 
Photo Edit Attributes 363 
Photo enhance tool 287 
Photo Filter Presets 367 
Photo Grids, Panels and Frames 347 
Photo Groups 347 
Photo Handling 345 
Photo Hover panels 27 
Photo Objects 346 
Photo pop-up 300 
Photo Regions and Masks 283 
Photo Tool Benefits 377 
Photo Tool Notes 385 
Photos 36, 463 
Photoshop Plug-ins 511 
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Pie chart SmartShapes 167 
Placeholder objects 308 
Placeholder Tab 306 
Placing objects onto the Guides Layer 112 
Polygons or stars with rounded corners 155 
Pop-up layer 292 
Pop-up Layers 60 
Pop-up layers and presentation layers 429 
Pop-up photo 292 
Popup Photo Options 301 
Pop-up Photos 61 
Pop-up slider controls 380 
Preparing Your Photo 392 
Presentation website 295 
Preview Controls 491 
Preview Flash 519 
Preview in Browser 479 
Preview supersite 519 
Preview web page (Shift + F5) 517 
Preview Website (F5) 518 
Previewing a Flash file in Xara Web Designer Premium 458 
Previewing and testing Auto-fit pages 132 
Previewing Your Website 24 
Previous & Next 378 
Previous and Current color 181 
Print (Ctrl+P) 520 
Print As 498 
Print button 496 
Print layers 498 
Print Options 

Output tab 498 

Print Layout tab 500 
Print to File 497 
Printer… button 496 
Printing 495 
Profile 268 
Program Layout 17 
Properties button 496 
PSD Export settings 488 
Publish supersite 519 
Publish Tab 309 
Publish Website 518 
Publishing to an alternative web host 335 
Publishing to Xara Hosting 334 
Publishing variants 317 
Publishing Your Website 61 
Push objects 134 
Put to Back (Arrange control bar or Ctrl+B) 523 
Putting shadows behind 406 
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Q 

Quality (Standard control bar) 530 
Quick export of HTML and web graphics formats 487 

R 

RAW photo import 485 
Recent files 504 
Recovering backups 78 
Recovering from abnormal program closures 78 
Rectangle Tool 52 
Redefining Text Styles 239 
Redo (Standard control bar or Ctrl+Y) 520 
Region Painter 284 
Remove soft group (Ctrl+Alt+U) 524 
Removing a bevel 277 
Removing a ClipView 123 
Removing a gallery from the workspace 90 
Removing a shadow 273 
Removing an anchor 228 
Removing objects from a group 114 
Removing objects from the document 99 
Removing pages from your document 73 
Removing Soft Groups 116 
Removing Styles 242 
Renaming named colors 186 
Re-ordering colors on the color line 177 
Re-ordering items in the gallery 89 
Repeating Groups 45 
Repeating object 525 
Repeating Objects 45, 124 
Repelling and Anchoring 524 
Repelling text objects 223 
Replace with Flash 307 
Replace with graphic file 307 
Replace with HTML code 307 
Replacing Bitmap Fills 260 
Replacing colors 184 
Replacing Image Files 483 
Replacing photos 353 
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